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1.  INVENTORY 
 
1.1. Hydrographic Vessels 
 
The NOAA Ship FAIRWEATHER (HRN S220) and her survey launches (HRN 1010 and HRN 1018) are 
equipped to acquire multibeam echosounder (MBES) and sound velocity profile (SVP) data.  The AMBAR 
(HRN 2302) and MonArk (HRN not assigned) are used during shoreline, dive, horizontal control, and vertical 
control operations.  See Table 1 below for a list of vessels and vessel information.  Any unusual vessel 
configurations or problems will be addressed in the Descriptive Reports of individual surveys. 
 

  FAIRWEATHER Launch 1010 Launch 1018 MonArk Ambar 700 Fast Rescue 
Boat 

Hull Registration 
Number S220 1010 1018 Not 

assigned 2302 2301 

Call Letters WTEB  WTEB 1010  WTEB 1018    WTEB 2302  WTEB 2301 

Builder Aerojet-General 
Shipyard 

The Boat 
Yard, Inc 

The Boat 
Yard, Inc MonArk 

Marine 
Silverships, 
Inc 

Zodiac of  
N. America 

Year built 1967 1974 / 2004 1982 / 2004   2004  2004 

Delivered to NOAA January 1968 1974 1982   2004  2004 

Commissioned October 1968           

Re-activated August 2004 2004  2004       

Length Overall 231 feet 28’ 10” 28’ 10” 17’ 23’ 23’ 

Beam 42 feet  10’ 8” 10’ 8”  7’ 9’ 4” 8’ 6” 

Draft, Maximum 15’ 6”  4’ 0” DWL  4’ 0” DWL 1’ 3” 1’ 4”  1’ 5” 

Cruising Speed 12.5 knots 24 knots 24 knots 20 knots 22 knots 20 knots 

Max Survey Speed 10 knots 10 knots 10 knots       

Capacity 58 13 13  7  7  5 

Crew 31 Authorized 2 2 2 2   

MBES Launches 2           

Primary 
Echosounder 

RESON 8111 & 
RESON 8160 RESON 8101 RESON 8101       

Secondary 
Echosounder        

Imagery System             

Sound Velocity 
Equipment 

SBE 19plus & 45, 
MVP 200 SBE 19plus  SBE19plus        

Table 4: Vessel Inventory 
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1.2.Hardware 
 
1.2.1. Sounding Equipment 
 
RESON 8111ER Multibeam Echosounder (MBES) 
FAIRWEATHER is equipped with a RESON SeaBat 8111 MBES with the Extended Range (ER) and snippet 
options.  The 8111ER is a 100 kHz multibeam system with a swath coverage of 150°.  The swath is made up 
of 101 discrete beams with an along-track and across-track beamwidth of 1.5°.  The typical operational depth 
range of the 8111ER on the FAIRWEATHER in 2004 was 20 to 400 meters.  No calibration information was 
provided by the manufacture for the system. 
 
The 8111ER is hull-mounted within a reinforced projection that extends 27 inches below the keel.  It is located 
39.5” starboard of the centerline at approximately frame 29.  It has a specified depth range of 3 to 1200 
meters.  See Appendix I-1 for system specifications.  
 
RESON 8160 Multibeam Echosounder (MBES) 
FAIRWEATHER is equipped with a RESON SeaBat 8160 MBES with the snippet option.  The 8160 is a 50 
kHz multibeam system with a swath coverage of 4x water depth.  Each swath is made up of 126 discrete 
beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth range of 10 to 3000 
meters.  No calibration information was provided by the manufacture for the system. 
 
The 8160 is hull-mounted within a reinforced projection that extends 13.6 inches below the keel.  It is located 
54 inches port the centerline at approximately frame 29.  See Appendix I-1 for system specifications.  The 
8160 was not used during the 2004 field season. 
 
RESON 8101 Multibeam Echosounder (MBES) 
Survey Launches 1010 and 1018 are each equipped with a RESON SeaBat 8101 MBES with the Extended 
Range and snippet option.  The 8101ER is a 240 kHz multibeam system with a swath coverage of 150°.  The 
swath is made up of 101 discrete beams with an along-track and across-track beamwidth of 1.5°.  It has a 
specified depth range of up to 500 meters.  The typical operational depth range of the 8101 on launches 1010 
and 1018 in 2004 was 3 to 120 meters.  Under optimal conditions with a hard bottom, high power and high 
gain, the depth range of the 8101 ER was observed to be as deep as 350 m producing a swath of ±45º from 
nadir.  No calibration information was provided by the manufacture for the system. 
 
Each system is attached to a launch using a swing mount which is to the starboard of the keel and 
approximately centered fore and aft.  See Appendix I-1 for system specifications.   
 
Leadlines 
Vessels 1010, 1018, MonArk, and 2302 are each equipped with a lead line.  Lead lines are used for depth 
measurements usually near shore and for echosounder depth comparison.   
 
Lead lines were created, measured and calibrated according to Section AF.1, pages AF1-3 in the 1976 NOS 
Hydro Manual, see Appendix VI-2. Calibration was performed on September 22 , 2004. Calibration reports for 
the lead lines are included in Appendix V.   
 
1.2.2. Positioning, Heading, and Attitude Equipment  
 
TSS Positioning and Orientation System for Marine Vehicles (POS/MV)  
FAIRWEATHER, 1010 and 1018, are each equipped with a TSS POS/MV 320 v.3, configured with 
TrueHeave™ and Precise Timing.  The POS/MV calculates the position, heading, attitude, and vertical 
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displacement (heave) of a vessel.  It consists of a rack mounted version 2.12 POS Computer System (PCS), 
a strap down IMU-200 Inertial Measurement Unit (IMU), and two NovAtel GPS antennas corresponding to 
GPS receivers in the PCS.  The port side antenna is designated as the primary receiver, and the starboard 
side antenna is the secondary receiver.  Differential correctors are supplied to the POS MV by a CSI wireless 
MBX-3S Automatic Differential GPS receiver.  
 
For all multibeam systems aboard FAIRWEATHER and her launches timing between the sonar swath, 
position, heading and attitude information was synchronized by utilizing the TSS POS/MV 320 v.3’s aboard 
each vessel.  A timing string was sent from the POS/MV to the RESON topside unit and to the ISIS computer 
recording the incoming data. See Appendix I-2 for system specifications.  
 
MBX-3S DGPS Receiver 
FAIRWEATHER, launch 1010, and launch 1018 are each equipped with commercial grade CSI Wireless 
MBX-3S DGPS Receivers that are used in conjunction with TSS POS/MV to provide vessel positioning during 
data acquisition.  The DGPS receivers are configured in manual mode to allow reception of only one U.S. 
Coast Guard (USCG) differential GPS beacon station.  Beacons used for a given survey will be reported in 
individual descriptive reports.  Vessel wiring diagrams are in Appendix III-(vssl)-6. 
 
Trimble Backpack  
FAIRWEATHER uses two GPS Pathfinder® Pro XRS receivers in conjunction with either a handheld data 
collector TSCe or a field computer to acquire detached and generic positions during shoreline verification in 
the field.  FAIRWEATHER’s field computers consist of three Panasonic CF-18 Toughbooks and one Dell 
Pentium 4 laptop. The receivers have integrated beacon/satellite differential antennas which allow access to 
digital real-time sub-meter accuracy solutions.  Data quality assurance testing was conducted by 
FAIRWEATHER personnel.  See Appendix I-4 for Trimble system specifications. 
 
Impluse LR Hand-Held Laser 
The Impluse Laser Rangefinder was used in conjunction with the Trimble Backpack GPS unit to acquire 
distances and heights during shoreline verification.  These data were entered directly into the TerraSync 
shoreline acquisition software and annotated on the detached position forms.  The Impulse LR does not 
function properly in lowlight, when a feature is not distinguishable from surroundings, or in choppy seas. The 
specification document Impulse200LRSpec.pdf is located in Appendix I-4. 
 
1.2.3. Sound Velocity Equipment 
 
SBE 19plus SEACAT Profiler 
FAIRWEATHER is equipped with three SBE 19plus SEACAT sound velocity profilers used to acquire 
conductivity, temperature, and depth (CTD) data in the water column to determine the speed of sound through 
water.  Two of the SBE 19plus profilers have pressure sensors rated to 1000 meters.  The third has a 
pressure sensor rated to 3,500 meters.   
 
Calibration files and testing information of the SBE 19plus SEACAT sound velocity profilers were included 
with the manuals provided by the manufacturer.  Periodic quality assurance checks include comparison casts 
between CTD instruments.  See Appendix I-5 for system specifications. 
 
SBE 45 Micro Thermosalinograph (TSG) 
FAIRWEATHER is equipped with one SBE 45 MicroTSG.  The SBE 45 uses continuously pumped sea water 
to measure conductivity and temperature near the ship’s hull mounted transducers.  The intake is located 9 
feet below the DWL (13 ft) between frames 11 and 12.   
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conductivity and temperature information is converted to sound velocity and output to the RESON 8160’s and 
8111’s processing units.  The 8160 requires sound velocity information for beam forming and pitch 
stabilization while the 8111 only requires it for pitch stabilization.  The 8111, when not receiving sound velocity 
information, can be used to acquire data but not in the pitch stabilization mode.  The 8160 cannot be used to 
acquire data without real time sound velocity information.   
 
Current calibration files are not available for the SBE 45.  The unit will be calibrated yearly.  At this time, 
FAIRWEATHER personnel have not developed data quality assurance testing procedures because the unit is 
newly installed.  FAIRWEATHER personnel are investigating techniques and processes for future testing. 
 
The SBE 45 MicroTSG was not utilized during the 2004 field season. 
 
1.2.4. Vertical Control Equipment 
 
Water Level Gauges 
Four Sutron 8210 tide gauges are provided to FAIRWEATHER by the Center for Operational Oceanographic 
Products and Services (CO-OPS). These gauges are equipped with Paros Scientific Sensors (SDI-12) for 
pressure measurements.  The tide gauges are checked annually by CO-OPS Field Operations Division 
personnel to ensure that their accuracy standards are being met.  

CO-OPS does not provide calibration or quality assurance documentation to the FAIRWEATHER.  
FAIRWEATHER personnel are responsible for installation and removal of the water level gauges.  CO-OPS is 
responsible for delivering final approved vertical correctors to the processing branch for application to the 
hydrographic data set.   
 
Leveling Equipment 
FAIRWEATHER is equipped with two Zeiss NI2 333 stadia levels and two Leica NA2 100 stadia levels used 
to level tide gauges.  Meter staffs are also used in the leveling process.  Specifications for the levels are in 
Appendix I-6. 
 
1.2.5. Horizontal Control Equipment 
 
FAIRWEATHER is equipped with three Ashtech Z-Xtreme dual-frequency GPS receivers for the positioning of 
tidal benchmarks, aids to navigation and portable DGPS reference stations (Fly-Aways).  The Ashtech Z-
Xtreme receivers are 12 channel, L1/L2 receivers that are connected to Ashtech Geodetic 4 GPS antennas. 
The Ashtech Geodetic 4 GPS antennas can be equipped with an optional ground plane and mounted on fixed 
height Seco GPS tripods.   
 
FAIRWEATHER also carries equipment for a portable DGPS reference station (Fly-Away).  This station is to 
be used when USCG DGPS corrector beacon reception is not available in an area.  The portable DGPS 
reference station consists of an Ashtech Z-Xtreme receiver, 1 Ashtech Geodetic 4 GPS antenna with ground 
plane, 1 Pacific Crest Position Data Link High Powered Base Unit, 1 VHF antenna, 3 Pacific Crest Position 
Data Link Rovers, 10 marine deep cycle batteries and 8 solar panels.  In addition, an Ashtech Z-Xtreme 
receiver, an Ashtech Geodetic 4 GPS antenna with ground plane, and a ruggedized laptop configured with 
Ashtech Evaluate v6.25 are necessary equipment to produce an analysis check.  
 
Horizontal control equipment specifications, ZXtreme Ashtech GPS and PDL Flyaway Specs, are located in 
Appendix I-6.   
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1.3. Software  
 
Hydrographic acquisition, processing and quality control software applications utilized aboard 
FAIRWEATHER and her launches were updated throughout the field season.  A list of software applications, 
versions and dates of patch applications, called Survey Software, is located in Appendix II. 
 
1.3.1. Data Acquisition Software 
 
Isis Sonar/BathyPro/DelphMap/DelphNav 
The FAIRWEATHER uses the Triton Imaging Inc. software packages Isis Sonar and Sonar Suite to acquire 
multibeam echo sounder and side scan sonar data on all of its’ multibeam platforms.   Sonar Suite has two 
software packages; DelphNav and DelphMap which work together along with Isis Sonar to produce real time 
data planning, acquisition, and execution.  
 
Triton Imaging BathyPro is an add-on package for Isis Sonar which processes XTF data real-time to produce 
DTMs supported by DelphMap. Triton Imaging DelphNav is an add-on package to DelphMap used for line 
planning and vessel navigation.  Triton Imaging DelphMap is a stand-alone GIS program which combines 
georeferenced bathymetric digital terrain models and reference files such as raster charts and vector 
shoreline files to display real-time bathymetric bottom coverage.  
 
See Appendices VI-1 & 3 for the Standard Operating Procedures, Configuring Real Time Bathy and TEI Real 
Time Bathy SOP respectively, and Appendices III-(vssl)-6 for vessel wiring diagrams.  
 
TerraSync/PathFinder Office 
For GPS positioning and shoreline verification FAIRWEATHER primarily used two Trimble Navigation Limited 
software programs: GPS Pathfinder 3.00 and TerraSync 2.4.1.   
 
GPS Pathfinder is run on a Microsoft Windows operating system and is used to manage and process Trimble 
GPS data, transfer files to and from GPS receivers and handheld data collectors, and export processed data.   
 
Trimble TerraSync 2.4.1. supports data dictionaries and georeferenced TIFF images. The georeferenced TIFF 
images are used for reference and navigation purposes as well as for immediate S-57 attribution of positions 
in the field.  TerraSync is installed and configured for data collection on the TSCe handheld computer as well 
as the Dell Pentium 4, both Toughbook field computers, and the ToughTab. 
 
 
GPS precision masks in TerraSync using the following parameters:  

• Horizontal Dilution of Precision (HDOP) ≤ 2.5 
• Signal-to-Noise Ratio (SNR) ≥ 4 
• Elevation Mask ≥ ~8°-15° (varies by location) 

 
Differential GPS correction is applied real-time, using the unit’s integrated beacon as the first choice corrector, 
and specifying “wait for real-time” as the secondary option.  Positions are filtered so that only those with a 
minimum of 4 satellites (3D position), and HDOP ≤ 2.5, and Positional Dilution of Precision (PDOP) ≤ 6 will be 
exported into shapefile format.  
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1.3.2. Data Processing Software   
 
Velocwin 
Sound velocity data is processed with Velocwin, in-house software produced and maintained by NOAA’s 
Hydrographic Systems and Technology Programs (HSTP) division. Velocwin creates and archives water 
column profiles, performs quality assurance, and processes pressure based depth data.  Velocwin creates a 
standard file format across NOAA’s hydrographic fleet for sound velocity profiles applied to shallow water 
multibeam and single beam data.  
 
CARIS HIPS & SIPS 
CARIS HIPS™ (Hydrographic Information Processing System) is used to process all shallow water multibeam 
data including data conversion, filtering, sound velocity, tide correcting, merging and cleaning. CARIS HIPS 
also calculates the Total Propagated Error (TPE) used to produce Bathymetry Associated with Statistical Error 
(BASE) surfaces which assist the Hydrographer in data cleaning and analysis.   
 
CARIS SIPS™ (Side-scan Information Processing System) is not currently used by the FAIRWEATHER as 
there is no side-scan sonar equipment.  
 
CARIS Notebook 
CARIS Notebook™ is utilized to stream line the data pipeline from the field to the processing branch.  
Notebook was used to compile and display source shoreline, shoreline updates and S-57 features imported 
from Pydro for cartographic review.  The .hob files created in Notebook are the initial components for H-cell 
creation.    
 
Pydro 
Pydro, another NOAA program produced and maintained by HSTP, is used to process features such as 
detached positions(DP), generic positions(GP), and Automated Wreck and Obstruction Information 
System(AWOIS) contacts. PYDRO also converts and attributes features according to S-57 standards for 
insertion in to CARIS Notebook.  
 
Fledermaus 
  Fledermaus is third-party, licensed software for which the FAIRWEATHER has two licenses.  Fledermaus ™, 
an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data visualizations and creation of 
public relations material, data quality control, and comparisons.   
 
As a data quality assurance check Fledermaus ™ is used to examine the CARIS HDCS multibeam data 
before submission.  The procedure is to convert the HDCS data using PFMDirect using a 2 to 5 meter grid 
size.  Because of the algorithms used to grid the data within Fledermaus ™ any data errors or flyers  tend to 
be highly visible.  The entire PFMDirect generated surface for a sheet is completely examined in a stepwise 
fashion.  If artifacts or fliers are visible in the grid then the soundings are examined in the 3D Editor.  Line 
numbers and soundings are then noted and given to the survey manager for investigation in CARIS. 
 
MapInfo 
MapInfo™ is utilized to review tables and workspaces associated with assigned projects received from 
Hydrographic Survey Division (HSD).  MapInfo may also be used to produce scaled plots produced for public 
relation purposes.  HydroMI, a HSTP produced and maintained MapBasic program, is used through MapInfo 
to convert tide and tidal zoning files into a format that is useable in CARIS HIPS, and obtain latitude/longitude 
coordinates for pre-survey planning.  
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1.4. Personnel 
 
The following personnel were involved with hydrographic systems and operations this field season:  CDR 
Lowell (CO), LCDR Baird (XO), LT Wetzler (FOO), LTjg Van Waes, ENS Higgins, CST Morgan, SST Abrams, 
SST Froelich, ST Keene, AST Kellner, AST Castle, PS Sampadian and ECO Eipert. 
  
2. DATA ACQUISITION 
 
2.1. Multibeam Echosounder 
 
Methods of acquisition took into consideration system performance limitations, the bottom topography, water 
depth, and the ability of the vessel to safely navigate the area. 
 
All multibeam data were acquired in Triton Elic’s extended transfer format (XTF) and monitored in real-time 
using the 2-D and 3-D data display windows and the on-screen displays for the RESON SeaBat 8101 and 
8111ER sonar processors. Adjustable parameters that were used to control the RESON from the ISIS 
software include range scale, power, gain, and pulse width. These parameters were adjusted as necessary to 
ensure best data quality.  Additionally, vessel speed was adjusted as necessary to ensure the required along-
track coverage for object detection in accordance with the NOS Specifications and Deliverables and Standing 
Project Instructions.  
 
Mainscheme multibeam sounding lines using the RESON Seabat 8101ER and 8111ER were generally run 
parallel to the contours at a line spacing approximately three to four times the water depth.  For discrete item 
developments, line spacing was reduced to two-times water depth to ensure least-depth determination by 
multibeam near-nadir beams.  Triton Elic’s DelphMap Real Time Bathy was utilized in lieu of planned line 
files.  The Real Time Bathy displayed the acquired multibeam swath, filtered to ±60˚, during acquisition and 
was monitored to ensure full bottom coverage.  If coverage was not adequate, additional lines were run while 
still in the area. 
 
For all multibeam systems aboard FAIRWEATHER and her launches, timing between the sonar swath, 
position, heading and attitude information was synchronized by utilizing the POS/MV version 3’s aboard each 
vessel.  A timing string was sent from the POS/MV to the RESON topside unit and to the ISIS computer 
recording the incoming data.  For further information see Upgrading to Precise Timing located in Appendix VI-
1.  In addition, vessel wiring diagrams are included in Appendix III-(vssl)-6. 
 
2.2. Shoreline 
 
FAIRWEATHER personnel conducted field shoreline verification at times near predicted low water, in 
accordance with the Standing Project Instructions and Field Procedures Manual, section 6.1 and 6.2.  
Pertinent standard operating procedures, S57 Shoreline Presurvey, S57 Shoreline Acquisition, and SHP File 
to Ntbk Edit Layer are included in Appendix VI-3.   
 
MapInfo was used to translate the source shoreline files to shape files for editing.  The shape files were then 
translated to .hob file format in CARIS Notebook 2.2 Beta.  Charted shoreline, when used for reference 
purposes or when source data were not available, was digitized with S57 attribution into the Notebook 
H#####_CHD_Shoreline.hob file.  
 
Detached positions (DPs) and generic positions (GPs) acquired during shoreline verification indicate revisions 
to features, or features not found in the field.  They were recorded in the shoreline acquisition software 
TerraSync and on DP forms, then processed through GPS Pathfinder.  Scanned copies of the DP forms are 
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included in the digital Separates folder and hard copies are submitted with the Separates to be included with 
Survey Data.  In addition, annotations describing shoreline were recorded on hard copy plots of the digital 
shoreline, or boat sheets which are also submitted with the Separates.   
 
3. DATA PROCESSING AND QUALITY CONTROL 
 
3.1. Processing 
 
3.1.1. Multibeam Echosounder Data 
 
Raw XTF multibeam data were converted to HDCS format in Caris HIPS & SIPS 5.4. After conversion, the 
Total Propagated Error (TPE) was calculated in HIPS to determine the quality of the multibeam data. Error 
estimates were entered into the HIPS Vessel File (HVF) file for each vessel.  A report was produced in the 
CARIS Vessel Editor for each vessel, which contain the values entered into the HVFs.   
 
The HVF Reports are included in Appendix III-(vssl)-1.  An HVF Database was utilized to track changes and 
the copying of the HVFs to specific projects, it is located in Appendix II.  The TPE values used on the 
FAIRWEATHER for the 2004 field season are provided in Appendix IV.  
 
Vessel heading, attitude, and navigation data were only reviewed and/or edited in navigation editor and 
attitude editor as deemed necessary by the Hydrographer.  When necessary, fliers or gaps in heading, 
attitude, or navigation data were manually rejected or interpolated for small periods of time.   
 
Sound velocity correction was applied in HIPS. Tide corrections, dynamic draft correctors, sensor lever arm 
information, bias information and timing errors, and attitude correctors were applied to the data during the 
“Merge” process. 
 
The TPE takes into account uncertainties in the measurements coming from each sensor (Heave, Pitch, Roll, 
Position, Heading, Sound Velocity, and Tide) and uncertainties in static measurements (Draft and Latency) to 
calculate the total uncertainty associated with each sounding.  Caris HIPS & SIPS 5.4 uses the vertical 
uncertainty from TPE to produce a Bathymetry Associated with Statistical Error (BASE) surface. These BASE 
surfaces and child layers (Depth,Uncertainty, Density, Standard Deviation, Mean, Shoal, Deep) were used for 
directed data editing, to demonstrate coverage, and to check for systematic errors such as tide, sound 
velocity, or attitude and timing errors.  The data were reviewed and edited in swath editor as needed.  All 
multibeam data were edited and reviewed in HIPS subset mode.  Located in Appendix VI-4, are the 
Hydrographic Surveys Technical Directives (HSTD) granting permission to process data using CARIS HIPS 
5.4 BASE surfaces along with details on the processing procedures utilized, outlined in the  Bathymetric 
Processing.   
 
3.1.2. Trimble Detached Positions and Generic Positions 
 
During shoreline verification, detached positions were acquired with TerraSync 2.4.1. Data were reviewed, 
edited and exported as ESRI shape files(shp) in GPS Pathfinder 3.00.  The exported shape files included the 
S-57 field attributed positions organized by object type.   
 
3.1.3. Field Products  
 
In an effort to streamline the data pipeline from the field to the processing branch, MapInfo tables and 
workspaces were not used for shoreline processing by FAIRWEATHER personnel.  Instead, Pydro and 
CARIS Notebook were used exclusively.   
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Positions acquired during shoreline verification operations are in shape file format from GPS Pathfinder.  The 
Generic GPs/DPs Import tool in Pydro is utilized to retain the S-57 attribution during import into Pydro.  Once 
the features are in Pydro, short descriptive comments along with investigation or survey methods are listed 
under the Remarks tab in Pydro.  Features were flagged as Primary, unless there were multiple detached 
(DPs) or generic (GPs) position taken on the same feature.  In that case, the most important DP was marked 
Primary and the associated DPs/GPs were flagged Secondary.  A Carto Action of Add, Modify or Delete was 
assigned to each item in Pydro, and all features were S57 attributed.  Items for particular surveys that were 
associated with a DP or GP that needed further discussion were flagged Report in Pydro.  Along with the 
investigation methods provided in the Remarks tab, the hydrographer included recommendations to the 
cartographer in the Recommendations tab when warranted. All features were flagged according to Pydro 
Logic located in Appendix VI-4.     
 
Terminology used during shoreline verification is as follows. The term “Noted” indicates that the feature is 
correctly located within the scale of the chart or source, as confirmed from a distance. The term “Verified”  
was used when the existence of the feature was confirmed in close proximity and the feature is correctly 
located within the scale of the survey.  
 
The HDCS_DATA line associated with DPs require further processing in CARIS HIPS & SIPS to correct for 
tide and sound velocity when necessary. GPs do not have heights associated with them and require no 
additional processing. 
  
All primary and accepted DPs and GPs were imported from Pydro as an .xml to CARIS Notebook 2.2 Beta.  
Three separate stand alone .hob files were created for the features, based on the Carto Action assigned in 
Pydro.  The separated files were named H#####_Add_Features.hob, H#####_Modify_Features.hob, 
H#####_Delete_Features.hob.  Remarks and recommendations from Pydro were imported to the “remrks” 
and “recomd” fields associated with each feature in CARIS Notebook. 
 
New HW/MLLW features and any changes to the source shoreline, such as ledges or reefs, were digitized 
with S57 attribution to the H#####_Shoreline_Updates.hob file.  Any comments or annotations made on the 
boat sheets from observations made in the field, including field notes made by the Hydrographer regarding 
verification of features, were added to the associated features in CARIS Notebook.  Remarks pertaining to 
point features were added directly to the “remrks” field of the feature in the .hob file.  Marker layers were used 
to add comments to line features that did not have an associated DP or GP.  Markers were also used for 
carto-symbols, because the text from the “remrks” field currently does not display in CARIS Notebook. 
 
Additional standard operating procedures used in field product creation were S57 Shoreline Processing, 
Pydro Editor Notebook, and Survey PIC Shoreline Duties, are included in Appendix VI-4. 
 
3.2. Quality Control 
 
3.2.1. Standard Operating Procedures 
 
The standard operating procedures (SOPs) followed by FAIRWEATHER survey personnel to ensure 
consistent and quality data and products are located in Appendix VI.  Procedures outlining Offsets and 
Configurations can be viewed in Appendix VI-2, and the pertinent Calibration and Testing procedures are 
included in Appendix VI-2.  The procedures pertaining to Acquisition are located in Appendix VI-3.  
Processing SOPs, Hydrographic Surveys Technical Directives pertinent to the 2004 field season, the data 
processing flowchart and the Survey Mangement SOP detailing specific steps in running a survey are all 
included in Appendix VI-4.   
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3.2.2. Data Review 
 
Specific procedures were used on the FAIRWEATHER to ensure quality control of data throughout 
acquisition, processing, and submission.  These procedures are outlined in the FA QC Checksheets located 
in Appendix VI-5.  The QC Check is preformed by the survey manager.  The QC Review is completed by an 
outside reviewer of the survey data and deliverables (can be FOO, CST or a qualified SST). The Data 
Submission and Analog Submission checklists are used to ensure that all data and deliverables are complete 
and included upon submission. 
 
4. CALIBRATIONS AND CORRECTORS 
 
In collaboration with Office of Coast Survey personnel, the FAIRWEATHER personnel determined appropriate 
methods for testing and calibration of systems used to acquire hydrographic data for 2004 projects.  Methods 
were in accordance with the Standing Letter Instructions (April, 2003), the Specifications and Deliverables 
(March, 2003), and the Field Procedures Manual (March, 1998).   
 
4.1. Vessels   
 
Sensor offsets were measured with respect to each vessel’s reference point.  Specific offset values were 
entered into the POS/MV.  All offsets and their associated error estimates were used to create a HIPS Vessel 
File (HVF).  For each vessel in CARIS HIPS & SIPS, an HVF Report was produced that contains all HVF 
entries.  These reports are included with the individual vessel reports in Appendix III-(vssl)-1. 
 
4.1.1. Ship Offsets 
 
A ship survey was done for the FAIRWEATHER by Westlake Consultants, Inc.  A report of the results from 
that survey, dated September 23, 2003, was used to define the ship offset values.  The Westlake document 
and detailed spreadsheet, which includes derivations, a description of methodology used, diagrams, and 
coordinate system references are located in Appendix III-S220-2. 
 
4.1.2. Launch Offsets 
 
Permanent control points were established on launches 1010 and 1018, in July of 2004.  Sensor offsets were 
measured according to the procedures listed in Measuring Launch Offsets & Installation of Benchmarks 
included in Appendix VI-1.  Total stations were utilized for positioning the permanent control points.  The total 
station specifications are located in Appendix I-7, the calibration certificates for the Nikon DTM 310 and the 
Sokkia SET 5F are included in Appendix V.  A summary of measurements, derivations, descriptions of 
methodology used, diagrams, and coordinate system references are included in the respective vessel’s 
Offsets section in Appendix III-(vssl)-2. 
 
4.1.3. POS/MV Correctors and Calibration 
 
POS/MV Position Computation 
On all FAIRWEATHER vessels the POS/MV is used for positioning multibeam data.  The POS/MV controller 
software was used to monitor position accuracy and quality during data acquisition.  This ensured that 
positioning accuracy requirements were met, as outlined in the NOS Hydrographic Surveys Specifications and 
Deliverables.  The POS/MV controller software provides clear visual indications whenever accuracy 
thresholds are exceeded.   
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Due to the high latitude and rough Alaskan topography, the Horizontal Dilution of Position (HDOP) would 
occasionally exceed 2.5, which is the maximum threshold allowed in Specifications and Deliverables section 
3.2.1.  In order to obtain 100% coverage in survey areas, FAIRWEATHER vessels would continue to acquire 
data up to a maximum HDOP of 4.0.  These data were examined during post-processing and positions were 
interpolated or rejected when necessary. 
  
POS/MV Heading Computation 
On all vessels, the heading computed by the POS/MV, was used as a corrector for multibeam data.  
 
POS/MV Pitch and Roll Computation 
On all vessels, the POS/MV was used for pitch and roll values.  
 
POS/MV Heave Computation 
The POS/MV’s on FAIRWEATHER and her launches are equipped with the TrueHeave™ option.  Stored 
TrueHeave™ data contains time stamps with attitude, position, acceleration and rotation information.  
TrueHeave™ data were acquired in accordance with section 6.0 of the POS/MV Version 3 Installation and 
Operation Manual, dated October 2003. These data were post processed in CARIS HIPS & SIPS  
5.4 in order to determine the vessel heave correctors associated with simultaneously collected multibeam 
data.  FAIRWEATHER personnel compared Applanix’s TrueHeave™ solution to the real time heave solution 
and found that induced heave artifacts were minimal or non-existent.  Previous work by Thales GeoSolutions 
(formally Fugro) show an increased heave corrector data quality in large swell (Earth Imaging Journal). Due to 
unresolved issues with recording and processing TrueHeave™ only 70% of the multibeam data acquired by 
FAIRWEATHER had TrueHeave™ correctors applied. 
 
In cases where post processed heave information could not be applied, real time heave correctors were used.  
Real time heave is computed in the POS/MV by performing a double integration of the IMU-sensed vertical 
accelerations.  This information is then run through a high pass filter which limits the appearance of noise in 
the solution.  The high pass filter is characterized by the heave bandwidth and dampening ratio.  For 
FAIRWEATHER and her launches, these constants were set at 20 s and 0.707 respectively.  Real time heave 
data were recorded in Triton Elic’s Isis software, stored in the .XTF format and applied as the heave corrector 
for multibeam data in CARIS HIPS & SIPS 5.4. 
 
POS/MV GAMS Calibration 
GAMS calibrations were performed on each of the three POS/MV units.  The GAMS calibration procedure is 
located in the POS/MV 320 manual, section 4-25 to 4-34, located in Appendix VI-2.  Results of the GAMS 
calibrations are included in the individual vessel reports and spreadsheets, with calibration details located in 
Appendix III-(vssl)-5.  
 
4.1.4. Dynamic Draft 
 
Dynamic draft tests were conducted for launches 1010 and 1018.  The Dynamic Draft Settlement & Squat 
Method, DDSSM Procedure is located in Appendix VI-2.  Results of the DDSSM for each vessel are included 
in the individual vessel reports located in Appendix III-(vssl).  Detailed processing spreadsheets from the 
DDSSM are also included in Appendix III-(vssl)-4.   In addition, optical settlement and squat testing was 
conducted on Launch 1010, results are included in Appendix III-1010-4. 
 
Dynamic draft tests were conducted for FAIRWEATHER in Port Angeles in August 2004.  Due to 
configuration issues, the results could not be applied to the HVF files.  The dynamic draft portion of the 
S220_8111.hvf was left blank. 
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4.1.5. Patch Tests 
 
Patch tests were conducted for FAIRWEATHER, 1010 and 1018.  The Patch Test Procedure is located in 
Appendix VI-2.  The results of the patch tests are included in the individual vessel reports located in Appendix 
III-(vssl).  Acquisition and Processing Logs utilized during testing are included in Appendix III-(vssl)-3.   
 
4.2. Uncertainty Modeling 
 
An understanding of the errors inherent in the multibeam systems and ancillary equipment is required for the 
proper use of CARIS HIPS & SIPS 5.4.  These values are used to generate an uncertainty model needed to 
compute the Total Propagated Error (TPE) estimation and for the creation of Bathymetry Associated with 
Statistical Error (BASE) surface.   Uncertainty information for FAIRWEATHER has been entered into the HIPS 
Vessel File (HVF).  The uncertainty information entered reflects the statistical accuracy to which equipment 
can measure a value or to which a value was measured in the case of offsets. 
 
Error estimates for FAIRWEATHER and associated survey launches were compiled from manufacturer 
specification sheets for each sensor (Heave, Pitch, Roll, Position, and Heading) and calculated for instrument 
reading uncertainty for static measurements (Draft and Offset measurements).   
  
In instances where uncertainty information was unavailable or unknown the best estimation of the uncertainty 
was used.   
 
The TPE values for FAIRWEATHER and her launches, referencing original source information, are entered 
into an Excel spreadsheet and included in Appendix IV.   
 
4.3. Static Draft and Loading 
 
The static draft value in the FAIRWEATHER HVF (Waterline Height in HVF) remained constant throughout 
the 2004 field season.  Its value and calculation are listed in the Offset spreadsheet located in Appendix III-
S220-2.  
 
Static drafts (Waterline Height in HFV) for launch 1010 and 1018 were calculated using measurements from a 
known reference mark to the waterline made with a steel tape.  The launch static drafts remained constant 
throughout the 2004 field season.   
 
Loading measurements were taken on both launches throughout the field season when weather conditions 
allowed.  The procedure was to measure from a known mark to the waterline to calculate the draft.  These 
values were collected and inserted into the Vessel Loading worksheet located in Appendix IV-1.  The 
standard deviations of the draft changes were used to generate the loading values for the TPE model which 
are listed in the FA_TPE_Values_2004 spreadsheet in Appendix IV.  These values were not used for vertical 
corrections to multibeam data.   
 
4.4. Sound Velocity Equipment 
 
The SBE 19plus SEACAT profilers were purchased in 2004 from Seabird Electronics.  Calibration files and 
testing information were included with the manuals provided by the manufacturer.  Simultaneous casts were 
taken with multiple instruments and compared to each other in Velocwin to ensure that the instruments met 
calibration specifications.   
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The calibration files were loaded into Velocwin and used during processing of casts.  See Appendix V-CTD’s 
for calibration and testing reports.   
 
SVP casts from the SBE 19plus were processed with Velocwin and the correctors were applied to 
echosounder data during post processing. 
 
4.5. Water Level 
 
Predicted and unverified observed water level correctors can be downloaded from the CO-OPS website.  
When internet was unavailable, the ship enabled the automated Tidebot program, which would send daily 
observed water level correctors for selected tide stations to the ship via email.  The daily water level 
correctors arrived in .txt file format.  The files for the relevant days were collated into a tide station master file 
which was converted to .tid file format in HydroMI.  The .tid files were applied to data along with the  
.zdf file in CARIS HIPS & SIPS.   The Pacific Hydrographic Branch applies final approved (smooth) tides to 
the survey data during final processing. 

 
4.5.1. Tide Gauges 
 
The Sutron 8210 tide gauges are equipped with factory calibrated Paros Scientific Sensors.  The Sutron 8120 
tide gauges are checked yearly by CO-OPS Field Operations Division personnel to ensure that accuracy 
standards are being met.  

 
4.5.2. Leveling Equipment 

 
FAIRWEATHER is equipped with two Zeiss NI2 333 levels and two Leica NA2 100 universal automatic levels.  
A Kukkamaki procedure was performed on Zeiss NI2 333 level S/N 100056 to verify the collimation.  The 
results of the Kukkamaki 100056 calibration are located in Appendix V-Control.  The results of the Kukkamaki 
calibrations for the remaining tides leveling equipment are not available.  
 
4.6. Horizontal Control 
 
The Ashtech Z-Xtreme GPS receiver is capable of 0.5cm horizontal and 1cm vertical accuracies.  Data is 
downloaded and converted to Rinex format using Ashtech Solutions v2.60.  Rinex files are uploaded to NGS 
Online Positioning User Service (OPUS) for processing.   
 
The FAIRWEATHER portable DGPS reference station (Fly-Away) is set up in conjunction with an Ashtech Z-
Xtreme receiver, an Ashtech Geodetic 4 GPS antenna with ground plane, and a ruggedized laptop configured 
with Ashtech Evaluate v6.25, in order to produce a 24 hour scatter plot for quality analysis check.   
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!! Phase and Amplitude
Bottom Detection

!! 150EE Wide Swath
Coverage

!! 240 kHz Frequency

!! Up to 500m Range
Capability

!! Portable
Configuration

!! Meets USACE Class 1
Standards

!! Meets IHO Standards

The SeaBat 8101 Multibeam Echo Sounder measures discrete depths, enabling
complex underwater features to be mapped with precision.  Dense coverage is
achieved utilizing up to 3,000 soundings per second for a swath that can be over
500 meters wide, even as the survey vessel travels at speeds of over 18 knots.

With high accuracy and a measurement rate up to 30 profiles per second, the
SeaBat 8101 enables surveys to be completed faster and in greater detail than
previously realized.  The SeaBat is an integral part of the new, integrated
bathymetry surveying systems.

The SeaBat transducer is available pressurized for depths from 100 to over 3,000
meters.  Small and lightweight, it can be can be mounted on small underwater
vehicles (ROV, AUV or towed) and taken to where accurate measurements are
required.

SeaBat 8101
PRODUCT SPECIFICATION

240kHz MULTIBEAM ECHO SOUNDER



©1999 RESON Inc.
Version 4.0  Due to our policy of continuous product improvement,
032399 specifications are subject to change without notice.

SeaBat 8101 Head
with Optional Fairings

SeaBat 8101 Built-In Test
Environment (“BITE”) Screen

SYSTEM SPECIFICATIONS

Operating Frequency: 240kHz
Range Scales: 5, 10, 15, 20, 25, 35, 50, 75, 100, 125,

150, 175, 200, 250, 300, 350, 400, 450,
500m. 

Range Resolution: 1.25 cm
Number of Beams: 101

Horizontal Beamwidth: 1.5E
Horizontal Coverage: 150E
Vertical Beamwidth: 1.5E

Update Rate: Range-variable up to
30 times per second

SONAR HEAD SPECIFICATIONS

Power Requirement: 24VDC, 2 Amps max.
(Power available from
surface processor.)

Uplink: Digital, 76.8 Mbaud
Down Link Control: RS-232 or RS-422, 19,200 baud

Operating Depth: 100 meters
(300m, 1500m, 3000m & 6000m avbl.)

Dimensions: 266x320mm W/Diam 
(does not include projector)

Temperature: Operating: -5E to +40EC
Storage: -30E to +55EC

Weight (aluminum): Dry: 26.8 kg (59 lbs)
Wet: 4.8 kg (10.6 lbs)

Weight (titanium): Dry: 40 kg (88 lbs)
Wet: 18 kg (39.6 lbs)

DISPLAY SPECIFICATIONS

Screen Size: 14 inch Diagonal 
Input: SVGA (800x600, 72 Hz)

Display: High Resolution Color
Power Consumption: 62 W

PROCESSOR SPECIFICATIONS

Power Requirements: 115/230VAC, 50/60Hz,
100W max.

Data Output: Selectable, 300-155.2 Kbaud
or Ethernet 10 base T
or 10 base 2

Video Output: SVGA (800x600, 72 Hz)
or NTSC or PAL video.

Graphics Colors: 256 colors (8-bit)
Display Mode: Sector Format

Display Arc: 150E
Input Device: 3-Button Trackball
Dimensions: 19" rack, 4U high

(266x483x434mm HWD)
Temperature: Operating: 0E to +40EC

Storage: -30E to +55EC
Weight: 20 kg (44 lbs)

OPTIONS

Option 033: Side Scan Upgrade
Option 034: Mounting Plate Assembly
Option 035: Fairings (pictured above)
Option 036: Spares Kit
Option 037: Titanium Housing
Option 038: 210° Swath
Option 040: Extended-Range Projector
Option 049: Increase Transducer Depth 

Rating



SeaBat 8111
PRODUCT SPECIFICATION

MULTIBEAM ECHOSOUNDER

•• Phase and amplitude
bottom detection

•• 100 kHz frequency

•• 150° swath coverage

•• Real-time quality
control

•• Sidescan upgradeable

•• Modular and portable

•• Pitch stabilization

The SeaBat 8111 is a modular multibeam echosounder system operating at
100 kHz. When installed on a vessel, it produces high-density, high-accuracy
soundings on the seafloor over a 150° swath. Major system components
include a transducer array, a transceiver unit, and a processor unit.

The SeaBat 8111 transducer array is comprised of a cylindrical receive array
and a linear transmitter array, mounted together on a support cradle that
provides mounting points to the vessel. Lightweight and portable, the array
can be installed temporarily over the side of a vessel of opportunity––a first for
a system in this frequency range.

The SeaBat 8111 transceiver features plug-in cards for easy maintenance and
is controlled from the sonar processor.

The Seabat 8111 processor is compatible with other SeaBat sonar heads, can
be updated in minutes to accommodate future requirements, and features a
user-friendly point-and-click interface.



MECHANICAL INTERFACE

Dimensions (in mm):
Transducer Array:

Hydrophone: 636 x 118 (Dia./Length)
Projector: 113 x 650 (Dia./Length)

Processor: 177 x 483 x 417
Transceiver: 267 x 483 x 489

Weight:
Transducer Array: 72 kg (dry) / 59 kg (wet)

with cables
Processor: 20 kg
Transceiver: 13.6 kg

Cable Length: 15m

SEAFLOOR COVERAGE
(with Extended Range option)

SeaBat 8111 SYSTEM SPECIFICATIONS

Version: B006 030205
©1999 RESON Inc.

Due to our policy of continuous product improvement,
RESON reserves the right change specifications without notice.

Transceiver
Processor

Transducer Array

636 OD

650118

113

Hydrophone Projector

SYSTEM PERFORMANCE

Frequency: 100 kHz

Range Resolution: 3.7 cm

Swath Coverage: 150º

Range: 3m to 1200m
(with Option 040)

Number of Beams: 101

Along-Track Beamwidth: 1.5º 3.0º 4.5º 6.0º*
Across-Track Beamwidth: 1.5º

Stabilization: Pitch stabilization 
within +/-15º

Projector Beam Control: External motion
sensor required

Accuracy: IHO Compliant

Operational Speed: Up to 20 knots

Max. Update Rate: 35 Hz

Transducer Pressure Rating: 100m

*operator selectable

INTERFACE

System Supply: 90 to 260VAC, 50/60 Hz,
200W max.

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

RELATED PRODUCTS
• Option 040 Extended range capabilities
• Option 033 Sidescan upgrade
• Option 051 24DC power supply for SeaBat

81-P Processor

Bottom Depth (meters) Swath Width (meters)
5 to 150 Up to 1110 (7.4 x water depth)

300 960 (3.2 x water depth)
450 810 (1.8 x water depth)
600 600 (1.0 x water depth)
750 450 (0.6 x water depth)
900 360 (0.4 x water depth)



SeaBat 8160
PRODUCT SPECIFICATION
MULTIBEAM ECHOSOUNDER SYSTEM

•• Swath coverage
greater than 4x
water depth

•• Operational depth:
10m to 3000m

•• 50 kHz frequency

•• 126 beams

•• Hull-mount or
portable

•• Meets IHO
accuracy

•• Sidescan
upgradable

The SeaBat 8160 is a new addition to the 8100 series of multibeam
echosounders. Operating at 50 kHz, the system ensonifies the whole
swath in a single ping, generating 126 simultaneous high-resolution
receive beams.

The SeaBat 8160 transducer array is comprised of a linear receive and
transmit array mounted together on a support base. The T-shaped array
geometry provides the basis for a compact, high-resolution sonar which
is easily installed for portable or hull mounts––a first for a high-resolution
system in this frequency range.

The system features a pitch-stabilized transmitter and an active roll-
compensated receiver.

The SeaBat 8160 processor is compatible with other SeaBat sonar heads.
It can be updated in minutes to accommodate future requirements, and
features a user-friendly point-and-click interface.

RESON, INC. • USA
Tel +1 805 964 6260
Fax +1 805 964 7537
Email: sales@reson.com

RESON A/S •  DENMARK
Tel +45 47 38 00 22
Fax +45 47 38 00 66
Email: reson@reson.dk
RESON OFFSHORE •  UK
Tel +44 1224 709 900
Fax +44 1224 709 910
Email: sales@reson.co.uk

w w w. r e s o n . c o m

RESON, GmbH • GERMANY
Tel +49 431 720 7180
Fax +49 431 720 7181
Email: reson@reson-gmbh.de



SYSTEM PERFORMANCE

Frequency: 50 kHz

Depth Resolution: 2.4 cm / 9.6 cm

Swath Coverage: Greater than 4x 
water depth

Max Operational Depth: 3000 m

Number of Beams: 126

Along-Track Beamwidth: 1.5º

Across-Track Beamwidth: 1.5º

Pitch Stabilization: ±10º

Accuracy: IHO Special Order

Operational Speed: Up to 20 knots

Max. Update Rate: 15

Transducer Depth Rating:

100m

INTERFACE

System Supply: 115V/230V 50/60 Hz,
350W

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from
Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

MECHANICAL INTERFACE

Dimensions (HWD in mm):
Transducer Array: 1474.5 x 1100 x 90.5
Processor: 177 x 483 x 417
Transceiver: 265 x 483 x 492

Weight:

Transducer Array: 50 kg (dry) / 30 kg (wet)
Processor: 20 kg
Transceiver: 13.6 kg

SeaBat 8160 SYSTEM SPECIFICATIONS

Version: B34-PDF-011009
Due to our policy of continuous product improvement,

RESON reserves the right change specifications without notice.

1100mm

1350mm

124.5mm

150mm

90.5mm

Transceiver Processor

Transducer Array

Mounting Frame
Option 034H



Applanix LLC  17461 Village Green Drive, Houston, TX, 77040  
tel: 713-896-9900  fax: 713-896-9919 email: info@applanix.com

Performance

Position (m)

Velocity (m/s)

Roll and Pitch

True Heading

Heave

0.02 - 0.10

0.03

0.01û

0.5 - 4.0

0.03

0.02û

4m baseline: 0.01, 2m baseline: 0.02û

5% of heave amplitude or 5cm

RTK DGPS

Size

Weight

Power

Operating Temperature

Humidity

Cables

IMU

PCS

Antenna

Choke Ring

IMU

PCS

IMU & Antennas

PCS

IMU & Antennas

PCS

IMU

Antennas

204 x 204 x 168mm

441 x 111 x 346mm, 2.5U 19" rack mount

178    x 77mm (2x)

360    x 61mm (2x)

3.5 Kg

7 Kg

110/220 VAC, 60/50 Hz, 60W

-40û to +60ûC

0û to +60ûC

0 to 100%

5 to 95% RH non-condensing

8m standard

15m standard (2x)

Ethernet Interface 
(10base-T)

Function

Data

UDP Ports

IP Ports

NMEA Port

High rate attitude 
data port

Auxillary GPS input

Operate POS MVTM & record data

Position, attitude, heading, velocity, track and speed, 

acceleration, status and performance, raw data.  

All data has time and distance tags

Display port - low rate (1Hz) data

Data port - high rate (1-200Hz) data

Control port - used by POSTM controller

GGA, HDT, VTG, GST, ZDA, PASHR, PRDID (1-50Hz), GGK

Roll, pitch, true heading and heave in all multibeam 

proprietary formats (1-200 Hz)

GGA, GST, GSA, GSV from Auxilliary DGPS, P-code or 

RTK reciever

RS232 Interface (DB9 
males)

Options Internal RTK GPS receiver; analog interface (roll, pitch & heave); field support kit

Physical Specifi cations

Interfaces

All performance figures are RMS, unless otherwise noted.  Specifications subject to change without notice.



MBX-3S
The most popular commercial-grade 
Coast Guard Beacon Receiver

www.csi-wireless.com

• Dual-channel Coast Guard beacon receiver

• Supplements GPS systems with free differential corrections,
enhancing accuracy

• Fast signal acquisition

• Wide input voltage range for a variety of power sources

• Low power consumption extends battery life 

• Automatic tuning mode for hands-free operation

• Integrated signal splitter outputs GPS signal from combined 
GPS /differential antennas

• Front-panel interface for easy configuration and status monitoring



Receiver Specifications 
Channels: 2 independent channels
Channel Spacing: 500 Hz
Frequency Range: 283.5 to 325.0 Hz
MSK Bit Rates: 50, 100, 200 bps 
Cold Start Time: <1 min
Warm Start Time: <2 seconds
Demodulation: Minimum shift keying
Sensitivity: 2.5 µV/m for 6 dB SNR
Dynamic Range: 100 dB
Frequency Offset: ±8 Hz (27 ppm)
Adjacent Channel Rejection: 61 dB fo ± 400 Hz
Correction Output Protocol: RTCM SC-104
Input Status Protocol: NMEA 0183

Communications 
Interface: RS-232C or RS-422
Baud Rates: 2400, 4800, 9600

Environmental Specifications
Operating Temperature: -30°C to +70°C
Storage Temperature: -40°C to +80°C
Humidity: 95% non-condensing
EMC: EN 60945

EN 50081-1
EN 50082-1
FCC: Part 15, sub-part J,
class A digital device

Power Specifications
Input Voltage Range: 9 to 40 VDC
Nominal Power: 2.5 W
Nominal Current: 210 mA
Antenna Voltage Output: 10 VDC (5 VDC optional)
Antenna Input Impedance: 50 Ω

Mechanical Specifications
Dimensions: 150 mm L x 125 mm W x 51 mm H

(5.9” L x 4.9” W x 2.0” H)
Weight: 0.64 kg (1.4 lb)
Display: 2-line x 16-character LCD
Keypad: 3-key switch membrane
Power Connector: 2-pin circular locking
Data Connector: DB9-S
Antenna Connector: BNC-S
Optional GPS Output Port: TNC-S

Operating Modes
MBX-3 Mode (Default): RTCM SC-104 correction and

NMEA status message output 
(Default Mode)

MBX-E Mode: RTCM SC-104 correction and 
NMEA status message output 
and GPS NMEA message 
input for position and satellite 
status display

NMEA 0183 I/O
• Receiver Automatic and Manual tune command
• Frequency and data rate query
• Receiver performance and operating status queries
• Automatic search almanac queries (proprietary)
• Baud rate selection command
• Receiver tune command
• Force cold start command (proprietary)
• Software upgrade command (proprietary)
• Configuration up-load command (proprietary)

Accessories
Antenna: Various
Power Cables: Various
Antenna Cables: Various
Data Cables: Various
CSI Beacon 
Command Center: MS Windows 95® beacon 

control software

Pin-out
RS, 232C (DB9 PIN#)

Pin 2 TXD,RTCM SC-104/Status Output
Pin 3 RXD, configuration input
Pin 5 Signal return 

RS-422 (DB9 PIN#)

Pin 1 TXD +, RTCM SC-104 / 
Status Output

Pin 2 TXD -, RTCM SC-104 / 
Status Output

Pin 4 RXD -, configuration input
Pin 5 Signal return
Pin 7 RXD +, configuration input

© Copyright September 2002, CSI Wireless Inc. All rights reserved. Specifications subject to change without notice.

CSI Wireless and the CSI Wireless logo are trademarks of CSI Wireless Inc. Made in Canada.

Warranty: Each CSI Wireless product is covered by a limited one-year warranty on parts and labor.
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Phone (403) 259•3311 • Fax (403) 259•8866
Printed in Canada.
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The most popular commercial-grade DGPS Beacon ReceiverMBX-3S



CEEDUCERTm Hydrographic Survey System
The CEEDUCER hydrographic survey system comprises of three basic modules, integrated with
appropriate firmware into one neat composite package to give a system that is unsurpassed for portability,
accuracy, ease of use and installation. Various options, such as tracking display, tide gauge, GPS Base
station, and radio telemetry are easily added with minimum fuss at additional cost.

Display and processor unit (DPU):
The DPU unit has been designed for easy of operation, with very simple controls. Provision is made for
entry of speed of sound, draft setting and calibration gate for bar checking the echo sounder. Where
appropriate, sounding velocity can be set automatically based on water temperature and salt/fresh water
selection by User.  The unit provides a RS232 output in NMEA or ODOM emulation formats. All
soundings, plus position every two seconds, are logged internally.  Special ‘event’ markers can be entered
manually from the keyboard. Full geodetic setup facilities for change of spheroid and grid are available.
Where appropriate, positions can be averaged automatically.  The LCD display is a high contrast type for
use in bright light conditions and includes a backlit panel for night use, the LCD can be turned off after a
selected interval when using the power save option.

Echo sounder unit:
The CEEDUCER echo sounder uses the latest technology in transducer manufacture. The sound source and
the power driver/receiver electronics are moulded as an integral unit. The result is that cable noise is totally
eliminated, with the echo returns being sent to the display unit in digital form rather than analogue. The
CEEDUCER produces a bottom trace that is remarkably free from noise. This design also allows the
CEEDUCER to work accurately in very shallow water, to a minimum depth of 30cm. No other echo
sounder can produce such noise-free signals to do this. Bruttour International has worked closely with the
manufacturer in design and testing, to produce a Bruttour proprietary survey standard, high-accuracy
instrument.  Two 200kHz-transducer types are available with beam widths of either 8° or 2.75°.  Depth
range is 0.3 to 99.99 metres with 0.01 metre accuracy. If preferred user can input Digital depth data (single
or dual channel) from external echosounder.

GPS Receiver:
The display unit can be fitted with an 8 or 12 channel GPS receiver using a dual Marine Beacon / GPS
antenna. The display unit's micro-controller integrates the GPS data and provides Grid conversions and
display / logging options. GPS position data can be averaged over a period of time. If preferred user can
input position from external GPS receiver. The CEEDUCER System can be also supplied with internally
installed RTK receiver and associated telemetry, plus remote RTK Base Station.

Differential input (DGPS):
For differential operation, a Marine Radio Beacon receiver is included to provide RTCM differential input
to the GPS receiver. Alternatively, differential corrections can be entered from an external source.

Track Guidance:
The companion program, CEEDUCER2, provides track guidance, graphical data editing, preparation of
plot files, and computation of quantities.  Alternatively, for track guidance use MiniCEE and the Psion
Workabout Handheld computer, especially suitable for bright sunlight conditions.

Units:  The CEEDUCER can operate in either metric or imperial units, User selects as required.

Bruttour International Pty Ltd       P.O. Box  118, Thornleigh,  NSW, 2120, Australia.

Tel: +61 2 9481 8730     Fax: +61 2 9484 1978     e-mail: bruttour@attglobal.net
www.bruttour.com.au



Impulse 200 LR Laser 
Our Impulse lasers are specifically designed for optimal performance under whatever conditions you might encounter
in the field. They are lightweight, extremely rugged, completely waterproof and versatile. Use them as a handheld
unit or mount them on a tripod for added stability. 

Impulse Laser w/
1.5 to 4 X Zoom Scope
and Mounting Bracket

Impulse Laser w/
Red-dot Scope
and Hand Strap

Hardware Specifications: 

7070 S. Tucson Way, Centennial, CO  80112 USA 
Toll Free: 1 (800) 280-6113  |  Local: 1 (303) 649-1000

 Web Page: www.lasertech.com  |  E-mail: info@lasertech.com

* All specifications are subject 
to change without notice.  

(Rev. 11/15/03)

Key Features: 

- Custom backlit LCD display
- Audible and visual indicators
- RS232 serial output for
   electronic data storage
- Selective range gating for
  positive target acquisition
- Built-in tilt sensor 
- Filter system to discriminate
  reflective targets
- Cumulative distance capability
- Determines the distance 
   between two in-line objects
- Integrates with GPS

For 3-D data collection,
integrate the Impulse with

a MapStar System.

Package Includes: 

- Impulse laser
- Red-dot scope
- Hand strap
- Tripod / monopod
   mounting bracket
- (2) AA batteries
- Operator's manual
- Padded carrying case

Optional Accessories:

- 1.5 to 4 X zoom scope
- Yoke and staff
- Remote trigger data cable

MapStar
Angle

Encoder

MapStar 
Compass
Module

Typical Target                   IMPULSE 200 LR

Accuracy & Range (Imperial) (Metric)

Accuracy (Typical) 0.1 - 0.2 ft 3 - 5 cm

Accuracy (Max) 0.5 ft 15 cm

Overhead cable / Stake 330 ft 100 m

Phone pole / Stockpile 655 ft 200 m

Tree / Tower 985 ft 300 m

Rock Face / Building 1640 ft 500 m

Max Distance 1885 ft 575 m

Range Resolution .01 ft 0.01 m

Inclination Limits  +/- 90 deg  +/- 90 deg

Inclination Accuracy  +/- 0.1 deg  +/- 0.1 deg

Weight 2.2 lbs. 1 kg

Size  6 x 2.5 x 5 in. 15.2 x 6.4 x 12.7 cm 

Power Supply  (2) AA batteries (20 hours of use)

Environment  Waterproof to IP 67 and NEMA 6

Temperature  - 22 to + 140 F  -30 to + 60 C   

(Max distances are approximate)



Key Features

High-performance 
GPS with a world of 
real-time options 
The versatile GPS Pathfinder® Pro XRS receiver is 
the thoroughbred of GPS receivers. Offering a full 
range of accurate real-time correction sources, 
great performance in all GPS conditions, and 
rugged design for the toughest environments, the 
Pro XRS is an essential tool for collecting and 
maintaining GPS data.

Built to meet your demands
With the Pro XRS, you don’t have to worry 
whether your GPS receiver can stand up to harsh 
conditions. All its components are sealed in a 
robust casing. Waterproof, dustproof, and  
shock-resistant, the Pro XRS can work  
anywhere you can. 

Just as tough is the custom-designed ergonomic 
backpack. But it’s light and comfortable, so you 
can wear it all day.

You’re spoiled for real-time choice
If you’re navigating in the field, or finding your way 
back to a previously recorded feature, you’ve got 
all the real-time options covered. Corrections from 
a radiobeacon, a satellite differential service such 
as OmniSTAR, or a satellite-based augmentation 
system (SBAS) like WAAS1 or EGNOS2 are not 
just built in, they’re seamlessly integrated into 
the receiver. Want the freedom to connect to an 
external correction source like a virtual reference 
station (VRS)? You’ve got it. This array of real-time 
sources makes the Pro XRS the most adaptable 
real-time GPS receiver around.

High quality, accurate data for your GIS
With the Pro XRS, you can be sure that the data 
you collect meets your high standards. Offering 
submeter accuracy in real time, and centimeter-
level postprocessed accuracy, it’s the obvious 
choice for collecting the high quality GPS data 

you need in your GIS. And it has advanced  
design features, like EVEREST™ multipath 
rejection technology, to ensure you get only the 
best positions.

Get the results you want
The GPS Pathfinder Pro XRS’s advanced design 
gives you complete control over GPS quality. You 
can focus on productivity, to keep working even in 
adverse GPS conditions. Or you can configure the 
receiver to deliver only the most precise positions. 
It’s up to you. 

Flexible data collection options
Pick the field device and software that fits your 
workflow. The Pro XRS is ready to use with a 
variety of field computers, including Trimble’s own 
range of handheld computers: the GIS TSCe™ 
field device, the Trimble® Recon™ handheld, and 
the GeoExplorer® series.

Choosing software? Try the TerraSync™ software, 
for a complete solution from the field to the  
office and back. Choose off-the-shelf GPS field 
software. Or use the GPS Pathfinder Tools SDK 
to build your own application that’s totally 
customized to your needs.

All you need
You need equipment that’s as 
adaptable and hard-working 
as you are. So when you’re 
choosing GPS equipment, 
don’t compromise. Get a 
GPS Pathfinder Pro XRS receiver 
and have it all. 

Key Features

• Real-time submeter accuracy

• Integrated satellite, beacon, 
and WAAS/EGNOS differential 
receiver

• EVEREST multipath rejection

• Rugged design

• Ergonomic, comfortable 
backpack system

• Choice of field device and field 
software 

GPS Pathfinder Pro XRSGPS Pathfinder Pro XRS
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4585



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4585)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Titanium) 7000 meters

Pressure Sensor (3500 dBar) Druck 3500 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4585 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 7000 meter (3AL-4V Titanium) 
 0 Conductivity Raw Frequency 2630.97 Hz 
 Pressure Sensor Strain Gauge: 3500 dBar, S/N 5433 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050647 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0647

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA8.015 7.73

Vin 9V voltage across C2: VDC      Current mA8.014 7.4

Vin 6V voltage across C2: VDC      Current mA5.888 7.61

Pump submerged test, no load, Vin 12VDC Average current draw in water: 121 mA
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APPLICATION NOTE NO. 2D Revised December 2002 
 
 

INSTRUCTIONS FOR CARE AND CLEANING OF CONDUCTIVITY CELLS 
 
Since any conductivity sensor’s output reading is proportional to its dimensions, it is important to keep the cell 
clean of internal coatings. Also, cell electrodes contaminated with oil, biological growths, or other foreign material 
will cause low conductivity readings. 
 
If the cell is allowed to dry out between usage, salt crystals may form on (and in) the platinized electrode surfaces. 
When the instrument is next used, there will be a delay before these crystals are dissolved - in the meantime, sensor 
accuracy may be affected. Therefore, we recommend that the cell be kept filled with distilled or de-ionized water 
between uses. A length of 7/16" ID Tygon tubing is provided for this purpose, to be connected in such a way that 
any air entrapped will be in the Tygon tube rather than in the cell. 
 
An additional important benefit of keeping the cell ends closed with Tygon is to keep air-borne contaminants 
(which are abundant on most research vessels) from entering the cell. 
 
If it is not practical to keep the cell filled with distilled (or de-ionized) water between use (for example, in Arctic 
environments where freezing is a hazard), flush the cell with clean fresh water (preferably distilled or de-ionized) 
and close the cell with Tygon. Also, remember to keep the Tygon in a clean place (so that it does not pick up 
contaminants) while the instrument is in use. 
 
Experience indicates that in normal intermittent use (such as in CTD profiling operations), drift rates of  
0.0003 S/m (0.003 mmho/cm) or less per month can be expected without any cleaning if the procedures described 
above are followed. 
 
PRECAUTIONS!!!!!! 
 
The conductivity cell is primarily made of glass, and therefore is subject to breakage if mishandled. It is especially 
important to use the right size Tygon tubing, since if you use tubing with a too small ID, it will be difficult to 
remove the tubing, and the cell end may break if excessive force is used. The correct size tubing for all 
instruments produced since 1980 is 7/16" ID, 9/16" OD, 1/16" wall. Instruments shipped prior to 1980 had 
smaller retaining ridges at the ends of the cell, and 3/8" ID Tygon is required for these older instruments. It is better 
to use Tygon (brand) than other plastic tubing, since it tends to remain flexible over a wide temperature range and 
with age. 
 
Do not insert any sort of cleaning probe (e.g., Q-tip) into the interior of the cell. If the platinized (black) 
electrode surface is touched, it may be damaged and require the electrodes to be replatinized. 
 
If a cell is filled with water, do not subject it to low temperatures that will freeze the water and break the cell. 
Remove the water before shipment during the winter, or to polar regions at any season. No adverse affects 
have been observed as a result of temporary dry storage, particularly if the cell is rinsed with fresh water  
before storage. 
 

Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, WA  98005 
USA 
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CELL CLEANING 
 
Routine Cleaning (inside of cell not visibly dirty) 
 
Fill the cell with a 1% solution of Triton X-100* and let soak for 30 minutes. This is most easily done by using a 
length of 7/16" ID Tygon tubing to form a closed loop including the cell. After the soak, drain and flush with warm 
(not hot) fresh water for 1 minute. Refill the cell with distilled (or de-ionized) water until the next usage. 
 
 
Cleaning Severely Fouled Cells (visible deposits or marine growths on the inside of the cell) 
 
Clamp the instrument so that the cell is vertical, and attach a length of 7/16" Tygon tubing to the lower end of the 
cell. Use masking or other tape to secure the open end of the Tygon about even with the top end of the cell. Pour 
Muriatic Acid (37% HCl) into the open end of the Tygon until the cell is filled to near the top and let soak for 1 to 2 
minutes only. Avoid breathing the acid fumes!! Drain the acid from the cell and flush for 5 minutes with warm 
(not hot) fresh water. Also rinse the exterior of the instrument to remove any spilled acid from the surface. Then fill 
the cell with 1% Triton* solution, let stand for 5 minutes, and flush with warm fresh water for 1 minute. Refill with 
distilled or de-ionized water until the next usage. 
 
If this process does not remove the visible deposits, mechanically clean the cell with a small (0.275" diameter). soft-
bristled nylon bottle brush and 1% Triton solution. NOTE: Be extremely careful when cleaning, because the 
platinum electrodes are thin and could be damaged if you use a brush that is too large or too stiff. The 
electrodes must be replatinized after brush cleaning. Our service department will clean and replatinize your 
cell for a nominal fee. 
 
 
 
*Triton X-100 (a trade name of J. T. Baker, Inc) is a concentrated liquid non-ionic detergent available at most 
chemical or scientific supply stores. Other liquid detergents can probably also be used, but scientific grades are 
preferable because of their known composition. It is better to use a non-ionic detergent since conductivity readings 
taken immediately after use are less likely to be affected by any residual detergent left in the cell. 
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APPLICATION NOTE NO. 6 July 1994

DETERMINATION OF SOUND VELOCITY FROM CTD DATA

Use of CTD measurement for determination of sound velocity is appealing because these instruments are
simpler and more rugged and because their resolution, accuracy, and stability lead to far better precision
than can be obtained with direct SV measuring devices. For example, specifications of 0.01 mS/cm
conductivity, 0.01 degrees C temperature, and 1 meter in depth are readily achieved with good quality
CTD equipment. Assuming that the relationship between C, T, and D on the one hand and SV on the other
is exactly known (see below), the resulting uncertainty in SV would be as follows:

from temperature error (0.01 deg C) 0.021 meters/second
from conductivity error (0.01 mS/cm) 0.011 meters/second
from salinity error (0.01 psu) 0.012 meters/second
from depth error (1 meter) 0.017 meters/second

The equivalent SV errors (considered at 15 degrees C, 42.9 mS/cm, 35 psu, and 0 pressure, i.e, typical
open-ocean surface conditions) are much smaller than those usually claimed for direct-
measurement instruments.

The question about the absolute accuracy of the inference of SV from CTD data is more difficult to
answer. The main reason for this is apparently the result of differences in the instrumentation used by
various researchers and is compounded by the difficulty of performing direct measurements of sound
velocity under controlled conditions of temperature, salinity, and (especially) pressure. For example,
3 widely used equations (Wilson, 1959; Del Grosso, 1972; Millero and Chen, 1977) show differences in
absolute sound speed on the order of 0.5 meter/second for various combinations of water temperature,
salinity, and pressure, despite being based on careful measurements made under laboratory conditions.

The work of Millero and Chen is, however, the most modern, and it builds upon and attempts to
incorporate the work of earlier investigators. Accordingly, the SV/CTD relationship described by these
researchers in their paper of 1977 was used as a major component in the derivation of the Equation of
State (Unesco technical papers in marine science no. 44). Millero and Chen's 1977 equation is also the one
endorsed by the Unesco/SCOR/ICES/IASPO Joint Panel on Oceanographic Tables and Standards which
comprises the internationally recognized authority for measurements of ocean parameters (in Sea-Bird's
SEASOFT software, users may select any of the 3 equations mentioned above).

We draw the following conclusions from the research papers listed above:

1) Investigators using specialized equipment under scrupulously controlled laboratory conditions
report measurements of SV vs. changes in temperature, salinity, and pressure which differ by
0.5 meters/second and more. It is unrealistic to expect that commercial direct-measurement
instruments will be more accurate under field conditions than the laboratory equipment used by
successions of careful researchers.

Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, WA  98005
USA
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2) The claimed 'accuracy' of commercial direct-measurement SV probes probably more legitimately
represents their 'precision' (compare with CTD/SV uncertainties tabulated above) than their
absolute accuracy. The relationship between what these instruments read and true sound velocity
is probably just as dependent on the same vagaries that are also the only significant sources of
error when employing the CTD approach.

3) Because of the uncertainties in the time-delays associated with the acoustic transducers and
electronics (and because of the difficulty of measuring with sufficient accuracy the length of the
acoustic path), direct-measurement probes must be calibrated in water. As suggested by the
research under controlled laboratory conditions, this is not an easy task, especially over a range of
temperature, pressure, and salinity. On the other hand, a CTD probe can easily be calibrated
using accepted methods.

4) A CTD can predict absolute SV to something better than 0.5 meter/second (a judgement seconded
by Professor Millero in a private conversation), while its relative accuracy (precision) is probably
better than 0.05 meter/s under the most demanding conditions of field use.

5) The very high precision associated with CTD measurements and the existence of an internationally
accepted relationship (even if imperfect) between CTD and SV permits very consistent
intercomparison and a high degree of uniformity among CTD-derived SV data sets, no matter
when and where taken.
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APPLICATION NOTE NO. 10 Revised May 2004 
 
 COMPRESSIBILITY COMPENSATION 
 OF SEA-BIRD CONDUCTIVITY SENSORS 
 
Sea-Bird conductivity sensors provide precise characterization of deep ocean water masses. To achieve the accuracy 
of which the sensors are capable, an accounting for the effect of hydrostatic loading (pressure) on the conductivity 
cell is necessary. Conductivity calibration certificates show an equation containing the appropriate pressure-
dependent correction term, which has been derived from mechanical principles and confirmed by field observations. 
The form of the equation varies somewhat, as shown below: 
 
 
SBE 4, 9, 9plus, 16, 19, 21, 25, and 26/26plus 
 
 

Conductivity (Siemens/meter) =   slope                                                         +  offset            (recommended) 
 
 
or 
 
Conductivity (Siemens/meter) =   slope                                                      +  offset 
 

 
 
SBE 16plus, 19plus, 37, 45, and 49 
 
 

Conductivity (Siemens/meter) =   slope                                                      +  offset 
 

 
where 
• a, b, c, d, m, and CPcor are the calibration coefficients used for older sensors (prior to January 1995);  

Sea-Bird continues to calculate and print these coefficients on the calibration sheets for use with  
old software, but recommends use of the g, h, I, j, CTcor, CPcor form of the equation for most  
accurate results 

• g, h, I, j, CTcor, and CPcor are the calibration coefficients used for newer sensors 
• CPcor is the correction term for pressure effects on conductivity 
• slope and offset are correction coefficients used to make corrections for sensor drift between calibrations; 

set to 1.0 and 0 respectively on initial calibration by Sea-Bird (see Application Note 31 for details on 
calculating slope and offset) 

• f is the instrument frequency (kHz) 
• t is the water temperature (°C) 
• p is the water pressure (decibars) 

 
Sea-Bird CTD data acquisition, display, and post-processing software SEASOFT automatically implements  
these equations. 
 
 

Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, WA  98005 
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g  +  h f 2  +  i f 3  +  j f 4 

1  +  [CTcor] t  +  [CPcor] p

( g  +  h f 2  +  i f 3  +  j f 4 ) / 10 

1  +  [CTcor] t  +  [CPcor] p

(a f m  +  b f 2  +  c  +  dt ) / 10 

1  + [CPcor] p
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DISCUSSION OF PRESSURE CORRECTION 
 
Conductivity cells do not measure the specific conductance (the desired property), but rather the conductance of a 
specific geometry of water. The ratio of the cell�s length to its cross-sectional area (cell constant) is used to relate the 
measured conductance to specific conductance. Under pressure, the conductivity cell�s length and diameter are 
reduced, leading to a lower indicated conductivity. The magnitude of the effect is not insignificant, reaching  
0.0028 S/m at 6800 dbars. 
 
The compressibility of the borosilicate glass used in the conductivity cell (and all other homogeneous, noncrystalline 
materials) can be characterized by E (Young�s modulus) and ν (Poisson�s ratio). For the Sea-Bird conductivity cell,  
E = 9.1 x 106 psi, ν = 0.2, and the ratio of indicated conductivity divided by true conductivity is: 
 

1 + s 
where s = (CPcor) (p)  
Typical value for CPcor is - 9.57 x 10-8 for pressure in decibars   or  - 6.60x 10-8 for pressure in psi  

 
Note: This equation, and the mathematical derivations below, deals only with the pressure correction term, and does 
not address the temperature correction term. 

 
MATHEMATICAL DERIVATION OF PRESSURE CORRECTION 
 
For a cube under hydrostatic load: 
 

∆L / L = s = -p (1 - 2 ν) / E 
where 
• p is the hydrostatic pressure 
• E is Young�s modulus 
• ν is Poisson�s ratio 
• ∆L / L and s are strain (change in length per unit length) 

 
Since this relationship is linear in the forces and displacements, the relationship for strain also applies for the length, 
radius, and wall thickness of a cylinder. 
 
To compute the effect on conductivity, note that R0 = ρL / A , where R0 is resistance of the material at 0 pressure,  
ρ is volume resistivity, L is length, and A is cross-sectional area. For the conductivity cell A = π r2 , where r is the 
cell radius. Under pressure, the new length is L (1 + s) and the new radius is r (1 + s). If Rp is the cell resistance 
under pressure: 
 

Rp = ρL (1 + s) / (π r2 [1 + s]2) = ρL / π r2 (1 + s) = R0 / (1 + s) 
 
Since conductivity is 1/R: 
 

Cp = C0 (1 + s)    and    C0 = Cp / (1 + s) = Cp / (1 +  [Cpcor] [p]) 
where 
• C0 is conductivity at 0 pressure 
• Cp is conductivity measured at pressure 

 
A less rigorous determination may be made using the material�s bulk modulus. For small displacements in a cube: 
 

∆V / V = 3∆L / L = -3p (1 - 2 ν) / E    or    ∆V/V = -p / K 
where  

• ∆V / V is the change in volume per volume or volume strain 
• K is the bulk modulus. K is related to E and ν by K = E / 3 (1 - 2 ν). 

 
In this case, ∆L / L = -p / 3K. 
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APPLICATION NOTE NO. 14 January 1989

1978 PRACTICAL SALINITY SCALE

Should you not be already familiar with it, we would like to call your attention to the January 1980 issue of the IEEE
Journal of Oceanic Engineering, which is dedicated to presenting the results of a multi-national effort to obtain a
uniform repeatable Practical Salinity Scale, based upon electrical conductivity measurements. This work has been
almost universally accepted by researchers, and all instruments delivered by Sea-Bird since February 1982 have been
supplied with calibration data based upon the new standard.

The value for conductivity at 35 ppt, 15 degrees C, and 0 pressure [C(35,15,0)] was not agreed upon in the IEEE
reports -- Culkin & Smith used 42.914 mmho/cm (p 23), while Poisson used 42.933 mmho/cm (p 47). It really does
not matter which value is used, provided that the same value is used during data reduction that was used to compute
instrument calibration coefficients. Our instrument coefficients are computed using C(35,15,0) = 42.914 mmho/cm.

The PSS 1978 equations and constants for computing salinity from in-situ measurements of conductivity,
temperature, and pressure are given in the 'Conclusions' section of the IEEE journal (p 14) and are reproduced back
of this note. In the first equation, 'R' is obtained by dividing the conductivity value measured by your instrument by
C(35,15,0), or 42.914 mmho/cm. Note that the PSS equations are based upon conductivity in units of mmho/cm,
which are equal in magnitude to units of mS/cm. If you are working in conductivity units of Siemens/meter
(S/m), multiply your conductivity values by 10 before using the PSS 1978 equations.

Also note that the equations assume pressure relative to the sea-surface. Absolute pressure gauges (as used in all
Sea-Bird CTD instruments) have a vacuum on the reference side of their sensing diaphragms and indicate
atmospheric pressure (nominally 10.1325 dBar) at the sea-surface. This reading must be subtracted to obtain
pressure as required by the PSS equations. The pressure reading displayed when using Sea-Bird's SEASOFT CTD
acquisition, display, and post-processing software is the corrected sea-surface pressure and is used by SEASOFT to
compute salinity, density, etc in accordance with the PSS equations.

Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, WA  98005
USA
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APPLICATION NOTE 27Druck NOVEMBER 2003 
 
 Minimizing Strain Gauge Pressure Sensor Errors 
 
The following Sea-Bird instruments use strain gauge pressure sensors manufactured by GE Druck: 
 
• SBE 16plus and 16plus-IM SEACAT (not 16*) with optional strain gauge pressure sensor 
• SBE 19plus SEACAT Profiler (not 19*) 
• SBE 25 SEALOGGER CTD, which uses SBE 29 Strain-Gauge Pressure Sensor (built after March 2001) 
• SBE 37 MicroCAT (37-IM, -IMP, -SM, -SMP, and -SI) with optional pressure sensor (built after September 2000) 
• SBE 39 Temperature Recorder with optional pressure sensor (built after September 2000) 
• SBE 49 FastCAT CTD Sensor 
• SBE 50 Digital Oceanographic Pressure Sensor 
 
* Note: SBE 16 and SBE 19 SEACATs were originally supplied with other types of pressure sensors. However, a few 
of these instruments have been retrofitted with Druck sensors. 
 
The Druck sensors are designed to respond to pressure in nominal ranges 0 - 20 meters, 0 - 100 meters, 0 - 350 meters, 
0 – 1000 meters, 0 – 2000 meters, 0 – 3500 meters, and 0 – 7000 meters (with pressures expressed in meters of 
deployment depth capability). The sensors offer an initial accuracy of 0.1% of full scale range. 
 
DEFINITION OF PRESSURE TERMS 
 
The term psia means pounds per square inch, absolute (absolute means that the indicated pressure is referenced to  
a vacuum). 
 
For oceanographic purposes, pressure is most often expressed in decibars (1 dbar = 1.4503774 psi). A dbar is 0.1 bar; a 
bar is approximately equal to a standard atmosphere (1 atmosphere = 1.01325 bar). For historical reasons, pressure at 
the water surface (rather than absolute or total pressure) is treated as the reference pressure (0 dbar); this is the value 
required by the UNESCO formulas for computation of salinity, density, and other derived variables. 
 
Some oceanographers express pressure in Newtons/meter2 or Pascals (the accepted SI unit). A Pascal is a very small 
unit (1 psi = 6894.757 Pascals), so the mega-Pascal (MPa = 106 Pascals) is frequently substituted (1 MPa = 100 dbar). 
 
Since the pressure sensors used in Sea-Bird instruments are absolute types, their raw data inherently indicate 
atmospheric pressure (about 14.7 psi) when in air at sea level. Sea-Bird outputs pressure in one of the following ways: 
 
• For CTDs that output raw data (SBE 16plus, 16plus-IM, 19plus, 25, and 49) and are supported by SEASOFT’s 

SEASAVE (real-time data acquisition) and SBE Data Processing (data processing) software – In SEASOFT, user 
selects pressure output in psi (not psia) or dbar. SEASOFT subtracts 14.7 psi from the raw absolute reading and 
outputs the remainder as psi or converts the remainder to dbar. 

• For the SBE 50 – User selects pressure output in psia (including atmospheric pressure) or dbar. Calculation of dbar 
is as described above. 

• For all other instruments that can output converted data in engineering units (SBE 16plus, 16plus-IM, 19plus, 
37, 39, and 49) – Instrument subtracts 14.7 psi from the raw absolute reading and converts the remainder to dbar. 

Note: SBE 16plus, 16plus-IM, 19plus, and 49 can output raw or converted data. 
 
RELATIONSHIP BETWEEN PRESSURE AND DEPTH 
 
Despite the common nomenclature (CTD = Conductivity - Temperature - Depth), all CTDs measure pressure, which is 
not quite the same thing as depth. The relationship between pressure and depth is a complex one involving water 
density and compressibility as well as the strength of the local gravity field, but it is convenient to think of a decibar as 
essentially equivalent to a meter, an approximation which is correct within 3% for almost all combinations of salinity, 
temperature, depth, and gravitational constant. 
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SEASOFT offers two methods for estimating depth from pressure. 
 
• For oceanic applications, salinity is presumed to be 35 PSU, temperature to be 0o C, and the compressibility of the 

water (with its accompanying density variation) is taken into account. This is the method recommended in 
UNESCO Technical Paper No. 44 and is a logical approach in that by far the greatest part of the deep-ocean water 
column approximates these values of salinity and temperature. Since pressure is also proportional to gravity and 
the major variability in gravity depends on latitude, the user’s latitude entry is used to estimate the magnitude of the 
local gravity field. 

 SBE 16plus, 16plus-IM, 19plus, 25, and 49 - User is prompted to enter latitude if Depth [salt water] is selected 
as a display variable in SEASAVE or as an output variable in the Data Conversion or Derive module of  
SBE Data Processing. 

 SBE 37-SI and 50 - Latitude is entered in the instrument’s EEPROM using the LATITUDE= command in 
SEASOFT’s SEATERM (terminal program) software. 

 SBE 39 – User is prompted to enter latitude if conversion of pressure to depth is requested when converting an 
uploaded .asc file to a .cnv file in SEATERM. 

• For fresh water applications, compressibility is not significant in the shallow depths encountered and is ignored, as 
is the latitude-dependent gravity variation. Fresh water density is presumed to be 1 gm/cm, and depth (in meters) is 
calculated as 1.019716 * pressure (in dbars). 

 
CHOOSING THE RIGHT SENSOR 
 
Initial accuracy and resolution are expressed as a percentage of the full scale range for the pressure sensor. The  
initial accuracy is 0.1% of the full scale range. Resolution is 0.002% of full scale range, except for the SBE 25  
(0.015% resolution). For best accuracy and resolution, select a pressure sensor full scale range to correspond to no more 
than the greatest depths to be encountered. The effect of this choice on CTD accuracy and resolution is shown below: 
 

Range 
(meters) 

Maximum Initial Error 
(meters) 

SBE 16plus, 16plus-IM, 19plus, 37, 39, 49, & 50 -  
Resolution (meters) 

SBE 25 -  
Resolution (meters) 

0 – 20 0.02 0.0004 0.003 
0 – 100 0.10 0.002 0.015 
0 – 350 0.35 0.007 0.052 
0 – 1000 1.0 0.02 0.15 
0 - 2000 2.0 0.04 0.30 
0 - 3500 3.5 0.07 0.52 
0 - 7000 7.0 0.14 1.05 

 
The meaning of accuracy, as it applies to these sensors, is that the indicated pressure will conform to true pressure to 
within ± maximum error (expressed as equivalent depth) throughout the sensor’s operating range. Note that a  
7000-meter sensor reading + 7 meters at the water surface is operating within its specifications; the same sensor would 
be expected to indicate 7000 meters ± 7 meters when at full depth. 
 
Resolution is the magnitude of indicated increments of depth. For example, a 7000-meter sensor on an SBE 25 
(resolution 1.05 meters) subjected to slowly increasing pressure will produce readings approximately following the 
sequence 0, 1.00, 2.00, 3.00 (meters). Resolution is limited by the design configuration of the CTD’s A/D converter.  
For the SBE 25, this restricts the possible number of discrete pressure values for a given sample to somewhat less than 
8192 (13 bits); an approximation of the ratio 1 : 7000 is the source of the SBE 25’s 0.015% resolution specification. 
 
Note: SEASOFT (and other CTD software) presents temperature, salinity, and other variables as a function of depth or 
pressure, so the CTD’s pressure resolution limits the number of plotted data points in the profile. For example, an  
SBE 25 with a 7000-meter sensor might acquire several values of temperature and salinity during the time required to 
descend from 1- to 2-meters depth. However, all the temperature and salinity values will be graphed in clusters 
appearing at either 1 or 2 meters on the depth axis. 
 
High-range sensors used in shallow water generally provide better accuracy than their absolute specifications indicate. 
With careful use, they may exhibit accuracy approaching their resolution limits. For example, a 3500-meter sensor has 
a nominal accuracy (irrespective of actual operating depth) of ± 3.5 meters. Most of the error, however, derives from 
variation over time and temperature of the sensor’s offset, while little error occurs as a result of changing sensitivity.  
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MINIMIZING ERRORS 
 
Offset Errors 
 
The primary offset error due to drift over time can be eliminated by comparing CTD readings in air before beginning 
the profile to readings from a barometer. Follow this procedure: 
 
1. Allow the instrument to equilibrate in a reasonably constant temperature environment for at least 5 hours. Pressure 

sensors exhibit a transient change in their output in response to changes in their environmental temperature; 
allowing the instrument to equilibrate before starting will provide the most accurate calibration correction. 

 
2. Place the instrument in the orientation it will have when deployed. 
 
3. Set the pressure offset to 0.0: 

• In the .con file, using SEASAVE or SBE Data Processing (for SBE 16plus, 16plus-IM, 19plus, 25, or 49). 
• In the CTD’s EEPROM, using the appropriate command in SEATERM (for SBE 16plus, 16plus-IM, 19plus, 

37, 39, 49, or 50). 
 
4. Collect pressure data from the instrument using SEASAVE or SEATERM (see instrument manual for details). If 

the instrument is not outputting data in decibars, convert the output to decibars. 
 

5. Compare the instrument output to the reading from a good barometer placed at the same height as the pressure 
sensor. Calculate offset (decibars) = barometer reading (converted to decibars) – instrument reading (decibars). 

 
6. Enter calculated offset in decibars: 

• In the .con file, using SEASAVE or SBE Data Processing (for SBE 16plus, 16plus-IM, 19plus, 25, or 49). 
• In the CTD’s EEPROM, using the appropriate command in SEATERM (for SBE 16plus, 16plus-IM, 19plus, 

37, 39, 49, or 50). 
 
Note: For instruments that store calibration coefficients in EEPROM and also use a .con file (SBE 16plus, 16plus-IM, 
19plus, and 49), set the pressure offset (Steps 3 and 6 above) in both the EEPROM and in the .con file. 

 
Offset Correction Example 
Pressure measured by a barometer is 14.65 psia. Pressure displayed from instrument is -2.5 dbars. 
Convert barometer reading to dbars using the relationship:     (psia – 14.7) * 0.6894759 = dbars 
Barometer reading = (14.65 – 14.7) * 0.6894759 = -0.034 dbars 
Offset = -0.034 – (-2.5) = + 2.466 dbar 
Enter offset in .con file (if applicable) and in instrument EEPROM (if applicable). 

 
 
 
Another source of offset error results from temperature-induced drifts. Because Druck sensors are carefully temperature 
compensated, errors from this source are small. Offset errors can be estimated for the conditions of your profile, and 
eliminated when post-processing the data in SBE Data Processing by the following procedure: 
 
1. Immediately before beginning the profile, take a pre-cast in air pressure reading. 
 
2. Immediately after ending the profile, take a post-cast in air pressure reading with the instrument at the same 

elevation and orientation. This reading reflects the change in the instrument temperature as a result of being 
submerged in the water during the profile. 

 
3. Calculate the average of the pre- and post-cast readings. Enter the negative of the average value (in decibars) as the 

offset in the .con file. 
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Hysteresis Errors 
 
Hysteresis is the term used to describe the failure of pressure sensors to repeat previous readings after exposure to other 
(typically higher) pressures. The Druck sensor employs a micro-machined silicon diaphragm into which the strain 
elements are implanted using semiconductor fabrication techniques. Unlike metal diaphragms, silicon’s crystal structure 
is perfectly elastic, so the sensor is essentially free of pressure hysteresis. 
 
 
Power Turn-On Transient 
 
Druck pressure sensors exhibit virtually no power turn-on transient. The plot below, for a 3500-meter pressure sensor in 
an SBE 19plus SEACAT Profiler, is representative of the power turn-on transient for all pressure sensor ranges. 

 
 
Thermal Transient 
 
Pressure sensors exhibit a transient change in their output in response to changes in their environmental temperature, so 
the thermal transient resulting from submersion in water must be considered when deploying the instrument. 
 
During calibration, the sensors are allowed to warm-up before calibration points are recorded. Similarly, for best depth 
accuracy the user should allow the CTD to warm-up for several minutes before beginning a profile; this can be part of 
the soak time in the surface water. Soaking also allows the CTD housing to approach thermal equilibrium (minimizing 
the housing's effect on measured temperature and conductivity) and permits a Beckman- or YSI-type dissolved oxygen 
sensor (if present) to polarize. 
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APPLICATION NOTE NO. 31 September 2001

Computing Temperature and Conductivity Slope and Offset Correction Coefficients from
Laboratory Calibrations and Salinity Bottle Samples

Conductivity Sensors

SEASOFT’s prompt for slope and offset values when the conductivity sensor is selected when setting up the
configuration (.con) file permits the user to make corrections for sensor drift between calibrations. For newly calibrated
sensors use slope = 1.0, offset = 0.0. The correction formula is:

(corrected conductivity) = slope * (computed conductivity) + offset

The conductivity sensor usually drifts by changing span (the slope of the calibration curve), and changes are typically
toward lower conductivity readings with time. Offset error in conductivity (error at 0 S/m) is usually due to electronics
drift, which is usually less than ±0.0001 S/m per year. Offsets greater than ±0.0002 S/m are symptomatic of sensor
malfunction. Sea-Bird, therefore, recommends drift corrections to conductivity sensors be made by assuming no offset
error, unless there is strong evidence to the contrary or a special need.

As an example of computing these correction coefficients, if we had the following calibration data:

true conductivity: 3.5 S/m
instrument reading: 3.49965 S/m

slope = 3.5 / 3.49965 = 1.000100

Correcting for Conductivity Drift Based on Pre- and Post-Cruise Laboratory Calibrations

Suppose a conductivity sensor is calibrated (pre-cruise), then immediately used at-sea, and then returned for post-cruise
calibration. The pre- and post-cruise calibration data can be used to generate a slope correction for data taken between
the pre- and post-cruise calibrations.

If α is the conductivity computed from the pre-cruise bath data (temperature and frequency) using post-cruise
calibration coefficients and β is the true conductivity in the pre-cruise bath, then:

Postslope =                                             (postslope is typically < 1.0)

Beginning in February 1995, the value for postslope was calculated and printed on the conductivity calibration sheet.

Σ   (α i)(β i)

n

Σ   (α i)(α i)
i=1

n

i=1
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To correct conductivity data taken between pre- and post-cruise calibrations:

Let:
n = number of days between pre- and post-cruise calibrations
b = number of days between pre-cruise calibration and the cast to be corrected
islope = interpolated slope; this is the value to enter in the .con file
postslope = slope from calibration sheet as calculated above

islope = 1.0 + (b / n) ((1 / postslope) - 1.0)

In the .con file, use the pre-cruise calibration coefficients and use islope for the value of slope.*

Note: The CTD configuration (.con) file is edited using the Configure menu (in SEASAVE or SBE Data Processing in
our SEASOFT-Win32 suite of programs) or SEACON (in SEASOFT-DOS).

For typical conductivity drift rates (equivalent to -0.003 PSU/month), islope would not need to be recalculated more
frequently than at weekly intervals.

* You can also calculate preslope. If α is the conductivity computed from the post-cruise bath data (temperature
and frequency) using pre-cruise calibration coefficients and β is the true conductivity in the post-cruise bath, then:

Preslope =                                             (preslope is typically > 1.0)

In this case, pre-cruise calibration coefficients would be used and:
islope = 1.0 + (b / n) (preslope - 1.0)

Correcting for Conductivity Drift Based on Salinity Bottles Taken At-Sea

For this situation the pre-cruise calibration coefficients are used to compute conductivity and CTD salinity. Salinity
samples are obtained using water sampler bottles during CTD profiles, and the difference between CTD salinity and
bottle salinity is used to determine the drift in conductivity.

In using this method to correct conductivity, it is important to realize that differences between CTD salinity and
hydrographic bottle salinity are due to errors in conductivity, temperature, and pressure measurements (as well as
errors in obtaining and analyzing bottle salinity values). All CTD temperature and pressure errors and bottle errors
must first be corrected before attributing the remaining salinity difference as CTD conductivity error and proceeding
with conductivity corrections.

Suppose that at a Pacific Ocean station, three salinity bottles are taken during a CTD profile and assume for this
discussion that shipboard analysis of the bottle salinities is perfect. The bottle salinities and the uncorrected CTD data
might be:

Σ   (α i)(β i)

n

Σ   (α i)(α i)
i=1

n

i=1
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Approximate
Depth (m)

Bottle
Salinity

CTD Raw
Salinity

CTD Raw
Conductivity (S/m)

CTD Temperature
(°C)

CTD Pressure
(dbar)

200 34.9770 34.9705 4.63421 18.3924 202.7
1000 34.4710 34.4634 3.25349 3.9841 1008.8
4000 34.6850 34.6778 3.16777 1.4527 4064.1

The uncorrected salinity differences (CTD salinity - bottle salinity) are approximately -0.007 ppt. To determine
conductivity drift, the CTD temperature and pressure data must first be corrected. Suppose that the error in temperature
measurements is +0.0015 C uniformly at all temperatures, and the error in pressure is +0.5 dbar uniformly at all
pressures. The drift offsets are obtained by projecting the drift history of both sensors from pre-cruise calibrations. If
these offsets are entered in the .con file, the correct CTD temperature and pressure will be the reported raw values and
will need no further correction. In addition, the CTD raw salinity will be reported using the correct CTD temperature
and pressure. This correction method also assumes that the pressure coefficient for the conductivity cell is correct. The
CTD data with corrected temperature and pressure are:

Correct CTD
Pressure (dbar)

Correct CTD
Temperature (°C)

CTD Conductivity
(S/m)

CTD Salinity
T,P Corrected

Bottle Salinity

202.2 18.3909 4.63421 34.9719 34.9770
1008.3 3.9826 3.25349 34.4652 34.4710
4063.6 1.4512 3.16777 34.6796 34.6850

The (CTD-bottle) salinity difference of -0.005 ppt is now properly assigned as conductivity error, equivalent to about -
0.0005 S/m at 4.0 S/m. By plotting the conductivity error versus conductivity, it is evident that the drift is primarily a
slope change.

The program SEACALC (in SEASOFT-DOS) can be used to compute bottle conductivity. Enter bottle salinity for
salinity, CTD corrected temperature for temperature, and CTD corrected pressure for pressure.

CTD Conductivity (S/m) Bottle Conductivity (S/m) [CTD - Bottle] Conductivity (S/m)
4.63421 4.63481 -0.00060
3.25349 3.25398 -0.00049
3.16777 3.16821 -0.00044

If α is the CTD conductivity computed with pre-cruise coefficients and β is the true bottle conductivity then:

slope =                                                         (slope is typically > 1.0)

Using the above data, the slope correction coefficient for conductivity at this station is slope = +1.000137. Following
Sea-Bird's recommendation of assuming no offset error in conductivity, offset is set to 0.0.

For typical Sea-Bird sensors that are calibrated regularly, 70 - 90% of the CTD salinity error is due to conductivity
calibration drift, 10 - 30% is due to temperature calibration drift, and only 0% - 10% is due to pressure calibration drift.

Σ   (α i)(β i)

n

Σ   (α i)(α i)
i=1

n

i=1
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Temperature Sensors

SEASOFT’s prompt for slope and offset values when the temperature sensor is selected when setting up the
configuration (.con) file permits the user to make corrections for sensor drift between calibrations. For newly calibrated
sensors, use slope = 1.0, offset = 0.0. The correction formula is:

(corrected temperature) = slope * (computed temperature) + offset

where :
slope = (true temperature span) / (instrument temperature span)
offset = (true temperature - instrument reading) * slope                    measured at 0.0 °C

As an example of computing the correction coefficients, if we had the following calibration data:

true temperature 0.0 °C 25.0 °C
instrument reading 0.0015 °C 25.0013 °C

slope = (true temperature span) / (instrument temperature span)
= (25.0 - 0.0) / (25.0013 - 0.0015)  = 1.000008000

offset = (true temperature - instrument reading) * slope measured at 0.0 °C
= (0.0 - 0.0015) * (1.000008000)  = -0.00150002

For this example Sea-Bird would recommend the drift correction values (entered in the .con file)
slope = 1.0 offset = -0.0015

Sea-Bird temperature sensors usually drift by changing offset (an error of equal magnitude at all temperatures). In
general, the drift can be toward higher or lower temperature with time; however, for a specific sensor the drift will
remain the same sign (direction) for many consecutive years. A large span error (change in calibration slope) indicates
an unusual aging of electronic components and is symptomatic of sensor malfunction. Sea-Bird therefore recommends
that drift corrections to temperature sensors be made by assuming no slope error, unless there is strong evidence to the
contrary or a special need.

Sensors with serial numbers less than 1050 drift more typically toward higher temperature with time, while sensors with
serial numbers greater than 1050 drift more typically toward lower temperature with time. Many years of experience
with hundreds of sensors indicates that the drift is smooth and uniform with time, allowing users to make very accurate
drift corrections to field data based only on pre- and post-cruise laboratory calibrations.

Calibration checks at-sea are advisable for consistency checks of the sensor drift rate and for early detection of sensor
malfunction. However, data from reversing thermometers is rarely accurate enough to make calibration corrections that
are better than those possible by shore-based laboratory calibrations. A proven alternate consistency check is to use dual
SBE 3 temperature sensors on a CTD and to track the difference in drift rates between the two sensors. In the deep
ocean, where temperatures are uniform, the difference in temperature measured by two sensors can be resolved to better
than 0.0002 °C and will change smoothly with time as predicted by the difference in drift rates of the two sensors.

The temperature sensors rarely exhibit span errors larger than 0.005 °C over the range -5 to 35 °C even after years of
drift. A span error that increases by more than ±0.0002 [°C per °C per year] is symptomatic of sensor malfunction.
Previous to January 1993 some calibrations have been delivered that include span errors up to 0.004 °C in 30 °C
(span error of 0.000133) because of undetected systematic errors in calibration. Temperature calibrations preformed at
Sea-Bird after January 1995 have span error less than 0.0002 °C in 30 °C.
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Correcting for Temperature Drift Based on Pre- and Post-Cruise Laboratory Calibrations

Suppose a temperature sensor is calibrated (pre-cruise), then immediately used at-sea for 4 months, and then returned
for post-cruise calibration. Converting the post-cruise calibration data using the pre-cruise coefficients, we obtain
the estimates:

Real Temperature........ 0.0°....... 25.0°C
Instrument Reading..... 0.002°... 25.001°C

These calibration data correspond to offset error = +0.002 °C, and span error = -0.00004 [°C per °C] at the end of
4 months of use. The correction coefficients are slope= 1.000040002, offset= -0.00200008. Note the difference
between the error value and the value of the correction coefficient.

For preliminary work at sea, use the pre-cruise calibration coefficients and slope = 1.0, offset = 0.0. Temperature
data obtained during the cruise is corrected for drift using properly scaled values of correction coefficients. Data
from the end of the second month at sea would be converted using pre-cruise coefficients and slope=1.00002,
offset= -0.001. At the end of the 4-month cruise, data could be converted by either using pre-cruise coefficients and
slope=1.00004, offset= -0.002, or by using post-cruise coefficients and slope= +1.0, offset = 0.0.
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APPLICATION NOTE NO. 34 January 1992

CONDUCTIVITY CELL FILLING AND STORAGE DEVICE P/N 50087
INSTRUCTIONS FOR USE

Sea-Bird recommends keeping the conductivity
cell full of purified water (except in freezing
environments) during periods when the CTD is not
being used. This is important in keeping the cell
free from contamination and in keeping the
electrodes wetted and ready for immediate use.

CTDs with pumped conductivity cells (SBE 911,
SBE 25, and some SEACATs) are shipped with
syringe and tubing assembly (P/N 50087) as an
accessory for filling and storing the conductivity
cell. The tubing assembly consists of a length of
1/4 inch I.D. tube connected to a short piece of
7/16 inch I.D. tube by a plastic reducing union.

To fill the conductivity cell, draw about 40-60 cc of
purified water into the syringe, connect the plastic
tubing to the TC duct intake on the temperature
sensor [Figure 1], (or to the open end of the
conductivity cell on systems without the TC duct
[Figure 2]) and inject water into the cell and
pump plumbing.

For CTDs with a TC duct, remove the plastic
reducing union and connect the smaller diameter
tubing directly to the TC duct. For CTDs without a
TC duct, leave the reducing union and large
diameter tubing attached and carefully connect the
tubing directly to the end of the glass conductivity
cell [Figure 2].

After filling the conductivity cell, loop the rubber
band around a bar on the CTD cage and back over
the top of the syringe to secure the apparatus for
storage.

REMEMBER TO REMOVE THE SYRINGE
AND TUBING ASSEMBLY BEFORE
DEPLOYMENT!

Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, WA  98005
USA
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Fax: (425) 643-9954
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APPLICATION NOTE NO. 40 Revised November 2002 
 
 SBE 5T PUMP SPEED ADJUSTMENT INSTRUCTIONS 
 
 
Equipment: DC power supply   Drawings: 31441 (schematic) 
  Frequency counter     40630 (3000 rpm pump) 
         40631 (1300 rpm pump) 
 
 
The pump housing must be disassembled to adjust the pump speed. Referencing above drawings: 
 
1. Remove the white plastic end cap retainer ring located at the connector end of the pump by twisting in a 

counter-clockwise motion. 
 
2. Install a 2-pin dummy plug with locking sleeve (P/N 17044.1) over the bulkhead connector. This will 

provide a good grip on the pump connector and will protect the connector pins.  
Rotate the connector back and forth while carefully pulling the end cap away from the housing. Pull the 
end cap (piston o-ring seal) out of the housing. The motor and electronics assembly are attached to the 
end cap and will come out as a unit. 

 
3. Connect the positive lead of your frequency counter to the yellow test post (T1) (drawing 40630/40631). 

Connect the frequency counter ground (negative) to the power supply ground (negative). 
 
4a. For low voltage pump (pump with LV in the serial number), supply 6 volts DC power to either  

the bulkhead connector (large pin is common, small pin is positive) or connect directly to the PCB  
(P8 is positive, P19 or P18 is common, drawing 40630/40631). 

 
4b. For normal voltage pump, supply 12 volts to either the bulkhead connector (large pin is common, 

small pin is positive) or connect directly to the PCB (P8 is positive, P19 or P18 is common,  
drawing 40630/40631). 

 
5. A 2K ohm potentiometer (R11, drawing 40630/40631) is located on the back side of the board. Adjust the 

potentiometer to obtain the frequency corresponding to the desired speed (Frequency * 30 = RPM). 
With the Pittman 18.2Ω motor (P/N 3711B113), set the jumper position P15 to P17 (1300 rpm) and P12 
to P13 (1300 rpm), and adjust the speed as desired, up to the nominal maximum of 2000 rpm. With the 
Pittman 7.4Ω motor (P/N 3711B112), set the jumper position P15 to P16 (3000 rpm) and P14 to P13 
(3000 rpm), and adjust the speed as desired, up to the nominal maximum of 4500 rpm. To adjust speed 
of the 7.4Ω motor below approximately 2200 rpm, set the jumper position P15 to P17 (1300 rpm) and 
P12 to P13 (1300 rpm), and adjust speed using the potentiometer. 

 
6. Disconnect the frequency counter and the power supply. Make sure the O-ring and mating surfaces 

are clean. Lightly lubricate before inserting the connector end cap into the housing cylinder. Replace the 
pump end cap retainer. 
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APPLICATION NOTE NO. 42 Revised September 2001

ITS-90 TEMPERATURE SCALE

Beginning January 1995, Sea-Bird temperature calibration certificates list a new set of coefficients labeled g, h, i, j,
and F0. These coefficients correspond to ITS90 (T90) temperatures and should be entered by those researchers
working with SEASOFT-DOS Versions 4.208 and higher (and all versions of SEASOFT-Win32). For the
convenience of users who prefer to use older SEASOFT versions, the new certificates also list a, b, c, d, and F0
coefficients corresponding to IPTS68 (T68) temperatures as required by SEASOFT-DOS versions older than 4.208.

It is important to note that the international oceanographic research community will continue to use T68 for
computation of salinity and other seawater properties. Therefore, following the recommendations of Saunders (1990)
and as supported by the Joint Panel on Oceanographic Tables and Standards (1991), SEASOFT-DOS 4.200 and
later and all versions of SEASOFT-Win32 convert between T68 and T90 according to the linear relationship:

T68 = 1.00024  * T90

The use of T68 for salinity and other seawater calculations is automatic in all SEASOFT programs. However, when
selecting temperature as a display/output variable, you will be prompted to specify which standard (T90 or T68) is
to be used to compute temperature. SEASOFT recognizes whether you have entered T90 or T68 coefficients in the
configuration (.con) file, and computes T90 temperature directly or calculates it from the Saunders linear
approximation, depending on which coefficients were used and which display variable type is selected.

For example, if g, h, i, j, F0 coefficients (T90) are entered in the .con file and you select temperature variable type as
T68, SEASOFT computes T90 temperature directly and multiplies it by 1.00024 to display T68. Conversely, if a, b,
c, d, and F0 coefficients (T68) are entered in the .con file and you select temperature variable type as T90,
SEASOFT computes T68 directly and divides by 1.00024 to display T90.

Note: The CTD configuration (.con) file is edited using the Configure menu (in SEASAVE or SBE Data Processing
in our SEASOFT-Win32 suite of programs) or SEACON (in SEASOFT-DOS).

Also beginning January 1995, Sea-Bird's own temperature metrology laboratory (based upon water triple-point and
gallium melt cell, SPRT, and ASL F18 Temperature Bridge) converted to T90. These T90 standards are now
employed in calibrating all Sea-Bird temperature sensors, and as the reference temperature used in conductivity
calibrations. Accordingly, all calibration certificates show T90 (g, h, i, j) coefficients that result directly from
T90 standards, and T68 coefficients (a, b, c, d) computed using the Saunders linear approximation.
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APPLICATION NOTE NO. 57 Revised May 2003 
 

I/O Connector Care and Installation 
 
This Application Note describes the proper care and installation of standard I/O connectors for Sea-Bird  
CTD instruments. Once properly installed, the connections require minimal care. Unless access to the bulkhead is 
required, the connections can be left in place indefinitely. 
 
The Application Note is divided into three sections: 
• Connector Cleaning and Installation 
• Locking Sleeve Installation 
• Cold Weather Tips 

Connector Cleaning and Installation 
 
1. Carefully clean the bulkhead connector and the inside of the mating inline (cable end) connector with a 

Kimwipe. Remove all grease, hair, dirt, and other contamination. 

2. Inspect the connectors: 
A. Inspect the pins on the bulkhead connector for signs of corrosion. The pins should be bright and shiny, with no 

discoloration. If the pins are discolored or corroded, clean with alcohol and a Q-tip. 
B. Inspect the bulkhead connector for chips, cracks, or other flaws that may compromise the seal. 
C. Inspect the inline connector for cuts, nicks, breaks, or other problems that may compromise the seal. 
 
Replace severely corroded or otherwise damaged connectors - contact SBE for instructions or a Return 
Authorization Number (RMA number). 

Clean bulkhead connector Clean inside of connector 

Corroded pins on bulkhead connectors - 
Connector on right has a missing pin 

Sea-Bird Electronics, Inc. 
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3. Using a tube of 100% silicone grease (Dow DC-4 or 
equivalent), squeeze approximately half the size of a 
pea onto the end of your finger. 

 
CAUTION: 
Do not use WD-40 or other petroleum-based 
lubricants, as they will damage the connectors. 
 
 
4. Apply a light, even coating of grease to the molded 

ridge around the base of the bulkhead connector.  
The ridge looks like an o-ring molded into the 
bulkhead connector base and fits into the groove of 
the mating inline connector. 

 

5. Mate the inline connector to the bulkhead, 
being careful to align the pins with the sockets. 
Do not twist the inline connector on the 
bulkhead connector. Twisting can lead to bent 
pins, which will soon break. 

 
 
6. Push the connector all the way onto the 

bulkhead. There may be an audible pop,  
which is good. With some newer cables,  
or in cold weather, there may not be an  
initial audible pop. 

7. After the cable is mated, run your fingers along the 
inline connector toward the bulkhead, milking any 
trapped air out of the connector. You should hear 
the air being ejected. 

 
CAUTION: 
Failure to eject the trapped air will result in the 
connector leaking. 
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Locking Sleeve Installation 
 
After the connectors are mated, install the locking sleeve. The locking sleeve secures the inline connector to the 
bulkhead connector and prevents the cable from being inadvertently removed. 
Important points regarding locking sleeves: 
 
• Tighten the locking sleeve by hand. Do not use a wrench or pliers to tighten the locking sleeve. 

Overtightening will gall the threads, which can bind the locking sleeve to the bulkhead connector. Attempting 
to remove a tightly bound locking sleeve may instead result in the bulkhead connector actually unthreading 
from the end cap. A loose bulkhead connector will lead to a flooded instrument. Pay particular attention 
when removing a locking sleeve to ensure the bulkhead connector is not loosened. 

 
• It is a common misconception that the locking sleeve provides watertight integrity. It does not, and 

continued re-tightening of the locking sleeve will not fix a leaking connector. 
 
• As part of routine maintenance at the end of every cruise, remove the locking sleeve, slide it up the cable, and 

rinse the connection (still mated) with fresh water. This will prevent premature cable failure. 

Cold Weather Tips 
 
In cold weather, the connector may be hard to install and remove. 
 
Removing a frozen inline connector: 
 
1. Wrap the connector with a washrag or other cloth. 
 
2. Pour hot water on the cloth and let the connector sit for a minute or two. The connector should thaw and become 

flexible enough to be removed. 
 
 
Installing an inline connector: 
When possible, mate connectors in warm environments before the cruise and leave them connected.  
If not, warm the connector sufficiently so it is flexible. A flexible connector will install properly. 
 

By following these procedures, you will have many years of reliable service from your cables! 

Locking Sleeve 
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APPLICATION NOTE NO. 67 October 2001

Editing Sea-Bird .hex Data Files

After acquiring real-time .hex data or uploading .hex data from CTD memory, users sometimes want to edit the header
to add or change explanatory notes about the cast. Some text editing programs modify the file in ways that are not visible
to the user (such as adding or removing carriage returns and line feeds), but that corrupt the format and prevent further
processing by SEASOFT (both DOS and Windows versions). This Application Note provides details on one way to
edit a .hex data file with a text editor while retaining the required format. The procedure described below has been
found to work correctly on computers running Win 98, Win 2000, and Win NT. If the editing is not performed using this
technique, SEASOFT may reject the data file and give you an error message.

1. Make a back-up copy of your .hex data file before you begin.

2. Run WordPad.

3. In the File menu, select Open. The Open dialog box appears. For Files of type, select All Documents (*.*). Browse
to the desired .hex data file and click Open.

4. Edit the file as desired, inserting any new header lines after the System Upload Time line. Note that all header
lines must begin with an asterisk (*), and *END* indicates the end of the header. An example is shown below, with
the added lines in bold:

* Sea-Bird SBE 21 Data File:
* FileName = C:\Odis\SAT2-ODIS\oct14-19\oc15_99.hex
* Software Version Seasave Win32 v1.10
* Temperature SN = 2366
* Conductivity SN = 2366
* System UpLoad Time = Oct 15 1999  10:57:19
* Testing adding header lines
* Must start with an asterisk
* Can be placed anywhere between System Upload Time and END of header
* NMEA Latitude = 30 59.70 N
* NMEA Longitude = 081 37.93 W
* NMEA UTC (Time) = Oct 15 1999  10:57:19
* Store Lat/Lon Data = Append to Every Scan and Append to .NAV File When <Ctrl F7> is Pressed
** Ship:       Sea-Bird
** Cruise:     Sea-Bird Header Test
** Station:   
** Latitude:  
** Longitude: 
*END*

5. In the File menu, select Save (not Save As). If you are running Windows 2000, the following message displays:
You are about to save the document in a Text-Only format, which will remove all formatting. Are you sure you
want to do this?

Ignore the message and click Yes.

6. In the File menu, select Exit.

NOTE: This Application Note does not apply to .dat data files. Sea-Bird is not aware of a technique for editing a .dat
file that will not corrupt the file.

Sea-Bird Electronics, Inc.
1808 136th Place NE
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USA
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APPLICATION NOTE NO. 68 Revised March 2004 
 
 

Using USB Ports to Communicate with Sea-Bird Instruments 
 
 
Most Sea-Bird instruments use the RS-232 protocol for transmitting setup commands to the 
instrument and receiving data from the instrument. However, many newer PCs and laptop 
computers have USB port(s) instead of RS-232 serial port(s). 
 
USB serial adapters are available commercially. These adapters plug into the USB port, and allow 
one or more serial devices to be connected through the adapter. Sea-Bird tested USB serial adapters 
from three manufacturers with our instruments, and verified compatibility. These manufacturers and 
the tested adapters are: 
 
• Keyspan (www.keyspan.com) - High Speed USB Serial Adapter (part # USA-19QW) and  

USB 4-Port Serial Adapter (part # USA-49W) 
 
• Edgeport (www.ionetworks.com) - Standard Serial Converter Edgeport/2 (part # 301-1000-02) 
 
• IOGEAR (www.iogear.com) – USB 1.1 to Serial Converter Cable (model # GUC232A) 
 
Other USB adapters from these manufacturers, and adapters from other manufacturers, may also be 
compatible with Sea-Bird instruments. We recommend testing of any other adapters with the 
instrument before deployment, to verify that there is no problem. 
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APPLICATION NOTE NO. 69 July 2002 
 
 

Conversion of Pressure to Depth 
 
 
Sea-Bird’s SEASOFT software can calculate and output depth, if the instrument data includes 
pressure. Additionally, some Sea-Bird instruments (such as the SBE 37-SI or SBE 50) can be set up 
by the user to internally calculate depth, and to output depth along with the measured parameters. 
 
Sea-Bird uses the following algorithms for calculating depth: 
 
Fresh Water Applications 
 
Because most fresh water applications are shallow, and high precision in depth not too critical,  
Sea-Bird software uses a very simple approximation to calculate depth: 
 

depth (meters) = pressure (decibars) * 1.019716 
 
 
Seawater Applications 
 
Sea-Bird uses the formula in UNESCO Technical Papers in Marine Science No. 44. This is an 
empirical formula that takes compressibility (that is, density) into account. An ocean water column 
at 0 °C (t = 0) and 35 PSU (s = 35) is assumed. 
 
The gravity variation with latitude and pressure is computed as: 
 

g (m/sec2) = 9.780318 * [ 1.0 + ( 5.2788x10 -3  + 2.36x10 -5  * x) * x ] + 1.092x10 -6  * p 
 
where 
x = [sin (latitude / 57.29578) ] 2 

p = pressure (decibars) 
 
Then, depth is calculated from pressure: 
 

depth (meters) = [(((-1.82x10 -15  * p + 2.279x10 -10 ) * p - 2.2512x10 -5  ) * p + 9.72659) * p] / g 
 
where 
p = pressure (decibars) 
g = gravity (m/sec2) 
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APPLICATION NOTE NO. 71 September 2003 
 

Desiccant Use and Regeneration (drying) 
 
 
This application note applies to all Sea-Bird instruments intended for underwater use. The application note covers: 
• When to replace desiccant 
• Storage and handling of desiccant 
• Regeneration (drying) of desiccant 
• Material Safety Data Sheet (MSDS) for desiccant 
 
 
When to Replace Desiccant Bags 
 
Before delivery of the instrument, a desiccant package is placed in the housing, and the electronics chamber is filled with dry 
Argon. These measures help prevent condensation. To ensure proper functioning: 
1. Install a new desiccant bag each time you open the housing and expose the electronics. 
2. If possible, dry gas backfill each time you open the housing and expose the electronics. If you cannot, wait at least  

24 hours before redeploying, to allow the desiccant to remove any moisture from the chamber. 
 
What do we mean by expose the electronics? 
• For most battery-powered Sea-Bird instruments (such as SBE 16, 16plus, 16plus-IM, 17plus, 19, 19plus, 25, 37-SM, 

37-SMP, 37-IM, 37-IMP, 44; PN 90208 Auto Fire Module [AFM]), there is a bulkhead between the battery and 
electronics compartments. Battery replacement does not affect desiccation of the electronics, as the batteries are 
removed without removing the electronics and no significant gas exchange is possible through the bulkhead. Therefore, 
opening the battery compartment to replace the batteries does not expose the electronics; you do not need to install a 
new desiccant bag in the electronics compartment each time you open the battery compartment. For these instruments, 
install a new desiccant bag if you open the electronics compartment to access the printed circuit boards. 

• For the SBE 39 and 48, the electronics must be removed or exposed to access the battery. Therefore, install a new 
desiccant bag each time you open the housing to replace a battery. 

 
 
Storage and Handling 
 
Testing by Süd-Chemie (desiccant’s manufacturer) 
at 60% relative humidity and 30 °C shows that 
approximately 25% of the desiccant’s adsorbing 
capacity is used up after only 1 hour of exposure to 
a constantly replenished supply of moisture in the 
air. In other words, if you take a bag out of a 
container and leave it out on a workbench for  
1 hour, one-fourth of its capacity is gone before 
you ever install it in the instrument. Therefore: 
• Keep desiccant bags in a tightly sealed, 

impermeable container until you are ready to 
use them. Open the container, remove a bag, 
and quickly close the container again. 

• Once you remove the bag(s) from the sealed 
container, rapidly install the bag(s) in the 
instrument housing and close the housing.  
Do not use the desiccant bag(s) if exposed to 
air for more than a total of 30 minutes. 
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Regeneration (drying) of Desiccant 
 
Replacement desiccant bags are available from Sea-Bird: 

• PN 60039 is a metal can containing 25 1-gram desiccant bags and 1 humidity indicator card. The 1-gram bags are 
used in our smaller diameter housings, such as the SBE 3 (plus, F, and S), 4 (M and C), 5T, 37 (-SI, -SM, -SMP,  
-IM, and –IMP), 38, 39, 43, 44, 45, 48, 49, and 50. 

• PN 31180 is a 1/3-ounce desiccant bag, used in our SBE 16plus, 16plus-IM, 19plus, and 21. 
• PN 30051 is a 1-ounce desiccant bag. The 1-ounce bags are used in our larger diameter housings, such as the  

SBE 9plus, 16, 17plus, 19, 25, 26, 32, AFM, and PDIM. 
However, if you run out of bags, you can regenerate your existing bags using the following procedure provided by the 
manufacturer (Süd-Chemie Performance Packaging, a Division of United Catalysts, Inc.): 
 
 

MIL-D-3464 Desiccant Regeneration Procedure 
 

Regeneration of the United Desiccants’ Tyvek Desi Pak® or Sorb-It® bags or United Desiccants’  
X-Crepe Desi Pak® or Sorb-It® bags can be accomplished by the following method: 
 
1. Arrange the bags on a wire tray in a single layer to allow for adequate air flow around the bags during 

the drying process. The oven’s inside temperature should be room or ambient temperature (25 – 29.4 
°C [77 – 85 °F] ). A convection, circulating, forced-air type oven is recommended for this 
regeneration process. Seal failures may occur if any other type of heating unit or appliance is 
used. 

 
2. When placed in forced air, circulating air, or convection oven, allow a minimum of 3.8 to 5.1 cm (1.5 

to 2.0 inches) of air space between the top of the bags and the next metal tray above the bags.  
If placed in a radiating exposed infrared-element type oven, shield the bags from direct exposure to the 
heating element, giving the closest bags a minimum of 40.6 cm (16 inches) clearance from the heat 
shield. Excessive surface film temperature due to infrared radiation will cause the Tyvek material to 
melt and/or the seals to fail. Seal failure may also occur if the temperature is allowed to increase 
rapidly. This is due to the fact that the water vapor is not given sufficient time to diffuse through the 
Tyvek material, thus creating internal pressure within the bag, resulting in a seal rupture. Temperature 
should not increase faster than 0.14 to 0.28 °C (0.25 to 0.50 °F) per minute. 

 
3. Set the temperature of the oven to 118.3 °C (245 °F), and allow the bags of desiccant to reach 

equilibrium temperature. WARNING: Tyvek has a melt temperature of 121.1 – 126.7 °C  
(250 – 260 °F) (Non MIL-D-3464E activation or reactivation of both silica gel and Bentonite clay can 
be achieved at temperatures of 104.4 °C [220 °F]). 

 
4. Desiccant bags should be allowed to remain in the oven at the assigned temperature for 24 hours.  

At the end of the time period, the bags should be immediately removed and placed in a desiccator jar or 
dry (0% relative humidity) airtight container for cooling. If this procedure is not followed precisely, 
any water vapor driven off during reactivation may be re-adsorbed during cooling  
and/or handling. 

 
5. After the bags of desiccant have been allowed to cool in an airtight desiccator, they may be removed 

and placed in either an appropriate type polyliner tightly sealed to prevent moisture adsorption, or a 
container that prevents moisture from coming into contact with the regenerated desiccant. 

 
 
NOTE: Use only a metal or glass container with a tight fitting metal or glass lid to store the regenerated desiccant. Keep 
the container lid closed tightly to preserve adsorption properties of the desiccant. 
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SECTION I -- PRODUCT IDENTIFICATION 

 
Trade Name and Synonyms: Silica Gel, Synthetic Amorphous Silica, 

Silicon, Dioxide 
Chemical Family: Synthetic Amorphous Silica 
Formula: SiO2.x H2O 
 
 

SECTION II -- HAZARDOUS INGREDIENTS 
 

Components in the Solid Mixture 
COMPONENT CAS No % ACGIH/TLV  (PPM) OSHA-(PEL) 

Amorphous 
Silica 

63231-67-4 >99 PEL - 20 (RESPIRABLE), 
TLV – 5 

LIMIT – NONE, 
HAZARD - 
IRRITANT 
 

 
Synthetic amorphous silica is not to be confused with crystalline silica such as quartz, 
cristobalite or tridymite or with diatomaceous earth or other naturally occurring forms of 
amorphous silica that frequently contain crystalline forms. 
 
This product is in granular form and packed in bags for use as a desiccant.  Therefore, no 
exposure to the product is anticipated under normal use of this product.  Avoid inhaling 
desiccant dust. 
 
 

SECTION III -- PHYSICAL DATA 
 
Appearance and Odor:  White granules; odorless. 
Melting Point: >1600 Deg C; >2900 Deg F 
Solubility in Water: Insoluble. 
Bulk Density: >40 lbs./cu. ft. 
Percent Volatile by Weight @ 1750 Deg F: <10%. 
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SECTION IV -- FIRE EXPLOSION DATA 
 
Fire and Explosion Hazard - Negligible fire and explosion hazard when exposed to heat 
or flame by reaction with incompatible substances. 
 
Flash Point - Nonflammable. 
 
Firefighting Media - Dry chemical, water spray, or foam.  For larger fires, use water spray 
fog or foam. 
 
Firefighting - Nonflammable solids, liquids, or gases:  Cool containers that are exposed 
to flames with water from the side until well after fire is out.  For massive fire in enclosed 
area, use unmanned hose holder or monitor nozzles; if this is impossible, withdraw from 
area and let fire burn.  Withdraw immediately in case of rising sound from venting safety 
device or any discoloration of the tank due to fire. 
 
 

SECTION V -- HEALTH HAZARD DATA 
 

Health hazards may arise from inhalation, ingestion, and/or contact with the skin and/or 
eyes.  Ingestion may result in damage to throat and esophagus and/or gastrointestinal 
disorders.  Inhalation may cause burning to the upper respiratory tract and/or temporary or 
permanent lung damage.  Prolonged or repeated contact with the skin, in absence of 
proper hygiene, may cause dryness, irritation, and/or dermatitis.  Contact with eye tissue 
may result in irritation, burns, or conjunctivitis. 
 
First Aid (Inhalation) - Remove to fresh air immediately.  If breathing has stopped, give 
artificial respiration.  Keep affected person warm and at rest.  Get medical attention 
immediately.   
 
First Aid (Ingestion) - If large amounts have been ingested, give emetics to cause 
vomiting.  Stomach siphon may be applied as well.  Milk and fatty acids should be 
avoided.  Get medical attention immediately. 
 
First Aid (Eyes) - Wash eyes immediately and carefully for 30 minutes with running 
water, lifting upper and lower eyelids occasionally.  Get prompt medical attention. 
 
First Aid (Skin) - Wash with soap and water. 
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NOTE TO PHYSICIAN: This product is a desiccant and generates heat as it adsorbs 
water.  The used product can contain material of hazardous nature.  Identify that material 
and treat accordingly. 
 
 

SECTION VI -- REACTIVITY DATA 
 
Reactivity - Silica gel is stable under normal temperatures and pressures in sealed 
containers.  Moisture can cause a rise in temperature which may result in a burn. 
 
 

SECTION VII  --SPILL OR LEAK PROCEDURES 
 
Notify safety personnel of spills or leaks.  Clean-up personnel need protection against 
inhalation of dusts or fumes.  Eye protection is required.  Vacuuming and/or wet methods 
of cleanup are preferred.  Place in appropriate containers for disposal, keeping airborne 
particulates at a minimum. 
 
 

SECTION VIII -- SPECIAL PROTECTION INFORMATION 
 
Respiratory Protection - Provide a NIOSH/MSHA jointly approved respirator in the 
absence of proper environmental control.  Contact your safety equipment supplier for 
proper mask type. 
 
Ventilation - Provide general and/or local exhaust ventilation to keep exposures below 
the TLV.  Ventilation used must be designed to prevent spots of dust accumulation or 
recycling of dusts. 
 
Protective Clothing - Wear protective clothing, including long sleeves and gloves, to 
prevent repeated or prolonged skin contact. 
 
Eye Protection - Chemical splash goggles designed in compliance with OSHA 
regulations are recommended.  Consult your safety equipment supplier. 
 
 

SECTION IX -- SPECIAL PRECAUTIONS 
 
Avoid breathing dust and prolonged contact with skin.  Silica gel dust causes eye irritation 
and breathing dust may be harmful. 
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* No Information Available 
 
HMIS (Hazardous Materials Identification System) for this product is as 
follows: 
 
Health Hazard 0 
Flammability 0 
Reactivity 0 
Personal Protection HMIS assigns choice of personal protective equipment to the 

customer, as the raw material supplier is unfamiliar with the 
condition of use. 

 
The information contained herein is based upon data considered true and accurate.  However, United Desiccants makes no warranties 
expressed or implied, as to the accuracy or adequacy of the information contained herein or the results to be obtained from the use 
thereof.  This information is offered solely for the user's consideration, investigation and verification.  Since the use and conditions of 
use of this information and the material described herein are not within the control of United Desiccants, United Desiccants assumes no 
responsibility for injury to the user or third persons.  The material described herein is sold only pursuant to United Desiccants' Terms 
and Conditions of Sale, including those limiting warranties and remedies contained therein.  It is the responsibility of the user to 
determine whether any use of the data and information is in accordance with applicable federal, state or local laws and regulations. 
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Application Note 56 Revised September 2003 
 
 Interfacing to RS-485 Sensors 
 
A few Sea-Bird instruments use the RS-485 protocol for transmitting setup commands to the instrument and  
receiving data from the instrument. However, most personal computers (PCs) do not come with an RS-485 port.  
This Application Note covers interfacing our RS-485 instruments with a PC by the following methods: 
 

• Connecting the instrument to an external RS-485/RS-232 Interface Converter that plugs into an existing  
RS-232 port on the PC. 

OR 
• Installing an RS-485 interface card (and associated software) in the PC, and then connecting the instrument 

directly to the new RS-485 port in the PC. 
 
 
External RS-485/RS-232 Interface Converter 
 
RS-485/RS-232 Interface Converters are available commercially. These converters plug into the RS-232 port on the PC, 
and allow an RS-485 device to be connected through the converter. Sea-Bird tested a converter from one manufacturer 
with our instruments, and verified compatibility. The manufacturer and tested converter is: 
 

Black Box (www.blackbox.com) –  
IC520A-F with RS-232 DB-25 female connector and RS-485 terminal block connector 

 
Other converters from this manufacturer, and converters from other manufacturers, may also be compatible with  
Sea-Bird instruments. We recommend testing other converters with the instrument before deployment, to verify that there 
is no problem. 
 
Follow this procedure to use the IC520A-F Converter: 
 

1. Connect the Converter to the PC: 
• If the PC has a 25-pin male RS-232 connector, plug the Converter directly into the PC connector. 
• If the PC has a 9-pin male RS-232 connector, plug the Converter into a 25-pin to 9-pin adapter  

(such as Black Box FA520A-R2 Adapter). Plug the 25-pin to 9-pin adapter into the PC. 
 

2. On the Converter, measure the voltage between XMT+ and ground and between XMT- and ground.  
Connect whichever has the highest voltage to RS-485 ‘A’ and the other to RS-485 ‘B’. The ground terminal can 
be left unconnected. 

 
 
RS-485 Interface Card and Port in the PC 
 
An RS-485 Interface Card installs in the PC, and allow an RS-485 device to be connected to the RS-485 port.  
These Interface Cards are available commercially. When using with a Sea-Bird instrument: 
 

• RS-485 Transmitter - 
The Interface Card must be configured to automatically handle the RS-485 driver enable. 

 
• Two-Wire Interface - 

TX+ and RX+ on the Interface Card must be connector together and to ‘A’ on the instrument.  
TX- and RX- on the Interface Card must be connected together and to ‘B’ on the instrument. 
Note: Some Interface Cards have a jumper to make the connections internally, while for other Cards the 
connections must be made in a jumper cable. 
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• Terminal Program Compatibility - 
If the Interface Card uses shared interrupts, SEATERM (our Windows terminal program) must be used to 
communicate with the instrument. 
If the Interface Card is configured as a standard COM port, either SEATERM or our DOS-based terminal 
programs may be used to communicate with the instrument. 

 
 
Sea-Bird tested two Interface Cards from one manufacturer with our instruments, and verified compatibility.  
The manufacturer and tested cards are: 
 

National Instruments (www.ni.com) -  
AT-485/2 
PCI-485/2 

 
Other Cards from this manufacturer, and Cards from other manufacturers, may also be compatible with Sea-Bird 
instruments. We recommend testing other Cards with the instrument before deployment, to verify that there is  
no problem. 
 
Follow this procedure to use the AT-485/2 or PCI-485/2 Interface Card: 
 

1. Install the RS-485 driver software (provided with Interface Card) on your PC before installing the  
Interface Card. 

 
2. Install the RS-485 Interface Card. 

 
3. Configure the RS-485 Interface Card in your PC (directions are for a PC running Windows XP): 

A. Right click on My Computer and select Properties. 
B. In the System Properties dialog box, click on the Hardware tab. Click the Device Manager button. 
C. In the Device Manager window, double click on Ports. Double click on the desired RS-485 port. 
D. In the Communications Port Properties dialog box, click the Port Settings tab.  

Click the Advanced button. 
E. In the Advanced Settings dialog box, set Transceiver Mode to 2 wire TxRdy Auto. 

 
4. Make a jumper cable (do not use a standard adapter cable) to connect the Interface Card to the instrument’s 

I/O cable. Pin outs are shown for a Sea-Bird 9-pin (current production) or 25-pin (older production) I/O cable: 
 

DB-9S  
(connect to PC) 

DB-9P  
(connect to Sea-Bird I/O cable PN 801385) 

DB-25P  
(connect to Sea-Bird I/O cable PN 801046) 

pin 1  common pin 5  common pin 7  common 
pin 4  TX+ pin 3  'A' pin 2  'A' 
pin 8  RX+ pin 3  'A' pin 2  'A' 
pin 5  TX- pin 2  'B' pin 3  'B' 
pin 9  RX- pin 2  'B' pin 3  'B' 

 
5. Run SEATERM (these Cards use shared interrupts, so the DOS terminal programs cannot be used): 

A. In SEATERM’s Configure menu, select the desired instrument. 
B. In the Configuration Options dialog box, set Mode to RS-485 and set COMM Port to the appropriate 

RS-485 port. 
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WARRANTY POLICY                           2003 

 
5-YEAR LIMITED WARRANTY (NEW PRODUCTS) 
 
For a period of five years after the date of original shipment from our factory, products manufactured by  
Sea-Bird are warranted to function properly and be free of defects in materials and workmanship. Should a 
Sea-Bird instrument fail during the warranty period, return it freight pre-paid to our factory. We will repair it 
(or at our option, replace it) at no charge, and pay the cost of shipping it back to you. Certain products and 
components have modified coverage under this warranty as described below. 
 
LIMITED WARRANTY ON  SERVICE & REPAIRS  
 
Service work, repairs, replacement parts and modifications are warranted to be free of defects in materials or 
workmanship for the remainder of the original 5-year warranty or one year from the date of shipment from our 
factory after repair or service, which ever is longer. Certain products and components have modified coverage 
under this warranty as described below. 
 
MODIFICATIONS / EXCEPTIONS / EXCLUSIONS  
 

1. The SBE 43 DO sensor is warranted to function properly for 5 years. Under normal use however, the 
electrolyte in an SBE 43 DO sensor will require replenishment after about 3 years. Purchase of an  
SBE 43 includes one free electrolyte replenishment (as necessitated by chemical depletion of 
electrolyte) anytime during the warranty period. To obtain the replenishment, return the sensor 
freight pre-paid to our factory. We will refurbish it for free (electrolyte refill, membrane 
replacement, and recalibration) and pay the cost of shipping it back to you. Membrane damage or 
depletion of electrolyte caused by membrane damage is not covered by this warranty. 

 
2. Because pH and other dissolved oxygen (DO) electrodes have a limited life caused by the depletion 

of their chemical constituents during normal storage and use, our warranty applies differently to such 
electrodes. Electrodes in SBE 13 and 23 DO sensors, SBE 18 pH sensors, and SBE 27 pH/ORP 
sensors are covered under warranty for the first 90 days only. Other components of the sensor are 
covered for 5 years. 

 
3. Equipment manufactured by other companies (e.g., fluorometers, transmissometers, PAR, optical  

backscatter sensors, altimeters, etc.) are warranted only to the limit of the warranties provided by 
their original manufacturers. 

 
4. Batteries, zinc anodes, or other consumable/expendable items are not covered under this warranty. 

 
5. This warranty is void if in our opinion the instrument has been damaged by accident, mishandled, 

altered, or repaired by the customer where such treatment has affected its performance or reliability. 
In the event of such abuse by the customer, costs for repairs plus two-way freight costs will be borne 
by the customer. Instruments found defective should be returned to the factory carefully packed, as 
the customer will be responsible for freight damage. 

 
6. Incidental or consequential damages or costs incurred as a result of product malfunction are not the 

responsibility of SEA-BIRD ELECTRONICS, INC 
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Warranty Administration Policy  
 
Sea-Bird Electronics, Inc. and its authorized representatives or resellers provide warranty support only to 
the original purchaser. Warranty claims, requests for information or other support, and orders for post-
warranty repair and service, by end-users that did not purchase directly from Sea-Bird or an authorized 
representative or reseller, must be made through the original purchaser. The intent and explanation of our 
warranty policy follows: 
 
1. Warranty repairs are only performed by Sea-Bird. 
 
2. Repairs or attempts to repair Sea-Bird products performed by customers (owners) shall be called  

owner repairs. 
 
3. Our products are designed to be maintained by competent owners. Owner repairs of Sea-Bird  

products will NOT void the warranty coverage (as stated above) simply as a consequence of their 
being performed. 

 
4. Owners may make repairs of any part or assembly, or replace defective parts or assemblies with  

Sea-Bird manufactured spares or authorized substitutes without voiding warranty coverage of the 
entire product, or parts thereof. Defective parts or assemblies removed by the owner may be returned 
to Sea-Bird for repair or replacement within the terms of the warranty, without the necessity to return 
the entire instrument. If the owner makes a successful repair, the repaired part will continue to be 
covered under the original warranty, as if it had never failed. Sea-Bird is not responsible for any costs 
incurred as a result of owner repairs or equipment downtime. 

 
5. We reserve the right to refuse warranty coverage on a claim by claim basis based on our judgment and 

discretion. We will not honor a warranty claim if in our opinion the instrument, assembly, or part has 
been damaged by accident, mishandled, altered, or repaired by the customer where such treatment has 
affected its performance or reliability. 

 
6. For example, if the CTD pressure housing is opened, a PC board is replaced, the housing is resealed, 

and then it floods on deployment, we do not automatically assume that the owner is to blame. We will 
consider a claim for warranty repair of a flooded unit, subject to our inspection and analysis. If there  
is no evidence of a fault in materials (e.g., improper or damaged o-ring, or seal surfaces) or 
workmanship (e.g., pinched o-ring due to improper seating of end cap), we would cover the flood 
damage under warranty. 

 
7. In a different example, a defective PC board is replaced with a spare and the defective PC board is sent 

to Sea-Bird. We will repair or replace the defective PC board under warranty. The repaired part as well 
as the instrument it came from will continue to be covered under the original warranty. 

 
8. As another example, suppose an owner attempts a repair of a PC board, but solders a component in 

backwards, causing the board to fail and damage other PC boards in the system. In this case, the 
evidence of the backwards component will be cause for our refusal to repair the damage under 
warranty. However, this incident will NOT void future coverage under warranty. 

 
9. If an owner's technician attempts a repair, we assume his/her qualifications have been deemed 

acceptable to the owner. The equipment owner is free to use his/her judgment about who is assigned to 
repair equipment, and is also responsible for the outcome. The decision about what repairs are 
attempted and by whom is entirely up to the owner. 
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Service Request Form

To return your instrument for calibration or other service, please take a few moments to provide us with
the information we need, so we can serve you better.

PLEASE:
1. Get a Returned Material Authorization (RMA) number from Sea-Bird (phone 425-643-9866,

fax 425-643-9954, or email seabird@seabird.com). Reference the RMA number on this form, on the
outside shipping label for the equipment, and in all correspondence related to this service request.

2. Fill out 1 form for each type (model) of instrument.
3. Include this form when shipping the instrument to Sea-Bird for servicing.
4. Fax us a copy of this form on the day you ship.     FAX: (425) 643-9954

RETURNED MATERIAL AUTHORIZATION (RMA) NUMBER
RMA Number:                                                                                                                                                   

CONTACT INFORMATION
Your name:                                                                                                                                                       
Institution/Organization/Company:                                                                                                                    
Shipping/Delivery address for packages:                                                                                                         
                                                                                                                                                      
                                                                                                                                                      
Telephone:                                                         Fax:                                                                         
e-mail:                                                                     

SERVICE INFORMATION
Date Shipped:                                                                                                                                                   
Sea-Bird Model Number (for example, SBE 37-SM):                                                                                       
Quantity:                                                                                                                                                            
Serial Numbers: _______________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
(Note: Specify instrument serial numbers below if specific services are required for some instruments.
For example, if 10 instruments are being returned for calibration, and 1 of the 10 also requires repairs,
specify the serial number for the instrument requiring the repairs in the appropriate section of the form.)
SEASOFT Version you have been using with this instrument(s):                                                                    

[   ] Perform Routine Services:
       Calibration (includes basic diagnostic):

      Temperature         Conductivity          Pressure         DO           pH
(Please allow a minimum of 3 weeks after we receive the instrument(s) to complete calibration.)

       Full System Diagnostic and Check Out
       Other (specify):                                                                                                                   

                                                                                                                                           

[   ] System Upgrade or Conversion:
Specify (include instrument serial number if multiple instruments are part of shipment):                     
                                                                                                                                                 
                                                                                                                                                 

[   ] Diagnose and Repair Operational Faults:
Please send a disk containing the raw data (.hex or .dat files) which shows the problems you
describe. Also send the .con files you used to acquire or display the data.
Problem Description (continue on additional pages if needed; include instrument serial number if
multiple instruments are part of shipment):                                                                                     
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PAYMENT/BILLING INFORMATION
Credit Card: Sea-Bird accepts payment by MasterCard, VISA, or American Express.
[    ]  MasterCard                         [    ] Visa                     [    ] American Express
Account Number:                                                                                Expiration Date:                        
Credit Card Holder Name (printed or typed):                                                                                                    
Credit Card Holder Signature:                                                                                                                          
Credit Card Billing Address (if different than shipping address):
                                                                                                                                                      
                                                                                                                                                      
                                                                                                                                                      

Invoice/Purchase Order: If you prefer us to invoice you, please complete the following or enclose a copy
of your Purchase Order:
Purchase Order Number:                                                                                                                                  
Billing Address (if different than shipping address):
                                                                                                                                                      
                                                                                                                                                      
                                                                                                                                                      

Instructions for Returning Goods to Sea-Bird

You can ship any of the following ways:
1. Domestic Shipments (USA) - Ship prepaid (via UPS, FedEx, DHL, etc.) directly to:

Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, WA  98005, USA
Telephone: (425) 643-9866 Fax: (425) 643-9954

2. Foreign Shipments - Ship via prepaid airfreight to:
Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, WA  98005, USA
Telephone: (425) 643-9866 Fax: (425) 643-9954
Notify: MTI Worldwide Logistics for Customs Clearance
Seattle, WA, USA
Telephone: (206) 431-4366 Fax: (206) 431-4374
(Please note Airport of Destination: SEA for Seattle, WA)

3. Ship via EXPRESS COURIER directly to Sea-Bird Electronics (UPS, FedEx, or DHL;
do not ship via TNT SKYPACK). Courier services will clear Customs and deliver the package to
Sea-Bird. It is not necessary to notify our customs broker.
Include a commercial invoice showing the description of the instruments, and value for Customs
purposes only. On the invoice, include the statement that “Goods are of USA Origin”.
Failure to include this statement in your invoice will result in US Customs assessing duties on
the shipment, which we will in turn pass on to the customer/shipper.

Note:
Due to changes in EU and Chinese regulations, if Sea-Bird receives an instrument from the EU or China
in a crate containing coniferous solid wood, we will return the instrument in a new crate made with
mahogany and plywood. We will charge for the replacement crates based on the dimensions of the crate
we receive. The charge will be determined as follows:
1. Multiply the crate length x width x height in centimeters (overall volume in cm3, not internal volume).
2. Determine the price based on your calculated overall volume and the following chart:

Overall Volume (cm3) Example Instrument Price (USD)
less than 52,000 37-SM MicroCAT $45

52,000 to less than 65,000 SEACAT, no cage $70
65,000 to 240,000 CTD in cage $125
more than 240,000 -- consult factory

These prices are valid only for crate replacement required in conjunction with the return of a customer's
instrument after servicing, and only when the instrument was shipped to Sea-Bird in a crate originally
supplied by Sea-Bird.
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Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4616 and -4617
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4616)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4617)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters

3
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4616 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2686.52 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5512 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050651 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4617 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2801.47 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5513 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050649 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 

4
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET for 4616

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0651

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.947 11.8

Vin 9V voltage across C2: VDC      Current mA7.948 11.0

Vin 6V voltage across C2: VDC      Current mA5.868 10.2

Pump submerged test, no load, Vin 12VDC Average current draw in water: 124 mA

105

verena.kellner
Highlight



1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET for 4617
Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0649

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.947 11.8

Vin 9V voltage across C2: VDC      Current mA7.948 11.0

Vin 6V voltage across C2: VDC      Current mA5.868 10.2

Pump submerged test, no load, Vin 12VDC Average current draw in water: 124 mA
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 

5



 
The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com 
1808 136th Place NE, Bellevue, Washington  98005  USA Telephone: (425) 643-9866 
Website: http://www.seabird.com Fax: (425) 643-9954 

Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0651

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.929 9.29

Vin 9V voltage across C2: VDC      Current mA7.928 8.8

Vin 6V voltage across C2: VDC      Current mA5.885 7.99

Pump submerged test, no load, Vin 12VDC Average current draw in water: 120 mA
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APPLICATION NOTE NO. 2D Revised December 2002 
 
 

INSTRUCTIONS FOR CARE AND CLEANING OF CONDUCTIVITY CELLS 
 
Since any conductivity sensor’s output reading is proportional to its dimensions, it is important to keep the cell 
clean of internal coatings. Also, cell electrodes contaminated with oil, biological growths, or other foreign material 
will cause low conductivity readings. 
 
If the cell is allowed to dry out between usage, salt crystals may form on (and in) the platinized electrode surfaces. 
When the instrument is next used, there will be a delay before these crystals are dissolved - in the meantime, sensor 
accuracy may be affected. Therefore, we recommend that the cell be kept filled with distilled or de-ionized water 
between uses. A length of 7/16" ID Tygon tubing is provided for this purpose, to be connected in such a way that 
any air entrapped will be in the Tygon tube rather than in the cell. 
 
An additional important benefit of keeping the cell ends closed with Tygon is to keep air-borne contaminants 
(which are abundant on most research vessels) from entering the cell. 
 
If it is not practical to keep the cell filled with distilled (or de-ionized) water between use (for example, in Arctic 
environments where freezing is a hazard), flush the cell with clean fresh water (preferably distilled or de-ionized) 
and close the cell with Tygon. Also, remember to keep the Tygon in a clean place (so that it does not pick up 
contaminants) while the instrument is in use. 
 
Experience indicates that in normal intermittent use (such as in CTD profiling operations), drift rates of  
0.0003 S/m (0.003 mmho/cm) or less per month can be expected without any cleaning if the procedures described 
above are followed. 
 
PRECAUTIONS!!!!!! 
 
The conductivity cell is primarily made of glass, and therefore is subject to breakage if mishandled. It is especially 
important to use the right size Tygon tubing, since if you use tubing with a too small ID, it will be difficult to 
remove the tubing, and the cell end may break if excessive force is used. The correct size tubing for all 
instruments produced since 1980 is 7/16" ID, 9/16" OD, 1/16" wall. Instruments shipped prior to 1980 had 
smaller retaining ridges at the ends of the cell, and 3/8" ID Tygon is required for these older instruments. It is better 
to use Tygon (brand) than other plastic tubing, since it tends to remain flexible over a wide temperature range and 
with age. 
 
Do not insert any sort of cleaning probe (e.g., Q-tip) into the interior of the cell. If the platinized (black) 
electrode surface is touched, it may be damaged and require the electrodes to be replatinized. 
 
If a cell is filled with water, do not subject it to low temperatures that will freeze the water and break the cell. 
Remove the water before shipment during the winter, or to polar regions at any season. No adverse affects 
have been observed as a result of temporary dry storage, particularly if the cell is rinsed with fresh water  
before storage. 
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CELL CLEANING 
 
Routine Cleaning (inside of cell not visibly dirty) 
 
Fill the cell with a 1% solution of Triton X-100* and let soak for 30 minutes. This is most easily done by using a 
length of 7/16" ID Tygon tubing to form a closed loop including the cell. After the soak, drain and flush with warm 
(not hot) fresh water for 1 minute. Refill the cell with distilled (or de-ionized) water until the next usage. 
 
 
Cleaning Severely Fouled Cells (visible deposits or marine growths on the inside of the cell) 
 
Clamp the instrument so that the cell is vertical, and attach a length of 7/16" Tygon tubing to the lower end of the 
cell. Use masking or other tape to secure the open end of the Tygon about even with the top end of the cell. Pour 
Muriatic Acid (37% HCl) into the open end of the Tygon until the cell is filled to near the top and let soak for 1 to 2 
minutes only. Avoid breathing the acid fumes!! Drain the acid from the cell and flush for 5 minutes with warm 
(not hot) fresh water. Also rinse the exterior of the instrument to remove any spilled acid from the surface. Then fill 
the cell with 1% Triton* solution, let stand for 5 minutes, and flush with warm fresh water for 1 minute. Refill with 
distilled or de-ionized water until the next usage. 
 
If this process does not remove the visible deposits, mechanically clean the cell with a small (0.275" diameter). soft-
bristled nylon bottle brush and 1% Triton solution. NOTE: Be extremely careful when cleaning, because the 
platinum electrodes are thin and could be damaged if you use a brush that is too large or too stiff. The 
electrodes must be replatinized after brush cleaning. Our service department will clean and replatinize your 
cell for a nominal fee. 
 
 
 
*Triton X-100 (a trade name of J. T. Baker, Inc) is a concentrated liquid non-ionic detergent available at most 
chemical or scientific supply stores. Other liquid detergents can probably also be used, but scientific grades are 
preferable because of their known composition. It is better to use a non-ionic detergent since conductivity readings 
taken immediately after use are less likely to be affected by any residual detergent left in the cell. 
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APPLICATION NOTE NO. 6 July 1994

DETERMINATION OF SOUND VELOCITY FROM CTD DATA

Use of CTD measurement for determination of sound velocity is appealing because these instruments are
simpler and more rugged and because their resolution, accuracy, and stability lead to far better precision
than can be obtained with direct SV measuring devices. For example, specifications of 0.01 mS/cm
conductivity, 0.01 degrees C temperature, and 1 meter in depth are readily achieved with good quality
CTD equipment. Assuming that the relationship between C, T, and D on the one hand and SV on the other
is exactly known (see below), the resulting uncertainty in SV would be as follows:

from temperature error (0.01 deg C) 0.021 meters/second
from conductivity error (0.01 mS/cm) 0.011 meters/second
from salinity error (0.01 psu) 0.012 meters/second
from depth error (1 meter) 0.017 meters/second

The equivalent SV errors (considered at 15 degrees C, 42.9 mS/cm, 35 psu, and 0 pressure, i.e, typical
open-ocean surface conditions) are much smaller than those usually claimed for direct-
measurement instruments.

The question about the absolute accuracy of the inference of SV from CTD data is more difficult to
answer. The main reason for this is apparently the result of differences in the instrumentation used by
various researchers and is compounded by the difficulty of performing direct measurements of sound
velocity under controlled conditions of temperature, salinity, and (especially) pressure. For example,
3 widely used equations (Wilson, 1959; Del Grosso, 1972; Millero and Chen, 1977) show differences in
absolute sound speed on the order of 0.5 meter/second for various combinations of water temperature,
salinity, and pressure, despite being based on careful measurements made under laboratory conditions.

The work of Millero and Chen is, however, the most modern, and it builds upon and attempts to
incorporate the work of earlier investigators. Accordingly, the SV/CTD relationship described by these
researchers in their paper of 1977 was used as a major component in the derivation of the Equation of
State (Unesco technical papers in marine science no. 44). Millero and Chen's 1977 equation is also the one
endorsed by the Unesco/SCOR/ICES/IASPO Joint Panel on Oceanographic Tables and Standards which
comprises the internationally recognized authority for measurements of ocean parameters (in Sea-Bird's
SEASOFT software, users may select any of the 3 equations mentioned above).

We draw the following conclusions from the research papers listed above:

1) Investigators using specialized equipment under scrupulously controlled laboratory conditions
report measurements of SV vs. changes in temperature, salinity, and pressure which differ by
0.5 meters/second and more. It is unrealistic to expect that commercial direct-measurement
instruments will be more accurate under field conditions than the laboratory equipment used by
successions of careful researchers.
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2) The claimed 'accuracy' of commercial direct-measurement SV probes probably more legitimately
represents their 'precision' (compare with CTD/SV uncertainties tabulated above) than their
absolute accuracy. The relationship between what these instruments read and true sound velocity
is probably just as dependent on the same vagaries that are also the only significant sources of
error when employing the CTD approach.

3) Because of the uncertainties in the time-delays associated with the acoustic transducers and
electronics (and because of the difficulty of measuring with sufficient accuracy the length of the
acoustic path), direct-measurement probes must be calibrated in water. As suggested by the
research under controlled laboratory conditions, this is not an easy task, especially over a range of
temperature, pressure, and salinity. On the other hand, a CTD probe can easily be calibrated
using accepted methods.

4) A CTD can predict absolute SV to something better than 0.5 meter/second (a judgement seconded
by Professor Millero in a private conversation), while its relative accuracy (precision) is probably
better than 0.05 meter/s under the most demanding conditions of field use.

5) The very high precision associated with CTD measurements and the existence of an internationally
accepted relationship (even if imperfect) between CTD and SV permits very consistent
intercomparison and a high degree of uniformity among CTD-derived SV data sets, no matter
when and where taken.
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APPLICATION NOTE NO. 10 Revised May 2004 
 
 COMPRESSIBILITY COMPENSATION 
 OF SEA-BIRD CONDUCTIVITY SENSORS 
 
Sea-Bird conductivity sensors provide precise characterization of deep ocean water masses. To achieve the accuracy 
of which the sensors are capable, an accounting for the effect of hydrostatic loading (pressure) on the conductivity 
cell is necessary. Conductivity calibration certificates show an equation containing the appropriate pressure-
dependent correction term, which has been derived from mechanical principles and confirmed by field observations. 
The form of the equation varies somewhat, as shown below: 
 
 
SBE 4, 9, 9plus, 16, 19, 21, 25, and 26/26plus 
 
 

Conductivity (Siemens/meter) =   slope                                                         +  offset            (recommended) 
 
 
or 
 
Conductivity (Siemens/meter) =   slope                                                      +  offset 
 

 
 
SBE 16plus, 19plus, 37, 45, and 49 
 
 

Conductivity (Siemens/meter) =   slope                                                      +  offset 
 

 
where 
• a, b, c, d, m, and CPcor are the calibration coefficients used for older sensors (prior to January 1995);  

Sea-Bird continues to calculate and print these coefficients on the calibration sheets for use with  
old software, but recommends use of the g, h, I, j, CTcor, CPcor form of the equation for most  
accurate results 

• g, h, I, j, CTcor, and CPcor are the calibration coefficients used for newer sensors 
• CPcor is the correction term for pressure effects on conductivity 
• slope and offset are correction coefficients used to make corrections for sensor drift between calibrations; 

set to 1.0 and 0 respectively on initial calibration by Sea-Bird (see Application Note 31 for details on 
calculating slope and offset) 

• f is the instrument frequency (kHz) 
• t is the water temperature (°C) 
• p is the water pressure (decibars) 

 
Sea-Bird CTD data acquisition, display, and post-processing software SEASOFT automatically implements  
these equations. 
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g  +  h f 2  +  i f 3  +  j f 4 

1  +  [CTcor] t  +  [CPcor] p

( g  +  h f 2  +  i f 3  +  j f 4 ) / 10 

1  +  [CTcor] t  +  [CPcor] p

(a f m  +  b f 2  +  c  +  dt ) / 10 

1  + [CPcor] p
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DISCUSSION OF PRESSURE CORRECTION 
 
Conductivity cells do not measure the specific conductance (the desired property), but rather the conductance of a 
specific geometry of water. The ratio of the cell�s length to its cross-sectional area (cell constant) is used to relate the 
measured conductance to specific conductance. Under pressure, the conductivity cell�s length and diameter are 
reduced, leading to a lower indicated conductivity. The magnitude of the effect is not insignificant, reaching  
0.0028 S/m at 6800 dbars. 
 
The compressibility of the borosilicate glass used in the conductivity cell (and all other homogeneous, noncrystalline 
materials) can be characterized by E (Young�s modulus) and ν (Poisson�s ratio). For the Sea-Bird conductivity cell,  
E = 9.1 x 106 psi, ν = 0.2, and the ratio of indicated conductivity divided by true conductivity is: 
 

1 + s 
where s = (CPcor) (p)  
Typical value for CPcor is - 9.57 x 10-8 for pressure in decibars   or  - 6.60x 10-8 for pressure in psi  

 
Note: This equation, and the mathematical derivations below, deals only with the pressure correction term, and does 
not address the temperature correction term. 

 
MATHEMATICAL DERIVATION OF PRESSURE CORRECTION 
 
For a cube under hydrostatic load: 
 

∆L / L = s = -p (1 - 2 ν) / E 
where 
• p is the hydrostatic pressure 
• E is Young�s modulus 
• ν is Poisson�s ratio 
• ∆L / L and s are strain (change in length per unit length) 

 
Since this relationship is linear in the forces and displacements, the relationship for strain also applies for the length, 
radius, and wall thickness of a cylinder. 
 
To compute the effect on conductivity, note that R0 = ρL / A , where R0 is resistance of the material at 0 pressure,  
ρ is volume resistivity, L is length, and A is cross-sectional area. For the conductivity cell A = π r2 , where r is the 
cell radius. Under pressure, the new length is L (1 + s) and the new radius is r (1 + s). If Rp is the cell resistance 
under pressure: 
 

Rp = ρL (1 + s) / (π r2 [1 + s]2) = ρL / π r2 (1 + s) = R0 / (1 + s) 
 
Since conductivity is 1/R: 
 

Cp = C0 (1 + s)    and    C0 = Cp / (1 + s) = Cp / (1 +  [Cpcor] [p]) 
where 
• C0 is conductivity at 0 pressure 
• Cp is conductivity measured at pressure 

 
A less rigorous determination may be made using the material�s bulk modulus. For small displacements in a cube: 
 

∆V / V = 3∆L / L = -3p (1 - 2 ν) / E    or    ∆V/V = -p / K 
where  

• ∆V / V is the change in volume per volume or volume strain 
• K is the bulk modulus. K is related to E and ν by K = E / 3 (1 - 2 ν). 

 
In this case, ∆L / L = -p / 3K. 
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APPLICATION NOTE NO. 14 January 1989

1978 PRACTICAL SALINITY SCALE

Should you not be already familiar with it, we would like to call your attention to the January 1980 issue of the IEEE
Journal of Oceanic Engineering, which is dedicated to presenting the results of a multi-national effort to obtain a
uniform repeatable Practical Salinity Scale, based upon electrical conductivity measurements. This work has been
almost universally accepted by researchers, and all instruments delivered by Sea-Bird since February 1982 have been
supplied with calibration data based upon the new standard.

The value for conductivity at 35 ppt, 15 degrees C, and 0 pressure [C(35,15,0)] was not agreed upon in the IEEE
reports -- Culkin & Smith used 42.914 mmho/cm (p 23), while Poisson used 42.933 mmho/cm (p 47). It really does
not matter which value is used, provided that the same value is used during data reduction that was used to compute
instrument calibration coefficients. Our instrument coefficients are computed using C(35,15,0) = 42.914 mmho/cm.

The PSS 1978 equations and constants for computing salinity from in-situ measurements of conductivity,
temperature, and pressure are given in the 'Conclusions' section of the IEEE journal (p 14) and are reproduced back
of this note. In the first equation, 'R' is obtained by dividing the conductivity value measured by your instrument by
C(35,15,0), or 42.914 mmho/cm. Note that the PSS equations are based upon conductivity in units of mmho/cm,
which are equal in magnitude to units of mS/cm. If you are working in conductivity units of Siemens/meter
(S/m), multiply your conductivity values by 10 before using the PSS 1978 equations.

Also note that the equations assume pressure relative to the sea-surface. Absolute pressure gauges (as used in all
Sea-Bird CTD instruments) have a vacuum on the reference side of their sensing diaphragms and indicate
atmospheric pressure (nominally 10.1325 dBar) at the sea-surface. This reading must be subtracted to obtain
pressure as required by the PSS equations. The pressure reading displayed when using Sea-Bird's SEASOFT CTD
acquisition, display, and post-processing software is the corrected sea-surface pressure and is used by SEASOFT to
compute salinity, density, etc in accordance with the PSS equations.

Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, WA  98005
USA

Phone: (425) 643-9866
Fax: (425) 643-9954

E-mail: seabird@seabird.com
Web: www.seabird.com

116



117



1 

 
 
 
APPLICATION NOTE 27Druck NOVEMBER 2003 
 
 Minimizing Strain Gauge Pressure Sensor Errors 
 
The following Sea-Bird instruments use strain gauge pressure sensors manufactured by GE Druck: 
 
• SBE 16plus and 16plus-IM SEACAT (not 16*) with optional strain gauge pressure sensor 
• SBE 19plus SEACAT Profiler (not 19*) 
• SBE 25 SEALOGGER CTD, which uses SBE 29 Strain-Gauge Pressure Sensor (built after March 2001) 
• SBE 37 MicroCAT (37-IM, -IMP, -SM, -SMP, and -SI) with optional pressure sensor (built after September 2000) 
• SBE 39 Temperature Recorder with optional pressure sensor (built after September 2000) 
• SBE 49 FastCAT CTD Sensor 
• SBE 50 Digital Oceanographic Pressure Sensor 
 
* Note: SBE 16 and SBE 19 SEACATs were originally supplied with other types of pressure sensors. However, a few 
of these instruments have been retrofitted with Druck sensors. 
 
The Druck sensors are designed to respond to pressure in nominal ranges 0 - 20 meters, 0 - 100 meters, 0 - 350 meters, 
0 – 1000 meters, 0 – 2000 meters, 0 – 3500 meters, and 0 – 7000 meters (with pressures expressed in meters of 
deployment depth capability). The sensors offer an initial accuracy of 0.1% of full scale range. 
 
DEFINITION OF PRESSURE TERMS 
 
The term psia means pounds per square inch, absolute (absolute means that the indicated pressure is referenced to  
a vacuum). 
 
For oceanographic purposes, pressure is most often expressed in decibars (1 dbar = 1.4503774 psi). A dbar is 0.1 bar; a 
bar is approximately equal to a standard atmosphere (1 atmosphere = 1.01325 bar). For historical reasons, pressure at 
the water surface (rather than absolute or total pressure) is treated as the reference pressure (0 dbar); this is the value 
required by the UNESCO formulas for computation of salinity, density, and other derived variables. 
 
Some oceanographers express pressure in Newtons/meter2 or Pascals (the accepted SI unit). A Pascal is a very small 
unit (1 psi = 6894.757 Pascals), so the mega-Pascal (MPa = 106 Pascals) is frequently substituted (1 MPa = 100 dbar). 
 
Since the pressure sensors used in Sea-Bird instruments are absolute types, their raw data inherently indicate 
atmospheric pressure (about 14.7 psi) when in air at sea level. Sea-Bird outputs pressure in one of the following ways: 
 
• For CTDs that output raw data (SBE 16plus, 16plus-IM, 19plus, 25, and 49) and are supported by SEASOFT’s 

SEASAVE (real-time data acquisition) and SBE Data Processing (data processing) software – In SEASOFT, user 
selects pressure output in psi (not psia) or dbar. SEASOFT subtracts 14.7 psi from the raw absolute reading and 
outputs the remainder as psi or converts the remainder to dbar. 

• For the SBE 50 – User selects pressure output in psia (including atmospheric pressure) or dbar. Calculation of dbar 
is as described above. 

• For all other instruments that can output converted data in engineering units (SBE 16plus, 16plus-IM, 19plus, 
37, 39, and 49) – Instrument subtracts 14.7 psi from the raw absolute reading and converts the remainder to dbar. 

Note: SBE 16plus, 16plus-IM, 19plus, and 49 can output raw or converted data. 
 
RELATIONSHIP BETWEEN PRESSURE AND DEPTH 
 
Despite the common nomenclature (CTD = Conductivity - Temperature - Depth), all CTDs measure pressure, which is 
not quite the same thing as depth. The relationship between pressure and depth is a complex one involving water 
density and compressibility as well as the strength of the local gravity field, but it is convenient to think of a decibar as 
essentially equivalent to a meter, an approximation which is correct within 3% for almost all combinations of salinity, 
temperature, depth, and gravitational constant. 
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SEASOFT offers two methods for estimating depth from pressure. 
 
• For oceanic applications, salinity is presumed to be 35 PSU, temperature to be 0o C, and the compressibility of the 

water (with its accompanying density variation) is taken into account. This is the method recommended in 
UNESCO Technical Paper No. 44 and is a logical approach in that by far the greatest part of the deep-ocean water 
column approximates these values of salinity and temperature. Since pressure is also proportional to gravity and 
the major variability in gravity depends on latitude, the user’s latitude entry is used to estimate the magnitude of the 
local gravity field. 

 SBE 16plus, 16plus-IM, 19plus, 25, and 49 - User is prompted to enter latitude if Depth [salt water] is selected 
as a display variable in SEASAVE or as an output variable in the Data Conversion or Derive module of  
SBE Data Processing. 

 SBE 37-SI and 50 - Latitude is entered in the instrument’s EEPROM using the LATITUDE= command in 
SEASOFT’s SEATERM (terminal program) software. 

 SBE 39 – User is prompted to enter latitude if conversion of pressure to depth is requested when converting an 
uploaded .asc file to a .cnv file in SEATERM. 

• For fresh water applications, compressibility is not significant in the shallow depths encountered and is ignored, as 
is the latitude-dependent gravity variation. Fresh water density is presumed to be 1 gm/cm, and depth (in meters) is 
calculated as 1.019716 * pressure (in dbars). 

 
CHOOSING THE RIGHT SENSOR 
 
Initial accuracy and resolution are expressed as a percentage of the full scale range for the pressure sensor. The  
initial accuracy is 0.1% of the full scale range. Resolution is 0.002% of full scale range, except for the SBE 25  
(0.015% resolution). For best accuracy and resolution, select a pressure sensor full scale range to correspond to no more 
than the greatest depths to be encountered. The effect of this choice on CTD accuracy and resolution is shown below: 
 

Range 
(meters) 

Maximum Initial Error 
(meters) 

SBE 16plus, 16plus-IM, 19plus, 37, 39, 49, & 50 -  
Resolution (meters) 

SBE 25 -  
Resolution (meters) 

0 – 20 0.02 0.0004 0.003 
0 – 100 0.10 0.002 0.015 
0 – 350 0.35 0.007 0.052 
0 – 1000 1.0 0.02 0.15 
0 - 2000 2.0 0.04 0.30 
0 - 3500 3.5 0.07 0.52 
0 - 7000 7.0 0.14 1.05 

 
The meaning of accuracy, as it applies to these sensors, is that the indicated pressure will conform to true pressure to 
within ± maximum error (expressed as equivalent depth) throughout the sensor’s operating range. Note that a  
7000-meter sensor reading + 7 meters at the water surface is operating within its specifications; the same sensor would 
be expected to indicate 7000 meters ± 7 meters when at full depth. 
 
Resolution is the magnitude of indicated increments of depth. For example, a 7000-meter sensor on an SBE 25 
(resolution 1.05 meters) subjected to slowly increasing pressure will produce readings approximately following the 
sequence 0, 1.00, 2.00, 3.00 (meters). Resolution is limited by the design configuration of the CTD’s A/D converter.  
For the SBE 25, this restricts the possible number of discrete pressure values for a given sample to somewhat less than 
8192 (13 bits); an approximation of the ratio 1 : 7000 is the source of the SBE 25’s 0.015% resolution specification. 
 
Note: SEASOFT (and other CTD software) presents temperature, salinity, and other variables as a function of depth or 
pressure, so the CTD’s pressure resolution limits the number of plotted data points in the profile. For example, an  
SBE 25 with a 7000-meter sensor might acquire several values of temperature and salinity during the time required to 
descend from 1- to 2-meters depth. However, all the temperature and salinity values will be graphed in clusters 
appearing at either 1 or 2 meters on the depth axis. 
 
High-range sensors used in shallow water generally provide better accuracy than their absolute specifications indicate. 
With careful use, they may exhibit accuracy approaching their resolution limits. For example, a 3500-meter sensor has 
a nominal accuracy (irrespective of actual operating depth) of ± 3.5 meters. Most of the error, however, derives from 
variation over time and temperature of the sensor’s offset, while little error occurs as a result of changing sensitivity.  
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MINIMIZING ERRORS 
 
Offset Errors 
 
The primary offset error due to drift over time can be eliminated by comparing CTD readings in air before beginning 
the profile to readings from a barometer. Follow this procedure: 
 
1. Allow the instrument to equilibrate in a reasonably constant temperature environment for at least 5 hours. Pressure 

sensors exhibit a transient change in their output in response to changes in their environmental temperature; 
allowing the instrument to equilibrate before starting will provide the most accurate calibration correction. 

 
2. Place the instrument in the orientation it will have when deployed. 
 
3. Set the pressure offset to 0.0: 

• In the .con file, using SEASAVE or SBE Data Processing (for SBE 16plus, 16plus-IM, 19plus, 25, or 49). 
• In the CTD’s EEPROM, using the appropriate command in SEATERM (for SBE 16plus, 16plus-IM, 19plus, 

37, 39, 49, or 50). 
 
4. Collect pressure data from the instrument using SEASAVE or SEATERM (see instrument manual for details). If 

the instrument is not outputting data in decibars, convert the output to decibars. 
 

5. Compare the instrument output to the reading from a good barometer placed at the same height as the pressure 
sensor. Calculate offset (decibars) = barometer reading (converted to decibars) – instrument reading (decibars). 

 
6. Enter calculated offset in decibars: 

• In the .con file, using SEASAVE or SBE Data Processing (for SBE 16plus, 16plus-IM, 19plus, 25, or 49). 
• In the CTD’s EEPROM, using the appropriate command in SEATERM (for SBE 16plus, 16plus-IM, 19plus, 

37, 39, 49, or 50). 
 
Note: For instruments that store calibration coefficients in EEPROM and also use a .con file (SBE 16plus, 16plus-IM, 
19plus, and 49), set the pressure offset (Steps 3 and 6 above) in both the EEPROM and in the .con file. 

 
Offset Correction Example 
Pressure measured by a barometer is 14.65 psia. Pressure displayed from instrument is -2.5 dbars. 
Convert barometer reading to dbars using the relationship:     (psia – 14.7) * 0.6894759 = dbars 
Barometer reading = (14.65 – 14.7) * 0.6894759 = -0.034 dbars 
Offset = -0.034 – (-2.5) = + 2.466 dbar 
Enter offset in .con file (if applicable) and in instrument EEPROM (if applicable). 

 
 
 
Another source of offset error results from temperature-induced drifts. Because Druck sensors are carefully temperature 
compensated, errors from this source are small. Offset errors can be estimated for the conditions of your profile, and 
eliminated when post-processing the data in SBE Data Processing by the following procedure: 
 
1. Immediately before beginning the profile, take a pre-cast in air pressure reading. 
 
2. Immediately after ending the profile, take a post-cast in air pressure reading with the instrument at the same 

elevation and orientation. This reading reflects the change in the instrument temperature as a result of being 
submerged in the water during the profile. 

 
3. Calculate the average of the pre- and post-cast readings. Enter the negative of the average value (in decibars) as the 

offset in the .con file. 
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Hysteresis Errors 
 
Hysteresis is the term used to describe the failure of pressure sensors to repeat previous readings after exposure to other 
(typically higher) pressures. The Druck sensor employs a micro-machined silicon diaphragm into which the strain 
elements are implanted using semiconductor fabrication techniques. Unlike metal diaphragms, silicon’s crystal structure 
is perfectly elastic, so the sensor is essentially free of pressure hysteresis. 
 
 
Power Turn-On Transient 
 
Druck pressure sensors exhibit virtually no power turn-on transient. The plot below, for a 3500-meter pressure sensor in 
an SBE 19plus SEACAT Profiler, is representative of the power turn-on transient for all pressure sensor ranges. 

 
 
Thermal Transient 
 
Pressure sensors exhibit a transient change in their output in response to changes in their environmental temperature, so 
the thermal transient resulting from submersion in water must be considered when deploying the instrument. 
 
During calibration, the sensors are allowed to warm-up before calibration points are recorded. Similarly, for best depth 
accuracy the user should allow the CTD to warm-up for several minutes before beginning a profile; this can be part of 
the soak time in the surface water. Soaking also allows the CTD housing to approach thermal equilibrium (minimizing 
the housing's effect on measured temperature and conductivity) and permits a Beckman- or YSI-type dissolved oxygen 
sensor (if present) to polarize. 
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APPLICATION NOTE NO. 31 September 2001

Computing Temperature and Conductivity Slope and Offset Correction Coefficients from
Laboratory Calibrations and Salinity Bottle Samples

Conductivity Sensors

SEASOFT’s prompt for slope and offset values when the conductivity sensor is selected when setting up the
configuration (.con) file permits the user to make corrections for sensor drift between calibrations. For newly calibrated
sensors use slope = 1.0, offset = 0.0. The correction formula is:

(corrected conductivity) = slope * (computed conductivity) + offset

The conductivity sensor usually drifts by changing span (the slope of the calibration curve), and changes are typically
toward lower conductivity readings with time. Offset error in conductivity (error at 0 S/m) is usually due to electronics
drift, which is usually less than ±0.0001 S/m per year. Offsets greater than ±0.0002 S/m are symptomatic of sensor
malfunction. Sea-Bird, therefore, recommends drift corrections to conductivity sensors be made by assuming no offset
error, unless there is strong evidence to the contrary or a special need.

As an example of computing these correction coefficients, if we had the following calibration data:

true conductivity: 3.5 S/m
instrument reading: 3.49965 S/m

slope = 3.5 / 3.49965 = 1.000100

Correcting for Conductivity Drift Based on Pre- and Post-Cruise Laboratory Calibrations

Suppose a conductivity sensor is calibrated (pre-cruise), then immediately used at-sea, and then returned for post-cruise
calibration. The pre- and post-cruise calibration data can be used to generate a slope correction for data taken between
the pre- and post-cruise calibrations.

If α is the conductivity computed from the pre-cruise bath data (temperature and frequency) using post-cruise
calibration coefficients and β is the true conductivity in the pre-cruise bath, then:

Postslope =                                             (postslope is typically < 1.0)

Beginning in February 1995, the value for postslope was calculated and printed on the conductivity calibration sheet.

Σ   (α i)(β i)

n

Σ   (α i)(α i)
i=1

n

i=1
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To correct conductivity data taken between pre- and post-cruise calibrations:

Let:
n = number of days between pre- and post-cruise calibrations
b = number of days between pre-cruise calibration and the cast to be corrected
islope = interpolated slope; this is the value to enter in the .con file
postslope = slope from calibration sheet as calculated above

islope = 1.0 + (b / n) ((1 / postslope) - 1.0)

In the .con file, use the pre-cruise calibration coefficients and use islope for the value of slope.*

Note: The CTD configuration (.con) file is edited using the Configure menu (in SEASAVE or SBE Data Processing in
our SEASOFT-Win32 suite of programs) or SEACON (in SEASOFT-DOS).

For typical conductivity drift rates (equivalent to -0.003 PSU/month), islope would not need to be recalculated more
frequently than at weekly intervals.

* You can also calculate preslope. If α is the conductivity computed from the post-cruise bath data (temperature
and frequency) using pre-cruise calibration coefficients and β is the true conductivity in the post-cruise bath, then:

Preslope =                                             (preslope is typically > 1.0)

In this case, pre-cruise calibration coefficients would be used and:
islope = 1.0 + (b / n) (preslope - 1.0)

Correcting for Conductivity Drift Based on Salinity Bottles Taken At-Sea

For this situation the pre-cruise calibration coefficients are used to compute conductivity and CTD salinity. Salinity
samples are obtained using water sampler bottles during CTD profiles, and the difference between CTD salinity and
bottle salinity is used to determine the drift in conductivity.

In using this method to correct conductivity, it is important to realize that differences between CTD salinity and
hydrographic bottle salinity are due to errors in conductivity, temperature, and pressure measurements (as well as
errors in obtaining and analyzing bottle salinity values). All CTD temperature and pressure errors and bottle errors
must first be corrected before attributing the remaining salinity difference as CTD conductivity error and proceeding
with conductivity corrections.

Suppose that at a Pacific Ocean station, three salinity bottles are taken during a CTD profile and assume for this
discussion that shipboard analysis of the bottle salinities is perfect. The bottle salinities and the uncorrected CTD data
might be:

Σ   (α i)(β i)

n

Σ   (α i)(α i)
i=1

n

i=1
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Approximate
Depth (m)

Bottle
Salinity

CTD Raw
Salinity

CTD Raw
Conductivity (S/m)

CTD Temperature
(°C)

CTD Pressure
(dbar)

200 34.9770 34.9705 4.63421 18.3924 202.7
1000 34.4710 34.4634 3.25349 3.9841 1008.8
4000 34.6850 34.6778 3.16777 1.4527 4064.1

The uncorrected salinity differences (CTD salinity - bottle salinity) are approximately -0.007 ppt. To determine
conductivity drift, the CTD temperature and pressure data must first be corrected. Suppose that the error in temperature
measurements is +0.0015 C uniformly at all temperatures, and the error in pressure is +0.5 dbar uniformly at all
pressures. The drift offsets are obtained by projecting the drift history of both sensors from pre-cruise calibrations. If
these offsets are entered in the .con file, the correct CTD temperature and pressure will be the reported raw values and
will need no further correction. In addition, the CTD raw salinity will be reported using the correct CTD temperature
and pressure. This correction method also assumes that the pressure coefficient for the conductivity cell is correct. The
CTD data with corrected temperature and pressure are:

Correct CTD
Pressure (dbar)

Correct CTD
Temperature (°C)

CTD Conductivity
(S/m)

CTD Salinity
T,P Corrected

Bottle Salinity

202.2 18.3909 4.63421 34.9719 34.9770
1008.3 3.9826 3.25349 34.4652 34.4710
4063.6 1.4512 3.16777 34.6796 34.6850

The (CTD-bottle) salinity difference of -0.005 ppt is now properly assigned as conductivity error, equivalent to about -
0.0005 S/m at 4.0 S/m. By plotting the conductivity error versus conductivity, it is evident that the drift is primarily a
slope change.

The program SEACALC (in SEASOFT-DOS) can be used to compute bottle conductivity. Enter bottle salinity for
salinity, CTD corrected temperature for temperature, and CTD corrected pressure for pressure.

CTD Conductivity (S/m) Bottle Conductivity (S/m) [CTD - Bottle] Conductivity (S/m)
4.63421 4.63481 -0.00060
3.25349 3.25398 -0.00049
3.16777 3.16821 -0.00044

If α is the CTD conductivity computed with pre-cruise coefficients and β is the true bottle conductivity then:

slope =                                                         (slope is typically > 1.0)

Using the above data, the slope correction coefficient for conductivity at this station is slope = +1.000137. Following
Sea-Bird's recommendation of assuming no offset error in conductivity, offset is set to 0.0.

For typical Sea-Bird sensors that are calibrated regularly, 70 - 90% of the CTD salinity error is due to conductivity
calibration drift, 10 - 30% is due to temperature calibration drift, and only 0% - 10% is due to pressure calibration drift.

Σ   (α i)(β i)

n

Σ   (α i)(α i)
i=1

n

i=1
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Temperature Sensors

SEASOFT’s prompt for slope and offset values when the temperature sensor is selected when setting up the
configuration (.con) file permits the user to make corrections for sensor drift between calibrations. For newly calibrated
sensors, use slope = 1.0, offset = 0.0. The correction formula is:

(corrected temperature) = slope * (computed temperature) + offset

where :
slope = (true temperature span) / (instrument temperature span)
offset = (true temperature - instrument reading) * slope                    measured at 0.0 °C

As an example of computing the correction coefficients, if we had the following calibration data:

true temperature 0.0 °C 25.0 °C
instrument reading 0.0015 °C 25.0013 °C

slope = (true temperature span) / (instrument temperature span)
= (25.0 - 0.0) / (25.0013 - 0.0015)  = 1.000008000

offset = (true temperature - instrument reading) * slope measured at 0.0 °C
= (0.0 - 0.0015) * (1.000008000)  = -0.00150002

For this example Sea-Bird would recommend the drift correction values (entered in the .con file)
slope = 1.0 offset = -0.0015

Sea-Bird temperature sensors usually drift by changing offset (an error of equal magnitude at all temperatures). In
general, the drift can be toward higher or lower temperature with time; however, for a specific sensor the drift will
remain the same sign (direction) for many consecutive years. A large span error (change in calibration slope) indicates
an unusual aging of electronic components and is symptomatic of sensor malfunction. Sea-Bird therefore recommends
that drift corrections to temperature sensors be made by assuming no slope error, unless there is strong evidence to the
contrary or a special need.

Sensors with serial numbers less than 1050 drift more typically toward higher temperature with time, while sensors with
serial numbers greater than 1050 drift more typically toward lower temperature with time. Many years of experience
with hundreds of sensors indicates that the drift is smooth and uniform with time, allowing users to make very accurate
drift corrections to field data based only on pre- and post-cruise laboratory calibrations.

Calibration checks at-sea are advisable for consistency checks of the sensor drift rate and for early detection of sensor
malfunction. However, data from reversing thermometers is rarely accurate enough to make calibration corrections that
are better than those possible by shore-based laboratory calibrations. A proven alternate consistency check is to use dual
SBE 3 temperature sensors on a CTD and to track the difference in drift rates between the two sensors. In the deep
ocean, where temperatures are uniform, the difference in temperature measured by two sensors can be resolved to better
than 0.0002 °C and will change smoothly with time as predicted by the difference in drift rates of the two sensors.

The temperature sensors rarely exhibit span errors larger than 0.005 °C over the range -5 to 35 °C even after years of
drift. A span error that increases by more than ±0.0002 [°C per °C per year] is symptomatic of sensor malfunction.
Previous to January 1993 some calibrations have been delivered that include span errors up to 0.004 °C in 30 °C
(span error of 0.000133) because of undetected systematic errors in calibration. Temperature calibrations preformed at
Sea-Bird after January 1995 have span error less than 0.0002 °C in 30 °C.
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Correcting for Temperature Drift Based on Pre- and Post-Cruise Laboratory Calibrations

Suppose a temperature sensor is calibrated (pre-cruise), then immediately used at-sea for 4 months, and then returned
for post-cruise calibration. Converting the post-cruise calibration data using the pre-cruise coefficients, we obtain
the estimates:

Real Temperature........ 0.0°....... 25.0°C
Instrument Reading..... 0.002°... 25.001°C

These calibration data correspond to offset error = +0.002 °C, and span error = -0.00004 [°C per °C] at the end of
4 months of use. The correction coefficients are slope= 1.000040002, offset= -0.00200008. Note the difference
between the error value and the value of the correction coefficient.

For preliminary work at sea, use the pre-cruise calibration coefficients and slope = 1.0, offset = 0.0. Temperature
data obtained during the cruise is corrected for drift using properly scaled values of correction coefficients. Data
from the end of the second month at sea would be converted using pre-cruise coefficients and slope=1.00002,
offset= -0.001. At the end of the 4-month cruise, data could be converted by either using pre-cruise coefficients and
slope=1.00004, offset= -0.002, or by using post-cruise coefficients and slope= +1.0, offset = 0.0.
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APPLICATION NOTE NO. 34 January 1992

CONDUCTIVITY CELL FILLING AND STORAGE DEVICE P/N 50087
INSTRUCTIONS FOR USE

Sea-Bird recommends keeping the conductivity
cell full of purified water (except in freezing
environments) during periods when the CTD is not
being used. This is important in keeping the cell
free from contamination and in keeping the
electrodes wetted and ready for immediate use.

CTDs with pumped conductivity cells (SBE 911,
SBE 25, and some SEACATs) are shipped with
syringe and tubing assembly (P/N 50087) as an
accessory for filling and storing the conductivity
cell. The tubing assembly consists of a length of
1/4 inch I.D. tube connected to a short piece of
7/16 inch I.D. tube by a plastic reducing union.

To fill the conductivity cell, draw about 40-60 cc of
purified water into the syringe, connect the plastic
tubing to the TC duct intake on the temperature
sensor [Figure 1], (or to the open end of the
conductivity cell on systems without the TC duct
[Figure 2]) and inject water into the cell and
pump plumbing.

For CTDs with a TC duct, remove the plastic
reducing union and connect the smaller diameter
tubing directly to the TC duct. For CTDs without a
TC duct, leave the reducing union and large
diameter tubing attached and carefully connect the
tubing directly to the end of the glass conductivity
cell [Figure 2].

After filling the conductivity cell, loop the rubber
band around a bar on the CTD cage and back over
the top of the syringe to secure the apparatus for
storage.

REMEMBER TO REMOVE THE SYRINGE
AND TUBING ASSEMBLY BEFORE
DEPLOYMENT!

Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, WA  98005
USA

Phone: (425) 643-9866
Fax: (425) 643-9954
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APPLICATION NOTE NO. 40 Revised November 2002 
 
 SBE 5T PUMP SPEED ADJUSTMENT INSTRUCTIONS 
 
 
Equipment: DC power supply   Drawings: 31441 (schematic) 
  Frequency counter     40630 (3000 rpm pump) 
         40631 (1300 rpm pump) 
 
 
The pump housing must be disassembled to adjust the pump speed. Referencing above drawings: 
 
1. Remove the white plastic end cap retainer ring located at the connector end of the pump by twisting in a 

counter-clockwise motion. 
 
2. Install a 2-pin dummy plug with locking sleeve (P/N 17044.1) over the bulkhead connector. This will 

provide a good grip on the pump connector and will protect the connector pins.  
Rotate the connector back and forth while carefully pulling the end cap away from the housing. Pull the 
end cap (piston o-ring seal) out of the housing. The motor and electronics assembly are attached to the 
end cap and will come out as a unit. 

 
3. Connect the positive lead of your frequency counter to the yellow test post (T1) (drawing 40630/40631). 

Connect the frequency counter ground (negative) to the power supply ground (negative). 
 
4a. For low voltage pump (pump with LV in the serial number), supply 6 volts DC power to either  

the bulkhead connector (large pin is common, small pin is positive) or connect directly to the PCB  
(P8 is positive, P19 or P18 is common, drawing 40630/40631). 

 
4b. For normal voltage pump, supply 12 volts to either the bulkhead connector (large pin is common, 

small pin is positive) or connect directly to the PCB (P8 is positive, P19 or P18 is common,  
drawing 40630/40631). 

 
5. A 2K ohm potentiometer (R11, drawing 40630/40631) is located on the back side of the board. Adjust the 

potentiometer to obtain the frequency corresponding to the desired speed (Frequency * 30 = RPM). 
With the Pittman 18.2Ω motor (P/N 3711B113), set the jumper position P15 to P17 (1300 rpm) and P12 
to P13 (1300 rpm), and adjust the speed as desired, up to the nominal maximum of 2000 rpm. With the 
Pittman 7.4Ω motor (P/N 3711B112), set the jumper position P15 to P16 (3000 rpm) and P14 to P13 
(3000 rpm), and adjust the speed as desired, up to the nominal maximum of 4500 rpm. To adjust speed 
of the 7.4Ω motor below approximately 2200 rpm, set the jumper position P15 to P17 (1300 rpm) and 
P12 to P13 (1300 rpm), and adjust speed using the potentiometer. 

 
6. Disconnect the frequency counter and the power supply. Make sure the O-ring and mating surfaces 

are clean. Lightly lubricate before inserting the connector end cap into the housing cylinder. Replace the 
pump end cap retainer. 

Sea-Bird Electronics, Inc. 
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APPLICATION NOTE NO. 42 Revised September 2001

ITS-90 TEMPERATURE SCALE

Beginning January 1995, Sea-Bird temperature calibration certificates list a new set of coefficients labeled g, h, i, j,
and F0. These coefficients correspond to ITS90 (T90) temperatures and should be entered by those researchers
working with SEASOFT-DOS Versions 4.208 and higher (and all versions of SEASOFT-Win32). For the
convenience of users who prefer to use older SEASOFT versions, the new certificates also list a, b, c, d, and F0
coefficients corresponding to IPTS68 (T68) temperatures as required by SEASOFT-DOS versions older than 4.208.

It is important to note that the international oceanographic research community will continue to use T68 for
computation of salinity and other seawater properties. Therefore, following the recommendations of Saunders (1990)
and as supported by the Joint Panel on Oceanographic Tables and Standards (1991), SEASOFT-DOS 4.200 and
later and all versions of SEASOFT-Win32 convert between T68 and T90 according to the linear relationship:

T68 = 1.00024  * T90

The use of T68 for salinity and other seawater calculations is automatic in all SEASOFT programs. However, when
selecting temperature as a display/output variable, you will be prompted to specify which standard (T90 or T68) is
to be used to compute temperature. SEASOFT recognizes whether you have entered T90 or T68 coefficients in the
configuration (.con) file, and computes T90 temperature directly or calculates it from the Saunders linear
approximation, depending on which coefficients were used and which display variable type is selected.

For example, if g, h, i, j, F0 coefficients (T90) are entered in the .con file and you select temperature variable type as
T68, SEASOFT computes T90 temperature directly and multiplies it by 1.00024 to display T68. Conversely, if a, b,
c, d, and F0 coefficients (T68) are entered in the .con file and you select temperature variable type as T90,
SEASOFT computes T68 directly and divides by 1.00024 to display T90.

Note: The CTD configuration (.con) file is edited using the Configure menu (in SEASAVE or SBE Data Processing
in our SEASOFT-Win32 suite of programs) or SEACON (in SEASOFT-DOS).

Also beginning January 1995, Sea-Bird's own temperature metrology laboratory (based upon water triple-point and
gallium melt cell, SPRT, and ASL F18 Temperature Bridge) converted to T90. These T90 standards are now
employed in calibrating all Sea-Bird temperature sensors, and as the reference temperature used in conductivity
calibrations. Accordingly, all calibration certificates show T90 (g, h, i, j) coefficients that result directly from
T90 standards, and T68 coefficients (a, b, c, d) computed using the Saunders linear approximation.
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APPLICATION NOTE NO. 57 Revised May 2003 
 

I/O Connector Care and Installation 
 
This Application Note describes the proper care and installation of standard I/O connectors for Sea-Bird  
CTD instruments. Once properly installed, the connections require minimal care. Unless access to the bulkhead is 
required, the connections can be left in place indefinitely. 
 
The Application Note is divided into three sections: 
• Connector Cleaning and Installation 
• Locking Sleeve Installation 
• Cold Weather Tips 

Connector Cleaning and Installation 
 
1. Carefully clean the bulkhead connector and the inside of the mating inline (cable end) connector with a 

Kimwipe. Remove all grease, hair, dirt, and other contamination. 

2. Inspect the connectors: 
A. Inspect the pins on the bulkhead connector for signs of corrosion. The pins should be bright and shiny, with no 

discoloration. If the pins are discolored or corroded, clean with alcohol and a Q-tip. 
B. Inspect the bulkhead connector for chips, cracks, or other flaws that may compromise the seal. 
C. Inspect the inline connector for cuts, nicks, breaks, or other problems that may compromise the seal. 
 
Replace severely corroded or otherwise damaged connectors - contact SBE for instructions or a Return 
Authorization Number (RMA number). 

Clean bulkhead connector Clean inside of connector 

Corroded pins on bulkhead connectors - 
Connector on right has a missing pin 

Sea-Bird Electronics, Inc. 
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3. Using a tube of 100% silicone grease (Dow DC-4 or 
equivalent), squeeze approximately half the size of a 
pea onto the end of your finger. 

 
CAUTION: 
Do not use WD-40 or other petroleum-based 
lubricants, as they will damage the connectors. 
 
 
4. Apply a light, even coating of grease to the molded 

ridge around the base of the bulkhead connector.  
The ridge looks like an o-ring molded into the 
bulkhead connector base and fits into the groove of 
the mating inline connector. 

 

5. Mate the inline connector to the bulkhead, 
being careful to align the pins with the sockets. 
Do not twist the inline connector on the 
bulkhead connector. Twisting can lead to bent 
pins, which will soon break. 

 
 
6. Push the connector all the way onto the 

bulkhead. There may be an audible pop,  
which is good. With some newer cables,  
or in cold weather, there may not be an  
initial audible pop. 

7. After the cable is mated, run your fingers along the 
inline connector toward the bulkhead, milking any 
trapped air out of the connector. You should hear 
the air being ejected. 

 
CAUTION: 
Failure to eject the trapped air will result in the 
connector leaking. 
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Locking Sleeve Installation 
 
After the connectors are mated, install the locking sleeve. The locking sleeve secures the inline connector to the 
bulkhead connector and prevents the cable from being inadvertently removed. 
Important points regarding locking sleeves: 
 
• Tighten the locking sleeve by hand. Do not use a wrench or pliers to tighten the locking sleeve. 

Overtightening will gall the threads, which can bind the locking sleeve to the bulkhead connector. Attempting 
to remove a tightly bound locking sleeve may instead result in the bulkhead connector actually unthreading 
from the end cap. A loose bulkhead connector will lead to a flooded instrument. Pay particular attention 
when removing a locking sleeve to ensure the bulkhead connector is not loosened. 

 
• It is a common misconception that the locking sleeve provides watertight integrity. It does not, and 

continued re-tightening of the locking sleeve will not fix a leaking connector. 
 
• As part of routine maintenance at the end of every cruise, remove the locking sleeve, slide it up the cable, and 

rinse the connection (still mated) with fresh water. This will prevent premature cable failure. 

Cold Weather Tips 
 
In cold weather, the connector may be hard to install and remove. 
 
Removing a frozen inline connector: 
 
1. Wrap the connector with a washrag or other cloth. 
 
2. Pour hot water on the cloth and let the connector sit for a minute or two. The connector should thaw and become 

flexible enough to be removed. 
 
 
Installing an inline connector: 
When possible, mate connectors in warm environments before the cruise and leave them connected.  
If not, warm the connector sufficiently so it is flexible. A flexible connector will install properly. 
 

By following these procedures, you will have many years of reliable service from your cables! 

Locking Sleeve 
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APPLICATION NOTE NO. 67 October 2001

Editing Sea-Bird .hex Data Files

After acquiring real-time .hex data or uploading .hex data from CTD memory, users sometimes want to edit the header
to add or change explanatory notes about the cast. Some text editing programs modify the file in ways that are not visible
to the user (such as adding or removing carriage returns and line feeds), but that corrupt the format and prevent further
processing by SEASOFT (both DOS and Windows versions). This Application Note provides details on one way to
edit a .hex data file with a text editor while retaining the required format. The procedure described below has been
found to work correctly on computers running Win 98, Win 2000, and Win NT. If the editing is not performed using this
technique, SEASOFT may reject the data file and give you an error message.

1. Make a back-up copy of your .hex data file before you begin.

2. Run WordPad.

3. In the File menu, select Open. The Open dialog box appears. For Files of type, select All Documents (*.*). Browse
to the desired .hex data file and click Open.

4. Edit the file as desired, inserting any new header lines after the System Upload Time line. Note that all header
lines must begin with an asterisk (*), and *END* indicates the end of the header. An example is shown below, with
the added lines in bold:

* Sea-Bird SBE 21 Data File:
* FileName = C:\Odis\SAT2-ODIS\oct14-19\oc15_99.hex
* Software Version Seasave Win32 v1.10
* Temperature SN = 2366
* Conductivity SN = 2366
* System UpLoad Time = Oct 15 1999  10:57:19
* Testing adding header lines
* Must start with an asterisk
* Can be placed anywhere between System Upload Time and END of header
* NMEA Latitude = 30 59.70 N
* NMEA Longitude = 081 37.93 W
* NMEA UTC (Time) = Oct 15 1999  10:57:19
* Store Lat/Lon Data = Append to Every Scan and Append to .NAV File When <Ctrl F7> is Pressed
** Ship:       Sea-Bird
** Cruise:     Sea-Bird Header Test
** Station:   
** Latitude:  
** Longitude: 
*END*

5. In the File menu, select Save (not Save As). If you are running Windows 2000, the following message displays:
You are about to save the document in a Text-Only format, which will remove all formatting. Are you sure you
want to do this?

Ignore the message and click Yes.

6. In the File menu, select Exit.

NOTE: This Application Note does not apply to .dat data files. Sea-Bird is not aware of a technique for editing a .dat
file that will not corrupt the file.
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APPLICATION NOTE NO. 68 Revised March 2004 
 
 

Using USB Ports to Communicate with Sea-Bird Instruments 
 
 
Most Sea-Bird instruments use the RS-232 protocol for transmitting setup commands to the 
instrument and receiving data from the instrument. However, many newer PCs and laptop 
computers have USB port(s) instead of RS-232 serial port(s). 
 
USB serial adapters are available commercially. These adapters plug into the USB port, and allow 
one or more serial devices to be connected through the adapter. Sea-Bird tested USB serial adapters 
from three manufacturers with our instruments, and verified compatibility. These manufacturers and 
the tested adapters are: 
 
• Keyspan (www.keyspan.com) - High Speed USB Serial Adapter (part # USA-19QW) and  

USB 4-Port Serial Adapter (part # USA-49W) 
 
• Edgeport (www.ionetworks.com) - Standard Serial Converter Edgeport/2 (part # 301-1000-02) 
 
• IOGEAR (www.iogear.com) – USB 1.1 to Serial Converter Cable (model # GUC232A) 
 
Other USB adapters from these manufacturers, and adapters from other manufacturers, may also be 
compatible with Sea-Bird instruments. We recommend testing of any other adapters with the 
instrument before deployment, to verify that there is no problem. 
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APPLICATION NOTE NO. 69 July 2002 
 
 

Conversion of Pressure to Depth 
 
 
Sea-Bird’s SEASOFT software can calculate and output depth, if the instrument data includes 
pressure. Additionally, some Sea-Bird instruments (such as the SBE 37-SI or SBE 50) can be set up 
by the user to internally calculate depth, and to output depth along with the measured parameters. 
 
Sea-Bird uses the following algorithms for calculating depth: 
 
Fresh Water Applications 
 
Because most fresh water applications are shallow, and high precision in depth not too critical,  
Sea-Bird software uses a very simple approximation to calculate depth: 
 

depth (meters) = pressure (decibars) * 1.019716 
 
 
Seawater Applications 
 
Sea-Bird uses the formula in UNESCO Technical Papers in Marine Science No. 44. This is an 
empirical formula that takes compressibility (that is, density) into account. An ocean water column 
at 0 °C (t = 0) and 35 PSU (s = 35) is assumed. 
 
The gravity variation with latitude and pressure is computed as: 
 

g (m/sec2) = 9.780318 * [ 1.0 + ( 5.2788x10 -3  + 2.36x10 -5  * x) * x ] + 1.092x10 -6  * p 
 
where 
x = [sin (latitude / 57.29578) ] 2 

p = pressure (decibars) 
 
Then, depth is calculated from pressure: 
 

depth (meters) = [(((-1.82x10 -15  * p + 2.279x10 -10 ) * p - 2.2512x10 -5  ) * p + 9.72659) * p] / g 
 
where 
p = pressure (decibars) 
g = gravity (m/sec2) 
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APPLICATION NOTE NO. 71 September 2003 
 

Desiccant Use and Regeneration (drying) 
 
 
This application note applies to all Sea-Bird instruments intended for underwater use. The application note covers: 
• When to replace desiccant 
• Storage and handling of desiccant 
• Regeneration (drying) of desiccant 
• Material Safety Data Sheet (MSDS) for desiccant 
 
 
When to Replace Desiccant Bags 
 
Before delivery of the instrument, a desiccant package is placed in the housing, and the electronics chamber is filled with dry 
Argon. These measures help prevent condensation. To ensure proper functioning: 
1. Install a new desiccant bag each time you open the housing and expose the electronics. 
2. If possible, dry gas backfill each time you open the housing and expose the electronics. If you cannot, wait at least  

24 hours before redeploying, to allow the desiccant to remove any moisture from the chamber. 
 
What do we mean by expose the electronics? 
• For most battery-powered Sea-Bird instruments (such as SBE 16, 16plus, 16plus-IM, 17plus, 19, 19plus, 25, 37-SM, 

37-SMP, 37-IM, 37-IMP, 44; PN 90208 Auto Fire Module [AFM]), there is a bulkhead between the battery and 
electronics compartments. Battery replacement does not affect desiccation of the electronics, as the batteries are 
removed without removing the electronics and no significant gas exchange is possible through the bulkhead. Therefore, 
opening the battery compartment to replace the batteries does not expose the electronics; you do not need to install a 
new desiccant bag in the electronics compartment each time you open the battery compartment. For these instruments, 
install a new desiccant bag if you open the electronics compartment to access the printed circuit boards. 

• For the SBE 39 and 48, the electronics must be removed or exposed to access the battery. Therefore, install a new 
desiccant bag each time you open the housing to replace a battery. 

 
 
Storage and Handling 
 
Testing by Süd-Chemie (desiccant’s manufacturer) 
at 60% relative humidity and 30 °C shows that 
approximately 25% of the desiccant’s adsorbing 
capacity is used up after only 1 hour of exposure to 
a constantly replenished supply of moisture in the 
air. In other words, if you take a bag out of a 
container and leave it out on a workbench for  
1 hour, one-fourth of its capacity is gone before 
you ever install it in the instrument. Therefore: 
• Keep desiccant bags in a tightly sealed, 

impermeable container until you are ready to 
use them. Open the container, remove a bag, 
and quickly close the container again. 

• Once you remove the bag(s) from the sealed 
container, rapidly install the bag(s) in the 
instrument housing and close the housing.  
Do not use the desiccant bag(s) if exposed to 
air for more than a total of 30 minutes. 
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Regeneration (drying) of Desiccant 
 
Replacement desiccant bags are available from Sea-Bird: 

• PN 60039 is a metal can containing 25 1-gram desiccant bags and 1 humidity indicator card. The 1-gram bags are 
used in our smaller diameter housings, such as the SBE 3 (plus, F, and S), 4 (M and C), 5T, 37 (-SI, -SM, -SMP,  
-IM, and –IMP), 38, 39, 43, 44, 45, 48, 49, and 50. 

• PN 31180 is a 1/3-ounce desiccant bag, used in our SBE 16plus, 16plus-IM, 19plus, and 21. 
• PN 30051 is a 1-ounce desiccant bag. The 1-ounce bags are used in our larger diameter housings, such as the  

SBE 9plus, 16, 17plus, 19, 25, 26, 32, AFM, and PDIM. 
However, if you run out of bags, you can regenerate your existing bags using the following procedure provided by the 
manufacturer (Süd-Chemie Performance Packaging, a Division of United Catalysts, Inc.): 
 
 

MIL-D-3464 Desiccant Regeneration Procedure 
 

Regeneration of the United Desiccants’ Tyvek Desi Pak® or Sorb-It® bags or United Desiccants’  
X-Crepe Desi Pak® or Sorb-It® bags can be accomplished by the following method: 
 
1. Arrange the bags on a wire tray in a single layer to allow for adequate air flow around the bags during 

the drying process. The oven’s inside temperature should be room or ambient temperature (25 – 29.4 
°C [77 – 85 °F] ). A convection, circulating, forced-air type oven is recommended for this 
regeneration process. Seal failures may occur if any other type of heating unit or appliance is 
used. 

 
2. When placed in forced air, circulating air, or convection oven, allow a minimum of 3.8 to 5.1 cm (1.5 

to 2.0 inches) of air space between the top of the bags and the next metal tray above the bags.  
If placed in a radiating exposed infrared-element type oven, shield the bags from direct exposure to the 
heating element, giving the closest bags a minimum of 40.6 cm (16 inches) clearance from the heat 
shield. Excessive surface film temperature due to infrared radiation will cause the Tyvek material to 
melt and/or the seals to fail. Seal failure may also occur if the temperature is allowed to increase 
rapidly. This is due to the fact that the water vapor is not given sufficient time to diffuse through the 
Tyvek material, thus creating internal pressure within the bag, resulting in a seal rupture. Temperature 
should not increase faster than 0.14 to 0.28 °C (0.25 to 0.50 °F) per minute. 

 
3. Set the temperature of the oven to 118.3 °C (245 °F), and allow the bags of desiccant to reach 

equilibrium temperature. WARNING: Tyvek has a melt temperature of 121.1 – 126.7 °C  
(250 – 260 °F) (Non MIL-D-3464E activation or reactivation of both silica gel and Bentonite clay can 
be achieved at temperatures of 104.4 °C [220 °F]). 

 
4. Desiccant bags should be allowed to remain in the oven at the assigned temperature for 24 hours.  

At the end of the time period, the bags should be immediately removed and placed in a desiccator jar or 
dry (0% relative humidity) airtight container for cooling. If this procedure is not followed precisely, 
any water vapor driven off during reactivation may be re-adsorbed during cooling  
and/or handling. 

 
5. After the bags of desiccant have been allowed to cool in an airtight desiccator, they may be removed 

and placed in either an appropriate type polyliner tightly sealed to prevent moisture adsorption, or a 
container that prevents moisture from coming into contact with the regenerated desiccant. 

 
 
NOTE: Use only a metal or glass container with a tight fitting metal or glass lid to store the regenerated desiccant. Keep 
the container lid closed tightly to preserve adsorption properties of the desiccant. 
 

140



                   ISO 9002 CERTIFIED 

Sud-Chemie Performance 
Packaging 

101 Christine Dr. 
Belen, New Mexico  87002 

Phone: (505) 864-6691 
Fax: (505) 864-9296

 
MATERIAL SAFETY DATA SHEET – August 13, 2002 

SORB-IT® 
Packaged Desiccant 

3 

 
SECTION I -- PRODUCT IDENTIFICATION 

 
Trade Name and Synonyms: Silica Gel, Synthetic Amorphous Silica, 

Silicon, Dioxide 
Chemical Family: Synthetic Amorphous Silica 
Formula: SiO2.x H2O 
 
 

SECTION II -- HAZARDOUS INGREDIENTS 
 

Components in the Solid Mixture 
COMPONENT CAS No % ACGIH/TLV  (PPM) OSHA-(PEL) 

Amorphous 
Silica 

63231-67-4 >99 PEL - 20 (RESPIRABLE), 
TLV – 5 

LIMIT – NONE, 
HAZARD - 
IRRITANT 
 

 
Synthetic amorphous silica is not to be confused with crystalline silica such as quartz, 
cristobalite or tridymite or with diatomaceous earth or other naturally occurring forms of 
amorphous silica that frequently contain crystalline forms. 
 
This product is in granular form and packed in bags for use as a desiccant.  Therefore, no 
exposure to the product is anticipated under normal use of this product.  Avoid inhaling 
desiccant dust. 
 
 

SECTION III -- PHYSICAL DATA 
 
Appearance and Odor:  White granules; odorless. 
Melting Point: >1600 Deg C; >2900 Deg F 
Solubility in Water: Insoluble. 
Bulk Density: >40 lbs./cu. ft. 
Percent Volatile by Weight @ 1750 Deg F: <10%. 
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SECTION IV -- FIRE EXPLOSION DATA 
 
Fire and Explosion Hazard - Negligible fire and explosion hazard when exposed to heat 
or flame by reaction with incompatible substances. 
 
Flash Point - Nonflammable. 
 
Firefighting Media - Dry chemical, water spray, or foam.  For larger fires, use water spray 
fog or foam. 
 
Firefighting - Nonflammable solids, liquids, or gases:  Cool containers that are exposed 
to flames with water from the side until well after fire is out.  For massive fire in enclosed 
area, use unmanned hose holder or monitor nozzles; if this is impossible, withdraw from 
area and let fire burn.  Withdraw immediately in case of rising sound from venting safety 
device or any discoloration of the tank due to fire. 
 
 

SECTION V -- HEALTH HAZARD DATA 
 

Health hazards may arise from inhalation, ingestion, and/or contact with the skin and/or 
eyes.  Ingestion may result in damage to throat and esophagus and/or gastrointestinal 
disorders.  Inhalation may cause burning to the upper respiratory tract and/or temporary or 
permanent lung damage.  Prolonged or repeated contact with the skin, in absence of 
proper hygiene, may cause dryness, irritation, and/or dermatitis.  Contact with eye tissue 
may result in irritation, burns, or conjunctivitis. 
 
First Aid (Inhalation) - Remove to fresh air immediately.  If breathing has stopped, give 
artificial respiration.  Keep affected person warm and at rest.  Get medical attention 
immediately.   
 
First Aid (Ingestion) - If large amounts have been ingested, give emetics to cause 
vomiting.  Stomach siphon may be applied as well.  Milk and fatty acids should be 
avoided.  Get medical attention immediately. 
 
First Aid (Eyes) - Wash eyes immediately and carefully for 30 minutes with running 
water, lifting upper and lower eyelids occasionally.  Get prompt medical attention. 
 
First Aid (Skin) - Wash with soap and water. 
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NOTE TO PHYSICIAN: This product is a desiccant and generates heat as it adsorbs 
water.  The used product can contain material of hazardous nature.  Identify that material 
and treat accordingly. 
 
 

SECTION VI -- REACTIVITY DATA 
 
Reactivity - Silica gel is stable under normal temperatures and pressures in sealed 
containers.  Moisture can cause a rise in temperature which may result in a burn. 
 
 

SECTION VII  --SPILL OR LEAK PROCEDURES 
 
Notify safety personnel of spills or leaks.  Clean-up personnel need protection against 
inhalation of dusts or fumes.  Eye protection is required.  Vacuuming and/or wet methods 
of cleanup are preferred.  Place in appropriate containers for disposal, keeping airborne 
particulates at a minimum. 
 
 

SECTION VIII -- SPECIAL PROTECTION INFORMATION 
 
Respiratory Protection - Provide a NIOSH/MSHA jointly approved respirator in the 
absence of proper environmental control.  Contact your safety equipment supplier for 
proper mask type. 
 
Ventilation - Provide general and/or local exhaust ventilation to keep exposures below 
the TLV.  Ventilation used must be designed to prevent spots of dust accumulation or 
recycling of dusts. 
 
Protective Clothing - Wear protective clothing, including long sleeves and gloves, to 
prevent repeated or prolonged skin contact. 
 
Eye Protection - Chemical splash goggles designed in compliance with OSHA 
regulations are recommended.  Consult your safety equipment supplier. 
 
 

SECTION IX -- SPECIAL PRECAUTIONS 
 
Avoid breathing dust and prolonged contact with skin.  Silica gel dust causes eye irritation 
and breathing dust may be harmful. 
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* No Information Available 
 
HMIS (Hazardous Materials Identification System) for this product is as 
follows: 
 
Health Hazard 0 
Flammability 0 
Reactivity 0 
Personal Protection HMIS assigns choice of personal protective equipment to the 

customer, as the raw material supplier is unfamiliar with the 
condition of use. 

 
The information contained herein is based upon data considered true and accurate.  However, United Desiccants makes no warranties 
expressed or implied, as to the accuracy or adequacy of the information contained herein or the results to be obtained from the use 
thereof.  This information is offered solely for the user's consideration, investigation and verification.  Since the use and conditions of 
use of this information and the material described herein are not within the control of United Desiccants, United Desiccants assumes no 
responsibility for injury to the user or third persons.  The material described herein is sold only pursuant to United Desiccants' Terms 
and Conditions of Sale, including those limiting warranties and remedies contained therein.  It is the responsibility of the user to 
determine whether any use of the data and information is in accordance with applicable federal, state or local laws and regulations. 
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Application Note 56 Revised September 2003 
 
 Interfacing to RS-485 Sensors 
 
A few Sea-Bird instruments use the RS-485 protocol for transmitting setup commands to the instrument and  
receiving data from the instrument. However, most personal computers (PCs) do not come with an RS-485 port.  
This Application Note covers interfacing our RS-485 instruments with a PC by the following methods: 
 

• Connecting the instrument to an external RS-485/RS-232 Interface Converter that plugs into an existing  
RS-232 port on the PC. 

OR 
• Installing an RS-485 interface card (and associated software) in the PC, and then connecting the instrument 

directly to the new RS-485 port in the PC. 
 
 
External RS-485/RS-232 Interface Converter 
 
RS-485/RS-232 Interface Converters are available commercially. These converters plug into the RS-232 port on the PC, 
and allow an RS-485 device to be connected through the converter. Sea-Bird tested a converter from one manufacturer 
with our instruments, and verified compatibility. The manufacturer and tested converter is: 
 

Black Box (www.blackbox.com) –  
IC520A-F with RS-232 DB-25 female connector and RS-485 terminal block connector 

 
Other converters from this manufacturer, and converters from other manufacturers, may also be compatible with  
Sea-Bird instruments. We recommend testing other converters with the instrument before deployment, to verify that there 
is no problem. 
 
Follow this procedure to use the IC520A-F Converter: 
 

1. Connect the Converter to the PC: 
• If the PC has a 25-pin male RS-232 connector, plug the Converter directly into the PC connector. 
• If the PC has a 9-pin male RS-232 connector, plug the Converter into a 25-pin to 9-pin adapter  

(such as Black Box FA520A-R2 Adapter). Plug the 25-pin to 9-pin adapter into the PC. 
 

2. On the Converter, measure the voltage between XMT+ and ground and between XMT- and ground.  
Connect whichever has the highest voltage to RS-485 ‘A’ and the other to RS-485 ‘B’. The ground terminal can 
be left unconnected. 

 
 
RS-485 Interface Card and Port in the PC 
 
An RS-485 Interface Card installs in the PC, and allow an RS-485 device to be connected to the RS-485 port.  
These Interface Cards are available commercially. When using with a Sea-Bird instrument: 
 

• RS-485 Transmitter - 
The Interface Card must be configured to automatically handle the RS-485 driver enable. 

 
• Two-Wire Interface - 

TX+ and RX+ on the Interface Card must be connector together and to ‘A’ on the instrument.  
TX- and RX- on the Interface Card must be connected together and to ‘B’ on the instrument. 
Note: Some Interface Cards have a jumper to make the connections internally, while for other Cards the 
connections must be made in a jumper cable. 
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• Terminal Program Compatibility - 
If the Interface Card uses shared interrupts, SEATERM (our Windows terminal program) must be used to 
communicate with the instrument. 
If the Interface Card is configured as a standard COM port, either SEATERM or our DOS-based terminal 
programs may be used to communicate with the instrument. 

 
 
Sea-Bird tested two Interface Cards from one manufacturer with our instruments, and verified compatibility.  
The manufacturer and tested cards are: 
 

National Instruments (www.ni.com) -  
AT-485/2 
PCI-485/2 

 
Other Cards from this manufacturer, and Cards from other manufacturers, may also be compatible with Sea-Bird 
instruments. We recommend testing other Cards with the instrument before deployment, to verify that there is  
no problem. 
 
Follow this procedure to use the AT-485/2 or PCI-485/2 Interface Card: 
 

1. Install the RS-485 driver software (provided with Interface Card) on your PC before installing the  
Interface Card. 

 
2. Install the RS-485 Interface Card. 

 
3. Configure the RS-485 Interface Card in your PC (directions are for a PC running Windows XP): 

A. Right click on My Computer and select Properties. 
B. In the System Properties dialog box, click on the Hardware tab. Click the Device Manager button. 
C. In the Device Manager window, double click on Ports. Double click on the desired RS-485 port. 
D. In the Communications Port Properties dialog box, click the Port Settings tab.  

Click the Advanced button. 
E. In the Advanced Settings dialog box, set Transceiver Mode to 2 wire TxRdy Auto. 

 
4. Make a jumper cable (do not use a standard adapter cable) to connect the Interface Card to the instrument’s 

I/O cable. Pin outs are shown for a Sea-Bird 9-pin (current production) or 25-pin (older production) I/O cable: 
 

DB-9S  
(connect to PC) 

DB-9P  
(connect to Sea-Bird I/O cable PN 801385) 

DB-25P  
(connect to Sea-Bird I/O cable PN 801046) 

pin 1  common pin 5  common pin 7  common 
pin 4  TX+ pin 3  'A' pin 2  'A' 
pin 8  RX+ pin 3  'A' pin 2  'A' 
pin 5  TX- pin 2  'B' pin 3  'B' 
pin 9  RX- pin 2  'B' pin 3  'B' 

 
5. Run SEATERM (these Cards use shared interrupts, so the DOS terminal programs cannot be used): 

A. In SEATERM’s Configure menu, select the desired instrument. 
B. In the Configuration Options dialog box, set Mode to RS-485 and set COMM Port to the appropriate 

RS-485 port. 
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LEICA NA2 • NAK2

Universal automatic level



LEICA NA2 
The classical level from Leica Geosystems

The NA2 universal auto-
matic level meets all
requirements regarding
precision, convenience 
and reliability.

It was designed by sur-
veyors and development
engineers with years of
experience and who know
what a field instrument 
has to be able to do.

The NA2 soon pays for 
itself, because it can be
used for all types of sur-
veying job; on building
sites for routine levelling, 
in engineering projects, 
and for geodetic control at
all levels of accuracy.

Universal application

• Levelling of all types and
all orders of accuracy

• Precise levelling and
settlement determinations
on buildings

• Routine heighting for 
the construction of roads,
railways, pipelines,
tunnels and so forth

• Setting-out work and
control measurements on
the construction site

• Area levelling of high
accuracy

• Tacheometric levelling
with the K-version on flat
terrain by combining 
stadia and angular meas-
urements with height 
readings

• Deformation measure-
ment and monitoring of
bridges



Quickly set up, simple to use

Strong tripods

In principle, the NA2 
can be set up on any Leica
Geosystems tripod. In
practice, for all-round
purposes, we recommend
the heavy-duty GST20
telescopic-leg tripod. 
For precise levelling the
GST40 fixed-leg tripod 
is suitable because of its
extreme rigidity.

The modular relationship
between instrument and
tripod is an advantage
when transport space is
limited.

Centring is easy

The circular level only
needs to be centred
approximately to bring the
compensator well into its
working range of ~30', and
so setting-up goes quicker. 

The bubble is viewed
positively via a pentaprism
and is monitored down 
the eyepiece.

Play-free footscrews

The pitch of the smooth-
running and backlash-free
footscrews is such that 
the bubble can be centred
in a very short time.

Independent of 
temperature

Unlike the tubular level of 
a traditional instrument, the
NA2 universal automatic
level is relatively insensitive
to direct solar radiation 
and an umbrella need only 
be considered for the most
precise levelling. 

Open sight

Rapid / fine focusing knob

Pentaprism for viewing circular level

Endless horizontal drive

Footscrew

Push-button for compensator control

Endless horizontal drive

Footscrew



Adjust the line of sight automatically

Easy to level up

The advantage of this
instrument is that, as soon
as the bubble is centred,
the line of sight is horizontal
for all pointings of the
telescope. The observer is
freed of the time-consuming
centring procedure involved
with the traditional tubular
level, and can concentrate
on the business of staff
readings.

Minimum maintenance

In the unlikely event that
the compensator is
damaged (and this can only
happen as a result of
extremely harsh treatment)
it is replaced easily, being
held only by three screws.

NA2/NAK2 compensator

1 Suspension tapes
2 Prism (fixed)
3 Compensator body
4 Pendulum with prism
5 Line of sight
6 Push-button
7 Spring which taps pendulum
8 Pneumatic damping mechanism

Push-button control –
added security

With most automatics one
taps the tripod or instru-
ment to check if the com-
pensator is functioning.
Leica Geosystems offers a
far more sophisticated
solution.

Pressing the button under
the NA2 eyepiece gives the
compensator a gentle tap,
so that you see the staff
image swing smoothly

away and then float gently
back to give the horizontal
line of sight. This check,
which takes less than 
a second, is technically
perfect, as the pendulum
itself is activated and
swings through its full
range. It is also immediately
apparent if the bubble 
is not centred.

Robust and automatic

The compensator is
essentially a pendulum 
with a prism (4). 

The suspension system
comprises four flexed 
tapes (1) made of a special
alloy to ensure faultless
functioning even at extreme
temperatures. The compen-
sator, which is located
between the focusing lens
and the crosshair reticle, 
is pneumatically damped
against mechanical vibra-
tion and is screened against
magnetic fields.



Top-class optics

Top-class optics

The telescope is of excellent
quality and gives a bright,
high-contrast, erect image,
even in poor light – an
essential for accurate
levelling. With the standard
eyepiece the magnification
is 32×, the optimum for
most applications of the
instrument. Optional
eyepieces are available; the
40× may be preferred for
precise levelling, the 25×
in hot, shimmer conditions.
Eyepiece exchange takes
only a second or so.

The focusing knob has a
coarse/fine movement:
– coarse, for rapid setting

with minimum turning
– fine, for the final delicate

touch to give the perfect
image.

Fatigue-free viewing

The reticle has:
– a single horizontal hair

for reading normal staffs
– a wedge-shaped hair for

use with invar staffs
– stadia hairs for distance

measurement and three-
wire levelling.

The general layout of 
the controls, the smooth
friction-braked rotation 
of the instrument, and the
endless horizontal drive
with bilateral knobs, 
all combine to make the
instrument easy to use.

At an advantage on 
unstable ground

If a tubular level is used 
on unstable ground it tilts
out of range and has to be
continuously reset. By
contrast, the pendulum of
the NA2 “compensates”
and keeps the line of sight
horizontal.

Angle measurement 
with the NAK2

Civil engineers and contrac-
tors often require a circle
for angle measurement 
and setting-out work. Even
simple detail surveys, by
taking angle, distance and
height, and plotting with
the polar method, can be
done with a level.

The model NAK2 has an
internal glass circle which
is read via a scale micro-
scope and which can be set
to any value by turning 
the rim around the base 
of the instrument.

NA2 field of view with metric levelling staff
Reading at horizontal hair: 1.143 m

NAK2 
circle reading (400 gon)

392.66 gon

NAK2 
circle reading (360°) 

314°42'



High-performance accessories for precise levelling

GPM3 
parallel-plate micrometer

This optional accessory
slips over the telescope
objective and blends
perfectly with the smooth
lines of the NA2. With 
a compensator setting
accuracy of ±0.3“ (equiva-
lent to 0.01 mm in 10 m)
and a micrometer reading
to 0.1 mm direct and 
0.01 mm by estimation, the
NA2 with GPM3 is an ideal
combination for precise
levelling, deformation 
studies, and even optical
tooling. The micrometer
drive for raising and lower-
ing the line of sight is con-
veniently located and read-
ings are taken on a glass
scale viewed through an
eyepiece just above the
telescope eyepiece. This
optical reading system,
which is digital apart from
the last and estimated
figure in the metric and
inch versions, is superior 
to the usual metal drum
system.

GPM6 
parallel-plate micrometer

There are tasks for which 
a micrometer is needed, 
yet for which the very high
accuracy of the GPM3 is 
not essential. 

To meet this requirement, 
a simpler micrometer
attachment, the GPM6 
with drum reading, 
is available for the NA2.

The GPM6 fits on to the
telescope objective in the
same manner as the GPM3,
but the graduation is
engraved on a metal drum.

Eyepiece accessories for
specialized tasks

Because of the bayonet
fastening of the inter-
changeable eyepiece, all
theodolite eyepiece acces-
sories can be used with 
the NA2.

• Diagonal eyepiece for
observing from above,
below, and from the side;
useful in cramped spaces

• Eyepiece lamp for con-
verting the NA2 into 
a horizontal collimator 
for laboratory work

• Autocollimation eye-
piece for setting machine 
parts and instrument 
components precisely
vertical



Precise

Reliable, automatic, 
maintenance-free

Easy handling

Quick levelling-up

Superb telescope

Abundant accessories; 
many applications

Effortless focusing

The rugged NA2 is indifferent
to weather conditions and 
is extremely reliable in the
rough world of the building
site. The pendulum compen-
sator is protected against
knocks and shocks. There is
a highly-effective vibration-
damping mechanism.

The high setting accuracy
ensures that the line of
sight stays put. The attach-
able parallel-plate micro-
meter renders the NA2 
ideal for precise fine 
levelling.

The instantaneous check
facility with the push-button
control not only makes 
work easier; it also
promotes confidence.

The convenient, well-
arranged controls are
designed for maximum 
convenience. The bilateral,
endless horizontal 
drive promotes rapid 
fine-pointing.

The instrument is quickly 
set up with the three rapid-
action footscrews. Their 
self-adjusting threads 
make subsequent resetting
unnecessary.

Telescope with excellently-
corrected optics for bright,
high-contrast images. 
All optical components are
coated on both sides.

The erect image seen down
the telescope is quickly 
and accurately brought into
focus with the convenient
rapid and fine focusing
knob.

Additional items such as 
the parallel-plate micro-
meter, the laser eyepiece, 
or theodolite eyepiece
accessories, offer almost
unlimited possibilities.

Compact



LEICA NA2 • NAK2
Proven reliability ensures precise results

Versatile accessories for
demonstrable success

A comprehensive program
of accessories enables you
to expand the performance
and applications range 
of each instrument. 
This way, you can match 
your equipment exactly 
to requirements. 

The possibilities are
described in brochure
“Survey accessories” 
710 883en.

Total Quality Management – 
Our commitment to total 
customer satisfaction

Ask your local Leica
Geosystems agent for 
more information 
about our TQM program.

Illustrations, descriptions, and technical data are not binding and may be changed.
Printed in Switzerland – Copyright Leica Geosystems AG, Heerbrugg, Switzerland, 1999
710 837en – V.03 – RDV

Technical data

Standard deviation for 1 km double-run 
levelling, depending on type of staff and on 
procedure up to 0.7 mm
With parallel-plate micrometer 0.3 mm

Telescope erect image
Standard eyepiece 32×
FOK73 eyepiece (optional) 40×
FOK117 (optional) 25×
Clear objective aperture 45 mm
Field of view at 100 m 2.2 m
Shortest focusing distance 1.6 m
Multiplication factor 100
Additive constant 0

Working range of compensator ~30’
Setting accuracy of compensator (stand. dev.) 0.3“
Sensitivity of circular level 8’/2 mm

Glass circle (K version) 400 gon (360°)
Graduation diameter 70 mm
Graduation interval 1 gon (1°)
Reading by estimation to 10 mgon (1’)

Water- and dust resistance IP53

Temperature range:
Operation –20°C to +50°C (– 4°F to 122°F)
Storage –40°C to +70°C (–40°F to 158°F)

Parallel-plate micrometer Range Interval Estimation
(optional accessory)

GPM3, with glass scale 10 mm 0.1 mm 0.01 mm

GPM6, with metal drum 10 mm 0.2 mm 0.05 mm

Robust container for 
safe transport

The NA2 is supplied in a
foam-padded container
made of high performance
synthetic material. The
foam padding absorbs all
jolts and shocks. The
container provides perfect
protection for the NA2.

ISO 9001 / ISO 14001

Leica Geosystems AG
CH-9435 Heerbrugg

(Switzerland)
Phone +41 71 727 31 31

Fax +41 71 727 46 73
www.leica-geosystems.com
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PDL

Positioning Data Link™

19,200 Baud Rate
Higher Over-the -Air Link Rate

Extends Your Battery Life

Enhanced User Interface
Change Channels in the Field

View Status Information

Compatible with GPS
RTK Equipment

Worldwide
Complete Kit Solutions Available

for Your Application

Reliable
Rugged, All Season Operation

2 Year Warranty
Lower Cost of Ownership

High Performance
Data Link

Designed for Survey Systems

Surveyors utilizing Global Positioning Systems require a rugged radio
modem data link for precise positioning information. The PDL is compact
and lightweight and offers power efficient operation. It is easy to use, and
provides high performance and rugged dependability for the toughest
survey environments.

PDL Products are designed to easily mount on all standard tripods and
range poles. Complete kit solutions are available.

™



RF Power Select	 	 Low/High. 		 			Factory Programmable. 	 	 	N/A.

External
Internal Battery 	 	 N/A 	 	 	 	 	 N/A. 	 	 	 	 	 Lithium Ion Battery Pack.
During TX (nominal) 		 110 Watts.	 	 	 	 11 Watts. 		 	 	 	 N/A.
During RX (nominal) 		 1.9 Watts.		 	 	 	 0.9 Watts. 	 	 	 	 0.3 Watts.
Antenna
External 		 	 50 Ohm, BNC.	 	 	 	 50 Ohm, NMO.	 	 	 	 50 Ohm, NMO.
Modem Specifications
Link Rate/Modulation

Hamming Code (12, 8) with Data Interleaving.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.
RF Power Select  Toggle Switch.

19,200 bps/4 Level FSK.

9600 bps/GMSK.
4800 bps/GMSK.

RoverHigh Power Base

3 Wire, RS-232, 38.4k Baud Maximum.

ANSI/ASAE EP455.

990 Richard Avenue, Suite 110, Santa Clara, CA 95050
1-800-795-1001, Tel: 408-653-2070, Fax: 408-748-9984
Web: www.paccrst.com, E-mail: sales@paccrst.com
©2000 Pacific Crest Corporation.
License required prior to operation of radio communication equipment. Specifications subject to change without prior notice.
TRIMTALK™ is a trademark of Trimble Navigation Limited. M00526-9/02

Positioning Data Link™

Refer to price list for available frequency bands.

Synthesized 12.5k Hertz Resolution.
±2.5 ppm Stability.

-116 dBm (12 dB SINAD).
>-70 dB at 9600 bps/GMSK.
>-60 dB at 19,000 bps/4 Level FSK.

-22     to +140    F (-30   to +60   C).
-67     to +185    F (-55   to +85   C).

IEC 60529 I.P. 66.
Water Tight and Dust Proof.

9 – 16 VDC.

Low Power Base

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, TRIMTALK.™

6.23" W x 2.77" H x 6.58" L.
(15.8 cm W x 7.0 cm H x 16.7 cm L).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

All models are type accepted and certified for operation in the U.S. and Canada.
For detailed information concerning your country's type certification, please contact your sales representative.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

-4   to +140   F (-20   to +85   C).
-4   to +185   F (-20   to +85   C).

General Specifications
DTE – DCE Interface
User Interface

Power

Link Protocols

Forward Error Correction
Radio Specifications
Frequency Bands
Frequency Control

Sensitivity
Adjacent Channel Selectivity

Type Certification

Environmental Specifications
Operating Temperature
Storage Temperature
Vibration/Shock
Enclosure

Mechanical Specifications
Dimensions

Weight 	 	 	 2.96 lbs. (1.34 Kg).	 					 	 	 	 0.65 lbs. (0.30 Kg). 	  	 	 	 	0.75 lbs. (0.34 Kg).
Data/Power Connector	 5 Pin LEMO #1 Shell. 				 	 	 	 5 Pin LEMO #0 Shell. 				 	 	 	 5 Pin LEMO #0 Shell.
Mount 	 	 	 Tripod Bracket. 	 			 	 	 	 5/8" – 11 Range Pole. 				 	 	 	 5/8" – 11 Range Pole.

Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

Antenna

Modem Specifications

RF Transmitter Output 	 3/35 Watts Maximum. 	 	 	 0.5 – 2 Watts. 	 		 	 	  	 	0 Watt (Receive Only).

>-60 dB. >-60 dB.

9600 bps/4 Level FSK.



THALES NAVIGATION

Z-XTREME
The Ashtech® Z-XtremeTM from Thales Navigation professional
products is a rugged, weather-proof, dual-frequency GPS receiver
designed to provide surveyors with cost-effective, centimeter-accurate
positions in a variety of system configurations.

The Z-Xtreme receiver begins with state-of-the-art satellite electronics
coupled with patented Z-Tracking™ to deliver the highest GPS signal
reception level.  A removable battery and flash memory card provide
enough capacity to last all day for maximum utility. Components are
completely integrated inside a weather-proof, high impact plastic
housing, ensuring your investment is safe, rain or shine. Use the easy-
to-operate interface on the front panel for important functions such as
site information entry, survey status, and set-up of RTK base stations
without the additional cost of a handheld controller. The result: 
Z-Xtreme with Instant-RTK® outperforms all other receivers in its class!

ZX-SOLUTIONS
The Z-Xtreme survey system from Thales Navigation provides a range
of solutions designed for the vast array of positioning needs – from
entry level static or kinematic post-processed surveys, all the way up
to real-time functions such as stake out. The entry level ZX-SolutionsTM

system dramatically increases your productivity for control surveys and
other post-processed applications. Add an optional kinematic kit to
make topographic feature collection more cost effective. Use Ashtech
Solutions™ software to easily process the field data, export results and

generate reports. Purchase only what you need for the job at hand
because ZX-Solutions is fully upgradeable.

ZX-SUPERSTATION
Eclipse the productivity of optical instrument stake out with a ZX-
SuperStationTM. The ZX-SuperStation is a field-to-finish GPS surveying
system that combines the Z-Xtreme receiver with a powerful data
collector and wireless modems for centimeter accuracy in real-time.
Instant-RTK gives you the ability to initialize the centimeter solution in
a fraction of the time of conventional RTK systems.  Powerful data
collection software gives you the ability to efficiently perform GPS
surveying techniques and to interface seamlessly with optical total stations.

Z-Xtreme
Survey System

INSTANT-RTK TECHNOLOGY

www.thalesnavigation.com



Z-XTREME

TECHNICAL SPECIFICATIONS

Ashtech Technology

• 12 channel all-in-view operation
• Full-wavelength carrier on L1 and L2
• Z-Tracking
• Multipath mitigation
• Dual-frequency smoothing for improved code   

differential
• Instant-RTK

Performance Figures1

Static, Rapid Static
• Horizontal: 0.005 m + 1 ppm 

(0.016ft+1ppm)
• Vertical: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
Post-Processed Kinematic
• Horizontal: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
• Vertical: 0.020 m + 1 ppm 

(0.065ft+1ppm)
Real-Time Code Differential Position
• <1 m (3.28 ft)
Real-Time Z Kinematic Position (Fine Mode)
• Horizontal: 0.010 m + 2 ppm

(0.033ft + 2 ppm)
• Vertical: 0.020 m + 2 ppm 

(0.065ft + 2 ppm)
• Azimuth (arc sec): 0.4 + 2.0/baseline (km)
RTK Occupation Time
• 2 seconds (typical - sub-centimeter accuracy 

with longer occupation time)
Instant-RTK Initialization
• 99.9% reliability
• Typically <2 seconds with 6 or more satellites, 

PDOP <5, baseline length <7 km (4.35 mi), 
open sky and low multipath conditions

RTK Operating Range
• Recommended: 10 km (6.21 mi)
• Maximum: 40 km (24.85 mi)

Standard Features

• 16 MB PCMCIA removable memory card
• NMEA 0183 output
• Selectable update rate from 999 sec to 10 Hz
• Event marker
• Point positioning
• 1 PPS timing signal
• Session programming

• Wide array of coordinate transformations
• Removable internal battery
• 8-character alphanumeric LED display with 4-    

button interface
• 3 function LED display - Radio,Memory, 

Satellites/Power
• Multi-function audible alarm
• Quick reference card holder
• External mount capabilities
• External power input
• 4 RS-232 ports (115200 baud max, 3   

external, 1 internal)
• 1-year warranty
• Free factory technical support

Standard Accessories

• Communications software
• Padded system bag and hard case
• RS-232 data cable
• Receiver operating manual
• Quick reference field card

Technical Data

Environmental
Z-Xtreme Receiver
• Meets MIL-STD 810E for wind driven rain  

and dust
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40° to +85°C

(-40° to 185°F)
Geodetic 4 Antenna
• Meets IPX7 specifications for submersion
• Operating temperature: -55 to +75°C

(-40° to 149°F)
• Storage temperature: -55° to +75°C 

(-67° to 167°F)

Physical
Weight
• Receiver: 1.59 kg (3.50 lb)
• Antenna: 0.82 kg (1.81 lb)
• Battery: 0.43 kg (0.95 lb)
Dimensions
• 76.2 H x 196.85 W x 222.25 D mm 
• (0.25 H x 0.646 W x 0.729 D ft)
Power
• 10 - 28 VDC, 6.0 W

Internal battery
• Capacity: 6000 mAh
• >9 hours (typical) @  25°C (77°F)
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40 to +60°C 

(-40° to + 140°F)

PC card
• ATA Type II PCMCIA memory card (16 MB  

standard)
• Temperature range: -40° to +85°C

(-40° to 185°F)
• Data capacity: 4500 epochs per 2 MB*
* Based on one session, eight satellites' data
and full measurements. This number can vary
significantly depending on the conditions of the
session.

Optional Features

• Real-time kinematic (base and rover modes)  
for cm-accuracy

• RTCM 2.2 (Types 1, 2, 3, 9, 16, 18, 19, 20, 
21, 22)

• Internal UHF or spread spectrum radio for 
RTK rover operations

• External UHF or spread spectrum radio for
RTK base and rover operations

• Geodetic 4 antenna ground plane kit
• Kinematic antenna kit
• Aircraft antenna kit
• AC power cable
• Choke ring antenna
• Long haul backpack kit
• All-on-a-pole kit

Optional Application Software

GPS data processing
• Ashtech Solutions

Land Surveying and Construction
• TDS Survey Pro
• Carlson SurvCE
• Ashtech Survey Control II
• Ashtech GPS Fieldmate

Mining and Land Seismic
• Ashtech Mine Surveyor II
• Ashtech Seismark II 

1 Specifications assume operation follows all the

procedures recommended in the product manual utilizing

Instant-RTK, post processing with Ashtech Solutions or

Ashtech Office Suite for Survey. High-multipath areas,

high PDOP values, low satellite visibility, and periods of

adverse atmospheric conditions and/or other adverse

circumstances will degrade system performance. All

accuracy specifications are RMS values.

Thales Navigation follows a policy of continuous product improvement; specifications and descriptions are thus subject to change without notice.
Please contact Thales Navigation for the latest product information.

© 2003 Thales Navigation, Inc. All rights reserved. Ashtech, Z-Xtreme, Instant-RTK, ZX-SuperStation, ZX-Solutions, Z-Tracking, GPS FieldMate, Survey Control II and Ashtech Solutions are trademarks
of Thales Navigation. All other product and brand names are trademarks or registered trademarks of their respective holders. Ashtech P-code GPS technology has been FGCC tested and is capable
of performing first order surveys (report available upon request).  rev(5.03)  part # 830190

Thales Navigation, Inc.
Corporate Headquarters, Santa Clara, CA, USA 
+1 408 615 5100 * Fax +1 408 615 5200
Toll Free (Sales in USA/Canada) 1 800 922 2401
Email   professionalsales@thalesnavigation.com
In Washington, DC   +1 703 476 2212 * Fax +1 703 476 2214
In South America   +56 2 234 56 43 * Fax +56 2 234 56 47
In China   +86 10 6566 9866 * Fax +86 10 6566 0246

European Headquarters, Carquefou, France  
+33 2 28 09 38 00 * Fax +33 2 28 09 39 39
Email   professionalsalesemea@thalesnavigation.com
In Germany   +49 81 6564 7930 * Fax +49 81 6564 7950
In Russia   +7 095 956 5400 * Fax +7 095 956 5360
In UK   +44 (0) 870 601 0000 * Fax +44 (0) 208 391 1672     
In the Netherlands   +31 78 61 57 988 * Fax +31 78 61 52 027
Web site   www.thalesnavigation.com















������ SET5F
Version 01-00

TOTAL STATION

SURVEYING INSTRUMENTS

Enhanced software with 3,000-point data memory.



Flexible, Friendly and Featherweight
The SET5F's powerful EDM, dependable dual-axis compensator and 3,000-point data memory
are conveniently packaged in a compact, lightweight body. Software [Version 01-00) has
been enhanced for more effective survey work, and "softkey" assignments can be freely
customized to suit all user needs.

Dependable
Hardware

Proven Dual-axis Compensator
•Since its introduction with the Series C
total station in 1989, Sokkia's dual-axis
compensator has proven its reliability and
accuracy at survey sites all over the world.
•The dual-axis tilt sensor monitors
deviations of both the X and Y axes and the
correct horizontal and vertical angle
readings are automatically computed and
applied. The result is easier and faster
instrument leveling.

Spacious 3,000-point Internal
Memory
•The SET5F's internal memory is large—
holding a full 3,000 data points—and
secure. For optimum convenience,
measurements can be performed and
recorded at the touch of a key.
•Up to five (5) job files can be created to
efficiently organize multiple survey tasks.
•Forty (40) feature codes (max.13 charac-
ters each) can be kept in the memory for
easy recall as needed.

The High-performing EDM
•1,500m/4,900ft range with a single prism
under good ambient conditions (40km/
25miles visibility, with no haze, overcast,
no scintillation).
•Outstanding precision;
±(3+2ppmxD)mm. This corresponds to a

deviation of a mere ±3.2mm at a distance
of 100m and ±5mm at 1,000m.
•Supreme speed; only 1.7 seconds initial
measuring time in the rapid measurement
mode.

Average Conditions Good Conditions
CP01 Compact Prism 700 m/2,300 ft.
One AP01 Prism 1,200 m/3,900 ft. 1,500 m 4,900 ft.
Three AP01 Prisms 1,600 m/5,200 ft. 2,000 m 6,500 ft.

Powerful Telescope
•Highest magnification in its class: 30x
•Easy, accurate sighting of prisms or
targets

Outstanding Mobility
•Total carrying weight (including instrument,
tribrach, battery and hard case) is a mere 8
kg/18 lbs. The secret lies in the lightest and
most compact carrying case of its kind

(W390 x D255 x
H220mm / W15.3 x
D10.0 x H8.6in.), making
the SET5F supremely

portable.
•A convenient
shoulder strap is
provided as
standard. An
optional back
pack (SC94) is
ideal for longer
day treks.

Enhanced
Software

The SET5F can be easily customized
to your preferred key assignments.
•The SET5F offers optimum keyboard
flexibility. Any keyboard layout can be
configured. For example, functions can be
assigned to any key position on any page,
and unused functions can be temporarily
deleted.
•A powerful "softkey" feature facilitates
input of coordinate values,
feature codes, etc.

Sophisticated Application Software
Missing Line Measurement (MLM)
•The SET5F measures horizontal distance,
slope distance, height difference, and slope
in percent (%) between two prisms, all at the
touch of a key.

EDM

THEO

S-O

Key assignment mode



The SET5F brings full freedom to survey work.

Remote Elevation Measurement
(REM)
•The SET5F can be used to easily
determine the height of a point where a
prism cannot be placed. The system
sights a prism directly above or below the
target point, and then sights the point
desired.

Angle Repetition
•For enhanced accuracy in the horizontal
angle measurement, the SET5F can
measure in repetition. It then calculates
and displays the average of the multiple
angle measurements.

Azimuth Angle Setting
•Using the coordinates of the instrument
station and a backlight point, the SET5F
can automatically set the horizontal angle
to the azimuth of the backlight.

Resection
•With 2 to 5 known points, the SET5F can
be used to determine the azimuth and
coordinates of the unknown instrument
station.
•When using 2 known points, both angles
and distances are measured. When
using 3 or more points, the distance does
not always have to be measured.

3-D Coordinate Measurement
•The SET5F calculates 3-D coordinate
values of measuring points.
•The operator may choose display settings
either of "N, E, Z" or "E, N, Z."

3-D Setting-out
•The SET5F can be used to perform
3-dimensional setting-out with N, E and/or
Z coordinates.

Offset Measurements
Two basic offset measurement methods
are provided to measure the hidden
points. One calls for input of the offset
distance and the direction between the
measuring point and the prism. The other
uses a prism set on the left or right side of
the measuring point at the same distance
from the SET5F; the angles and distance
to the prism are measured, and the
measuring point is sighted. In both cases,
the SET5F calculates the horizontal and
vertical angles and distance, or the N, E,
Z coordinates.



Standard Configuration
The SET5F comes with two (2) BDC25
rechargeable batteries EDC19 battery
charging adapter CDC27, CDC31 or
CDC31A quick charger, CP7 tubular
compass, sunshade, lens cap, plumb bob,
vinyl cover, tool kit, operator's manual,
carrying case and shoulder strap.

Electronic Field Books
(SDR33/SDR31)
Thanks to its advanced two-way commu-
nications port, the SET5F's functions can
all be accessed by external controller. For
example, by connecting one of the
Sokkia's acclaimed Electronic Field Books
(SDR33 or SDR31), complex field
operations such as traverse adjustment,
intersection, area calculations and roading
can be carried out with remarkable ease.

Optional Accessories
DE17A Diagonal Eyepiece
OF1/OF1A Solar Filters
SC94 Back Pack

Designs and specifications are subject to change without notice.

SOKKIA CO.,LTD.
1-1, TOMIGAYA l-CHOME, SHIBUYA-KU, TOKYO, 151 JAPAN
PHONE +81-3-3465 5211 FAX +81-3-346-5203
INTERNATIONAL DEPT. PHONE +81-3-346-5201 FAX +81-3-3465-5202

SET5F Specifications
Telescope Fully transiting, coaxial EDM
Length 165mm (6.5in)
Objective aperture 45mm (1.8in)
Magnification, image 30x, Erect
Resolving power 3.0"
Field of view 1°30'(26m/1,000m)
Minimum focus 1.3m (4.3ft.)
Reticle illumination Bright or Dim, selectable
Angle measurement Incremental encoder, diametrical detection
Display resolution H&V 1"/ 0.2 mgon/ 0.005 mil, 5"/1 mgon/ 0.02 mil
Angle unit H&V Degree/Gon/Mil
Accuracy H&V 5" (1.5 mgon/ 0.02 mil) according to DIN18723
Dual-axis compensator Liquid dual-axis tilt sensor, range: ±3' (±55 mgon)
Display mode H Clockwise/ Counterclockwise, Repetition, Oset, Hold available

V Zenith 0°/ Horizontal 0°/ Horizontal 0°±90°/ Slope%
Distance measurement Electro-optical with modulated infrared LED.
Measuring range (slope distance) A: Average conditions; slight haze, visibility about 20km(12 miles),

  sunny periods, weak scintillation.
G: Good conditions; no haze, visibility about 40km (25 miles),
  overcast, no scintillation.
Maximum ranges are achieved with Sokkia CP/AP prisms.

With CP01 compact prism A: 1.3m (4.3ft.) to 700m (2,300ft.)
With one AP01 prism A: 1.3m (4.3ft.) to 1,200m (3,900ft.), G: 1,500m (4,900ft.)
With three AP01 prism A: 1.3m (4.3ft.) to 1,600m (5,200ft.), G: 2,000m (6,500ft.)
Distance unit Meters or feet, selectable
Accuracy (Fine measurement) ±(3+2ppmxD)mm D=measuring range, unit=mm
Measuring unit and time Fine 0.001 m Every 3.2 seconds (initial 4.7 seconds)
(slope distance) Rapid 0.001 m 1.7 seconds

Tracking 0.01 m Every 0.3 seconds (initial 1.4 seconds)
Average 0.0001 m (average of 2 to 9 times measurement)

Atmospheric correction Key-in the temperature and pressure, or -499 to +499ppm.
Prism constant -99 to 0mm (1 mm steps)
Refraction & Earth-curvature On/off selectable (K=0.142)
  correction
General
Display LCD dot matrix display (20 characters x 4 lines) on both faces with

  back light.
Keyboard 5 keys on both faces, free assignment of functions.
Resume function On/off selectable
Sensitivity of levels Plate level: 40"/2mm, Circular level: 10'/2mm (in tribrach)
Optical plummet Image: erect, Magnification: 3x, Minimum focus: 0.5m (1.6ft.)
Interface Asynchronous serial, RS-232C compatible, baud rate 1200/

  9600bps
2-way communication Provided
Data storage 3,000-point data memory
Operating temperature -20°C to +50°C (-4°F to +122°F)
Tilting/Trunnion axis height 236mm (9.3in) from tribrach bottom, 193mm (7.6in) from

  tribrach dish.
Size with handle and battery W150 x D165 x H353mm, W5.9 x D6.5 x H13.9in.
Weight with handle and battery 5.4kg (11.9lbs)
Weight of parts BDC25 battery: 240g (8.5oz.), Handle: 100g (3.5oz.),

  Tribrach: 740g (1.6 lbs), Case:2.4kg (5.3lbs)
Power supplies
Battery level display 4 steps with warning message.
Automatic power cut-off On/off selectable (30 minutes after the last operation)
Power source BDC25 rechargeable battery, Ni-Cd 6V, 2 supplied as standard.
Working duration at 25°C (77°F) Distance & angle measurement: about 5 hours, about 600 points
    w/one BDC25 battery (Fine & single measurement with 30 seconds intervals).

Angle measurement only: about 9 hours.
Charging time CDC27/31: about 80 minutes, CDC31A: about 90 minutes
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S220 Hardware Serial Numbers
Unit S/N Comment

POS/MV PCS 846
POS/MV IMU 292
POS/MV Port Ant. SGN 98490013
POS/MV Stbd Ant. CGN 96200099
DGPS Receiver 0426-16627-0001
DGPS Ant.
Reson 81-P Processor (8111) 35652
Reson 81-P Processor (8160) 35385
Reson 8111 Transducer
Reson 8160 Transducer



1010 Hardware Serial Numbers
Unit S/N Comment

POS/MV PCS 788
POS/MV IMU 294
POS/MV Port Ant. SGN 00160051
POS/MV Stbd Ant. SGN 00120116
DGPS Receiver 0331-12579-0008
DGPS Ant.
Reson 81-P Processor 34497
Reson 8101 Transducer 2701011 removed 10/6/04 for repair



1018 Hardware Serial Numbers
Unit S/N Comment

POS/MV PCS 786
POS/MV IMU 323
POS/MV Port Ant. SGN 99330009
POS/MV Stbd Ant. SGN 98370085
DGPS Receiver 0328-12352-0001
DGPS Ant.
Reson 81-P Processor 35737
Reson 8101 Transducer 3102026



Ceeducer Hardware Serial Numbers
Unit S/N Comment

Ceeducer Transducer No S/N visible
Ceeducer GPS Ant. 0238-10468-0004
Ceeducer Processor 409



Trimble Backpack 1 Hardware Serial Numbers
Unit S/N Comment

Pro XRS 0224078543
Antenna 0220341062



Trimble Backpack 2 Hardware Serial Numbers
Unit S/N Comment

Pro XRS 0224090101
Antenna 0220321059



Licenses:
Caris License # On GIS HIPS Notebook Expires Type

CW9604043 FADC2 5 5 5 10/31/05 Red USB
CW9604041 1 1 08/31/05 Purple USB
CW9604042 1 10/31/05 Purple USB

         

ISIS Dongle # On Processor Isis DelphMap DelphNav BathyPro RT Bathy 81XX Server
TEI 03-1525 1018_ACQ 1 1
TEI 03-15250 1018_NAV 1 1 1 1 1
TEI 03-1526 220_ACQ 1 1
TEI 03-15260 220_NAV 1 1 1 1 1
TEI 03-1527 1010_ACQ 1 1
TEI 03-15270 1010_NAV 1 1 1 1 1

Processor Physical #         Pydro License # Expires
FA_Process_1 00-0B-DB-5A-62-2B dea12ac772937d0f31 02/01/05
FA_Process_2 00-11-11-0F-84-44 14fdc8d5d469ffbf3b 02/01/05
FA_Process_3 00-11-11-06-9D-42 14fdc8d5d408bae80e 02/01/05
FA_Process_4 00-01-02-69-5A-45 071585a354707b549a 02/01/05
FA_Process_6 00-0B-DB-56-68-2B dea12ac772909a8c74 02/01/05
FA_Process_8 00-11-11-06-A1-B5 14fdc8d5db7aa97b5e 02/01/05
FA_Process_9 00-0B-DB-56-68-30 dea12ac7732dd4af42 02/01/05
FA_CST 00-11-11-06-A4-68 14fdc8d5d6a1d8ac82 02/01/05
FA_FOO 00-0B-DB-56-68-8C dea12ac778e79bfc91 02/01/05

Fledermaus FLEXid License # Processor
9-45953CB6 2518891E2E69 FA_Process_8
9-65012FEB B18BA0DE2D3F FA_Process_3

MapInfo v7.5 & v7.8 Processor
MUIWEU0750026833 FA_Process_3
MIUWEU0750026834 FA_Process_6
MIUWEU0750025574 FA_CST
# UNKNOWN FA_FOO

GPS Pathfinder S/N
011746-00300-04309-3BAD03D2
024156-00300-05068-0E94DA58

TerraSync Pro S/N
498295-00110-04309-7073A4A7
498295-00110-05068-EBD4EA8B



Isis Sonar:
1010_ACQ 1018_ACQ 220_ACQ FA_Process_4

v.6.5.0 d.u. d.u. d.u. d.u.
v6.5.1 d.u. d.u. d.u. d.u.
v6.6.0 d.u. d.u. d.u. d.u.
v6.7.0 10/01/04 10/01/04 09/20/04 10/01/04

d.u.= date unknown; it was installed, but the date was not documented



Isis DelphNav/DelphMap:
1010_NAV 1018_NAV 220_NAV

v2.10 d.u. d.u. d.u.
v2.11 10/01/04 10/01/04 09/20/04

d.u.= date unknown; it was installed, but the date was not documented



TerraSync:
ToughBook1 ToughTab1 TSCe FA-Mobile1 ToughBook2

v2.40 d.u. d.u. d.u.
v2.41 10/5/2004 10/5/2004 10/5/2004 10/6/2004 10/13/2004

d.u.= date unknown; it was installed, but the date was not documented



Pathfinder:
ToughBook1 ToughTab1 FA-Mobile1 ToughBook2 Olab

v3.00 9/30/2004 10/4/2004 d.u. 10/13/2004 d.u.

d.u.= date unknown; it was installed, but the date was not documented



CARIS HIPS & SIPS:
FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_6 FA_Process_8 FA_Process_9 FA_CST FA_FOO Comments

v5.4 full 05/05/04 08/02/04 08/02/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/11/04

HF1 06/14/04

HF2 06/14/04

HF3 06/14/04

HF4 06/14/04

HF5 06/14/04

HF6 06/14/04

HF7 06/14/04

HF8 06/14/04

HF9 06/14/04

HF10 06/14/04

HF11 06/14/04

HF12 06/14/04

HF13 06/17/04

HF14 06/18/04

HF15
SP1 07/27/04 08/02/04 08/03/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/26/04

SP1+HF1 07/27/04 08/02/04 08/03/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/26/04

SP1+HF2 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/26/04

SP1+HF3 08/04/04 08/04/04 08/05/04 08/04/04 09/11/04 08/04/04 08/06/04 08/04/04 08/26/04

SP1+HF4 08/26/04 08/26/04 08/26/04 08/26/04 09/11/04 08/26/04 08/26/04 08/26/04 08/26/04

SP1+HF5 08/26/04 08/26/04 08/26/04 08/26/04 09/11/04 08/26/04 08/26/04 08/26/04 08/26/04

SP1+HF6 08/26/04 08/26/04 08/26/04 08/26/04 09/11/04 08/26/04 08/26/04 08/26/04 08/26/04

SP1+HF7 08/26/04 08/26/04 08/26/04 08/26/04 09/11/04 08/26/04 08/26/04 08/26/04 08/26/04

SP1+HF8 10/06/04 10/07/04 09/26/04 10/08/04 09/23/04 09/22/04 09/23/04 10/07/04 10/07/04

SP1+HF9 10/06/04 10/07/04 09/26/04 10/08/04 09/23/04 09/22/04 09/23/04 10/07/04 10/07/04

SP1+HF10 10/06/04 10/07/04 10/07/04 10/08/04 10/07/04 10/05/04 10/07/04 10/07/04 10/07/04

SP1+HF11 10/06/04 10/07/04 10/07/04 10/08/04 10/07/04 10/05/04 10/07/04 10/07/04 10/07/04

SP1+HF12 10/06/04 10/07/04 10/07/04 10/08/04 10/07/04 10/05/04 10/07/04 10/07/04 10/07/04

SP1+HF14 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04



CARIS Utilities:
FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_6 FA_Process_8 FA_Process_9 FA_CST FA_FOO Comments

LUv2.1.0 05/05/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

CPCR v2.0 06/14/04 08/02/04 08/02/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/11/04

EasyENCv3.0 11/05/04 10/07/04 10/07/04 10/08/04 09/23/04 10/08/04 09/23/04 10/07/04 10/07/04



CARIS GIS:
FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_6 FA_Process_8 FA_Process_9 FA_CST FA_FOO Comments

v4.4a 05/05/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

LUv2.1.0 05/05/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4 05/05/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF1 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF2 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF3 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF4 06/17/04 08/02/04 05/05/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF5 06/17/04 08/02/04 08/03/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF6 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF7 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF8 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF9 08/26/04 08/26/04 08/26/04 08/26/04 09/11/04 08/26/04 08/26/04 08/26/04 08/26/04

SP4+HF10 08/31/04 08/31/04 08/31/04 08/31/04 09/11/04 08/31/04 09/01/04 08/31/04 09/01/04

SP4+HF11 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF12 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF13 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF14 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF15 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04 11/06/04



CARIS Notebook:
FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_6 FA_Process_8 FA_Process_9 FA_CST FA_FOO Comments

v2.1 05/14/04 08/06/04 08/09/04 08/06/04 09/11/04 08/02/04 08/06/04 08/06/04 08/13/04

SP1 06/23/04 08/06/04 08/09/04 08/06/04 09/11/04 08/02/04 08/06/04 08/06/04 08/13/04

SP1+HF1 08/06/04 08/06/04 08/09/04 08/06/04 09/11/04 08/06/04 08/06/04 08/06/04 08/13/04



Pydro:
FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_6 FA_Process_8 FA_Process_9 FA_CST FA_FOO Comments

v4.5.1 06/14/04
v4.6.1 08/03/04 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04 08/06/04 08/13/04
v4.6.1patches 08/03/04 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04 08/06/04 08/13/04
v4.7.1 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04 08/06/04 08/13/04
v4.8.2 08/26/04 08/26/04 08/25/04 08/26/04 08/26/04 08/26/04 08/26/04 08/26/04
v4.8.3 08/31/04 08/31/04 08/31/04 08/31/04 08/31/04 09/01/04 08/31/04 09/01/04
v4.9.0 09/12/04 09/12/04 09/12/04 09/12/04 09/12/04 09/12/04 09/12/04
v4.9.1 09/30/04 10/04/04 10/04/04 10/08/04 10/07/04 10/5/2004 10/07/04 10/07/04 10/07/04
v4.9.1a 10/04/04 10/04/04 10/04/04 10/08/04 10/07/04 10/05/04 10/07/04 10/07/04 10/07/04 You can import GP's w/ this version
v4.9.3 11/27/04 11/27/04 11/19/04 11/27/04 11/27/04 11/27/04 11/27/04 11/27/04 11/27/04



Velocwin:
OLAB 1010_NAV 1018_NAV Comments

v8.5.2 07/31/04 8/10/2004 8/12/2004
v8.6.0 doesn't apply directly to us



Fledermaus:
FA_Process_3 FA_Process_8 FA_FOO Comments

v6.1.0 07/28/04 07/28/04
V6.1.1 08/03/04 08/03/04 08/13/04
v6.1.2c 10/05/04 10/07/04 10/07/04 The keys alternate btwn, 3 & 8 currently have them



MapInfo:
FA_Process_1 FA_CST FA_Process_3 FA_FOO FA_Process_6 Comments

v7.5 (4) 06/15/04 08/04/04 07/30/04 09/01/04 10/07/04 Removed from FA_Process_1
v7.8 Update to v7.5, only 2 licenses



HVF Update Made Locations Pushed To Date DN Comments By
1010_8101 Initial Creation of HVF for 1010 Local Drive Processor 3, Fa-proc (testing data) 5-Aug-2004 218 Needs Dynamic draft, Patch values GF
1010_8101 Input Dynamic Draft Table Local Drive Processor 3, Fa-proc (testing data) 17-Aug-2004 230 Needs patch values, Loading Std. Dev GF
1010_8101 Updated Dynamic Draft Table (245 entry date) from testing to H11362, H11363 10-Sep-2004 254 used DDSSM values confirmed w/ all 3 stop pts LM
1010_8101 Changed value of Position Nav Std. Dev to 0.5 from H11362 to Testing, H11363 20-Sep-2004 264 As per POS/MV spec sheet GF
1010_8101 copied to H11334, H11335, H11369 26-Sep-2004 270 moved into vsl config folders for OPR-O193, Rudyerd LM
1010_8101 Updated values based on Rudyerd patch test 293 Updated testing and copied to H11334, H11335, H11369 20-Oct-2004 294 Changed Transducer MW
1010_8101 input dynamic draft std dev Updated testing and copied to H11334, H11335, H11369 20_oct-2004 294 updated tpe for delta draft std dev GF
1010_8101 changed roll bias value to 1.07 updated H11369 9-Nov-2004 314 backdated to Dn313 GF
1010_8101 changed roll bias value to 1.07 updated H11334 15-Nov-2004 314 backdated to Dn313 GF
1010_8101 copied H11334 hvf to all projects for data management H11335, H11369, H11362 15-Nov-2004 320 GF
1010_8101 copied H11334 hvf to testing data for data mngmnt Testing Data 12-Jan-2005 LM



HVF Update Made Locations Pushed To Date DN Comments By
1018_8101 Initial Creation of HVF for 1018 Local Drive Processor 3 5-Aug-2004 218 Needs Dynamic draft, Patch values, Loading Std. Dev GF
1018_8101 Update TPE Offsets, Input Dummy Dynamic Draft Local Drive Processor 3, Fa-proc (testing data) 25-Aug-2004 238 Needs Real Dynamic Draft, Patch values, Loading Std. Dev GF
1018_8101 Inputed Dynamic Draft Table (215 entry date) from testing to H11362, H11363 9-Sep-2004 253 used DDSSM values, used only 1 stop pt LM
1018_8101 Changed value of Position Nav Std. Dev to 0.5 from H11362 to Testing, H11363 20-Sep-2004 264 As per POS/MV spec sheet GF

1018_8101 Changed value of Sensor Time Errors to 0.1, removed  -0.1 
from Swath 1 from H11362 to Testing 23-Sep-2004 267 swapped latency values from swath to sensors GF

1018_8101 copied to H11334, H11335, H11369 26-Sep-2004 270 moved into vsl config folders for OPR-O193, Rudyerd LM
1018_8101 Calc'd Patch & Applied New Values for reattached ducer copied to H11334, H11335, H11369 4-Nov-2004 310 moved into vsl config folders for OPR-O193, Rudyerd MW
1018_8101 corrected x value for IMU 2 Ducer (TPE and Swath 1) copied to H11334, H11335, H11369, H11362 8-Nov-2004 313 moved into vsl config folders for Rudyerd, Descision GF
1018_8101 X 0.272 changed to 0.302 (TPE and Swath 1) as above testing data updated to match project HVFs 12-Jan-2005 sign error on x value fixed 



HVF Update Made Locations Pushed To Date DN Comments By
S220_8111 Initial Creation of HVF for 8111 Local Drive Processor 3 5-Aug-2004 218 Needs Dynamic draft, Patch values GF
S220_8111 Updated device model to 8111 Local Drive Processor 3 31-Aug-2004 244 Needs Dynamic draft, Patch values GF
S220_8111 " Fa-proc (Testing Data) 7-Sep-2004 251 Needs Dynamic draft, Patch values GF
S220_8111 Changed value of Position Nav Std. Dev to 0.5 to Testing 20-Sep-2004 264 As per POS/MV spec sheet GF
S220_8111 Updated HVF w/ Cape Decision Patch values in Testing & copied  to H11362 20-Sep-2004 264 Dn 260 Patch test - Cape Decision LM
S220_8111 copied to H11334, H11335, H11369 26-Sep-2004 270 moved into vsl config folders for OPR-O193, Rudyerd LM
S220_8111 (TPE) Changed MRU to Trans Z from 4.585 to 4.753 in testing data & to be used from Dn 218 for all data 12-Jan-2005 Error Base of IMU to Top of IMU not acct'd for LM
S220_8111 (TPE) Changed NAV to Trans X from 2.868 to 2.993 in testing data & to be used from Dn 218 for all data 12-Jan-2005 Error in interpretation of TPE value LM
S220_8111 (TPE) Changed NAV to Trans Y from 8.252 to 19.145 in testing data & to be used from Dn 218 for all data 12-Jan-2005 Error in interpretation of TPE value LM
S220_8111 (TPE) Changed NAV to Trans Z from 4.585 to 16.253 in testing data & to be used from Dn 218 for all data 12-Jan-2005 Error in interpretation of TPE value LM
S220_8111 WaterlineHeight changed from -0.07 to 0.074 in testing data & to be used from Dn 218 for all data 12-Jan-2005 Error in sign of measurement LM
S220_8111 Tstg HVF copied to H11362, H11334, H11335, H11369 12-Jan-2005 all data for S220_8111 to be remrgd, TPE recmptd & BASE surfaces recmptd LM



HVF Update Made Locations Pushed To Date DN Comments By
S220_8160 Initial Creation of HVF for 8160 Local Drive Processor 3 5-Aug-2004 218 Needs Dynamic draft, Patch values GF
S220_8160 updated value for MRU to Trans Z in Testing 28-Oct-2004 302 offset from base to top of IMU not accounted for previously GF
S220_8160 updated value for NAV to Trans Z, Trans Y in Testing 28-Oct-2004 302 bad values GF



HVF Update Made Locations Pushed To Date DN Comments By
Ceeducer Initial Creation of HVF for Ceeducer VBES Local Drive Processor 3, Fa-proc (testing data) 14-Sep-2004 257 No Offsets, offsets in Ceeducer itself GF
Ceeducer copied to H11334, H11335, H11369 26-Sep-2004 270 moved into vsl config folders for OPR-O193, Rudyerd LM
Ceeducer Added SVP copied to H11334, H11335, H11369, H11362 30-Sep-2004 274 moved into vsl config folders for OPR-O193, Rudyerd, O167 GF



HVF Update Made Locations Pushed To Date DN Comments By
TRB1_DPNE Initial Creation of HVF for Trimble backpack DP's Tstg Data, H11362, H11334, H11335, H11369 30-Sep-2004 274 No Offsets, Backdated to Dn221 GF



HVF Update Made Locations Pushed To Date DN Comments By

TRB1_DPES Initial Creation of HVF for Trimble backpack 
Echosounder DP's in Tstg Data mvd to H11362, H11334, H11335, 

H11369
4-Oct-2004 278

Based on R7SB_03 from Rainier. No Offsets, 
Backdated to Dn221. RP is located on the pole at 

the waterline.
lm



HVF Update Made Locations Pushed To Date DN Comments By
TRB2_DPNE Initial Creation of HVF for Trimble backpack DP's in Tstg Data, H11362, H11334, H11335, H11369 25-Oct-2004 274 No Offsets, Backdated to Dn221 LM



HVF Update Made Locations Pushed To Date DN Comments By
TRB2_DPESInitial Creation of HVF for Trimble backpack Echosounder 

DP's
in Tstg Data mvd to H11362, H11334, H11335, 
H11369

25-Oct-2004 278 Based on R7SB_03 from Rainier. No Offsets, Backdated to Dn221. RP is located on the pole at the 
waterline.

LM



Appendix III 
 
 
Vessel Reports, Offsets, and Diagrams 

 
 

Launch 1010 
   Vessel Report 

1      HVF 
2      Offsets 
3      Patch Test 
4      DDSSM and Settlement and Squat 
5      POS Gams Calibration 
6      Wire Diagram 
 
 
Launch 1018  

   Vessel Report 
1      HVF 
2      Offsets 
3      Patch Test 
4      DDSSM and Settlement and Squat 
5      POS Gams Calibration 
6      Wire Diagram 
 
 
S220  

   Vessel Report 
1      HVF 
2      Offsets 
3      Patch Test 
5      POS Gams Calibration 
6      Wire Diagram 
 
 

 



NOAA SHIP FAIRWEATHER 

N

                                         

NOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001100  
CCAALLIIBBRRAATTIIOONN  RREEPPOORRTT  22000044 

Compiled by: SST Grant Froelich 
 

 
Background: 
NOAA Hydrographic Survey Launch (HSL) 1010 is a high speed, 29’ aluminum 
Jensen survey launch.  It is equipped with a Reson 8101 SWMB system 
mounted on a swing mount to the starboard of the keel and approximately 
centered fore and aft.  The Reson 8101 operates at a frequency of 240 kHz and 
has a variable ping rate dependant upon depth.  The maximum ping rate is user 
set to 20 Hz.  The Reson 8101 has 101 1.5° x 1.5° beams and has an effective 
range of 120m depth.  Multibeam data is collected in XTF format using TEI Isis 
Sonar v6.6.  NOAA HSL 1010 is equipped with an Applanix Position and 
Orientation system for Marine Vessels (POS MV) 320 Version 3 consisting of a 
IMU-200 strap-down inertial measurement unit (IMU), a version 2.10d POS 
computer system (PCS) and two NovAtel GPS antennas. Differential correctors 
are supplied to the POS MV by a CSI wireless MBX-3S Automatic Differential 
GPS receiver. Sound velocity correctors are obtained by a SeaBird SeaCat SBE 
19plus sound velocity profiler.  NOAA HSL 1010 is also configured with Applanix 
TrueHeave1 and “Precise Timing”2.  Residual biases in sensor misalignment 
were assessed in CARIS HIPS & SIPS v5.4 (SP 1, HF’s 1-7) calibration mode 
and applied to the HIPS Vessel File (HVF), 1010_8101.HVF.     
 
Location, Date, Personnel: 
Patch Test 
Multiple patch tests were attempted with NOAA HSL 1010 in several different 
locations at the beginning of the 2004 field season.  Due to various different mis-
entries and mis-configurations, none of these were accepted into the final 
1010_8101.HVF.  The patch test conducted in the vicinity of Ketchikan, AK in 

        Figure 1.  Location of Heading, Roll and Pitch Lines 
1 Applanix web site. http://www.applanix.com. June 2004 
2 Evans, Ben, LTJG, NOAA. Upgrading NOAA Multibeam Acquisition Systems to “Precise Timing”. May 

2004 

 - 1 - 



NOAA SHIP FAIRWEATHER 

Tongass Narrows and Blank Inlet on September 1st (Dn245) was accepted and 
processed for residual biases.  The heading bias patch was conducted over a 
wreck lying in an average depth of 42m with a least depth of 24m at 
55°19’56.21”N, 131°37’52.09”W. The roll bias patch was conducted over a flat 
area in approximately 60m of water at location 55°16’50.70”N, 131°40’06.47”W. 
The pitch bias patch was conducted in the same area on a 10m shoal (see 
Figure 1). The patch data was collected by SST Abrams, ENS Higgins, and LTJG 
Van Waes. The patch biases were processed by CST Morgan, SST Abrams, LT 
Wetzler, and PS Sampadian. 
 
Dynamic Draft 
Due to a mechanical malfunction, dynamic draft was not able to be collected on 
the same day.  Dynamic draft lines were collected at location 55°12’58.36”N, 
131°43’24.71”W in approximately 10m of water on September 3rd (Dn 247) (see 
Figure 2).  The dynamic draft data was collected by SST Froelich, ENS Higgins 
and LT Wetzler. The dynamic draft data was processed using the Dynamic Draft 
Settlement and Squat Method (DDSSM) by LT Wetzler. 
 

 
Figure 2.  Location of Dynamic Draft 

GAMS Calibration 
POS MV GPS Azimuth Measurement Subsystem (GAMS) calibration occurred 
on August 27th (Dn240) in Ketchikan, Alaska.  GAMS calibration was performed 
by SST Abrams, LT Wetzler and PS Sampadian.   
 
 
Procedure: 
All patch test and dynamic draft lines were “lightly” cleaned in CARIS swath 
mode to remove major data fliers.  SVP and observed tides were applied.   
 
Patch 
Sensor Latency: One line from the dynamic draft or roll patch data was selected 
for latency biases. It was determined that either dynamic draft or roll data was 
suitable for sensor latency bias evaluation after examining previous patch test 
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data.  Those who chose to look at a dynamic draft line also looked at a roll line 
for comparison.  The lines were reviewed in CARIS calibration mode 
independently by CST Morgan, SST Abrams, LT Wetzler and PS Sampadian to 
determine the bias.  Final values entered into 1010_8101.HVF were based on a 
consensus value between those involved.  
 
Pitch: One pair of coincident lines was run over a shoal of 10m at the same 
speed in different directions.  The lines were run at 5 knots. The lines were 
reviewed in CARIS calibration mode independently by CST Morgan, SST 
Abrams, LT Wetzler and PS Sampadian to determine the pitch bias.  Final values 
entered into 1010_8101.HVF were based on a consensus value between those 
involved. 
  
Roll: One pair of coincident lines was run over a flat area approximately 60m 
deep at the same speed in different directions.  The lines were run at 6 knots.  
The lines were reviewed in CARIS calibration mode independently by CST 
Morgan, SST Abrams, LT Wetzler and PS Sampadian to determine the roll bias.  
Final values entered into 1010_8101.HVF were based on a consensus value 
between those involved. 
 
Heading: One pair of parallel lines offset by 120m was run in opposite directions 
at the same speed over a known target.  The lines were run at 6 knots. The lines 
were reviewed in CARIS calibration mode independently by CST Morgan, SST 
Abrams, LT Wetzler and PS Sampadian to determine the heading bias.  Final 
values entered into 1010_8101.HVF were based on a consensus value between 
those involved. 
 
The patch test acquisition and processing logs for Dn#245 are located in 
Appendix III-1010-3. 
 

Patch Bias Bias value 
Sensor Latency 

Pitch 
Roll 

Heading 

0.00 sec 
-0.90° 
-0.38° 
-0.32° 

Table 1. Patch Test Bias Result 
 
Dynamic Draft
One line was run nine times in the same direction but at different speeds.  Six 
lines were collected at speeds ranging from 4.8 knots to 14.5 knots at an average 
depth of 13m.  At three points along the line, data was collected with the engine 
in idle.  The lines were reviewed in CARIS by LT Wetzler and statistical 
comparisons between the speeds and δ draft were made using Microsoft Excel.  
The dynamic draft, settlement and squat spreadsheet, 1010_DDSSM.xls, is 
located in Appendix III-1010-4. 
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Speed (knots) Delta Draft (m) 
0.0 
4.8 
5.6 
7.8 

10.3 
11.7 
14.5 

0.000 
0.079 
0.118 
0.137 
0.022 
-0.198 
-0.378 

Table 2.Dynamic Draft Results 
 
POS MV GAMS Calibration 
The GAMS heading calibration threshold was initially set to 0.300°.  NOAA HSL 
1010 was maneuvered in “figure 8’s” to lower the heading accuracy as much as 
possible.  The best heading accuracy value achieved during this process was 
0.237°.  The vessel steadied up on a constant heading and GAMS calibration 
was requested. The vessel maintained the constant heading until the calibration 
was complete. The POS MV settings were then saved to the file 
POSMV_Settings_082704.nvm (see Table 3).   
 

 

Component Value 
Baseline Vector X 
Baseline Vector Y 
Baseline Vector Z 

Two Antenna Separation 
Heading Correction 

0.004 m 
1.841 m 
0.030 m 
1.841 m 
0.000 ° 

Table 3. POS MV GAMS Calibration Results 
 
The detailed POS/MV Calibration Report, 1010_POS_Calibration_082704.xls, is 
located in Appendix III-1010-5. 
 
Recommendations: 
These patch test calibration results should be used from September 1st, 2004 (Dn 
245) and should be used until such a time or event warrants a new calibration.   
 
These dynamic draft results should be used from September 3rd, 2004 (Dn 247) 
and should be used until such a time or event warrants a new test. 
 
These POS MV GAMS calibration results should be used from August 27th, 2004 
(Dn240) and should be used until such a time or event warrants a new 
calibration. 
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ADDENDUM 1 
NOAA HYDROGRAPHIC SURVEY LAUNCH 1010 

PATCH TEST REPORT OCTOBER 2004 
ST Jennifer Keene 

 
Background: 
Residual biases for NOAA Hydrographic Survey Launch (HSL) 1010 were 
assessed in CARIS HIPS & SIPS v5.4 calibration mode and applied to the HIPS 
Vessel File (HVF), 1010_8101.HVF.     
 
The transducer from HSL 1018 was transferred to HSL 1010 on October 18, 
2004, because the original 1010 transducer had been removed for repairs.  This 
swap required that the patch test biases be recalculated for HSL 1010. 
 
Location, Date, Personnel: 
The patch test was conducted on October 19th (DN 293) in Punchbowl Cove, off 
of Rudyerd Bay in Alaska.  All data were acquired in the vicinity of 55°31’46”N, 
130°46’46”W (See Figure 1).  ST Keene, AST Kellner and LT Wetzler acquired 
the patch data.  The data were processed in CARIS 5.4 for residual biases by ST 
Keene, AST Kellner, LT Wetzler, SST Froelich and ENS Higgins.     
 
Dynamic Draft, Settlement & Squat data were not acquired at this time.  
Correctors from the September 3rd (DN 247) DDSSM data set should continue to 
be used in the HVF. 
 
 

 
 Figure 1  Location of Patch Test Lines 

 
Equipment: 

1  Reson 8101 Shallow Water Multibeam Echosounder 
1  Applanix POS/MV Version 3.20 Strap-Down IMU 
2  Novatel GPS Antennas 
1  CSI wireless MBX-3S Automatic Differential GPS receiver 
1  Seabird Seacat SBE 19plus sound velocity profiler 
 TEI Isis Sonar v6.6 w/ BathyPro Real Time Bathymetry 
 CARIS HIPS & SIPS v5.4 SP1, HF’s1-12 
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Procedure: 
All lines: All lines were “lightly” cleaned in CARIS Swath Editor to get rid of major 
data fliers.  SVP and Zero Tides were applied.   
 
Sensor Latency: Sensor latency data were acquired by turning the boat into its 
own wake and then putting it into neutral while data was acquired, in order to 
generate roll in the outer beams.  The lines were reviewed in CARIS calibration 
mode independently by the processing personnel listed above, in order to 
determine the bias.  Final values entered into 1010_8101.HVF were based on an 
average value of the individual results. Roll Time error was applied to Nav Time, 
Gyro Time and Pitch Time errors in the 1010_8101.HVF. 
 
Pitch: One pair of coincident lines was run over a known rock on a slope at the 
same speed in different directions.  The lines were run at eight knots. The lines 
were reviewed in CARIS calibration mode independently by processing 
personnel in order to determine the pitch bias.  Final values entered into 
1010_8101.HVF were based on an average value of the individual results. 
  
Roll: One pair of coincident lines was run over an area approximately 60m deep 
at the same speed in different directions.  The lines were run at eight knots.  The 
lines were reviewed in CARIS calibration mode independently by the processing 
personnel in order to determine the roll bias.  Final values entered into 
1010_8101.HVF were based on an average value of the individual results. 
 
Heading: Two parallel lines offset by approximately 120m were run in opposite 
directions at the same speed over a known rock.  The lines were reviewed in 
CARIS calibration mode independently by processing personnel, as well as CST 
Morgan, in order to determine the heading bias.  Final values entered into 
1010_8101.HVF were based on a consensus value between those involved. 
 
The patch test acquisition and processing logs for Dn#293 are located in 
Appendix III-1010-3. 
 
Results: 
The following table displays the results of this patch test, as well as the previous 
patch test, conducted in September. 
 

PATCH BIAS SEPTEMBER BIAS VALUE OCTOBER BIAS VALUE 
SENSOR LATENCY 

PITCH 
ROLL 

HEADING 

0.00 sec 
-0.90° 
-0.38° 
-0.32° 

0.01 sec 
-0.43° 
0.23° 
-0.30° 

 
Table 1  Patch test bias results 
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Recommendations: 
The topography of the Punchbowl Cove is steep and deep, making it difficult to 
find a suitable location for the roll bias patch.  The area in which the roll bias 
patch was conducted was not as flat as desired.  This portion of the patch test 
may need to be repeated in a different area.   
 
These patch test calibration results should be used from October 19th, 2004 (DN 
293) until such a time or event warrants a new calibration.   
 
The DDSSM results from September 3rd, 2004 (DN 247) should continue to be 
used until such a time or event warrants a new test. 
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ADDENDUM 2 
NOAA HYDROGRAPHIC SURVEY LAUNCH 1010 

PATCH TEST REPORT OCTOBER 2004 
LT Mark Wetzler 

 
Background: 
Residual biases for NOAA Hydrographic Survey Launch (HSL) 1010 were 
assessed in CARIS HIPS & SIPS v5.4 calibration mode and applied to the HIPS 
Vessel File (HVF), 1010_8101.HVF.     
 
As noted in Addendum 1 a transducer was attached to launch 1010, which was 
subsequently patch tested on October 19th, 2004 (DN 293).  Around day 298 
there was a suspicion that problems existed with the launches roll bias value.  
This was difficult to determine as there were also some extreme sound velocity 
issues present with the data.  Once the data from DN 308 was processed it was 
apparent that there was a problem with the roll bias value.  An investigation of 
the launch turned up 2 loose bolts which held the swing arm transducer mount in 
place.  This prompted a roll bias test to be conducted on the next operational 
day. 
 

Day 
Number Sheet(s) Roll Bias Comment 

293 Patch Test 0.23 Patch Test for Initial Bias 
294 H11335 0.23  
295 H11335 0.23  
296 H11335 0.23  
297 H11334 0.23  
298 H11334 0.43 Roll Bias Calc From Data 
299 H11334, H11335 1.00 Roll Bias Back Dated From DN 313
313 H11369 1.07 Roll Bias Calc From Testing 

Table 1, Launch 1010 Roll Bias and Usage 
  
Location, Date, Personnel: 
 
The roll bias tests were conducted on November 8th, 2004 (DN 313) in the vicinity 
of New Eddystone Rock at 55°30'08.58" N  130°55'21.24" W.   LT Wetzler, ENS 
Higgins and AST Kellner acquired the roll bias data.  Data was processed in 
CARIS 5.4 and a value was determined by LT Wetzler. 
 
Dynamic Draft, Settlement & Squat data were not acquired at this time.  
Correctors from the September 3rd (DN 247) DDSSM data set should continue to 
be used in the HVF. 
 
 

Equipment: 
1  Reson 8101 Shallow Water Multibeam Echosounder 
1  Applanix POS/MV Version 3.20 Strap-Down IMU 
2  Novatel GPS Antennas 
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1  CSI wireless MBX-3S Automatic Differential GPS receiver 
1  Seabird Seacat SBE 19plus sound velocity profiler 
 TEI Isis Sonar v6.6 w/ BathyPro Real Time Bathymetry 
 CARIS HIPS & SIPS v5.4 SP1, HF’s1-12 

Procedure: 
All lines: All lines were “lightly” cleaned in CARIS Swath Editor to get rid of major 
data fliers.  SVP and Zero Tides were applied.   
 
Roll: Prior to testing, the bolts on the swing arm mount were securely tightened.  
The testing consisted of acquiring data over a single line with a depth of 200 m.  
Four lines were run, 2 in the morning and 2 in the evening.  On each set, the line 
was run at 8 knots and in opposite directions.    
 
All other biases were kept static as they were not affected by the athwartships 
stability issues of the swing arm mount. 
 
Results: 
Data were examined from both the morning test and evening test.  It was noted 
that from the start of the day to the end of the day, the roll bias value changed by 
0.15°, from 1.00° to 1.15°.  The average value of 1.07° was entered in the HVF 
for DN 313. 
 
The following table displays the results of this patch test, as well as the previous 
patch test, conducted in September. 
 
 

PATCH BIAS SEPTEMBER BIAS 
VALUE 

OCTOBER BIAS 
VALUE 

DN 313 

SENSOR LATENCY 
PITCH 
ROLL 

HEADING 

0.00 sec 
-0.90° 
-0.38° 
-0.32° 

0.01 sec 
-0.43° 
0.23° 
-0.30° 

0.01 sec 
-0.43° 
1.07° 
-0.30° 

 
Table 2  Patch test bias results 

 
 
Implications of DN 313 Roll Bias Testing and resulting changes to the 1010 
HVF 
 
Once the magnitude of the roll bias issue was realized, prior data were reviewed.  
Data quality issues that were previously attributed to SV errors were found to 
also be partially due to roll bias errors.   
 
Data were systematically examined by ST Keene in an effort to find locations 
within the previously acquired main scheme data that could be used for roll bias 
calibrations.  In the data set from October 24, 2004 (DN 298), there were two 
lines of data acquired in opposite directions, which overlapped each other.  
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These lines were used to perform a roll bias calibration in CARIS Calibration 
Editor.  The roll bias in the HVF for Launch 1010 was changed from 0.23° to 
0.43° for DN 298.   
 
This roll bias value of 0.43° was not large enough to correct errors in data 
acquired after DN 298.  Therefore, the bias determined from the patch test 
conducted on the morning of DN 313 was used.  A roll bias value of 1.00° was 
entered in the HVF, back dated to DN 299.  The morning value was used instead 
of the averaged value from DN313, because it was closer in time to the data to 
which it was being applied. 
 
Recommendations: 
These roll bias results should be used for the 1010 HVF and are the best 
solutions which can be deduced by the hydrographer.  The swing arm mount for 
the transducer needs to be re-engineered for stability and tested before the 
beginning of the CY 2005 field season. 
 
The DDSSM results from September 3rd, 2004 (DN 247) should continue to be 
used until such a time or event warrants a new test. 
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Vessel Name: 1010_8101.hvf 
Vessel created: December 09, 2004 
 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2004-218 00:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.900 
 Roll Offset: -0.380 
 Azimuth Offset: -0.320 
 
 DeltaX: 0.262 
 DeltaY: -0.151 
 DeltaZ: 0.546 
 
 Manufacturer:  Reson 
 Model:   sb8101 
 Serial Number:  (null) 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2004-293 00:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.430 
 Roll Offset: 0.230 
 Azimuth Offset: -0.300 
 
 DeltaX: 0.262 
 DeltaY: -0.151 
 DeltaZ: 0.546 
 
 Manufacturer:  Reson 
 Model:   sb8101 
 Serial Number:  3102020 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2004-298 01:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.430 
 Roll Offset: 0.430 
 Azimuth Offset: -0.300 
 
 DeltaX: 0.262 
 DeltaY: -0.151 
 DeltaZ: 0.546 
 



 Manufacturer:  Reson 
 Model:   sb8101 
 Serial Number:   
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2004-299 01:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.430 
 Roll Offset: 1.000 
 Azimuth Offset: -0.300 
 
 DeltaX: 0.262 
 DeltaY: -0.151 
 DeltaZ: 0.546 
 
 Manufacturer:  Reson 
 Model:   sb8101 
 Serial Number:   
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2004-313 00:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.430 
 Roll Offset: 1.070 
 Azimuth Offset: -0.300 
 
 DeltaX: 0.262 
 DeltaY: -0.151 
 DeltaZ: 0.546 
 
 Manufacturer:  Reson 
 Model:   sb8101 
 Serial Number:   
 
_________________________________________________________ 
Navigation Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Latency 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  788 
 



_________________________________________________________ 
Gyro Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Latency 0.000 
 
_________________________________________________________ 
Heave Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments TrueHeave Enabled 
 Apply Yes 
 Latency 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV V320 
 Serial Number:  788 
 
_________________________________________________________ 
Pitch Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Apply Yes 
 Latency 0.000 
 Pitch offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  788 
 
_________________________________________________________ 
Roll Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Apply Yes 
 Latency 0.000 
 Roll offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  788 
 
_________________________________________________________ 
Draft Sensor: 
 
 Time Stamp:  2004-218 00:00 
 



 Apply Yes 
 Comments (null) 
 Entry 1) Draft: 0.000 Speed: 0.000 
 Entry 2) Draft: -0.026 Speed: 4.000 
 Entry 3) Draft: -0.032 Speed: 6.000 
 Entry 4) Draft: -0.039 Speed: 8.000 
 Entry 5) Draft: 0.032 Speed: 10.000 
 Entry 6) Draft: 0.161 Speed: 12.000 
 Entry 7) Draft: 0.273 Speed: 14.000 
 
 Time Stamp:  2004-245 00:00 
 
 Apply Yes 
 Comments DDSSM 
 Entry 1) Draft: 0.000 Speed: 0.000 
 Entry 2) Draft: 0.079 Speed: 4.800 
 Entry 3) Draft: 0.118 Speed: 5.600 
 Entry 4) Draft: 0.137 Speed: 7.800 
 Entry 5) Draft: 0.022 Speed: 10.300 
 Entry 6) Draft: -0.198 Speed: 11.700 
 Entry 7) Draft: -0.378 Speed: 14.500 
_________________________________________________________ 
TPE 
 
 Time Stamp:  2004-218 00:00 
 
 Comments need loading 
 Offsets  
 
 Motion sensing unit to the transducer 1  
  X Head 1 0.262 
  Y Head 1 -0.151 
  Z Head 1 0.546 
 Motion sensing unit to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 Navigation antenna to the transducer 1 
  X Head 1 1.159 
  Y Head 1 1.048 
  Z Head 1 3.687 
 Navigation antenna to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 
 Roll offset of transducer number 1 0.000 
 Roll offset of transducer number 2 0.000 
 
 Heave Error: 0.050 or 5.000'' of heave amplitude. 
 Measurement errors: 0.007 
 Motion sensing unit alignment errors 
 Gyro:0.000 Pitch:0.000 Roll:0.000 
 Gyro measurement error: 0.020 
 Roll measurement error: 0.020 
 Pitch measurement error: 0.020 
 Navigation measurement error: 0.500 



 Transducer timing error: 0.001 
 Navigation timing error: 0.001 
 Gyro timing error: 0.001 
 Heave timing error: 0.001 
 PitchTimingStdDev: 0.001 
 Roll timing error: 0.001 
 Sound Velocity speed measurement error: 0.500 
 Surface sound speed measurement error: 0.500 
 Tide measurement error: 0.010 
 Tide zoning error: 0.000 
 Speed over ground measurement error: 0.030 
 Dynamic loading measurement error: 0.000 
 Static draft measurement error: 0.050 
 Delta draft measurement error: 0.040 
_________________________________________________________ 
Svp Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.262 
 DeltaY: -0.151 
 DeltaZ: 0.546 
 
_________________________________________________________ 
WaterLine: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Apply Yes 
 WaterLine -0.253 
 WaterLineStdDev 0.000 
_________________________________________________________ 



Summary of Measurements:
Measurement IMU to RP* 8101 to RP* IMU to 8101 Port Ant to 8101 RP* to Waterline
Coord. Sys. Caris Caris Caris Caris Caris
x 0.000 0.262 0.262 1.159 n/a
y 0.000 -0.151 -0.151 1.048 n/a
z 0.000 0.546 0.546 3.687 -0.25

*IMU is RP (Reference Pt)

Vessel Offsets for 1010_8101 are derived from the Horizontal, Vertical & XYZ worksheets in this spreadsheet.

Calculations
Coord. Sys. 8101 to RP* IMU to 8101 Port Ant to 8101 RP to Waterline
Theodolite IMU (m) x 3.516 Port Ant (m) x 2.317 IMU (m) x 3.516

y 0.011 y -0.886 y 0.011
z -1.183 z 1.958 z -1.183

8101 (m) x 3.365 8101 (m) x 3.365 BM A x -0.005
y 0.273 y 0.273 y -1.002
z -1.729 z -1.729 z -0.020

BM A to IMU
x n/a
y n/a
z -1.163

BM A to Waterline
x n/a
y n/a

see z -0.913
Coord. Sys. IMU to 8101 IMU to 8101 Port Ant to 8101 RP to Waterline
Theodolite x -0.151 x 1.048 x n/a

y 0.262 y 1.159 y n/a
z -0.546 z -3.687 z 0.250

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS
x 0.262 x 1.159 x n/a
y -0.151 y 1.048 y n/a
z 0.546 z 3.687 z -0.250



Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave
Caris Pos/Mv Caris Pos/Mv

Scaler Distance 1.842 -0.897 -1.199 -0.011 -0.574
-1.199 -0.897 -0.574 -0.011
-3.141 -3.141 -0.253 -0.253

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave
Port Ant (m) x 2.317 IMU (m) x 3.516 IMU (m) y 0.011

y -0.889 y 0.011 x is n/a z -1.183
z 1.958 z -1.183

Heave Pt (m)
Stbd Ant (m) x 2.324 Port Ant (m) x 2.317 (centerline) y 0.000

y 0.953 y -0.886
z 1.929 z 1.958 BM B to Waterline (m)

measured scalar dist 0.877

BM B
x&y are n/a z -0.053

BM C to Waterline (m)
(Heave Pt) z -0.93

IMU to Hv x -0.574
Location - from RA DAPR

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave
x -1.199 x -0.574

Scalar Distance 1.842 y -0.897 y -0.011
z 3.141 z 0.253

Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x -1.199 x -0.574
y -0.897 y -0.011
z -3.141 z -0.253

see Description tab



Horizontal
All offsets are in Theodolite Coordinate System

BM CT BS BM A m S DD dA Hd Vd BM A
X 5.123977 HA 11 2 35 191.0431 5.22883 -1.793911 X -0.0080
Y -0.000827 VA 108 56 10 108.9361 -18.93611 Y -1.0024
Z 0.845 SDx 5.528 Z -0.0229

HI 1.031
HT 0.105

BM CT BS BM A m S DD dA Hd Vd BM A
X 5.123977 HA 11 2 50 191.0472 5.223191 0.091931 X -0.0024
Y -0.000827 VA 88 59 30 88.99167 1.008333 Y -1.0017
Z 0.845 SDx 5.224 Z -0.0351

HI 1.028
HT 2

BM CT BS BM B m S DD dA Hd Vd BM B
X 5.123977 HA 348 57 40 168.9611 5.227332 -1.825751 X -0.0066
Y -0.000827 VA 109 15 10 109.2528 -19.25278 Y 1.0001
Z 0.845 SDx 5.537 Z -0.0548

HI 1.031
HT 0.105

BM CT BS BM B m S DD dA Hd Vd BM B
X 5.123977 HA 348 57 20 168.9556 5.22166 0.05962 X -0.0010
Y -0.000827 VA 89 20 45 89.34583 0.654167 Y 0.9995
Z 0.845 SDx 5.222 Z -0.0674

HI 1.028
HT 2

BM CT BS BM C m S DD dA Hd Vd BM C
X 5.12892 HA 180 0 0 180 5.128883 -1.773947 X 0.0000
Y 0 VA 109 4 45 109.0792 -19.07917 Y 0.0000
Z 0.847926 SDx 5.427 Z 0.0000

HI 1.031
HT 0.105

BM CT BS BM C m S DD dA Hd Vd BM C
X 5.1257 HA 0 0 0 180 5.125747 0.113336 X 0.0000
Y 0 VA 88 44 0 88.73333 1.266667 Y 0.0000
Z 0.8586 SDx 5.127 Z -0.0001

HI 1.028
HT 2



BM F BS BM D m S DD dA Hd Vd BM D
X 1.668082 HA 0 0 0 0 5.249724 -1.383634 X 6.9178
Y -0.001217 VA 104 45 55 104.7653 -14.76528 Y -0.0012
Z 1.649 SDx 5.429 Z 0.3394

HI 1.234
HT 1.16

BM C BS BM D m S DD dA Hd Vd BM D
X 0 HA 0 0 0 0 6.906514 0.342484 X 6.9065
Y 0 VA 87 9 40 87.16111 2.838889 Y 0.0000
Z 0 SDx 6.915 Z 0.3805

HI 1.225
HT 1.187

BM CT BS BM D m S DD dA Hd Vd BM D
X 5.123977 HA 180 1 25 0.023611 1.782119 -1.402809 X 6.9061
Y -0.000827 VA 128 12 30 128.2083 -38.20833 Y -0.0001
Z 0.845 SDx 2.268 Z 0.3932

HI 1.031
HT 0.08

BM CT BS BM D m S DD dA Hd Vd BM D
X 5.123977 HA 180 1 35 0.026389 1.800322 0.049414 X 6.9243
Y -0.000827 VA 88 25 40 88.42778 1.572222 Y 0.0000
Z 0.845 SDx 1.801 Z 0.3724

HI 1.028
HT 1.55

TBM 2 BS BM D m S DD dA Hd Vd BM D
X 18.8276 HA 2 4 10 182.0694 11.91991 2.88893 X 6.9154
Y 0.4290 VA 76 22 35 76.37639 13.62361 Y -0.0014  
Z -2.1960 SDx 12.265 Z 0.3759

HI 1.233
HT 1.55

BM CT BS BM E m S DD dA Hd Vd BM E
X 5.123977 HA 14 27 40 194.4611 3.568662 -0.176011 X 1.6684
Y -0.000827 VA 92 49 25 92.82361 -2.823611 Y -0.8920
Z 0.845 SDx 3.573 Z 1.6200

HI 1.031
HT 0.08

BM CT BS BM E m S DD dA Hd Vd BM E



X 5.123977 HA 14 27 5 194.4514 3.57438 1.278054 X 1.6627
Y -0.000827 VA 70 19 30 70.325 19.675 Y -0.8928
Z 0.845 SDx 3.796 Z 1.6011

HI 1.028
HT 1.55

TBM CT BS BM F m S DD dA Hd Vd BM F
X 5.123977 HA 180 0 0 180 3.456432 -0.062679 X 1.6675
Y -0.000827 VA 91 2 20 91.03889 -1.038889 Y -0.0008
Z 0.845 SDx 3.457 Z 1.6433

HI 0.941
HT 0.08

BM CT BS BM F m S DD dA Hd Vd BM F
X 5.123977 HA 0 1 10 180.0194 3.448108 -0.141253 X 1.6759
Y -0.000827 VA 92 20 45 92.34583 -2.345833 Y -0.0020
Z 0.845 SDx 3.451 Z 1.6547

HI 1.031
HT 0.08

BM CT BS BM F m S DD dA Hd Vd BM F
X 5.123977 HA 0 0 0 180 3.463146 1.316679 X 1.6608
Y -0.000827 VA 69 11 0 69.18333 20.81667 Y -0.0008  
Z 0.845 SDx 3.705 Z 1.6397  

HI 1.028
HT 1.55

BM CT BS BM G m S DD dA Hd Vd BM G
X 5.123977 HA 344 29 55 164.4986 3.578828 -0.210271 X 1.6753
Y -0.000827 VA 93 21 45 93.3625 -3.3625 Y 0.9557
Z 0.845 SDx 3.585 Z 1.5857

HI 1.031
HT 0.08

BM CT BS BM G m S DD dA Hd Vd BM G
X 5.123977 HA 344 29 40 164.4944 3.593882 1.243713 X 1.6609
Y -0.000827 VA 70 54 40 70.91111 19.08889 Y 0.9599
Z 0.845 SDx 3.803 Z 1.5667

HI 1.028
HT 1.55

TBM2 BS BM H m S DD dA Hd Vd BM H
X 18.8276 HA 180 0 0 180 15.55637 -0.418679 X 3.2712
Y 0.4290 VA 91 32 30 91.54167 -1.541667 Y 0.4290



Z -2.1960 SDx 15.562 Z -1.3537
HI 1.171
HT -0.09

TBM 2 BS BM H m S DD dA Hd Vd BM H
X 18.8276 HA 0 0 50 180.0139 15.55449 -0.449948 X 3.2731
Y 0.4290 VA 91 39 25 91.65694 -1.656944 Y 0.4252
Z -2.1960 SDx 15.561 Z -1.3639

HI 1.232
HT -0.05

TBM 2 BS BM H m S DD dA Hd Vd BM H
X 18.8276 HA 0 1 25 180.0236 15.5575 -0.449658 X 3.2701
Y 0.4290 VA 91 39 20 91.65556 -1.655556 Y 0.4226
Z -2.1960 SDx 15.564 Z -1.3627

HI 1.233
HT -0.05

TBM 2 BS BM I m S DD dA Hd Vd BM I
X 18.8276 HA 359 59 35 179.9931 15.06194 -0.390392 X 3.7656
Y 0.4290 VA 91 29 5 91.48472 -1.484722 Y 0.4308
Z -2.1960 SDx 15.067 Z -1.3504

HI 1.171
HT -0.065

TBM 2 BS BM I m S DD dA Hd Vd BM I
X 18.8276 HA 0 0 55 180.0153 15.06239 -0.44631 X 3.7652
Y 0.4290 VA 91 41 50 91.69722 -1.697222 Y 0.4250
Z -2.1960 SDx 15.069 Z -1.3593

HI 1.233
HT -0.05

TBM 2 BS BM I m S DD dA Hd Vd BM I
X 18.8276 HA 359 59 50 179.9972 15.06336 -0.447435 X 3.7642
Y 0.4290 VA 91 42 5 91.70139 -1.701389 Y 0.4297
Z -2.1960 SDx 15.07 Z -1.3614

HI 1.232
HT -0.05

TBM CT BS Stbd Ant m S DD dA Hd Vd Stbd Ant
X 5.123977 HA 161 13 25 161.2236 2.958503 0.249444 X 2.3229
Y -0.000827 VA 85 10 50 85.18056 4.819444 Y 0.9514
Z 0.845 SDx 2.969 Z 1.9344

HI 0.92



HT 0.08

BM CT BS Stbd Ant m S DD dA Hd Vd Stbd Ant
X 5.123977 HA 341 9 55 161.1653 2.956677 0.140223 X 2.3256
Y -0.000827 VA 87 17 5 87.28472 2.715278 Y 0.9537
Z 0.845 SDx 2.96 Z 1.9362

HI 1.031
HT 0.08

TBM CT BS Port Ant m S DD dA Hd Vd Port Ant
X 5.123977 HA 197 31 25 197.5236 2.943877 0.278278 X 2.3167
Y -0.000827 VA 84 36 0 84.6 5.4 Y -0.8872
Z 0.845 SDx 2.957 Z 1.9633

HI 0.92
HT 0.08

BM CT BS Port Ant m S DD dA Hd Vd Port Ant
X 5.123977 HA 17 29 45 197.4958 2.943124 0.169485 X 2.3170
Y -0.000827 VA 86 42 15 86.70417 3.295833 Y -0.8856
Z 0.845 SDx 2.948 Z 1.9655

HI 1.031
HT 0.08

BM C BS IMU m S DD dA Hd Vd IMU
X 0.0000 HA 359 35 35 359.5931 3.519377 -0.713627 X 3.5193
Y 0.0000 VA 101 27 45 101.4625 -11.4625 Y -0.0250
Z 0.0000 SDx 3.591 Z -1.1936

HI 1.07
HT 1.55

BM C BS IMU m S DD dA Hd Vd IMU
X 0.0000 HA 359 37 30 359.625 3.519208 -0.709419 X 3.5191
Y 0.0000 VA 101 23 50 101.3972 -11.39722 Y -0.0230
Z 0.0000 SDx 3.59 Z -1.1944

HI 1.065
HT 1.55

BM C BS IMU m S DD dA Hd Vd IMU
X 0.0000 HA 359 44 25 359.7403 3.508314 -0.722813 X 3.5083
Y 0.0000 VA 101 38 30 101.6417 -11.64167 Y -0.0159
Z 0.0000 SDx 3.582 Z -1.1748

HI 1.147
HT 1.599



BM CT BS TBM 1 m S DD dA Hd Vd TBM 1
X 5.123977 HA 180 0 10 0.002778 13.70743 -2.535711 X 18.8314
Y -0.000827 VA 100 28 50 100.4806 -10.48056 Y -0.0002
Z 0.845 SDx 13.94 Z -2.2127

HI 1.028
HT 1.55

BM CT BS TBM 1 m S DD dA Hd Vd TBM 1
X 5.123977 HA 179 59 45 359.9958 13.70731 -2.536376 X 18.8313
Y -0.000827 VA 100 29 0 100.4833 -10.48333 Y -0.0018
Z 0.845 SDx 13.94 Z -2.2104

HI 1.031
HT 1.55

BM D BS TBM 1 m S DD dA Hd Vd TBM 1
X 6.9065 HA 0 0 0 0 11.91516 -2.662444 X 18.8217
Y 0.0000 VA 257 24 15 257.4042 -12.59583 Y 0.0000
Z 0.3805 SDx 12.209 Z -2.2020

HI 1.165
HT 1.085

BM CT BS TBM 2 m S DD dA Hd Vd TBM 2
X 5.123977 HA 181 47 50 1.797222 13.70934 -2.541907 X 18.8266
Y -0.000827 VA 100 30 15 100.5042 -10.50417 Y 0.4291
Z 0.845 SDx 13.943 Z -2.2159

HI 1.031
HT 1.55

TBM1 Pier BS TBM 2 m S DD dA Hd Vd TBM 2
X 18.8281 HA 90 0 0 90 0.43 0 X 18.8281
Y -0.0007 VA 0 0 0 0 0 Y 0.4293
Z -2.1960 SDx 0.43 Z -2.1960

HI 0
HT 0

BM CT BS TBM 2 m S DD dA Hd Vd TBM 2
X 5.123977 HA 181 47 40 1.794444 13.71075 -2.539763 X 18.8280
Y -0.000827 VA 100 29 40 100.4944 -10.49444 Y 0.4285
Z 0.845 SDx 13.944 Z -2.2168

HI 1.028
HT 1.55

BM C BS TBM CT m S DD dA Hd Vd TBM CT
X 0 HA 359 58 20 359.9722 5.117313 0.241326 X 5.1173



Y 0 VA 87 18 0 87.3 2.7 Y -0.0025
Z 0 SDx 5.123 Z 0.8483

HI 1.225
HT 0.618

BM H BS PC m S DD dA Measured  PC
X 3.2714 HA N/A N/A N/A N/A 0.089 N/A X 3.3604 Direct Measurement
Y 0.4256 VA N/A N/A N/A N/A N/A -0.153 Y 0.2726
Z -1.3680 SDx N/A -0.351 Z -1.7190

HI N/A
HT N/A

BM H BS PC m S DD dA Measured  PC
X 3.2714 HA N/A N/A N/A N/A 0.093 N/A X 3.3644 Direct Measurement
Y 0.4256 VA N/A N/A N/A N/A N/A -0.154 Y 0.2716
Z -1.3680 SDx N/A -0.351 Z -1.7190

HI N/A
HT N/A

BM H BS PC m S DD dA Measured  PC
X 3.2714 HA N/A N/A N/A N/A 0.099 N/A X 3.3704 Direct Measurement
Y 0.4256 VA N/A N/A N/A N/A N/A -0.15 Y 0.2756
Z -1.3680 SDx N/A -0.354 Z -1.7220

HI N/A
HT N/A



Vertical
All offsets are in Theodolite Coordinate System

FR
SETUP 1
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 2.014 1.988333333
Mid 1.967 0.025 Mid 1.988 0.026
Bot 1.943 0.024 Bot 1.963 0.025

DTI DTI
1 1

BM C HI Rod BM A
0 1.967333333 1.988333 -0.021

SETUP 5
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 1.908 1.883 Top 1.928 1.902333333
Mid 1.883 0.025 Mid 1.902 0.026
Bot 1.858 0.025 Bot 1.877 0.025

DTI DTI
0 1

BM C HI Rod BM A BM A Ave -0.02016667
0 1.883 1.902333 -0.019333 mm DIFF -1.66666667

SETUP 1
BS BM C FS BM B

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 2.046 2.021
Mid 1.967 0.025 Mid 2.021 0.025
Bot 1.943 0.024 Bot 1.996 0.025

DTI DTI
1 0

BM C HI Rod BM B
0 1.967333333 2.021 -0.053667

SETUP 5
BS BM C FS BM B

TI Ave (HI) TI Ave BM El



Top 1.908 1.883 Top 1.961 1.935
Mid 1.883 0.025 Mid 1.935 0.026
Bot 1.858 0.025 Bot 1.909 0.026

DTI DTI
0 0

BM C HI Rod BM B BM B Ave -0.05283333
0 1.883 1.935 -0.052 mm DIFF -1.66666667

BM C 0 BY DEFINITION

SETUP 1
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 1.59 1.580666667
Mid 1.967 0.025 Mid 1.581 0.009
Bot 1.943 0.024 Bot 1.571 0.01

DTI DTI
1 1

BM C HI Rod BM D
0 1.967333333 1.580667 0.386667

SETUP 5
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 1.908 1.883 Top 1.502 1.494333333
Mid 1.883 0.025 Mid 1.495 0.007
Bot 1.858 0.025 Bot 1.486 0.009

DTI DTI
0 2

BM C HI Rod BM D BM D Ave 0.387666667
0 1.883 1.494333 0.388667 mm DIFF -2

SETUP 1
BS BM C FS BM E

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 0.372 0.354666667
Mid 1.967 0.025 Mid 0.354 0.018
Bot 1.943 0.024 Bot 0.338 0.016



DTI DTI
1 2

BM C HI Rod BM E
0 1.967333333 0.354667 1.612667

SETUP 6
BS BM D FS BM E

TI Ave (HI) TI Ave BM El
Top 1.697 1.689 Top 0.481 0.463
Mid 1.689 0.008 Mid 0.463 0.018
Bot 1.681 0.008 Bot 0.445 0.018

DTI DTI
0 5.55E-14

BM D HI Rod BM E BM E Ave 1.612666833
0.386667 1.689 0.463 1.612667 mm DIFF -0.00033333

SETUP 1
BS BM C FS BM F

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 0.336 0.319666667
Mid 1.967 0.025 Mid 0.319 0.017
Bot 1.943 0.024 Bot 0.304 0.015

DTI DTI
1 2

BM C HI Rod BM F
0 1.967333333 0.319667 1.647667

SETUP 5
BS BM C FS BM F

TI Ave (HI) TI Ave BM El
Top 1.908 1.883 Top 0.249 0.232666667
Mid 1.883 0.025 Mid 0.233 0.016
Bot 1.858 0.025 Bot 0.216 0.017

DTI DTI
0 1

BM C HI Rod BM F BM F Ave 1.649
0 1.883 0.232667 1.650333 mm DIFF -2.66666667

SETUP 1



BS BM C FS BM G
TI Ave (HI) TI Ave BM El

Top 1.992 1.967333 Top 0.406 0.389333333
Mid 1.967 0.025 Mid 0.389 0.017
Bot 1.943 0.024 Bot 0.373 0.016

DTI DTI
1 1

BM C HI Rod BM G
0 1.967333333 0.389333 1.578

SETUP 6
BS BM D FS BM G

TI Ave (HI) TI Ave BM El
Top 1.697 1.689 Top 0.515 0.497666667
Mid 1.689 0.008 Mid 0.497 0.018
Bot 1.681 0.008 Bot 0.481 0.016

DTI DTI
0 2

BM D HI Rod BM G BM G Ave 1.578000167
0.386667 1.689 0.497667 1.578 mm DIFF -0.00033333

SETUP 10
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 0.667 0.657 Top 1.764 1.755
Mid 0.657 0.01 Mid 1.755 0.009
Bot 0.647 0.01 Bot 1.746 0.009

DTI DTI
0 2.22E-13

BM C HI Rod BM J
0 0.657 1.755 -1.098

SETUP 11
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 0.658 0.648333 Top 1.761 1.752
Mid 0.649 0.009 Mid 1.752 0.009
Bot 0.638 0.011 Bot 1.743 0.009

DTI DTI



2 0
BM C HI Rod BM J BM J Ave -1.10083333

0 0.648333333 1.752 -1.103667 mm DIFF 5.666666667

SETUP 2
BS BM C FS TBM 2

TI Ave (HI) TI Ave BM El
Top 1.381 1.347333 Top 3.609 3.549666667
Mid 1.348 0.033 Mid 3.55 0.059
Bot 1.313 0.035 Bot 3.49 0.06

DTI DTI
2 1

BM C HI Rod TBM 2
0 1.347333333 3.549667 -2.202333

BS BM C FS TBM 2 NOTE
TI Ave (HI) TI Ave BM El

Top - 1.188 Top - 3.395
Mid 1.188 n/a Mid 3.395 n/a
Bot - n/a Bot -

DTI DTI
n/a n/a

BM C HI Rod TBM 2 TBM 2 Ave -2.20466667
0 1.188 3.395 -2.207 mm DIFF 4.666666667

SETUP 2
BS BM C FS BM CT

TI Ave (HI) TI Ave BM El
Top 1.381 1.347333 Top 0.51 0.502
Mid 1.348 0.033 Mid 0.502 0.008
Bot 1.313 0.035 Bot 0.494 0.008

DTI DTI
2 0

BM C HI Rod BM CT
0 1.347333333 0.502 0.845333

SETUP 7
BS BM C FS BM CT



TI Ave (HI) TI Ave BM El
Top 1.563 1.528 Top 0.693 0.683333333
Mid 1.528 0.035 Mid 0.684 0.009
Bot 1.493 0.035 Bot 0.673 0.011

DTI DTI
0 2

BM C HI Rod BM CT BM CT Ave 0.845
0 1.528 0.683333 0.844667 mm DIFF 0.666666667

SETUP 3
BS BM C FS Stbd Ant

TI Ave (HI) TI Ave BM El
Top 2.068 2.044333 Top 0.128 0.116
Mid 2.045 0.023 Mid 0.116 0.012
Bot 2.02 0.025 Bot 0.104 0.012

DTI DTI
2 1.39E-14

BM C HI Rod Stbd Ant
0 2.044333333 0.116 1.928333

SETUP 4
BS BM C FS Stbd Ant

TI Ave (HI) TI Ave BM El
Top 2.067 2.043333 Top 0.126 0.114333333
Mid 2.044 0.023 Mid 0.114 0.012
Bot 2.019 0.025 Bot 0.103 0.011

DTI DTI
2 1

BM C HI Rod Stbd Ant Stbd Ant Ave 1.928666667
0 2.043333333 0.114333 1.929 mm DIFF -0.66666667

SETUP 3
BS BM C FS Port Ant

TI Ave (HI) TI Ave BM El
Top 2.068 2.044333 Top 0.102 0.086666667
Mid 2.045 0.023 Mid 0.086 0.016
Bot 2.02 0.025 Bot 0.072 0.014

DTI DTI



2 2
BM C HI Rod Port Ant

0 2.044333333 0.086667 1.957667
SETUP 4
BS BM C FS Port Ant

TI Ave (HI) TI Ave BM El
Top 2.067 2.043333 Top 0.101 0.085333333
Mid 2.044 0.023 Mid 0.085 0.016
Bot 2.019 0.025 Bot 0.07 0.015

DTI DTI
2 1

BM C HI Rod Port Ant Port Ant Ave 1.957833333
0 2.043333333 0.085333 1.958 mm DIFF -0.33333333

SETUP 10
BS BM C FS IMU

TI Ave (HI) TI Ave BM El
Top 0.667 0.657 Top 1.849 1.841
Mid 0.657 0.01 Mid 1.841 0.008
Bot 0.647 0.01 Bot 1.833 0.008

DTI DTI
0 0

BM C HI Rod IMU
0 0.657 1.841 -1.184

SETUP 11
BS BM C FS IMU

TI Ave (HI) TI Ave BM El
Top 0.658 0.648333 Top 1.839 1.830333333
Mid 0.649 0.009 Mid 1.83 0.009
Bot 0.638 0.011 Bot 1.822 0.008

DTI DTI
2 1

BM C HI Rod IMU IMU Ave -1.183
0 0.648333333 1.830333 -1.182 mm DIFF -2

SETUP 8
BS TBM 2 FS BM H NOTE



TI Ave (HI) TI Ave BM El
Top 0.792 0.755667 Top -0.032 -0.072
Mid 0.755 0.037 Mid -0.072 0.04
Bot 0.72 0.035 Bot -0.112 0.04

DTI DTI
2 1.39E-14

TBM 2 HI Rod BM H
-2.204667 0.755666667 -0.072 -1.377

SETUP 9
BS TBM 2 FS BM H NOTE

TI Ave (HI) TI Ave BM El
Top 0.783 0.746333 Top -0.041 -0.082
Mid 0.746 0.037 Mid -0.082 0.041
Bot 0.71 0.036 Bot -0.123 0.041

DTI DTI
1 6.94E-15

TBM 2 HI Rod BM H BM H Ave -1.37666667
-2.204667 0.746333333 -0.082 -1.376333 mm DIFF -0.66666667

SETUP 8
BS TBM 2 FS BM I NOTE

TI Ave (HI) TI Ave BM El
Top 0.792 0.755667 Top -0.036 -0.075
Mid 0.755 0.037 Mid -0.075 0.039
Bot 0.72 0.035 Bot -0.114 0.039

DTI DTI
2 6.94E-15

TBM 2 HI Rod BM I
-2.204667 0.755666667 -0.075 -1.374

SETUP 9
BS TBM 2 FS BM I NOTE

TI Ave (HI) TI Ave BM El
Top 0.783 0.746333 Top -0.047 -0.085666667
Mid 0.746 0.037 Mid -0.086 0.039
Bot 0.71 0.036 Bot -0.124 0.038

DTI DTI
1 1



TBM 2 HI Rod BM I BM I Ave -1.37333333
-2.204667 0.746333333 -0.085667 -1.372667 mm DIFF -1.33333333



1010 Launch Offsets Measurements
Jul-04

All offsets are in Theodolite Coordinate System
The Z plane means were taken using only the vertical level measurements.
BM A 88 165 133
X -0.0080 -0.0024 Mean -0.00523
Y -1.0024 -1.0017 -1.002038
Z -0.0229 -0.0351 -0.021 -0.019333333 -0.020167

BM B 95 172 13 143
X -0.006636 -0.000971 Mean -0.003804
Y 1.000078 0.999488 0.999783
Z -0.054751 -0.06738 -0.053666667 -0.052 -0.052833

BM C
X 0 By Definition
Y 0
Z 0

BM D 3 39 137 200 235
X 6.906514 6.917806 6.90609668 6.924299204 6.908486 Mean 6.912961 0.008066 ⇐ X Std De
Y 0 -0.001217 -9.25846E-05 2.19861E-06 -0.003272 -0.001121 0.001414 ⇐ Y Std De
Z 0.380484 0.339366 0.393190546 0.372414056 0.358922 0.386667 0.3886667 0.387667

BM E 102 179 174 33
X 1.66838 1.662692 Mean 1.665536
Y -0.892003 -0.892844 -0.892424
Z 1.619989 1.601054 1.612667 1.612666667 1.612667

BM F 18 109 186 43 163
X 1.667546 1.67587 1.660831138 Mean 1.668082 0.007534 ⇐ X Std De
Y -0.000827 -0.001997 -0.000826981 -0.001217 0.000676 ⇐ Y Std De
Z 1.643321 1.654747 1.63967874 1.647666667 1.650333 1.649

BM G 116 193 53 184
X 1.675333 1.660896 Mean 1.668115
Y 0.955657 0.959932 0.957794
Z 1.585729 1.566713 1.578 1.578000333 1.578



BM H 60 221 242
X 3.271201 3.270066 3.273074882 Mean 3.271447 0.001519 ⇐ X Std De
Y 0.428992 0.422581 0.425221731 0.425598 0.003222 ⇐ Y Std De
Z -1.353679 -1.362658 -1.363947954 -1.377 -1.376333 -1.376667

BM I 67 228 249 234 254
X 3.7656 3.7652 3.764211686 Mean 3.765006 0.000723 ⇐ X Std De
Y 0.4308 0.4250 0.429722538 0.428505 0.003105 ⇐ Y Std De
Z -1.3504 -1.3593 -1.361435445 -1.374 -1.372667 -1.373333

BM J 67 228 249 274 294
X n/a n/a n/a n/a n/a Mean
Y n/a n/a n/a n/a n/a
Z -1.3504 -1.3593 -1.361435445 -1.098 -1.103667 -1.100833

BM CT 11 81 158
X 5.117312 5.12892 5.1257 Mean 5.123977 0.005993 ⇐ X Std De
Y -0.002481 0 0 -0.000827 0.001432 ⇐ Y Std De
Z 0.848326 0.847926 0.8586 0.845333333 0.844667 0.845

TBM 1 46 144 207
X 18.82167 18.83129 18.83141214 Mean 18.82813 0.005587 ⇐ X Std De
Y 0 -0.001824 -0.000162426 -0.000662 0.001009 ⇐ Y Std De
Z -2.20196 -2.210376 -2.212711485 -2.196 -2.197 -2.1965

TBM 2 53 151 214 63
X 18.82813 18.82657 18.82800643 Mean 18.82757 0.000865 ⇐ X Std De
Y 0.429338 0.429129 0.428509392 0.428992 0.000431 ⇐ Y Std De
Z -2.196 -2.215907 -2.216762747 -2.202333333 -2.207 -2.204667

IMU 74 256 263
X 3.5083 3.519289 3.519132539 Mean 3.515566 0.006313 ⇐ X Std De
Y -0.0159 0.024996 0.023032997 0.010709 0.023067 ⇐ Y Std De
Z -1.1748 -1.193627 -1.194419237 -1.184 -1.182 -1.183

Port Ant 25 130 103 123
X 2.316717 2.3170 Mean 2.316862



Y -0.887225 -0.8856 -0.886431
Z 1.963278 1.9655 1.957666667 1.958 1.957833

Stbd Ant 32 123 93 113
X 2.32292 2.32562 Mean 2.32427
Y 0.951443 0.953705 0.952574
Z 1.934444 1.936223 1.928333333 1.929 1.928667

Phase Center of Ducer
270 277 284

X 3.360447 3.364447 3.370447321 Mean 3.365114 0.005033 ⇐ X Std De
Y 0.272598 0.271598 0.275598369 0.273265 0.002082 ⇐ Y Std De
Z -1.719 -1.719 -1.722 -1.729166667 -1.729167









 

1010 Vessel Diagram 



1010 Offset Measurements 
 
Sources 
 
In general launches require two pieces of information in order to determine their lever 
arms for CARIS and the POS/MV.  The first piece of information is the position of the 
physical offsets between the multibeam system components and the second is the position 
of the roll point. 
 
Physical offset information was derived from values measured by ship’s personnel with the 
assistance of Hydrographic Systems and Technology Personnel and Pacific Hydrographic Branch 
Personnel.  The general procedure used is described in the Measuring Launch Offsets SOP 
document contained in Appendix VI-1 of the 2004 FAIRWEATHER Data Acquisition 
and Processing Report (hereafter known as the DAPR).  The resulting measurements are 
located in the offset sections of Appendix III. 
 
The second source of information was from Appendix III of the RAINIER DAPR titled 
OPR_O112-RA-02.  Information about the roll point, center of motion for a vessel, was needed 
for the 1010 HVF.  Roll point values are calculated by conducting an inclination 
experiment.  The FAIRWEATHER had no roll point information since the results of an 
inclination experiment were not released before or during the field season.   For Launch 
2123 the roll point was 0.574 m aft of the IMU on the centerline and at the waterline.  
Launch 2123 is very similar to Launch 1010 and its roll point approximation was used in 
Launch 1010’s offset measurements. 
 
Measurements 
 
All measurements were taken after launch 1010 was “leveled” in accordance with the 
Measuring Launch Offsets SOP using Leveling Procedure Method A:  Leveling to an 
Installed IMU.   Most horizontal measurements were taken 3 times in order to determine 
a standard deviation.  The average standard deviation for horizontal measurements was 
4.3 mm.  For launch 1010, since it was the first time the procedure was run, all horizontal 
control points do not have three measurements. 
 
Vertical measurements were conducted in accordance with the procedures defined in the 
Users Guide for the Installation of Bench marks and Leveling Requirements for Water 
Level Stations dated October 1987.  Vertical measurements were made with a Leica NA2 
with a stadia of 100.  The level specifications can be found in Appendix I of the DAPR.  
Each point was measured twice in accordance with the leveling procedure, and the runs 
between benchmarks were checked for closure.  According to Users Guide for the 
Installation of Bench marks and Leveling Requirements for Water Level Stations,  
the maximum closure tolerance for a single third-order section, one setup, less than 0.1 
km in length, is 2 mm.  Three out of fifteen vertical measurements exceeded the 
specification ranging from 5.67 mm to 2.67 mm.  These errors in closure were not found 
before the vessel was placed back in the water.  There was not an opportunity to re-level 
the vessel. 
 

Jess
This is a huge assumption. 



With the exception of one set of measurements, horizontal measurements for lever arm 
distances were taken using a Nikon DTM 310.  The Nikon specifications are located in 
Appendix I.  In one instance, over a very short distance (< 0.4 m), the instrument could 
not be set up to calculate the difference in location.  That offset distance was measured 
with steel tape, plumb bob and carpenter’s squares.  
 
Required Measurements 
 
Pos/MV 
 
Measurements required by the IMU are lever arm distances from the IMU, the multibeam 
transducer, the heave measurement location (roll point), and the primary GPS antenna to 
the chosen reference point.  In the case of launch 1010 the reference point and the IMU 
are coincident.  This simplifies installation.  There is also a need for an antenna 
separation distance. 
 
CARIS 
 
Measurements required by CARIS are transducer to the reference point, IMU to the 
reference point and waterline to the reference point. 
 
Calculations 
 
The values for the required lever arms are listed in the 1010_Offsets and Measurements 
spreadsheet.  The reference point and the IMU are identical. 
  
As a requirement for the Total Propagated Error (TPE) model, the standard deviation for 
each position, in each axis, was stated to be 7 mm. 
 
Pos/MV—IMU to Reference Point  
 
IMU to the Reference Point is zero on all axes since the IMU is chosen to be the origin. 
 
Pos/MV, CARIS—IMU (Reference Point) to Reson 8101 
 
The location of the phase center of the Reson 8101 and the location of the IMU were 
measured by NOAA personnel with respect to the Ship Reference Frame (SRF).  The 
lever arm distance between the phase center of the Reson 8101 and the IMU were then 
calculated.  The measurements and calculations are listed in the 1010 Offsets 
Measurements spreadsheet in Appendix III. 
 
Pos/MV—Antenna Separation  
 
The location of the phase center of the port and starboard POS/MV antennas were 
measured by NOAA personnel with respect to the SRF.  The scalar distance between the 

Jess
Might want to mention that the GAMS solution needs this, but will also figure the number itself.

verena.kellner
Note
Unmarked set by verena.kellner



phase centers was then calculated. The measurements and calculations are listed in the 
1010 Offsets Measurements spreadsheet in Appendix III. 
 
Pos/MV— IMU(Reference Point) to Primary (Port) antenna 
 
The location of the IMU and the location of the port antenna were measured by NOAA 
personnel with respect to the Ship Reference Frame (SRF).  The lever arm distance 
between the IMU and the port antenna were then calculated. The measurements and 
calculations are listed in the 1010 Offsets Measurements spreadsheet in Appendix III. 
 
CARIS—IMU(Reference Point) to Waterline 
 
The vertical distance between the top of the IMU to the waterline was measured by 
FAIRWEATHER personnel using a steel tape measuring from BM A to the waterline.  
With the knowledge of BM A’s height above the IMU the waterline height above the 
IMU was calculated.   The measurements and calculations are listed in the 1010 Offsets 
Measurements spreadsheet in Appendix III. 
 
Pos/MV—IMU (Reference Point) to Roll Point 
 
The roll point was positioned differently on the three axes.  On the longitudinal axis the 
distance was determined from the RAINIER DAPR described on page 1 of this 
document.  The athwart ships axis for the roll point is the vessel centerline.  Lastly, the 
height of the roll point was equivalent to the waterline.  This waterline value was 
calculated in the same manner as the above paragraph, though the values are not identical 
as they were measured on different days.  The measurements and calculations are listed 
in the 1010 Offsets Measurements spreadsheet in Appendix III. 
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Date: Sept. 1,2004 DN: 245 Local Area:  Tongass Narrows/Blank Inlet Wx: 
SV Cast #1 filename: 
04245103.2 

UTC time: 
1032 

Lat: 
55/20/03.32 

Lon: 
131/38/05.92 

Depth: 
48 

Ext Depth: 
62.4 

SV Cast #2 filename: 
04245125.7 

UTC time: 
1257 

Lat: 
55/16/30.31 

Lon: 
131/39/39.7 

Depth: 
71.5 

Ext Depth: 
92.9 

 

Personnel: 
Abrams, Van Waes, Higgins 

Other Comments: 

 

ROLL LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Roll1 113 7.1  
Roll2 275 7.6  
Roll3 117 5.5  
Roll4 283 6.1  
    

2 

    

 

PITCH LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Pitch1 227 5.5  
Pitch2 058 5.8  
Pitch5 235 5.9  
Pitch6 59 6.3  
    
    
    

2 

    

HEADING LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Heading5 222 4 Run parallel to wreck 
Heading6 222 4 “              “               “ 
Heading7 42 6 “              “               “ 
Heading8 40 6 “              “               “ 
Heading9 114 4.7 Run perpendicular to wreck 

1 

Heading11 121 4.7 “              “               “ 



 

 

 

 

HEADING LINES Continued 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Heading14 295 7.6 Run perpendicular to wreck 
Heading15 288 6.9 “              “               “ 
    
    
    

1 

    



Processing Patch Test        __1010___ _             245/9-1-04                              
     (Vessel)    (Dn/Date) 

□ HVF Hydrographic Vessel File created or updated with current offsets 
Name: __________________________ Date/Time: ______________________ 

x Data Converted  HDCS_Data in CARIS 

x True Heave Applied 

x Tide Applied ________ Observed  9450460____________________________        
Type (Zero, Observed, Verified) 

x        Zoned ________FA_Patch2004Corp.zdf____________________________ 
ZDF File 

x SVP applied 04245103 applied to Heading and 04245125 applied to Pitch and Roll 
 File 

x Lines merged 

        x Data cleaned to remove gross fliers 
Compute Correctors – Order 

 
1) Precise Timing         2) Pitch Bias         3) Roll Bias        3) Heading Bias 
 
Do not Enter/Apply Correctors until all evaluations are complete and analyzed. 

  
Patch Test Results/Correctors 
 
Evaluator Timing (sec) Pitch (deg) Roll (deg) Hdg (deg) 
Jess 0.01 -1.20 -0.39 -0.32 

Kim 0.00 -0.65 -0.38 -0.35 

Mark 0.00 -1.3 -0.39 -0.30 

Lynn 0.00 -0.9 -0.35 -0.10 

     

Final Values 0.00 -0.9 -0.38 -0.32 

 
Final Values based on:   Consensus
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Date:  10/19/04 DN:  293 Local Area:  Rudyerd Bay Wx:  Clear & Cold 
SV Cast #1 filename: 
04293180 

UTC time: 
1805 

Lat: 
55/31.918 

Lon: 
130/47.152 

Depth: 
91.0 

Ext Depth: 
118.3 

SV Cast #2 filename: UTC time: Lat: Lon: Depth: Ext Depth: 

 

Personnel:  Wetzler, Keene, Kellner 

Other Comments:  Forgot to bring CTD on launch, so cast was done from the ship at anchor in the same area after 
acquisition. 

 

TIME LATENCY LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): XTF Line Filename: 
LATENCY1 NA  LATENCY3  

1 LATENCY2 NA  LATENCY4 

 

ROLL LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
ROLL1 138 8  
ROLL2 312 8  
ROLL3 318 8 Run after latency lines to check roll stability. 
    
    

 
 
1 

    

 

PITCH LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
PITCH 24 8  
PITCH2 200 8  
    

 
 
1 

    

HEADING LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
HEADING1 154 8 Rock in outer beams to port. 
HEADING2 330 8  
HEADING3 155 8 Attempt to run straighter line. 
HEADING4 333 8 Didn’t see rock in outer beams. 
HEADING5 330 8 Good rock image. 

 
 
1 

    



 
Processing Patch Test        __1010_                293  10/19/04                  
      (Vessel)    (Dn/Date) 
 

x Data Converted  HDCS_Data in CARIS 

x Tide Applied ___________Zero______________________________________ 
Type (Zero, Observed, Verified) 

        □ Zoned _____________________________________________________ 
ZDF File 

x SVP applied _______04293180______________________________________ 
 File 

x Lines merged 

        x Data cleaned to remove gross fliers 
Compute Correctors – Order 

 
1) Precise Timing         2) Pitch Bias         3) Roll Bias        3) Heading Bias 
 
Do not Enter/Apply Correctors until all evaluations are complete and analyzed. 

Patch Test Results/Correctors 
 
Evaluator Timing (sec) Pitch (deg) Roll (deg) Hdg (deg) 
Keene/Wetzler/Kellner 0.0 -0.38 0.24 -0.30 

Froelich 0.02 -0.44 0.27 -0.90 

Abigail 0.01 -0.47 0.18 -0.09 

Lynn    -0.30 

     

Final Values 0.01 (ave) -0.43 (ave) 0.23 (ave) -0.30 
(consensus) 

 
Final Values based on ____________________________________________________________ 
 

□ HVF Hydrographic Vessel File created or updated with current offsets 
Name: __________________________ Date: ______________________ 

 
 
8/04                                                           R:\Utilities\Survey_Forms\Calibration Packet\Processing Patch Test.doc                            



Line Speed Depth Delta Depth SpeedAvg Delta Depth Avg
Loc 1 DDSSM11 1.4 12.66266937 0 δ Depth Avg 1.5 0

DDSSM2 4.8 12.56513743 0.097531945 4.8 0.079172346
DDSSM3 5.6 12.54164628 0.121023089 5.6 0.117831517
DDSSM4 7.8 12.53501136 0.127658008 7.8 0.1372383
DDSSM5 10.3 12.60566272 0.05700665 10.3 0.022496767
DDSSM6 11.7 12.84574877 -0.183079397 11.7 -0.198367583
DDSSM10 14.5 13.02615407 -0.363484698 14.5 -0.377554616

Loc 2 DDSSM12 1.5 12.03156266 0
DDSSM2 4.8 11.9533921 0.078170561
DDSSM3 5.6 11.96975088 0.061811781
DDSSM4 7.8 11.92639686 0.105165797
DDSSM5 10.3 12.082 -0.050437342
DDSSM6 11.7 12.25242806 -0.220865399
DDSSM10 14.5 12.40895522 -0.377392566

Loc 3 DDSSM13 1.6 15.72363089 0
DDSSM2 4.8 15.66181636 0.061814534
DDSSM3 5.6 15.55297121 0.170659682
DDSSM4 7.8 15.5447398 0.178891096
DDSSM5 10.3 15.6627099 0.060920994
DDSSM6 11.7 15.91478884 -0.191157953
DDSSM10 14.5 16.11541748 -0.391786584

-0.5
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-0.3

-0.2

-0.1

0

0.1

0.2
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SETTLEMENT & SQUAT DATA COLLECTION FORM
Date 10/5/2004 DN 278 Wind 10 knots Level S/N 10327 (Zeiss NI-2 )

Launch 1010 Location Ward Cove Seas 0-2 Rod S/N A
Average Depth 60 feet Weather rain Measured By ENS Higgins

Personnel Morgan, Heiner, Froelich, Higgins, Kellner

Comments measurements taken with trim tabs up and ducer up; launch measured with coxin and two personnel on board;
rising tide; rain; visibility not ideal

A B B-A
Start End Rest Speed

 RPM Speed Rest 1 2 3 4 5 6 7 8 9 10 Rest Average Average Corrector

Towards 0.570 0.580 0.600 0.610 0.590 0.570 0.630 0.590 0.580 0.575 0.600 0.560

750 5.8 Away 0.555 0.580 0.590 0.585 0.580 0.575 0.610 0.580 0.570 0.565 0.570 0.540 0.55625 0.5865 0.03025

Towards 0.545 0.550 0.570 0.565 0.570 0.570 0.565 0.575 0.570 0.555 0.540 0.530

800 6 Away 0.535 0.540 0.530 0.580 0.565 0.565 0.540 0.580 0.585 0.565 0.550 0.500 0.5275 0.5615 0.034

Towards 0.495 0.530 0.570 0.560 0.565 0.540 0.565 0.540 0.570 0.575 0.565 0.490

900 6.7 Away 0.495 0.530 0.580 0.510 0.550 0.540 0.580 0.540 0.610 0.540 0.530 0.475 0.48875 0.5545 0.06575

Towards 1.050 1.040 1.050 1.100 1.100 1.080 1.110 1.100 1.080 1.080 1.110 1.000

1000 7 Away 1.010 1.050 1.060 1.040 1.080 1.060 1.040 1.030 0.980 1.01 1.07118 0.061176

Towards 0.980 1.040 1.030 1.020 1.040 1.040 1.035 1.050 1.030 1.000 1.030 0.950

1100 7.5 Away 0.945 1.010 1.010 0.990 0.975 1.000 1.020 1.000 1.005 1.020 1.025 0.940 0.95375 1.0185 0.06475

Towards 0.930 1.020 1.000 0.995 1.010 0.990 0.985 1.010 0.990 1.000 1.000 0.905

1200 7.5 Away 0.900 0.980 0.970 0.990 0.970 0.990 1.000 0.985 0.995 1.000 0.980 0.860 0.89875 0.993 0.09425

Towards 0.860 0.980 0.975 0.965 0.950 0.970 0.980 0.970 0.980 0.840

1400 8.5 Away 0.835 0.930 0.940 0.950 0.960 0.950 0.950 0.800 0.83375 0.96071 0.126964

Towards 0.790 0.940 0.930 0.900 0.900 0.930 0.920 0.940 0.920 0.910 0.920 0.790

1600 10 Away 0.790 0.910 0.910 0.900 0.905 0.870 0.900 0.880 0.910 0.850 0.750 0.78 0.90763 0.127632

Towards 0.590 0.630 0.620 0.620 0.640 0.645 0.620 0.640 0.610 0.590 0.610 0.600

1800 12.5 Away 0.590 0.540 0.660 0.610 0.590 0.590 0.610 0.630 0.625 0.600 0.610 0.570 0.5875 0.6145 0.027

Towards 0.680 0.640 0.650 0.660 0.670 0.640 0.640 0.660 0.665 0.670 0.665

2000 14 Away 0.665 0.630 0.620 0.590 0.580 0.640 0.600 0.640 0.6625 0.637 -0.0255



Speed Corrector

5.8 0.03025
6.1 0.034
6.7 0.06575

7 0.06118
7.5 0.06475
7.5 0.09425
8.5 0.12696
10 0.12763

12.5 0.027
14 -0.0255

900 RPM with Ducer DOWN
A B B-A

Start End Rest Speed
 RPM Speed Rest 1 2 3 4 5 6 7 8 9 10 Rest Average Average Corrector

Towards 0.440 0.480 0.470 0.450 0.490 0.500 0.470 0.465 0.480 0.485 0.490 0.420 0.430 0.478 0.048
900 Away 0.455 0.510 0.480 0.510 0.500 0.490 0.500 0.510 0.510 0.520 0.510 0.435 0.445 0.504 0.059

900 RPM with Ducer UP
Towards 0.495 0.530 0.570 0.560 0.565 0.540 0.565 0.540 0.570 0.575 0.565 0.490 0.4925 0.558 0.0655

900 6.7 Away 0.495 0.530 0.580 0.510 0.550 0.540 0.580 0.540 0.610 0.540 0.530 0.475 0.485 0.551 0.066

-0.04
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Ship: Fairweather Vessel: 1010
Date: 8/27/2004 Dn: 240
Personnel: Abrams, Wetzler, Sampadian

PCS Serial # 788

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 2.10d

POS Version (Use Menu View > Statistics) MV320 Ver3 
GPS Receivers

Primary Receiver SGN 00160051

Secondary Receiver SGN 00120116

Calibration area
Location: D M S
Approximate Position: Lat 55 19 52

Lon 131 37 27
DGPS Beacon Station: Annette Island, AK
Frequency: 323 kHZ

Satellite Constellation (Use View> GPS Data)
Primary GPS (Port Antenna) N

HDOP:
VDOP:

Satelites in Use: 8

PDOP (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector

1.839 Two Antenna Separation (m) 0 X Component (m)
0.30 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

NOAA POS/MV Calibration Report

Ketchikan, AK



Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 14:25
End time: 14:25
Heading accuracy achieved for calibration: 0.237

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
1.841 Two Antenna Separation (m) 0.004 X Component (m)
0.300 Heading Calibration Threshold 1.841 YComponent (m)

0 Heading Correction 0.03 Z Component (m)

GAMS Status Online X
Save Settings X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: POSMV_Settings_082704.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS This is not the same as S220 or 1018

Input/Output Ports (Use Settings > Input/Output Ports)



NOTE: COM3 and Analog are not used.

Heave Filter (Use Settings > Heave) Events (Use Settings > Events)

SETTINGS Continued
Time Sync (Use Settings > Time Sync)

INSTALLATION (Use Settings > Installation)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)
This is not the same as 1018

Frame Control (Use Tools > Config)



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver
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FAIRWEATHER LAUNCH 1010
CONFIGURATION

DRAWN BY GRANT FROELICH

SEPTEMBER 28, 2004
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NOAA SHIP FAIRWEATHER 

N

                                   

NOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001188  
CCAALLIIBBRRAATTIIOONN  RREEPPOORRTT  22000044 

Compiled by: SST Grant Froelich 
 

 
Background: 
NOAA Hydrographic Survey Launch (HSL) 1018 is a high speed, 29’ aluminum 
Jensen survey launch.  It is equipped with a Reson 8101 SWMB system 
mounted on a swing mount to the starboard of the keel and approximately 
centered fore and aft.  The Reson 8101 operates at a frequency of 240 kHz and 
has a variable ping rate dependant upon depth.  The maximum ping rate is user 
set to 20 Hz.  The Reson 8101 has 101 1.5° x 1.5° beams and has an effective 
range of 120m depth.  Multibeam data is collected in XTF format using TEI Isis 
Sonar v6.6.  NOAA HSL 1018 is equipped with an Applanix Position and 
Orientation system for Marine Vessels (POS MV) 320 Version 3 consisting of a 
IMU-200 strap-down inertial measurement unit (IMU), a version 2.10d POS 
computer system (PCS) and two NovAtel GPS antennas. Differential correctors 
are supplied to the POS MV by a CSI wireless MBX-3S Automatic Differential 
GPS receiver. Sound velocity correctors are obtained by a SeaBird SeaCat SBE 
19plus sound velocity profiler.  NOAA HSL 1018 is also configured with Applanix 
TrueHeave1 and “Precise Timing”2.  Residual biases in sensor misalignment 
were assessed in CARIS HIPS & SIPS v5.4 (SP 1, HF’s 1-7) calibration mode 
and applied to the HIPS Vessel File (HVF), 1018_8101.HVF.  NOAA HSL 1018 is 
configured with a hydraulic A-frame on the aft quarter for deployment of heavy 
gear or towing side scan.  
 
Location, Date, Personnel: 
Patch Test 
Multiple patch tests were attempted with NOAA HSL 1018 in several different 
locations at the beginning of the 2004 field season.  Due to various different mis-

              Figure 1.  Location of Heading, Roll and Pitch Lines 
1 Applanix web site. http://www.applanix.com. June 2004 
2 Evans, Ben, LTJG, NOAA. Upgrading NOAA Multibeam Acquisition Systems to “Precise Timing”. May 

2004 
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NOAA SHIP FAIRWEATHER 

entries and mis-configurations, none of these were accepted into the final 
1018_8101.HVF.  The patch test conducted in the vicinity of Ketchikan, AK in 
Tongass Narrows and Blank Inlet on September 1st (Dn245) was accepted and 
processed for residual biases.  The heading bias patch was conducted over a 
wreck lying in an average depth of 42m with a least depth of 24m at 
55°19’56.21”N, 131°37’52.09”W.  The roll bias patch was conducted over a flat 
area in approximately 60m of water at location 55°16’50.70”N, 131°40’06.47”W. 
The pitch bias patch was conducted in the same area on a 10m shoal (see 
Figure 1). Sound velocity profiles were collected by NOAA HSL 1010, which was 
acquiring data in the same areas.  NOAA HSL 1010’s CTD and line was used for 
the dynamic draft determination after 1010 returned home due to mechanical 
malfunctions.  The patch data was collected by SST Froelich, LT Wetzler, and 
PS Sampadian. The patch biases were processed by CST Morgan, SST 
Froelich, LT Wetzler, and PS Sampadian.   
 
Dynamic Draft 
Dynamic draft lines were collected at location 55°12’58.36”N, 131°43’24.71”W in 
approximately 10m of water on September 1st (Dn 245) (see Figure 2).  The 
dynamic draft data was collected by SST Froelich and PS Sampadian. The 
dynamic draft data was processed using the Dynamic Draft Settlement and 
Squat Method (DDSSM) by LT Wetzler. 
 

 
Figure 2.  Location of Dynamic Draft 

GAMS Calibration 
POS MV GPS Azimuth Measurement Subsystem (GAMS) calibration occurred 
on September 1st (Dn245) in Ketchikan, Alaska.  GAMS calibration was 
performed by SST Froelich, LT Wetzler and PS Sampadian.   
 
 
Procedure: 
All patch test and dynamic draft lines were “lightly” cleaned in CARIS swath 
mode to remove major data fliers.  SVP and observed tides were applied.   
 

 - 2 - 



NOAA SHIP FAIRWEATHER 

 
Patch 
SST Froelich reviewed the patch data twice due to large discrepancies between 
his initial values and the other reviewers’ values.  The values found in his second 
review were used in the consensus values.  
 
Sensor Latency: One line from the dynamic draft or roll patch data was selected 
for latency biases. It was determined that either dynamic draft or roll data was 
suitable for sensor latency bias evaluation after examining previous patch test 
data.  Those who chose to look at a dynamic draft line also looked at a roll line 
for comparison.  The lines were reviewed in CARIS calibration mode 
independently by CST Morgan, SST Froelich, LT Wetzler and PS Sampadian to 
determine the bias.  Final values entered into 1018_8101.HVF were based on a 
consensus value between those involved.  
 
Pitch: One pair of coincident lines was run over a shoal of 10m at the same 
speed in different directions.  The lines were run at 7.5 knots. The lines were 
reviewed in CARIS calibration mode independently by CST Morgan, SST 
Froelich, LT Wetzler and PS Sampadian to determine the pitch bias.  Final 
values entered into 1018_8101.HVF were based on a consensus value between 
those involved. 
  
Roll: One pair of coincident lines was run over a flat area approximately 60m 
deep at the same speed in different directions.  A single cross line was also run 
perpendicular to the roll lines as a quality check.  The lines were run at 5.5 knots.  
The lines were reviewed in CARIS calibration mode independently by CST 
Morgan, SST Froelich, LT Wetzler and PS Sampadian to determine the roll bias.  
Final values entered into 1018_8101.HVF were based on a consensus value 
between those involved.  
 
Heading: One pair of parallel lines offset by 130m was run in opposite directions 
at different speeds over a known target.  The lines were run at 4.5 and 7.5 knots. 
The lines were reviewed in CARIS calibration mode independently by CST 
Morgan, SST Froelich, LT Wetzler and PS Sampadian to determine the heading 
bias.  Final values entered into 1018_8101.HVF were based on a consensus 
value between those involved.  Errors seen in heading bias may be attributed to 
the difference in acquisition speeds.   
 

Patch Bias Bias value 
Sensor Latency 

Pitch 
Roll 

Heading 

0.10 sec 
-0.70° 
-0.38° 
-0.66° 

Table 1. Patch Test Bias Result 
 
The patch test acquisition and processing logs for Dn#245 are located in 
Appendix III-1018-3. 
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Dynamic Draft 
One line was run nine times in the same direction but at different speeds.  Six 
lines were collected at speeds ranging from 4.7 knots to 14.3 knots at an average 
depth of 13m.  At three points along the line, data was collected with the engine 
in idle.  The lines were reviewed in CARIS by LT Wetzler and statistical 
comparisons between the speeds and δ draft were made using Microsoft Excel.  
The dynamic draft, settlement and squat spreadsheet, 1018_DDSSM.xls, is 
located in Appendix III-1018-4. 
 

Speed (knots) Delta Draft (m) 
0.0 
4.7 
6.4 
8.4 

10.6 
12.3 
14.3 

0.000 
0.016 
0.037 
0.052 
0.023 
-0.043 
-0.132 

Table 2.Dynamic Draft Results 
 
POS MV GAMS Calibration 
The GAMS heading calibration threshold was initially set to 0.300°.  There was 
difficulty in getting the POS MV to switch into Ready Offline mode to begin 
calibration.  After relocating to an area with less traffic and smaller waves, the 
POS MV switched into Ready Offline mode.  NOAA HSL 1018 was maneuvered 
in “figure 8’s” to lower the heading accuracy as much as possible.  The best 
heading accuracy value achieved during this process was 0.099°.  The vessel 
steadied up on a constant heading and GAMS calibration was requested. The 
vessel maintained the constant heading until the calibration was complete. The 
POSMV settings were then saved to the file POSMV_ 09012004.nvm (see  
Table 3).   
 

 

Component Value 
Baseline Vector X 
Baseline Vector Y 
Baseline Vector Z 

Two Antenna Separation 
Heading Correction 

-0.002 m 
 1.831 m 
 0.021 m 
 1.831 m 
 0.000 ° 

Table 3. POS MV GAMS Calibration Results 
 
The detailed POS/MV Calibration Report, 1018_POS_Calibration_090104.xls, is 
located in Appendix III-1018-5. 
 
Recommendations: 
These patch test, GAMS calibration, and dynamic draft results should be used 
from September 1st, 2004 (Dn 245) until such a time or event warrants a new 
calibration.   
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ADDENDUM 1 
NOAA HYDROGRAPHIC SURVEY LAUNCH 1018 

PATCH TEST REPORT NOVEMBER 2004 
Compiled by: Verena Kellner 

 
Background: 
Residual biases for NOAA Hydrographic Survey Launch (HSL) 1018 were 
assessed in CARIS HIPS & SIPS v5.4 calibration mode and applied to the HIPS 
Vessel File (HVF), 1018_8101.HVF.     
 
The RESON 8101 for launch 1018 was returned from RESON after repairs were 
made to the transducer circuit. A new patch test was conducted after the 
installation of the transducer onto HSL 1018, in order to update the biases in the 
current HVF. 
 
Location, Date, Personnel: 
The patch test was conducted on November 3rd, 2004 (DN 308) in Punchbowl 
Cove, off of Rudyerd Bay in Alaska.  All data were acquired in the vicinity of 
55°31’54”N, 130°47’00”W (See Figure 1).  LT Wetzler, ENS Higgins, and AST 
Kellner acquired the patch data.  The data was processed in CARIS 5.4 for 
residual biases by AST Kellner, AST Castle and ENS Higgins.     
 
 
 

 
 Figure 1:  Location of Patch Test Lines in Punchbowl Cove 

 
 
POS MV GPS Azimuth Measurement Subsystem (GAMS) calibration occurred 
on November 3rd (Dn308) in Punchbowl Cove, off of Rudyerd Bay in Alaska.  
GAMS calibration was performed by LT Wetzler, ENS Higgins and AST Kellner.   
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Dynamic Draft, Settlement & Squat data were not acquired at this time.  
Correctors from the September 3rd (DN 247) DDSSM data set should continue to 
be used in the HVF.   
 
Equipment: 
 Hardware: 

1  Reson 8101 Shallow Water Multibeam Echosounder 
1  Applanix POS/MV Version 3.20 Strap-Down IMU 
2  Novatel GPS Antennas 
1  CSI wireless MBX-3S Automatic Differential GPS receiver 
1  Seabird Seacat SBE 19plus sound velocity profiler 
Software: 
 TEI Isis Sonar v6.6 w/ BathyPro Real Time Bathymetry 
 CARIS HIPS & SIPS v5.4 SP1, HF’s1-12 
 

Procedure: 
Patch 
All lines: All lines were “lightly” cleaned in CARIS Swath Editor to get rid of major 
data fliers.  SVP and Zero Tides were applied.   
 
Sensor Latency: Sensor latency data were acquired by turning the boat into its 
own wake while data was acquired, in order to generate roll in the outer beams.  
The lines were reviewed in CARIS calibration mode independently by SST 
Abrams, ENS Higgins, and LT Van Waes, in order to determine the bias.  Final 
values entered into 1018_8101.HVF were based on an average value of the 
individual results. Roll Time (error Sensor Latency) was applied to Nav Time, 
Gyro Time, Pitch Time, Roll Time, and Heave Time errors in the 
1018_8101.HVF. 
 
Pitch: One pair of coincident lines was run over a known rock on a slope at the 
same speed in different directions.  The lines were run at eight knots. The lines 
were reviewed in CARIS calibration mode independently by SST Abrams, ENS 
Higgins, and LT Van Waes in order to determine the pitch bias.  Final values 
entered into 1018_8101.HVF were based on an average value of the individual 
results. 
  
Roll: One pair of coincident lines was run over an area approximately 65m deep 
at the same speed in different directions.  The lines were run at eight knots.  The 
lines were reviewed in CARIS calibration mode independently by SST Abrams, 
ENS Higgins, and LT Van Waes in order to determine the roll bias.  Final values 
entered into 1018_8101.HVF were based on an average value of the individual 
results. 
 
Heading: Two parallel lines offset by approximately 100m were run in opposite 
directions at the same speed over a known rock.  The lines were reviewed in 
CARIS calibration mode independently by SST Abrams, ENS Higgins, and LT 
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Van Waes, in order to determine the heading bias.  Final values entered into 
1018_8101.HVF were based on the FOO’s evaluation of the data. 
 
The patch test acquisition and processing logs for Dn308 are located in Appendix 
III-3. 
 
The following table displays the results of this patch test, as well as the previous 
patch test, conducted in September. 
 

PATCH BIAS SEPTEMBER BIAS 
VALUE 

NOVEMBER BIAS 
VALUE 

SENSOR LATENCY
PITCH 
ROLL 

HEADING 

0.10 sec 
-0.70° 
-0.38° 
-0.66° 

0.00 sec 
-0.60° 
0.54° 
0.00° 

 
Table 1  Patch test bias results 

 
POS MV GAMS Calibration 
The GAMS heading calibration threshold was initially set to 0.100°. NOAA HSL 
1018 was maneuvered in “figure 8’s” to lower the heading accuracy as much as 
possible.  The best heading accuracy value achieved during this process was 
0.098°.  The vessel steadied up on a constant heading and GAMS calibration 
was requested. The vessel maintained the constant heading until the calibration 
was complete. The POSMV settings were then saved to the file 
POSMV_110304_2.nvm (see Table 2).   
 

 

Component Value 
Baseline Vector X 
Baseline Vector Y 
Baseline Vector Z 

Two Antenna Separation 
Heading Correction 

-0.002 m 
 1.831 m 
 0.021 m 
 1.831 m 
 0.000 ° 

Table 2. POS MV GAMS Calibration Results 
 
The detailed POS/MV Calibration Report, 1018_POS_Calibration_DN308.xls, is 
located in Appendix III-5. 
  
Recommendations: 
These patch test calibration and GAMS calibration results should be used from 
November 3rd, 2004 (DN 308) until such a time or event warrants new calibration.   
 
The DDSSM results from September 1st, 2004 (Dn 245) should continue to be 
used until such a time or event warrants a new test. 
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Vessel Name: 1018_8101.hvf 
Vessel created: December 09, 2004 
 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2004-218 00:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.700 
 Roll Offset: 0.380 
 Azimuth Offset: -0.660 
 
 DeltaX: 0.302 
 DeltaY: -0.164 
 DeltaZ: 0.550 
 
 Manufacturer:  Reson 
 Model:   sb8101 
 Serial Number:  (null) 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2004-308 00:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.600 
 Roll Offset: 0.540 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.302 
 DeltaY: -0.164 
 DeltaZ: 0.550 
 
 Manufacturer:  Reson 
 Model:   sb8101 
 Serial Number:   
 
_________________________________________________________ 
Navigation Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Latency 0.100 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 



 
 Time Stamp:  2004-308 00:00 
 
 Comments  
 Latency 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 
_________________________________________________________ 
Gyro Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Latency 0.100 
 
 
 Time Stamp:  2004-308 00:00 
 
 Comments  
 Latency 0.000 
 
_________________________________________________________ 
Heave Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments TrueHeave Enabled 
 Apply Yes 
 Latency 0.100 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 
 
 Time Stamp:  2004-308 00:00 
 
 Comments TrueHeave Enabled 
 Apply Yes 
 Latency 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 



_________________________________________________________ 
Pitch Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Apply Yes 
 Latency 0.100 
 Pitch offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 
 
 Time Stamp:  2004-308 00:00 
 
 Comments  
 Apply Yes 
 Latency 0.000 
 Pitch offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 
_________________________________________________________ 
Roll Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Apply Yes 
 Latency 0.100 
 Roll offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 
 
 Time Stamp:  2004-308 00:00 
 
 Comments  
 Apply Yes 
 Latency 0.000 
 Roll offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  786 
 
_________________________________________________________ 
Draft Sensor: 
 
 Time Stamp:  2004-215 00:00 
 



 Apply Yes 
 Comments (null) 
 Entry 1) Draft: 0.000 Speed: 0.000 
 Entry 2) Draft: 0.016 Speed: 4.700 
 Entry 3) Draft: 0.037 Speed: 6.400 
 Entry 4) Draft: 0.052 Speed: 8.400 
 Entry 5) Draft: 0.023 Speed: 10.600 
 Entry 6) Draft: -0.043 Speed: 12.300 
 Entry 7) Draft: -0.132 Speed: 14.300 
_________________________________________________________ 
TPE 
 
 Time Stamp:  2004-218 00:00 
 
 Comments Not Finished 
 Offsets  
 
 Motion sensing unit to the transducer 1  
  X Head 1 0.302 
  Y Head 1 -0.164 
  Z Head 1 0.550 
 Motion sensing unit to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 Navigation antenna to the transducer 1 
  X Head 1 1.200 
  Y Head 1 0.937 
  Z Head 1 3.719 
 Navigation antenna to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 
 Roll offset of transducer number 1 0.000 
 Roll offset of transducer number 2 0.000 
 
 Heave Error: 0.050 or 5.000'' of heave amplitude. 
 Measurement errors: 0.007 
 Motion sensing unit alignment errors 
 Gyro:0.000 Pitch:0.000 Roll:0.000 
 Gyro measurement error: 0.020 
 Roll measurement error: 0.020 
 Pitch measurement error: 0.020 
 Navigation measurement error: 0.500 
 Transducer timing error: 0.001 
 Navigation timing error: 0.001 
 Gyro timing error: 0.001 
 Heave timing error: 0.001 
 PitchTimingStdDev: 0.001 
 Roll timing error: 0.001 
 Sound Velocity speed measurement error: 0.500 
 Surface sound speed measurement error: 0.500 
 Tide measurement error: 0.010 
 Tide zoning error: 0.000 
 Speed over ground measurement error: 0.030 
 Dynamic loading measurement error: 0.000 



 Static draft measurement error: 0.050 
 Delta draft measurement error: 0.010 
_________________________________________________________ 
Svp Sensor: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments  
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.302 
 DeltaY: -0.164 
 DeltaZ: 0.550 
 
_________________________________________________________ 
WaterLine: 
 
 Time Stamp:  2004-218 00:00 
 
 Comments (null) 
 Apply Yes 
 WaterLine -0.340 
 WaterLineStdDev 0.000 
_________________________________________________________ 



Summary of Measurements
Measurement IMU to RP* 8101 to RP* IMU to 8101 Port Ant to 8101 RP* to Waterline  IMU to Port Ant IMU to Heave Port Ant to Stbd Ant
Coord. Sys. Caris Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.302 0.302 1.200 n/a -0.898 -1.101 0.015 -0.574 Scaler Distance 1.834
y 0.000 -0.164 -0.164 0.937 n/a -1.101 -0.898 -0.574 0.015
z 0.000 0.55 0.55 3.719 -0.34 -3.169 -3.169 -0.315 -0.315

*RP is Reference Point

Vessel Offsets for 1018_8101 are derived from the Horizontal,  Vertical & XYZ worksheets in this spreadsheet.

Calculations
Coord. Sys. 8101 to RP* IMU to 8101 Port Ant to 8101 RP to Waterline  IMU to Port Ant IMU to Heave Port Ant to Stbd Ant
Theodolite IMU (m) x 3.546 Port Ant (m) x 2.445 IMU (m) x 3.546 IMU (m) x 3.546 IMU (m) y -0.015 Port Ant (m) x 2.445

y -0.015 y -0.913 y -0.015 y -0.015 x is n/a z -0.859 y -0.913
z -0.859 z 2.310 z -0.859 z -0.859 z 2.31

Heave Pt (m)
8101 x 3.382 8101 x 3.382 BM A x -0.003 Port Ant(m) x 2.445 (centerline) y 0.000 Stbd Ant (m) x 2.445
(Phase Cntr) y 0.287 (Phase Cntr) y 0.287 y -1.413 y -0.913 y 0.921

(m) z -1.409 (m) z -1.409 z 0.299 z 2.310 BM B to Waterline (m) z 2.31
measured scalar dist 0.82

BM A to IMU
x n/a BM B
y n/a x&y are n/a z 0.276
z 1.158

BM C to Waterline (m)
BM B to Waterline (m) (Heave Pt) z -0.544
measured  0.818
scalar dist IMU to Hv x -0.574

see Location - from RA DAPR
Coord. Sys. IMU to 8101 IMU to 8101 Port Ant to 8101 RP to Waterline  IMU to Port Ant IMU to Heave Port Ant to Stbd Ant
Theodolite x -0.164 x 0.937 x n/a x -1.101 x -0.574

y 0.302 y 1.200 y n/a y -0.898 y 0.015 Scalar Distance 1.834
z -0.550 z -3.719 z 0.340 z 3.169 z 0.315

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x 0.302 x 1.200 x n/a x -1.101 x -0.574
y -0.164 y 0.937 y n/a y -0.898 y 0.015
z 0.550 z 3.719 z -0.340 z -3.169 z -0.315

see Description tab



Horizontal
All offsets are in Theodolite Coordinate System

BM C BS BM A D m S DD dA Hd Vd BM A
X 0 HA 269 55 40 269.9278 1.412249 -1.000956 X -0.0018
Y 0 VA 125 19 40 125.3278 -35.32778 Y -1.4122
Z 0 SDx 1.731 Z 0.2940

HI 1.385
HT 0.09

BM L BS BM A D m S DD dA Hd Vd BM A
X 4.8802 HA 196 5 30 196.0917 5.084436 -0.720982 X -0.0050
Y -0.00318 VA 98 4 15 98.07083 -8.070833 Y -1.4125
Z 1.192667 SDx 5.1353 Z 0.3037

HI 1.431
HT 1.599

BM F BS BM A D m S DD dA Hd Vd BM A
X 1.8269 HA 217 38 5 217.6347 2.310529 -1.824927 X -0.0029
Y -0.0020 VA 128 18 10 128.3028 -38.30278 Y -1.4129
Z 2.0543 SDx 2.9443 Z 0.3004

HI 1.673
HT 1.602

BM C BS BM B D m S DD dA Hd Vd BM B
X 0 HA 90 6 50 90.11389 1.408507 -1.02162 X -0.0028
Y 0 VA 125 57 15 125.9542 -35.95417 Y 1.4085
Z 0 SDx 1.74 Z 0.2734

HI 1.385
HT 0.09

BM F BS BM B D m S DD dA Hd Vd BM B
X 1.8269 HA 142 17 30 142.2917 2.30385 -1.847291 X 0.0042
Y -0.0020 VA 128 43 25 128.7236 -38.72361 Y 1.4071
Z 2.0543 SDx 2.953 Z 0.2780

HI 1.673
HT 1.602

BM L BS BM B D m S DD dA Hd Vd BM B
X 4.8802 HA 163 48 50 163.8139 5.07525 -0.745425 X 0.0061
Y -0.00318 VA 98 21 20 98.35556 -8.355556 Y 1.4116
Z 1.192667 SDx 5.1297 Z 0.2792

HI 1.431



HT 1.599

BM D BS BM C D m S DD dA Hd Vd BM C
X 6.970125 HA 180 0 0 180 6.971795 -0.940903 X -0.0017 Modified D so C is 0
Y -0.002655 VA 97 41 10 97.68611 -7.686111 Y -0.0027
Z 0.695667 SDx 7.035 Z 0.0108

HI 1.451
HT 1.195

BM F BS BM C D m S DD dA Hd Vd BM C
X 1.8244 HA 180 4 0 180.0667 1.824376 -2.121032 X 0.0000 Modified F so C is 0
Y 0.0021 VA 139 18 0 139.3 -49.3 Y 0.0000
Z 2.0500 SDx 2.7977 Z 0.0000

HI 1.673
HT 1.602

 BS BM C D m S DD dA Hd Vd BM C
X 0 HA 0 0 0 0 0 0 X 0.0000
Y 0 VA 0 0 0 0 90 Y 0.0000
Z 0 SDx 0 Z 0.0000

HI 0
J HT 0

BM C BS BM D D m S DD dA Hd Vd BM D
X 0 HA 0 0 0 0 6.971868 0.503147 X 6.9719
Y 0 VA 85 52 20 85.87222 4.127778 Y 0.0000
Z 0 SDx 6.99 Z 0.6901

HI 1.385
HT 1.198

 BS BM D D m S DD dA Hd Vd BM D
X 0 HA 0 0 0 0 0 0 X 6.9718
Y 0 VA 0 0 0 0 90 Y 0.0000 IN BM D BS BM C
Z 0 SDx 0 Z 0.6849

HI 0
HT 0

BM F BS BM D D m S DD dA Hd Vd BM D
X 1.8269 HA 359 58 20 359.9722 5.142666 -1.428201 X 6.9695
Y -0.0020 VA 105 31 15 105.5208 -15.52083 Y -0.0045
Z 2.0543 SDx 5.3373 Z 0.6971

HI 1.673
HT 1.602



BM L BS BM D D m S DD dA Hd Vd BM D
X 4.8802 HA 359 59 50 359.9972 2.085613 -1.839614 X 6.9658
Y -0.00318 VA 131 24 50 131.4139 -41.41389 Y -0.0033
Z 1.192667 SDx 2.781 Z 0.7021

HI 1.431
HT 0.082

BM C BS BM E D m S DD dA Hd Vd BM E
X 0 HA 334 42 5 334.7014 2.016759 1.426038 X 1.8233
Y 0 VA 54 44 10 54.73611 35.26389 Y -0.8618
Z 0 SDx 2.47 Z 2.0160

HI 1.385
HT 0.795

BM D BS BM E D m S DD dA Hd Vd BM E
X 6.970125 HA 189 28 15 189.4708 5.214703 0.66789 X 1.8265
Y -0.002655 VA 82 42 5 82.70139 7.298611 Y -0.8607
Z 0.695667 SDx 5.2573 Z 2.0166

HI 1.451
HT 0.798

BM L BS BM E D m S DD dA Hd Vd BM E
X 4.8802 HA 195 42 25 195.7069 3.171173 0.192337 X 1.8274
Y -0.00318 VA 86 31 45 86.52917 3.470833 Y -0.8617
Z 1.192667 SDx 3.177 Z 2.0220

HI 1.431
HT 0.794

BM C BS BM F D m S DD dA Hd Vd BM F
X 0 HA 359 48 40 359.8111 1.823512 1.461634 X 1.8235
Y 0 VA 51 17 10 51.28611 38.71389 Y -0.0060
Z 0 SDx 2.337 Z 2.0516

HI 1.385
HT 0.795

BM D BS BM F D m S DD dA Hd Vd BM F
X 6.970125 HA 180 1 10 180.0194 5.139289 0.704122 X 1.8308
Y -0.002655 VA 82 11 55 82.19861 7.801389 Y -0.0044
Z 0.695667 SDx 5.1873 Z 2.0528

HI 1.451
HT 0.798



BM L BS BM F D m S DD dA Hd Vd BM F
X 4.8802 HA 179 56 15 179.9375 3.051481 0.228177 X 1.8287
Y -0.00318 VA 85 43 25 85.72361 4.276389 Y 0.0001
Z 1.192667 SDx 3.06 Z 2.0578

HI 1.431
HT 0.794

BM C BS BM G D m S DD dA Hd Vd BM G
X 0 HA 26 44 30 26.74167 2.041987 1.405606 X 1.8236
Y 0 VA 55 27 30 55.45833 34.54167 Y 0.9188
Z 0 SDx 2.479 Z 1.9956

HI 1.385
HT 0.795

BM D BS BM G D m S DD dA Hd Vd BM G
X 6.970125 HA 169 49 30 169.825 5.221683 0.647696 X 1.8306
Y -0.002655 VA 82 55 45 82.92917 7.070833 Y 0.9198
Z 0.695667 SDx 5.2617 Z 1.9964

HI 1.451
HT 0.798

BM L BS BM G D m S DD dA Hd Vd BM G
X 4.8802 HA 163 11 15 163.1875 3.185444 0.170427 X 1.8309
Y -0.00318 VA 86 56 15 86.9375 3.0625 Y 0.9182
Z 1.192667 SDx 3.19 Z 2.0001

HI 1.431
HT 0.794

TBM BS BM H D m S DD dA Hd Vd BM H
X 10.0263 HA 179 55 15 179.9208 6.721906 0.035522 X 3.3044
Y 0.4245 VA 89 41 50 89.69722 0.302778 Y 0.4337
Z -1.8654 SDx 6.722 Z -1.0239

HI 0.756
HT -0.05

TBM BS BM H D m S DD dA Hd Vd BM H
X 10.0263 HA 179 57 40 179.9611 6.726626 -0.031633 X 3.2996
Y 0.4245 VA 90 16 10 90.26944 -0.269444 Y 0.4290
Z -1.8654 SDx 6.7267 Z -1.0231

HI 0.824
HT -0.05

TBM BS BM H D m S DD dA Hd Vd BM H



X 10.0263 HA 179 57 20 179.9556 6.724154 -0.044336 X 3.3021
Y 0.4245 VA 90 22 40 90.37778 -0.377778 Y 0.4297
Z -1.8654 SDx 6.7243 Z -1.0098

HI 0.85
HT -0.05

TBM BS BM I D m S DD dA Hd Vd BM I
X 10.0263 HA 179 57 50 179.9639 6.189202 0.034807 X 3.8371
Y 0.4245 VA 89 40 40 89.67778 0.322222 Y 0.4284
Z -1.8654 SDx 6.1893 Z -1.0246

HI 0.756
HT -0.05

TBM BS BM I D m S DD dA Hd Vd BM I
X 10.0263 HA 180 1 50 180.0306 6.186227 -0.030142 X 3.8400
Y 0.4245 VA 90 16 45 90.27917 -0.279167 Y 0.4212
Z -1.8654 SDx 6.1863 Z -1.0216

HI 0.824
HT -0.05

TBM BS BM I D m S DD dA Hd Vd BM I
X 10.0263 HA 180 0 0 180 6.187145 -0.043795 X 3.8391
Y 0.4245 VA 90 24 20 90.40556 -0.405556 Y 0.4245
Z -1.8654 SDx 6.1873 Z -1.0092

HI 0.85
HT -0.05

BM C BS BM J D m S DD dA Hd Vd BM J
X 0 HA 0 5 40 0.094444 3.28806 -0.990463 X 3.2881
Y 0 VA 106 45 50 106.7639 -16.76389 Y 0.0054
Z 0 SDx 3.434 Z -0.8005

HI 1.385
HT 1.195

BM C BS BM J D m S DD dA Hd Vd BM J
X 0 HA 0 3 45 0.0625 3.291776 -0.936134 X 3.2918
Y 0 VA 105 52 30 105.875 -15.875 Y 0.0036
Z 0 SDx 3.4223 Z -0.7991

HI 1.372
HT 1.235

BM C BS BM J D m S DD dA Hd Vd BM J
X 0 HA 0 2 15 0.0375 3.291552 -0.928486 X 3.2916



Y 0 VA 105 45 10 105.7528 -15.75278 Y 0.0022
Z 0 SDx 3.42 Z -0.8065

HI 1.36
HT 1.238

BM C BS BM K D m S DD dA Hd Vd BM K
X 0 HA 2 19 25 2.323611 3.293853 -0.992034 X 3.2911
Y 0 VA 106 45 40 106.7611 -16.76111 Y 0.1335
Z 0 SDx 3.44 Z -0.8020

HI 1.385
HT 1.195

BM C BS BM K D m S DD dA Hd Vd BM K
X 0 HA 2 19 55 2.331944 3.294948 -0.938504 X 3.2922
Y 0 VA 105 53 55 105.8986 -15.89861 Y 0.1341
Z 0 SDx 3.426 Z -0.8015

HI 1.372
HT 1.235

BM C BS BM K D m S DD dA Hd Vd BM K
X 0 HA 2 21 0 2.35 3.293653 -0.92951 X 3.2909
Y 0 VA 105 45 35 105.7597 -15.75972 Y 0.1351
Z 0 SDx 3.4223 Z -0.8075

HI 1.36
HT 1.238

BM C BS BM L D m S DD dA Hd Vd BM L
X 0 HA 359 58 35 359.9764 4.884186 -0.13311 X 4.8842
Y 0 VA 91 33 40 91.56111 -1.561111 Y -0.0020
Z 0 SDx 4.886 Z 1.1899

HI 1.385
HT 0.062

BM D BS BM L D m S DD dA Hd Vd BM L
X 6.970125 HA 180 2 45 180.0458 2.089829 0.115163 X 4.8803
Y -0.002655 VA 86 50 45 86.84583 3.154167 Y -0.0043
Z 0.695667 SDx 2.093 Z 1.1938

HI 1.451
HT 1.068

BM F BS BM L D m S DD dA Hd Vd BM L
X 1.8269 HA 0 3 10 0.052778 3.052617 -0.926082 X 4.8795
Y -0.0020 VA 106 52 35 106.8764 -16.87639 Y 0.0008



Z 2.0543 SDx 3.19 Z 1.1993
HI 1.673
HT 1.602

BM D BS PORT ANT D m S DD dA Hd Vd PORT ANT
X 0 HA 339 28 10 339.4694 2.610523 1.726867 X 2.4447
Y 0 VA 56 30 55 56.51528 33.48472 Y -0.9155
Z 0 SDx 3.13 Z 2.3219

HI 1.385
HT 0.79

BM D BS PORT ANT D m S DD dA Hd Vd PORT ANT
X 6.970125 HA 191 21 30 191.3583 4.613315 0.970543 X 2.4472
Y -0.002655 VA 78 7 10 78.11944 11.88056 Y -0.9112
Z 0.695667 SDx 4.7143 Z 2.3222

HI 1.451
HT 0.795

BM L BS PORT ANT D m S DD dA Hd Vd PORT ANT
X 4.8802 HA 200 29 30 200.4917 2.600669 -0.216924 X 2.4441
Y -0.00318 VA 94 46 5 94.76806 -4.768056 Y -0.9136
Z 1.192667 SDx 2.6097 Z 2.3247

HI 1.431
HT 0.082

BM C BS STBD ANT D m S DD dA Hd Vd STBD ANT
X 0 HA 20 41 20 20.68889 2.60875 1.709557 X 2.4405
Y 0 VA 56 45 45 56.7625 33.2375 Y 0.9217
Z 0 SDx 3.119 Z 2.3046

HI 1.385
HT 0.79

BM D BS STBD ANT D m S DD dA Hd Vd STBD ANT
X 6.970125 HA 168 29 0 168.4833 4.617073 0.951015 X 2.4460
Y -0.002655 VA 78 21 40 78.36111 11.63889 Y 0.9192
Z 0.695667 SDx 4.714 Z 2.3027

HI 1.451
HT 0.795

BM L BS STBD ANT D m S DD dA Hd Vd STBD ANT
X 4.884186 HA 159 15 20 159.2556 2.605607 -0.236301 X 2.4475
Y -0.002013 VA 95 10 55 95.18194 -5.181944 Y 0.9209
Z 1.18989 SDx 2.6163 Z 2.3026



HI 1.431
HT 0.082

BM H BS PHASE CENT D m S DIRECT MEASUREMENT PHASE CENT
X 3.302044 HA N/A N/A N/A 0.08 X 3.3820
Y 0.430807 VA N/A N/A N/A -0.143 Y 0.2878
Z -1.0485 SDx N/A -0.36 Z -1.4085

HI N/A
HT N/A

BM H BS PHASE CENT D m S DIRECT MEASUREMENT PHASE CENT
X 3.302044 HA N/A N/A N/A 0.08 X 3.3820
Y 0.430807 VA N/A N/A N/A -0.145 Y 0.2858
Z -1.0485 SDx N/A -0.36 Z -1.4085

HI N/A
HT N/A

BM H BS PHASE CENT D m S DIRECT MEASUREMENT PHASE CENT
X 3.302044 HA N/A N/A N/A 0.08 X 3.3820
Y 0.430807 VA N/A N/A N/A -0.143 Y 0.2878
Z -1.0485 SDx N/A -0.36 Z -1.4085

HI N/A
HT N/A

BM C BS IMU D m S DD dA Hd Vd IMU
X 0 HA 359 45 30 359.7583 3.545118 -1.038158 X 3.5451
Y 0 VA 106 19 20 106.3222 -16.32222 Y -0.0150
Z 0 SDx 3.694 Z -0.8482

HI 1.385
HT 1.195

BM C BS IMU D m S DD dA Hd Vd IMU
X 0 HA 359 45 55 359.7653 3.5471 -0.98379 X 3.5471
Y 0 VA 105 30 5 105.5014 -15.50139 Y -0.0145
Z 0 SDx 3.681 Z -0.8468

HI 1.372
HT 1.235

BM C BS IMU D m S DD dA Hd Vd IMU
X 0 HA 359 44 30 359.7417 3.545481 -0.975756 X 3.5454
Y 0 VA 105 23 15 105.3875 -15.3875 Y -0.0160
Z 0 SDx 3.6773 Z -0.8538

HI 1.36



HT 1.238

BM D BS TBM D m S DD dA Hd Vd TBM
X 6.970125 HA 7 55 30 7.925 3.082642 -2.405777 X 10.0233
Y -0.002655 VA 127 58 10 127.9694 -37.96944 Y 0.4224
Z 0.695667 SDx 3.9103 Z -1.8641

HI 1.451
HT 1.605

BM L BS TBM D m S DD dA Hd Vd TBM
X 4.8802 HA 4 45 40 4.761111 5.161378 -2.88509 X 10.0238
Y -0.00318 VA 119 12 15 119.2042 -29.20417 Y 0.4252
Z 1.192667 SDx 5.913 Z -1.8664

HI 1.431
HT 1.605

BM F BS TBM D m S DD dA Hd Vd TBM
X 1.8269 HA 2 59 5 2.984722 8.215994 -4.000061 X 10.0317
Y -0.0020 VA 115 57 35 115.9597 -25.95972 Y 0.4258
Z 2.0543 SDx 9.138 Z -1.8657

HI 1.673
HT 1.593



E

Vertical
All offsets are in Theodolite Coordinate System

FR
SETUP 1
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.409 2.383
Mid 2.681 0.023 Mid 2.383 0.026
Bot 2.657 0.024 Bot 2.357 0.026

DTI DTI
1 0

BM C HI Rod BM A
0 2.680667 2.383 0.297667

SETUP 2
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 2.409 2.383667
Mid 2.685 0.023 Mid 2.384 0.025
Bot 2.661 0.024 Bot 2.358 0.026

DTI DTI
1 1

BM C HI Rod BM A BM A AV 0.299333
0 2.684667 2.383667 0.301 mm DIFF -3.333333

SETUP 1
BS BM C FS BM B

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.431 2.406333
Mid 2.681 0.023 Mid 2.406 0.025
Bot 2.657 0.024 Bot 2.382 0.024

DTI DTI
1 1

BM C HI Rod BM B
0 2.680667 2.406333 0.274333

SETUP 2
BS BM C FS BM B

TI Ave (HI) TI Ave BM El



E

Top 2.708 2.684667 Top 2.432 2.407667
Mid 2.685 0.023 Mid 2.408 0.024
Bot 2.661 0.024 Bot 2.383 0.025

DTI DTI
1 1

BM C HI Rod BM B BM B AV 0.275667
0 2.684667 2.407667 0.277 mm DIFF -2.666667

SETUP 1
BS BM C FS BM C

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.409 2.383
Mid 2.681 0.023 Mid 2.383 0.026
Bot 2.657 0.024 Bot 2.357 0.026

DTI DTI
1 0

BM C HI Rod BM C
0 2.680667 2.383 0.297667

SETUP 2
BS BM C FS BM C 0 BY DEFINITION

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 2.409 2.383667
Mid 2.685 0.023 Mid 2.384 0.025
Bot 2.661 0.024 Bot 2.358 0.026

DTI DTI
1 1

BM C HI Rod BM C
0 2.684667 2.383667 0.301 mm DIFF -0.003333

SETUP 1
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 1.997 1.986667
Mid 2.681 0.023 Mid 1.986 0.011
Bot 2.657 0.024 Bot 1.977 0.009

DTI DTI
1 2 ??



E

BM C HI Rod BM D
0 2.680667 1.986667 0.694

SETUP 2
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 1.997 1.987333
Mid 2.685 0.023 Mid 1.987 0.01
Bot 2.661 0.024 Bot 1.978 0.009

DTI DTI
1 1

BM C HI Rod BM D BM D AV 0.695667
0 2.684667 1.987333 0.697333 mm DIFF -3.333333

SETUP 1
BS BM C FS BM E

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.68 0.664333
Mid 2.681 0.023 Mid 0.664 0.016
Bot 2.657 0.024 Bot 0.649 0.015

DTI DTI
1 1

BM C HI Rod BM E
0 2.680667 0.664333 2.016333

SETUP 2
BS BM C FS BM E

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.679 0.663667
Mid 2.685 0.023 Mid 0.663 0.016
Bot 2.661 0.024 Bot 0.649 0.014

DTI DTI
1 2

BM C HI Rod BM E BM E AVE 2.018667
0 2.684667 0.663667 2.021 mm DIFF -4.666667

SETUP 1
BS BM C FS BM F

TI Ave (HI) TI Ave BM El



E

Top 2.704 2.680667 Top 0.643 0.628
Mid 2.681 0.023 Mid 0.628 0.015
Bot 2.657 0.024 Bot 0.613 0.015

DTI DTI
1 0

BM C HI Rod BM F
0 2.680667 0.628 2.052667

SETUP 2
BS BM C FS BM F

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.643 0.628667
Mid 2.685 0.023 Mid 0.629 0.014
Bot 2.661 0.024 Bot 0.614 0.015

DTI DTI
1 1

BM C HI Rod BM F BM F AVE 2.054333
0 2.684667 0.628667 2.056 mm DIFF -3.333333

SETUP 1
BS BM C FS BM G

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.699 0.684
Mid 2.681 0.023 Mid 0.684 0.015
Bot 2.657 0.024 Bot 0.669 0.015

DTI DTI
1 1.11E-13

BM C HI Rod BM G
0 2.680667 0.684 1.996667

SETUP 2
BS BM C FS BM G

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.699 0.684667
Mid 2.685 0.023 Mid 0.685 0.014
Bot 2.661 0.024 Bot 0.67 0.015

DTI DTI
1 1

BM C HI Rod BM G BM G AV 1.998333



E

0 2.684667 0.684667 2 mm DIFF -3.333333

SETUP 5
BS TBM FS BM H

TI Ave (HI) TI Ave BM El
Top 0.506 0.492 Top -0.058 -0.072333
Mid 0.492 0.014 Mid -0.072 0.014
Bot 0.478 0.014 Bot -0.087 0.015

DTI DTI
0 1

TBM HI Rod BM H
-1.612667 0.492 -0.072333 -1.048333

SETUP 6
BS TBM FS BM H

TI Ave (HI) TI Ave BM El
Top 0.403 0.418 Top -0.131 -0.146
Mid 0.418 -0.015 Mid -0.146 0.015
Bot 0.433 -0.015 Bot -0.161 0.015

DTI DTI
5.55E-14 2.78E-14

TBM HI Rod BM H BM H AV -1.0485
-1.612667 0.418 -0.146 -1.048667 mm DIFF 0.333333

SETUP 5
BS TBM FS BM I

TI Ave (HI) TI Ave BM El
Top 0.506 0.492 Top -0.06 -0.073667
Mid 0.492 0.014 Mid -0.074 0.014
Bot 0.478 0.014 Bot -0.087 0.013

DTI DTI
0 1

TBM HI Rod BM I
-1.612667 0.492 -0.073667 -1.047

SETUP 6
BS TBM FS BM I

TI Ave (HI) TI Ave BM El
Top 0.403 0.418 Top -0.134 -0.147333



Mid 0.418 -0.015 Mid -0.147 0.013
Bot 0.433 -0.015 Bot -0.161 0.014

DTI DTI
5.55E-14 1

TBM HI Rod BM I BM I AVE -1.047167
-1.612667 0.418 -0.147333 -1.047333 mm DIFF 0.333333

SETUP 7
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 1.068 1.06 Top 1.88 1.871
Mid 1.06 0.008 Mid 1.871 0.009
Bot 1.052 0.008 Bot 1.862 0.009

DTI DTI
0 0

BM C HI Rod BM J
0 1.06 1.871 -0.811

SETUP 8
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 1.058 1.049 Top 1.865 1.857333
Mid 1.049 0.009 Mid 1.857 0.008
Bot 1.04 0.009 Bot 1.85 0.007

DTI DTI
2.22E-13 1

BM C HI Rod BM J BM J AVE -0.809667
0 1.049 1.857333 -0.808333 mm DIFF -2.666667

SETUP 7
BS BM C FS BM K

TI Ave (HI) TI Ave BM El
Top 1.068 1.06 Top 1.88 1.871
Mid 1.06 0.008 Mid 1.871 0.009
Bot 1.052 0.008 Bot 1.862 0.009

DTI DTI
0 0

BM C HI Rod BM K



E

0 1.06 1.871 -0.811
SETUP 8
BS BM C FS BM K

TI Ave (HI) TI Ave BM El
Top 1.058 1.049 Top 1.868 1.859667
Mid 1.049 0.009 Mid 1.86 0.008
Bot 1.04 0.009 Bot 1.851 0.009

DTI DTI
2.22E-13 1

BM C HI Rod BM K BM K AV -0.810833
0 1.049 1.859667 -0.810667 mm DIFF -0.333333

SETUP 3
BS BM C FS BM L

TI Ave (HI) TI Ave BM El
Top 1.852 1.817333 Top 0.633 0.623667
Mid 1.818 0.034 Mid 0.624 0.009
Bot 1.782 0.036 Bot 0.614 0.01

DTI DTI
2 1

BM C HI Rod BM L
0 1.817333 0.623667 1.193667

SETUP 4
BS BM C FS BM L

TI Ave (HI) TI Ave BM El
Top 1.851 1.817 Top 0.635 0.625333
Mid 1.817 0.034 Mid 0.625 0.01
Bot 1.783 0.034 Bot 0.616 0.009

DTI DTI
0 1

BM C HI Rod BM L BM L AVE 1.192667
0 1.817 0.625333 1.191667 mm DIFF 2

SETUP 1
BS BM C FS P ANT

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.377 0.364



Mid 2.681 0.023 Mid 0.364 0.013
Bot 2.657 0.024 Bot 0.351 0.013

DTI DTI
1 0

BM C HI Rod P ANT
0 2.680667 0.364 2.316667

SETUP 2
BS BM C FS P ANT

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.394 0.382
Mid 2.685 0.023 Mid 0.382 0.012
Bot 2.661 0.024 Bot 0.37 0.012

DTI DTI
1 0

BM C HI Rod P ANT P ANT AVE 2.309667
0 2.684667 0.382 2.302667 mm DIFF 14

SETUP 1
BS BM C FS S ANT

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.394 0.381667
Mid 2.681 0.023 Mid 0.382 0.012
Bot 2.657 0.024 Bot 0.369 0.013

DTI DTI
1 1

BM C HI Rod S ANT
0 2.680667 0.381667 2.299

SETUP 2
BS BM C FS S ANT

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.376 0.363333
Mid 2.685 0.023 Mid 0.363 0.013
Bot 2.661 0.024 Bot 0.351 0.012

DTI DTI
1 1

BM C HI Rod S ANT S ANT AVE 2.310167
0 2.684667 0.363333 2.321333 mm DIFF -22.33333



SETUP 7
BS BM C FS IMU

TI Ave (HI) TI Ave BM El
Top 1.068 1.06 Top 1.928 1.918
Mid 1.06 0.008 Mid 1.918 0.01
Bot 1.052 0.008 Bot 1.908 0.01

DTI DTI
0 0

BM C HI Rod IMU
0 1.06 1.918 -0.858

SETUP 8
BS BM C FS IMU

TI Ave (HI) TI Ave BM El
Top 1.058 1.049 Top 1.918 1.908667
Mid 1.049 0.009 Mid 1.909 0.009
Bot 1.04 0.009 Bot 1.899 0.01

DTI DTI
2.22E-13 1

BM C HI Rod IMU IMU AVE -0.858833
0 1.049 1.908667 -0.859667 mm DIFF 1.666667

SETUP 1
BS BM C FS PC

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.409 2.383
Mid 2.681 0.023 Mid 2.383 0.026
Bot 2.657 0.024 Bot 2.357 0.026

DTI DTI
1 0

BM C HI Rod PC
0 2.680667 2.383 0.297667 MEASURED

SETUP 2
BS BM C FS PC

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 2.409 2.383667
Mid 2.685 0.023 Mid 2.384 0.025



Bot 2.661 0.024 Bot 2.358 0.026
DTI DTI

1 1
BM C HI Rod PC PC AVE 0.299333

0 2.684667 2.383667 0.301 mm DIFF -3.333333

SETUP 3
BS BM C FS TEMP BM

TI Ave (HI) TI Ave BM El
Top 1.852 1.817333 Top 3.448 3.429667
Mid 1.818 0.034 Mid 3.429 0.019
Bot 1.782 0.036 Bot 3.412 0.017

DTI DTI
2 2

BM C HI Rod TEMP BM
0 1.817333 3.429667 -1.612333

SETUP 4
BS BM C FS TEMP BM

TI Ave (HI) TI Ave BM El
Top 1.851 1.817 Top 3.449 3.43
Mid 1.817 0.034 Mid 3.43 0.019
Bot 1.783 0.034 Bot 3.411 0.019

DTI DTI
0 4.44E-13

BM C HI Rod TEMP BM TEMP BM -1.612667
0 1.817 3.43 -1.613 mm DIFF 0.666667



1018 Launch Offset Measurements
Jul-04

All offsets are in Theodolite Coordinate System
The Z plane means were taken using only the vertical level measurements.
BM A      
X -0.00178 -0.005025 -0.002888 Mean -0.003231 0.001649 ⇐ X Std Dev
Y -1.412248 -1.412458 -1.41291 -1.412539 0.000338 ⇐ Y Std Dev
Z 0.294044 0.303685 0.300406 0.299333 0.299333

BM B      
X -0.0028 0.00421 0.006127 Mean 0.002512 0.004699 ⇐ X Std Dev
Y 1.408504 1.407088 1.411589 1.40906 0.002301 ⇐ Y Std Dev
Z 0.27338 0.278042 0.279241 0.275667  0.275667

BM C      
X 0 By Definition
Y 0
Z 0  

BM D      
X 6.971868 6.971768 6.9671 6.9698 Mean 6.970125 0.002251 ⇐ X Std Dev
Y 0 0 -0.0085 -0.0021 -0.002655 0.004025 ⇐ Y Std Dev
Z 0.690147 0.684947 0.6944 0.6993 0.695667 0.695667

BM E      
X 1.823338 1.826502 1.827443 Mean 1.825761 0.002151 ⇐ X Std Dev
Y -0.861834 -0.860711 -0.86167 -0.861405 0.000607 ⇐ Y Std Dev
Z 2.016038 2.016557 2.022004 2.018667  2.018667

BM F      
X 1.823502 1.830837 1.828721 1.824402 Mean 1.826865 0.003493 ⇐ X Std Dev
Y -0.006012 -0.004399 0.000149 0.002088 -0.002043 0.003794 ⇐ Y Std Dev
Z 2.051634 2.052789 2.057844 2.050034 2.054333 2.054333

BM G      



X 1.823585 1.830565 1.830913 Mean 1.828354 0.004134 ⇐ X Std Dev
Y 0.91883 0.919783 0.91818 0.918931 0.000806 ⇐ Y Std Dev
Z 1.995606 1.996363 2.000093 1.998333  1.998333

BM H      
X 3.30437 3.299646 3.302118 Mean 3.302044 0.002363 ⇐ X Std Dev
Y 0.433739 0.429017 0.429667 0.430807 0.002559 ⇐ Y Std Dev
Z -1.023898 -1.023054 -1.009757 -1.0485 -1.0485

BM I      
X 3.8371 3.840044 3.839125 Mean 3.838746 0.001523 ⇐ X Std Dev
Y 0.4284 0.421152 0.424451 0.424652 0.003604 ⇐ Y Std Dev
Z -1.0246 -1.021562 -1.009215 -1.047167  -1.047167

BM J      
X 3.288056 3.291774 3.291551 Mean 3.29046 0.002086 ⇐ X Std Dev
Y 0.00542 0.003591 0.002154 0.003722 0.001637 ⇐ Y Std Dev
Z -0.800463 -0.799134 -0.806486 -0.809667  -0.809667

BM K      
X 3.291145 3.29222 3.290883 Mean 3.291416 0.000708 ⇐ X Std Dev
Y 0.133544 0.134068 0.135052 0.134221 0.000765 ⇐ Y Std Dev
Z -0.802034 -0.801504 -0.80751 -0.810833  -0.810833

BM L      
X 4.884186 4.880297 4.876118 Mean 4.8802 0.004035 ⇐ X Std Dev
Y -0.002013 -0.004326 -0.0032 -0.00318 0.001157 ⇐ Y Std Dev
Z 1.18989 1.193829 1.196552 1.192667 1.192667

S ANT      
X 2.440518 2.446009 2.447502 Mean 2.444676 0.003678 ⇐ X Std Dev
Y 0.921654 0.919158 0.920894 0.920569 0.00128 ⇐ Y Std Dev
Z 2.304557 2.302682 2.302589 2.310167  2.310167

P ANT      
X 2.444717 2.447164 2.444094 Mean 2.445325 0.001623 ⇐ X Std Dev



Y -0.915528 -0.911221 -0.913599 -0.913449 0.002157 ⇐ Y Std Dev
Z 2.321867 2.322209 2.324743 2.309667  2.309667

IMU      
X 3.545087 3.54707 3.545445 Mean 3.545867 0.001057 ⇐ X Std Dev
Y -0.014953 -0.014531 -0.015986 -0.015157 0.000748 ⇐ Y Std Dev
Z -0.848158 -0.84679 -0.853756 -0.858833  -0.858833

TBM Theo     
X 10.02333 10.02377 10.03171 Mean 10.02627 0.00472 ⇐ X Std Dev
Y 0.42237 0.425222 0.425761 0.424451 0.001822 ⇐ Y Std Dev
Z -1.864111 -1.866423 -1.865728 -1.86542  -1.86542

Phase Center     
X 3.382044 3.382044 3.382044 Mean 3.382044 0 ⇐ X Std Dev
Y 0.287807 0.285807 0.287807 0.287141 0.001155 ⇐ Y Std Dev
Z -1.4085 -1.4085 -1.4085 -1.4085  -1.4085









 

1018 Vessel Diagram



1018 Offset Measurements 
 
Sources 
 
In general launches require two pieces of information in order to determine their lever 
arms for CARIS and the POS/MV.  The first piece of information is the position of the 
physical offsets between the multibeam system components and the second is the position 
of the roll point. 
 
Physical offset information was derived from values measured by ship’s personnel with the 
assistance of Hydrographic Systems and Technology Personnel and Pacific Hydrographic Branch 
Personnel.  The general procedure used is described in the Measuring Launch Offsets SOP 
document contained in Appendix VI-1 of the 2004 FAIRWEATHER Data Acquisition 
and Processing Report (hereafter known as the DAPR).  The resulting measurements are 
located in the Appendix III. 
 
The second source of information was from Appendix III of the RAINIER DAPR titled 
OPR_O112-RA-02.  Information about the roll point, center of motion for a vessel, was needed 
for the 1018 HVF.  Roll point values are calculated by conducting an inclination 
experiment.  The FAIRWEATHER had no roll point information since the results of an 
inclination experiment were not released before or during the field season.   For Launch 
2123 the heave measurement location (roll point) was 0.574 m aft of the IMU on the 
centerline and at the waterline.  Launch 2123 is very similar to Launch 1018 and its 
heave measurement location was used in Launch 1018’s offset measurements. 
 
Measurements 
 
All measurements were taken after launch 1018 was “leveled” in accordance with the 
Measuring Launch Offsets SOP using Leveling Procedure Method A:  Leveling to an 
Installed IMU.  All horizontal measurements were taken 3 times in order to determine a 
standard deviation.  The average standard deviation for horizontal measurements was 2.2 
mm.  
 
Vertical measurements were conducted in accordance with the procedures defined in the 
Users Guide for the Installation of Bench marks and Leveling Requirements for Water 
Level Stations dated October 1987.  Vertical measurements were made with a Leica NA2 
with a stadia of 100.  The level specifications can be found in Appendix I of the DAPR.  
Each point was measured twice in accordance with the leveling procedure, and the runs 
between benchmarks were checked for closure.  According to Users Guide for the 
Installation of Bench marks and Leveling Requirements for Water Level Stations, the 
maximum closure tolerance for a single third-order section, one setup, less than 0.1 km in 
length, is 2 mm.  10 out of 17 vertical measurements exceeded the specification ranging 
from 4.67 mm to 2.67 mm.  These errors in closure, a function of training, were not found 
before the vessel was placed back in the water.  There was not an opportunity to re-level 
the vessel. 
 
 



 
With the exception of one set of measurements, horizontal measurements for lever arm 
distances were taken using a Sokkia Set 5F.  The Sokkia specifications are located in 
Total Station section of Appendix I.  In one instance, over a very short distance (< 0.4 m), 
the instrument could not be set up to calculate the difference in location.  That offset 
distance was measured with steel tape, plumb bob and carpenter’s squares.  
 
Required Measurements 
 
Pos/MV 
 
Measurements required by the IMU are lever arm distances from the IMU, the multibeam 
transducer, the heave measurement location (roll point), and the primary GPS antenna to 
the chosen reference point.  In the case of launch 1018 the reference point and the IMU 
are coincident.  This simplifies installation.  There is also a need for an antenna 
separation distance. 
 
CARIS 
 
Measurements required by CARIS are transducer to the reference point, IMU to the 
reference point and waterline to the reference point. 
 
Calculations 
 
The values for the required lever arms are listed in the 1018_Offsets and Measurements 
spreadsheet.  The reference point and the IMU are identical. 
  
As a requirement for the TPE, the standard deviation for each position, in each axis, was 
stated to be 7 mm. 
 
Pos/MV—IMU to Reference Point  
 
IMU to the Reference Point is zero on all axes since the IMU is chosen to be the origin. 
 
Pos/MV, CARIS—IMU (Reference Point) to Reson 8101 
 
The location of the phase center of the Reson 8101 and the location of the IMU were 
measured by NOAA personnel with respect to the Ship Reference Frame (SRF).  The 
lever arm distance between the phase center of the Reson 8101 and the IMU were then 
calculated.  The measurements and calculations are listed in the 1018 Offsets 
Measurements spreadsheet in Appendix III. 
 
Pos/MV—Antenna Separation  
 
The location of the phase center of the port and starboard POS/MV antennas were 
measured by NOAA personnel with respect to the SRF.  The scalar distance between the 



phase centers was then calculated.  The measurements and calculations are listed in the 
1018 Offsets Measurements spreadsheet in Appendix III. 
 
IMU(Reference Point) to Primary (Port) antenna —Pos/MV 
 
The location of the IMU and the location of the port antenna were measured by NOAA 
personnel with respect to the Ship Reference Frame (SRF).  The lever arm distance 
between the IMU and the port antenna were then calculated. The measurements and 
calculations are listed in the 1018 Offsets Measurements spreadsheet in Appendix III. 
 
CARIS—IMU(Reference Point) to Waterline 
 
The vertical distance between the top of the IMU to the waterline was measured by 
FAIRWEATHER personnel using a steel tape measuring from BM A to the waterline.  
With the knowledge of BM A’s height above the IMU the waterline height above the 
IMU can be calculated.   The measurements and calculations are listed in the 1018 
Offsets Measurements spreadsheet in Appendix III. 
 
Pos/MV—IMU (Reference Point) to Heave 
 
The heave measurement location was positioned differently on the three axes.  On the 
longitudinal axis the distance was determined from the RAINIER DAPR described on 
paged 1 of this document.  The athwart ships axis for the heave measurement location is 
the vessel centerline.  Lastly the height of the heave measurement location was equivalent 
to the waterline.  This waterline value was calculated in the same manner as the above 
paragraph, though the values are not identical as they were measured on different days. 
The measurements and calculations are listed in the 1018 Offsets Measurements 
spreadsheet in Appendix III. 
 
 

Jess
Might want to state where exactly we were measuring to on the antennas (base center).
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Date: Sept. 1,2004 DN: 245 Local Area:  Tongass Narrows/Blank Inlet Wx: Sunny 
SV Cast #1 filename: 
04245103.2 

UTC time: 
1032 

Lat: 
55/20/03.32 

Lon: 
131/38/05.92 

Depth: 
48 

Ext Depth: 
62.4 

SV Cast #2 filename: 
04245125.7 

UTC time: 
1257 

Lat: 
55/16/30.31 

Lon: 
131/39/39.7 

Depth: 
71.5 

Ext Depth: 
92.9 

 

Personnel: 
Walker, Froelich, Wetzler, Sampadian 

Other Comments: 
Use 1010 SVP casts 

 

ROLL LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
245-2046 (Roll1) 142 5.5  
245-2052 (Roll2) 252 5.5  
245-2131 (Roll3) 175 6.8 XL 
    
    

2 

    

 

PITCH LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
245-2059 (Pitch1) 190 7.4 Do Not Use (Logs in water) 
245-2102 (Pitch2) 355 8.0  
245-2105 (Pitch3) 175 7.5 Do Not Use 
245-2111 (Pitch4) 155 7.5  
245-2120 (Pitch5) 165 7.0  
245-2124 (Pitch6) 365 7.5  
    

2 

    

HEADING LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
245-1913 (Yaw1) 153 5 Test line- Do not use 
245-1923 (Yaw2) 115 4.9 Perpendicular over wreck 
245-1929 (Yaw3) 295 7.7 “                 “                “ 
    
    

1 

    



Processing Patch Test        __1018___ _             245/9-1-04                              
     (Vessel)    (Dn/Date) 

x Data Converted  HDCS_Data in CARIS 

x True Heave Applied 

x Tide Applied ________  9450460.tid___ Observed_________________________    
Type (Zero, Observed, Verified) 

        Zoned ____________________________________ 
ZDF File 

x SVP applied 1010_245.svp 
 File 

x Lines merged  

        x Data cleaned to remove gross fliers 
Compute Correctors – Order 

 
1) Precise Timing         2) Pitch Bias         3) Roll Bias        3) Heading Bias 
 
Do not Enter/Apply Correctors until all evaluations are complete and analyzed. 

  
Patch Test Results/Correctors 
 
Evaluator Timing (sec) Pitch (deg) Roll (deg) Hdg (deg) 
Grant 0.00 0.93 0.43 -0.30 

Kim 0.10 -0.70 0.37 -0.54 

Mark 0.10 -0.80 0.38 -0.70 

Lynn 0.10 -0.54 0.39 -0.66 

Grant #2 0.10 -0.72 0.38 -0.68 

Final Values 0.10 -0.70 0.38 -0.66 

 
Final Values based on:   Consensus 
 

□ HVF Hydrographic Vessel File created or updated with current offsets 
Name: __________________________ Date: ______________________ 
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Patch Test Acquisition Log __1018_________ 
                                                                      (Vessel) 
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Date: Nov. 3 ,2004 DN: 308 Local Area:  Punchbowl Cove, Rudyerd Bay Wx: Rainy 
SV Cast #1 filename: 
04308220.5ex 

UTC time: 
2205 

Lat: 
55/31/54 

Lon: 
130/47/00 

Depth: 
84.7 

Ext Depth: 
110.1 

SV Cast #2 filename: 
 

UTC time: 
 

Lat: 
 

Lon: 
 

Depth: 
 

Ext Depth: 
 

 

Personnel: 
Wetzler, Kellner, Higgins 

Other Comments: 
 

 

ROLL LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Roll1_1018_308  8  
Roll2  8  
Roll3  8  
Roll4  8  
Roll5  14 Coming on too line quickly 
Roll6  14  
Roll7  14  

 

Roll8  14  
 Roll9  14  
 Roll10  14  
 Roll11  14  

 

PITCH LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Pitch1_1018_308  8  
Pitch2_1018_308  8  
    
    
    
    
    

2205 

    



 

HEADING LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Heading1_1018_308  8  
Heading2_1018_308  8  
Heading3_1018_308  8  
Heading4_1018_308  8  
Heading5_1018_308  8  

2205 

Heading6_1018_308  8  
 Circle_Test  7  
     
     
     

 
 

 

NAV Latency 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Latency1_1018_308    
Latency2_1018_308    
Latency3_1018_308    
    
    

2205 

    
     
     
     
     

 
 
 
 
 
 
 
 
 
 



Processing Patch Test        __1018___ _             308/11-3-04                           
        (Vessel)    (Dn/Date) 

x Data Converted  HDCS_Data in CARIS 

x True Heave Applied 

x Tide Applied ________         Zero Tide___________                   
Type (Zero, Observed, Verified) 

        Zoned ________________________________ 
ZDF File 

x SVP applied 04308220.5ex 
 File 

x Lines merged  

        x Data cleaned to remove gross fliers 
Compute Correctors – Order 

 
1) Precise Timing         2) Pitch Bias         3) Roll Bias        3) Heading Bias 
 
Do not Enter/Apply Correctors until all evaluations are complete and analyzed. 

  
Patch Test Results/Correctors 
 
Evaluator Timing (sec) Pitch (deg) Roll (deg) Hdg (deg) 
Abigail 0.01 -0.60 0.52 0.12 

Jess 0.00 -0.62 0.56 -0.9 

Mark Van Waes 0.00 -0.60 0.51 -0.6 

     

     

Final Values 0.00 -0.60 0.54 0 

Final Values 
based on 

Average Average Average FOO 

 
 

X HVF Hydrographic Vessel File created or updated with current offsets 
Name: __Mark Wetzler               __ Date: _______Dn 310_______________ 
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Location 1
Speed        Delta Depth

The DDSSM values at location 1 were used in the HVF, the values at this location better represent the motion of 
launch 1018.  Location 3 was completely disregarded after analyzing the data in that area in subset mode in CARIS 
Hips.

3.2 0
4.7 0.016255
6.4 0.037244
8.4 0.052051

10.6 0.02324
12.3 -0.0435
14.3 -0.13204

Location 2
Speed DD2

0 0
4 -0.02113
6 -0.01012
8 0.009358

10 -0.03981
12 -0.11947
14 -0.16339

Location 3
Speed DD3

0.9 0
4 -0.16615
6 -0.12654
8 -0.11113

10 -0.10011
12 -0.09211
14 -0.08562

Average
0 0
4 -0.05701
6 -0.03314
8 -0.01657

10 -0.03889
12 -0.08502
14 -0.12702

Average Loc 1 & 2
0 0
4 -0.00244
6 0.013562
8 0.030704

10 -0.00828
12 -0.08148
14 -0.14772

1018 DDSSM

-0.2

-0.15

-0.1

-0.05

0

0.05

0.1

0 4 6 8 10 12 14
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D
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Ship: Fairweather Vessel: 1018
Date: 9/1/2004 Dn: 245
Personnel: Froelich, Wetzler, Sampadian

PCS Serial # 786

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 2.10d

POS Version (Use Menu View > Statistics) MV320 Ver3 
GPS Receivers

Primary Receiver SGN 99330009

Secondary Receiver SGN 98370085

Calibration area
Location: D M S
Approximate Position: Lat 55 19 46

Lon 131 37 27
DGPS Beacon Station: Annette Island, AK
Frequency: 323 kHZ

Satellite Constellation (Use View> GPS Data)
Primary GPS (Port Antenna) N

HDOP: 0.873
VDOP: 1.033

Sattelites in Use: 9
1,4,11,13,16,20,23,25,30

PDOP 1.352 (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS

NOAA POS/MV Calibration Report

Ketchikan, AK



POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector

1.834 Two Antenna Separation (m) 0 X Component (m)
0.30 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

Configuration Notes: GAMS needed re-calibration because the leverarm for IMU to Port Antenna was incorrect

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 10:18
End time: 10:20
Heading accuracy achieved for calibration: 0.099

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
1.831 Two Antenna Separation (m) -0.002 X Component (m)
0.300 Heading Calibration Threshold 1.831 YComponent (m)

0 Heading Correction 0.021 Z Component (m)

GAMS Status Online X
Save Settings X

Calibration Notes: Took over an hour to get fixed OTF solution and GAMS Ready Offline

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: POSMV_09012004.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

NOTE: COM3 and Analog are not used.

Heave Filter (Use Settings > Heave) Events (Use Settings > Events)

SETTINGS Continued
Time Sync (Use Settings > Time Sync)



INSTALLATION (Use Settings > Installation)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)



User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



Ship: Fairweather Vessel: 1018
Date: 11/3/2004 Dn: 308
Personnel: Wetzler, Kellner, Higgins

PCS Serial # IMU Serial # 323

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 2.1

POS Version (Use Menu View > Statistics) MV320 V3
GPS Receivers

Primary Receiver SGN99330009

Secondary Receiver SGN98370085

Calibration area
Location: D M S
Approximate Position: Lat 55 32 25

Lon 130 47 52
DGPS Beacon Station: Annette Island
Frequency: 323 KHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Primary and secondary GPS satellite configurations are identical.

N
HDOP HDOP

1.01 1.01

VDOP VDOP
1.033 1.033

Sattelites in use: 8 Sattelites in use: 8
L1 SNR > 45 L1 SNR > 45

PDOP 1.352 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector

1.83 Two Antenna Separation (m) 0 X Component (m)
0.3 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

Configuration Notes:

NOAA POS/MV Calibration Report

Punchbowl Cove, Rudyerd Bay, AK

Secondary GPS

N

786



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 1056
End time: 1058
Heading accuracy achieved for calibration: 0.098

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
1.83 Two Antenna Separation (m) -0.002 X Component (m)
0.3 Heading Calibration Threshold 1.831 YComponent (m)

0 Heading Correction 0.021 Z Component (m)

GAMS Status Online X
Save Settings X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 110304_2.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

Note: In COM1, only the UTC string is selected

Note: COM3 and Analog are not used



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Time Sync (Use Settings > Time Sync)
1 User Time Conversion (Units/Sec.)

INSTALLATION (Use Settings > Installation)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Lever Arms & Mounting Angles (Use Settings > Installation > Lever Arms & Mounting Angles)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)



Frame Control (Use Tools > Config)
X User Frame Primary GPS Measurement Normal

IMU Frame Auxiliary GPS Measurement Normal

X Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver
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NOAA SHIP FAIRWEATHER 

NOAA SHIP FAIRWEATHER (S220) 
RESON 8111ER CALIBRATION REPORT 20041

SST Jessica Abrams 
 

 
Background: 
NOAA Ship FAIRWEATHER (S220) is a 231' hydrographic survey vessel.  It is 
equipped with a Reson 8111 MWMB system mounted in the hull of the vessel 
starboard of the centerline.  The Reson 8111ER operates at a frequency of 100 
kHz and has a variable ping rate dependant upon depth.  The maximum ping rate 
is user set to 35 Hz.  The Reson 8111ER has 101 1.5° across-track x 1.5°, 3.0°, 
4.5°, or 6.0° (operator selected) along-track beams and has an technical depth 
range of 3m to 1200m.  Multibeam data is collected in XTF format using TEI Isis 
Sonar v6.6.  Sound velocity correctors are acquired with a SeaBird SeaCat SBE 
19plus sound velocity profiler.  FAIRWEATHER (S220) is equipped with an 
Applanix Position and Orientation System for Marine Vessels (POS/MV) 320 
version 3.  The POS/MV components include an IMU-200 strap down inertial 
measurement unit (IMU), a version 2.10d POS Computer System (PCS) and two 
NovAtel GPS antennas.  Differential correctors are supplied to the POS/MV by a 
CSI Wireless MBX-3S Automatic Differential GPS receiver.  FAIRWEATHER 
(S220) is equipped with Applanix TrueHeave1 and “Precise Timing”2.  Residual 
biases were assessed in CARIS HIPS & SIPS v5.4 calibration mode and applied 
to the HIPS Vessel File (HVF), S220_8111.HVF.     
 
Location, Date, Personnel: 
Patch Test 
Multiple patch tests of the Reson 8111ER were attempted with FAIRWEATHER 
(S220) in several different locations in the 2004 field season.  Because of various 
technical issues and incorrect configurations, only one of these was used in the 
final S220_8111.HVF.  The patch test done on September 16th  (Dn 260) in 
Sumner Strait off Point Saint Albans, AK was accepted and processed for 
residual biases.  The pitch and heading bias patch lines were run over a 16 
fathom shoal at 56°03’44.60”N, 133°55’24.75”W.  The roll and precise timing bias 
patch lines were run over a flat area at location 56°01’53.25”N. 133°57’33.95”W 
with an approximate depth of 75m.  See Figure 1 for patch test area.  
 
GAMS Calibration 
A POS/MV GPS Azimuth Measurement Subsystem (GAMS) calibration was 
conducted on September 16th (Dn 260) in Affleck Canal, AK.  The GAMS 
calibration was performed by LT Wetzler and PS Sampadian.  

                                                 
1 Applanix web site. http://www.applanix.com. June 2004 
2 Evans, Ben, LTJG, NOAA. Upgrading NOAA Multibeam Acquisition Systems to “Precise Timing”. May 

2004 
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NOAA SHIP FAIRWEATHER 

 

     
 

Figure 1:  Location of heading, pitch, roll and precise timing bias patch lines.  
Dynamic Draft 
A Dynamic Draft, Settlement and Squat Method (DDSSM) test was conducted on 
July 3, 2004 off Port Angeles, WA, but changes in POS/MV configuration since 
that test have rendered the results unusable.  The DDSSM calibration will be 
done again at a later date.  Until those results are available, no values for 
dynamic draft will be included in S220_8111.HVF. 
 
Equipment: 
1 Reson 8111ER Medium Water Multibeam Echosounder 
1 Applanix POS/MV Version 3.20 Strap-Down IMU 
2 Novatel GPS Antennas 
1 CSI wireless MBX-3S Automatic Differential GPS receiver 
1 Seabird Seacat SBE 19plus sound velocity profiler 
TEI Isis Sonar v6.6 w/ BathyPro Real Time Bathymetry 
CARIS HIPS & SIPS v5.4 SP1, HF’s1-7 
 
Procedure: 
Patch
All lines: All lines were “lightly” cleaned in CARIS swath mode to get rid of major 
data fliers.  SVP and observed tides were applied.  The patch data were 
processed and examined for bias independently by SST Froelich, SST Abrams, 
LT Wetzler, CST Morgan, and PS Sampadian.  All patch lines were examined for 
biases and latency in CARIS HIPS & SIPS Calibration mode in the order listed 
below.  The patch test results are located in Table 1.      
 
Sensor Latency: One line from the roll patch data was chosen for latency biases.  
Final values entered into S220_8111.HVF were based on an average value. Roll 
time error was applied to Nav time, Gyro time and Pitch time errors in the 
S220_8111.HVF. 
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NOAA SHIP FAIRWEATHER 

Pitch: One pair of coincident lines was run over a 16 fathom shoal at the same 
speed in different directions.  The lines were run at 6 knots.  Final values entered 
into S220_8111.HVF were based on a consensus value. 
  
Roll: One pair of coincident lines was run over a flat area approximately 60m 
deep at the same speed in different directions.  The lines were run at 7 to 8 
knots.  Final values entered into S220_8111.HVF were based on a consensus 
value. 
 
Heading: One pair of parallel lines offset by 170m was run in opposite directions 
at the same speed over a known target.  The lines were run at 6 to 7 knots.  Final 
values entered into S220_8111.HVF were based on a consensus value. 
 

Patch Bias Bias value 
Sensor Latency 

Pitch 
Roll 

Heading 

0.11 sec 
 0.20° 
 0.00° 
-0.80° 

Table 1. Patch test bias results 
 
The patch test acquisition and processing logs for Dn#260 are located in 
Appendix III-S220-3. 
 
POS/MV GAMS Calibration 
The CSI wireless MBX-3S Automatic Differential GPS receiver was set to the 
DGPS Beacon station Biorka (305 kHz)  The GAMS heading calibration 
threshold was set initially to 0.70°, though a heading accuracy of 0.468° was 
achieved before GAMS calibration was requested.  A GAMS was then requested 
and the ship maintained a constant speed and heading until the calibration was 
complete.  The resulting POS/MV settings were saved to the file 
S220_091604_SN846.nvm (see Table 2). 
 

Component Value 
Baseline Vector X 
Baseline Vector Y 
Baseline Vector Z 

Two Antenna Separation 
Heading Correction 

-0.032 m 
4.067 m 
0.017 m 
4.067 m 
0.000 ° 

Table 2. POS MV GAMS Calibration Results 
 

The detailed POS/MV Calibration Report, 1010_POS_Calibration_091604.xls, is 
located in Appendix III-S220-5. 

 
Recommendations: 
The patch test calibration results should be used from September 16, 2004 (Dn 
260) and should be used until such time as a new calibration is necessary.   
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NOAA SHIP FAIRWEATHER 

No DDSSM results are presently available and so no values should be entered 
into S220_8111.HVF until a new test is conducted and accepted. 
 
The POS/MV GAMS calibration results should be used from September 16th (Dn 
260) and should be used until such time as a new calibration is necessary. 
 
 
                                                 
1 The format and much of the content of this document was adapted directly from NOAA Hydrographic 
Survey Launch 1010 Calibration Report 2004, by SST Grant Froelich 
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Vessel Name: S220_8111.hvf 
Vessel created: October 29, 2004 
 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2003-365 00:00 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: 0.200 
 Roll Offset: 0.000 
 Azimuth Offset: -0.800 
 
 DeltaX: 2.868 
 DeltaY: 8.252 
 DeltaZ: 4.753 
 
 Manufacturer:  Reson 
 Model:   sb8111 
 Serial Number:  (null) 
 
_________________________________________________________ 
Navigation Sensor: 
 
 Time Stamp:  2003-365 00:00 
 
 Comments (null) 
 Latency 0.110 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  846 
 
_________________________________________________________ 
Gyro Sensor: 
 
 Time Stamp:  2003-365 00:00 
 
 Comments (null) 
 Latency 0.110 
 
_________________________________________________________ 
Heave Sensor: 
 
 Time Stamp:  2003-365 00:00 
 
 Comments TrueHeave Enabled 
 Apply Yes 
 Latency 0.110 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 



 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  846 
 
_________________________________________________________ 
Pitch Sensor: 
 
 Time Stamp:  2003-365 00:00 
 
 Comments (null) 
 Apply Yes 
 Latency 0.110 
 Pitch offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  846 
 
_________________________________________________________ 
Roll Sensor: 
 
 Time Stamp:  2003-365 00:00 
 
 Comments (null) 
 Apply Yes 
 Latency 0.110 
 Roll offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV v320 
 Serial Number:  846 
 
_________________________________________________________ 
Draft Sensor: 
 
 Time Stamp:  2003-365 00:00 
 
 Apply Yes 
 Comments (null) 
_________________________________________________________ 
TPE 
 
 Time Stamp:  2003-365 00:00 
 
 Comments Not Finished 
 Offsets  
 
 Motion sensing unit to the transducer 1  
  X Head 1 2.868 
  Y Head 1 8.252 
  Z Head 1 4.753 
 Motion sensing unit to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 Navigation antenna to the transducer 1 



  X Head 1 2.993 
  Y Head 1 19.145 
  Z Head 1 16.253 
 Navigation antenna to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 
 Roll offset of transducer number 1 0.000 
 Roll offset of transducer number 2 0.000 
 
 Heave Error: 0.050 or 5.000'' of heave amplitude. 
 Measurement errors: 0.003 
 Motion sensing unit alignment errors 
 Gyro:0.000 Pitch:0.000 Roll:0.000 
 Gyro measurement error: 0.020 
 Roll measurement error: 0.020 
 Pitch measurement error: 0.020 
 Navigation measurement error: 0.500 
 Transducer timing error: 0.001 
 Navigation timing error: 0.001 
 Gyro timing error: 0.001 
 Heave timing error: 0.001 
 PitchTimingStdDev: 0.001 
 Roll timing error: 0.001 
 Sound Velocity speed measurement error: 0.500 
 Surface sound speed measurement error: 0.500 
 Tide measurement error: 0.010 
 Tide zoning error: 0.000 
 Speed over ground measurement error: 0.030 
 Dynamic loading measurement error: 0.030 
 Static draft measurement error: 0.050 
 Delta draft measurement error: 0.010 
_________________________________________________________ 
Svp Sensor: 
 
 Time Stamp:  2003-365 00:00 
 
 Comments (null) 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 2.868 
 DeltaY: 8.252 



 DeltaZ: 4.753 
 
_________________________________________________________ 
WaterLine: 
 
 Time Stamp:  2003-365 00:00 
 
 Comments (null) 
 Apply Yes 
 WaterLine 0.074 
 WaterLineStdDev 0.000 
_________________________________________________________ 



S220_8111

S220 - 8111
Measurement IMU to 8111 (MRU to Trans) Port Ant to 8111 (Nav to Trans) Waterline to RP* Port Ant to Stbd Ant
Coord. Sys. Caris Caris Caris
x 2.868 2.993 n/a Scaler Distance 4.064
y 8.252 19.145 n/a
z 4.753 16.253 0.074

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf

Calculations
Coord. Sys. IMU to 8111 Port Ant to 8111 Waterline to RP* Port Ant to Stbd Ant
Westlake IMU easting 0.000 Port easting -35.739 IMU Base to baseline at Keel Port easting -35.739

Base northing 0.000 Ant northing -0.409 (ft) elevation 12.856 Ant northing -0.409
(ft/m) elevation 0.000 (ft) elevation -38.283 IMU Base to baseline at Keel (ft) elevation -38.283

(m) elevation 3.919
8111 easting 27.072 8111 easting 27.072 Stbd easting -35.866

(ft) northing 9.410 (ft) northing 9.410 Waterline to Keel Ant northing 12.925
elevation 15.042 elevation 15.042 (ft) elevation 13.167 (ft) elevation -38.209

Waterline to Keel
8111 easting 8.252 Port Ant to 8111 (m) elevation 4.013

(m) northing 2.868 (ft) easting 62.811
elevation 4.585 northing 9.819 Top of IMU to Base of IMU

elevation 53.325 (m) elevation 0.168
Base of IMU to Top of IMU Top of IMU to Keel

(m) elevation -0.168 (m) elevation 4.087

Top of IMU to 8111 Port Ant to 8111 Waterline to IMU
(m) easting 8.252 (m) easting 19.145 (m) easting N/A

northing 2.868 northing 2.993 northing N/A Port Ant to Stbd Ant
elevation 4.753 elevation 16.253 elevation 0.074

Scalar Distance (ft) 13.335
Coord Sys. CARIS Coord Sys. CARIS Coord. Sys. CARIS

x 2.868 x 2.993 x N/A Scalar Distance (m) 4.064
y 8.252 y 19.145 y N/A
z 4.753 z 16.253 z 0.074

see Description Tab
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S220_8111

IMU to Port Ant IMU to Heave
Caris Pos/Mv Caris Pos/Mv

-0.125 -10.893 1.866 -7.028
-10.893 -0.125 -7.028 1.866
-11.501 -11.501 -2.085 -2.085

IMU to Port Ant IMU to Heave
IMU easting 0.000 IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel
Base northing 0.000 (ft) easting 11.638 (ft) elevation 12.856

(ft/m) elevation 0.000 (m) easting 3.547 (m) elevation 3.919

Port easting -35.739 Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU
Ant northing -0.409 (m) easting 27.737 (m) elevation 0.168

(ft) elevation -38.283 Top of IMU to Keel
IMU to Frame 0 (FP) (m) elevation 4.087

Port easting -10.893 (m) easting 24.19
Ant northing -0.125 Center of Gravity above baseline

(m) elevation -11.669 Heave Pt* to Frame 0 (FP) (ft) elevation 16.37
(ft) easting 102.42 Mean Metacentric height

Base of IMU to Top of IMU (m) easting 31.218 (ft) elevation 3.88
(m) elevation -0.168

IMU to Centerline Heave Pt* to baseline at Keel
Top of IMU to Port Ant (ft) northing 6.122 (ft) elevation 20.25

(m) easting -10.893 (m) northing 1.866 (m) elevation 6.172
northing -0.125
elevation -11.501 Heave Pt* to Centerline Top of IMU to Heave Pt*

(m) northing 0 (m) easting -7.028
Coord Sys. Pos/Mv northing 1.866

x -10.893 Coord. Sys. Pos/Mv elevation -2.085
y -0.125 x -7.028
z -11.501 y 1.866 (*Heave Pt is Metacenter)

z -2.085 (FP is Forward Perpendicular)
see Description Tab
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S220_8160

S220 - 8160
Measurement IMU to 8160 (MRU to Trans) Port Ant to 8160 (Nav to Trans) Waterline to RP* Port Ant to Stbd Ant
Coord. Sys. Caris Caris Caris
x 0.493 0.618 n/a Scaler Distance 4.064
y 7.665 18.559 n/a
z 4.727 16.227 0.074

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220_8160 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf

Derivisions
Coord. Sys. IMU to 8160 Port Ant to 8160 Waterline to RP Port Ant to Stbd Ant
Westlake IMU easting 0.000 Port easting -35.739 IMU Base to baseline at Keel Port easting -35.739

Base northing 0.000 Ant northing -0.409 (ft) elevation 12.856 Ant northing -0.409
(ft/m) elevation 0.000 (ft) elevation -38.283 IMU Base to baseline at Keel (ft) elevation -38.283

(m) elevation 3.919
8160 easting 25.149 8160 easting 25.149 Stbd easting -35.866

(ft) northing 1.619 (ft) northing 1.619 Waterline to Keel Ant northing 12.925
elevation 14.956 elevation 14.956 (ft) elevation 13.167 (ft) elevation -38.209

Waterline to Keel
8160 easting 7.665 Port Ant to 8160 (m) elevation 4.013

(m) northing 0.493 (ft) easting 60.888
elevation 4.559 northing 2.028 Top of IMU to Base of IMU

elevation 53.239 (m) elevation 0.168
Base of IMU to Top of IMU Top of IMU to Keel

(m) elevation -0.168 (m) elevation 4.087

Top of IMU to 8160 Port Ant to 8160 Waterline to IMU
(m) easting 7.665 (m) easting 18.559 (m) easting N/A

northing 0.493 northing 0.618 northing N/A Port Ant to Stbd Ant
elevation 4.727 elevation 16.227 elevation 0.074

Scalar Distance (ft) 13.335
Coord Sys Caris Coord Sys Caris Coord. Sys. CARIS

x 0.493 x 0.618 x N/A Scalar Distance (m) 4.064
y 7.665 y 18.559 y N/A
z 4.727 z 16.227 z 0.074

see Description Tab
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S220_8160

IMU to Port Ant IMU to Heave
Caris Pos/Mv Caris Pos/Mv

-0.125 -10.893 1.866 -7.028
-10.893 -0.125 -7.028 1.866
-11.501 -11.501 -2.085 -2.085

IMU to Port Ant IMU to Heave
IMU easting 0.000 IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel
Base northing 0.000 (ft) easting 11.638 (ft) elevation 12.856

(ft/m) elevation 0.000 (m) easting 3.547 (m) elevation 3.919

Port easting -35.739 Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU
Ant northing -0.409 (m) easting 27.737 (m) elevation 0.168

(ft) elevation -38.283 Top of IMU to Keel
IMU to Frame 0 (FP) (m) elevation 4.087

Port easting -10.893 (m) easting 24.19
Ant northing -0.125 Center of Gravity above baseline

(m) elevation -11.669 Heave Pt* to Frame 0 (FP) (ft) elevation 16.37
(ft) easting 102.42 Mean Metacentric height

Base of IMU to Top of IMU (m) easting 31.218 (ft) elevation 3.88
(m) elevation -0.168

IMU to Centerline Heave Pt* to baseline at Keel
Top of IMU to Port Ant (ft) northing 6.122 (ft) elevation 20.25

(m) easting -10.893 (m) northing 1.866 (m) elevation 6.172
northing -0.125
elevation -11.501 Heave Pt* to Centerline Top of IMU to Heave Pt*

(m) northing 0 (m) easting -7.028
Coord Sys. Pos/Mv northing 1.866

x -10.893 Coord. Sys. Pos/Mv elevation -2.085
y -0.125 x -7.028
z -11.501 y 1.866 (*Heave Pt is Metacenter)

z -2.085 (FP is Forward Perpendicular)

see Description Tab
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S220 Offset Measurements 
 
Sources 
 
Offset values for the ship were derived from three sources.  A static offset survey, an inclination experiment, and 
values measured or approximated by ship’s personnel. 
 
On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by: 

 
Westlake Consultants, Incorporated 
15115 SW Sequoia Parkway, Suite 150 
Tigard, Oregon 97224 
Phone (503) 684-0652 
 

These values relate the physical positions of one sensor to the next with the base plate of the IMU being 
the point of origin.  All dimensions in the document are given in feet and decimal feet.  The Westlake 
document is located in the Data Acquisition and Processing Report (DAPR) appendices. 
 
On July 16, 2004 an inclination experiment was conducted at MOC-P by: 
  

Art Anderson Associates 
 202 Pacific Avenue 
 Bremerton, WA  98337-1932 
 
The importance of the inclination experiment document is the calculation of the location of the Heave 
Measurement location (Roll Point) of the vessel.  The Roll Point is the point of least nausea and is used by 
the IMU for the calculation of heave and the relative movement between sensors with respect to an earth 
reference frame.  The value of the Heave Measurement location is used in the POS/MV, but is not used in 
CARIS directly. 
 
Required Measurements 
 
Pos/MV 
Measurements required by the IMU are lever arm distances from the IMU, the multibeam transducer, the 
heave measurement location (roll point), and the primary GPS antenna to the chosen reference point.  In 
the case of the FAIRWEATHER the reference point and the IMU are coincident.  This simplifies 
installation.  There is also a need for an antenna separation distance. 
 
CARIS 
Measurements required by CARIS are transducer to the reference point, IMU to the reference point and 
waterline to the reference point. 
 
Calculations 
 
The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The 
reference point and the IMU are identical.  Difference in documentation between Westlake and FA 
calculations are based off of measuring up from the IMU base (Westlake’s origin) and the top of the IMU.  
The top center of the IMU for the POS/MV is the defined origin for the POS/MV and the origin that is 
being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of the IMU is 
0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft. 



 
As a requirement for the TPE, the standard deviation for each position is 3 mm.  This value is based upon 
a conversation with Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  
The email is located at the end of this document. 
 
Pos/MV—IMU to Reference Point  
 
IMU to the Reference Point is zero on all axes since the IMU is chosen to be the origin. 
 
Pos/MV, CARIS—IMU (Reference Point) to Reson 8111, and Reson 8160 
 
The lever arms between the IMU and phase center of the 8111 and the 8160 transducers are taken from 
the Westlake report with the addition of the 0.168 m offset included for the height of the IMU. 
 
Pos/MV—Antenna Separation  
 
From the Westlake survey it was determined that the vector for antenna separation was 4.064 m.   
 
Pos/MV— IMU(Reference Point) to Primary (Port) antenna 
 
This information comes directly from the Westlake survey. 
 
CARIS—IMU(Reference Point) to Waterline 
 
The height of the IMU above the keel comes from the Westlake survey as 3.919 m + 0.168 m for the IMU 
height for a total of 4.087 m above the keel.  The draft used for the FAIRWEATHER (based on repeated 
observations) was 13’ 2” (4.013 m).  Differencing the value of IMU to keel and waterline to keel gives a 
value of 0.074 m.  Since the waterline is below the reference point (IMU) the value is positive. 
 
Pos/MV—IMU (Reference Point) to Heave Measurement Location (Roll Point) 
 
Key points on the IMU, from the Westlake survey, are its location with respect to the ship’s reference 
frame.  It is 4.087 m (3.919 m to base line + 0.168 m for IMU height above base plate) above the keel, 
1.866 m port of centerline and 3.547 m forward of frame 52.  This information is needed to reference the 
IMU to the ship’s Heave Measurement Location (Heave Point).   
 
From the Art Anderson inclination experiment the position of the metacenter was used as the position of 
the ship’s Heave Point. (There may be a better way to determine the Heave Point, but this decision was 
based upon available information).  The metacenter is defined by the center of buoyancy.  As a vessel 
inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is at 
the metacenter.   
 
Important numbers and information determined from the Art Anderson report are the location of the 
metacenter and how it is positioned with respect to the vessel.  The longitudinal location of the metacenter 
is defined as 102.42 feet (31.217 m) aft of the forward perpendicular.  The height of the metacenter is 
20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on the centerline of 
the vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular 
and 5.2 m above the keel.  The difference in the height of the metacenter can be attributed to the 
difference between the FA’s and RA’s average draft which is 13.12 feet as opposed to approximately 14.5 
feet respectively. 



 
Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the 
frame spacing of the vessel.  From the Westlake survey, the IMU is located 3.547 m forward of frame 52.  
From Inclination document, the HP is 31.217 m aft of the forward perpendicular.  From engineering 
drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal 
location of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows: 
 
52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0. 
 
31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU) 
 
The calculation for the vertical separation between the IMU and the HP is based on the height of the 
metacenter being 6.172m and the height of the IMU being 4.087 m above the keel.  Differencing yields 
the metacenter being 2.085 m above the IMU. 
 
The calculation for the athwartship separation is based upon the assumption that the HP is on the 
centerline and the knowledge that the IMU is 1.866 m to port of the centerline. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



IMU to Heave
From pg 3 of the Westlake Survey









 



Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings 

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.
Negative values are port of the IMU.
Calculated values are in italics.

Eastings 

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU. 
Negative values are aft of the IMU.
Calculated values are in italics.

Elevations  

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation. 
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions 

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data 

At project initiation, control was established to define the ship's centerline 
as a plane running from a point on the centerline of the keel at the stern through a 
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock. 

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry. 
Following location of the IMU, data was transformed to the IMU as point of origin for 
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."
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Westlake Consultants, Inc.
9/23/2003

Ship's Centerline - Control Measurements 
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Defined by measurements at the keel centerline 
longitude transverse elevation

near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180' forward) 1180.121 1000.000 116.6810

Ship's Baseline

Defined by measurements on the keel 
longitude transverse elevation

at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines 
on IMU foundation plate 0.001

0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *
0.001

-0.001
0.000

-0.001

SUMMARY 
•  IMU foundation plate is level to within +/-0.001 feet.
•  IMU foundation plate is located 12.856 feet above baseline established at the keel.
•  IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
•  IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52. 

* elevation check adjusted for target 
that created 10 mm offset =.03281 

feet
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Westlake Consultants, Inc.
9/23/2003

Granite Block 
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines
1.584
1.583

Scribed lines - intersection/centerline of granite block 
-0.003 1.583

Deviation
Elevation checks near four corners of granite block from level

-0.217 -0.001
-0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY 
•  Granite block is level to within +/-0.001 foot 

of average elevation = -0.21632 feet
•  Granite block is parallel to ship's centerline to within  0.001 foot 

Location is  4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
•  Granite block is aligned with IMU to within 0.003 feet longitudinally. 

* elevation check adjusted for target that created 10 
mm offset = 0.03281 feet
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 

EASTING NORTHING ELEVATION

PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the 
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)

27.008 Forward edge of foundation as measured 
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array 
25.149 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation. 

1.369 Port edge of foundation  as measured 
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General 
 + 0.172 Distance from bolt hole centerline to array center 

1.619 feet starboard of IMU

Elevation 
Per Reson drawing 2148M011_001  the elevation is 83 mm below array mounting surface

14.679 Array foundation elevation as measured. 
  0.005 Isolation "shim" added between foundation and array 
  0.272 83 mm below array mounting surface to acoustical center 
14.956 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 
EASTING NORTHING ELEVATION

STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes. 
The elevation is defined as the center of the receiving array. 

Easting
Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation

28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated 

 - 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
 - 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.

9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation 
Elevation is 0.401 feet above receiver array mounting surface

16.085 Mounting foundation fixture plate as measured. 
15.447 Receiver foundation elevation - as calculated 

 + 0.005 Isolation "shim" added between foundation and array 
 - 0.410 Design distance from mounting surface of array to acoustic center 
15.042 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Port Side 
EASTING NORTHING ELEVATION

Horizontal alignment measured  at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated  to array centerline 
1.619
1.619

deviation from 
Elevation checks near four corners of array foundation level (average)

14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002

SUMMARY 
•  Port longitudinal array foundation average elevation is 14.679 feet.

Variation in elevation is +0.002 to -0.002 feet.
•  Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.

Calculated array centerline is 1.619 feet starboard of IMU 

Foundation edge is 0.25 feet port of 
array centerline
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Starboard Side 
EASTING NORTHING ELEVATION deviation from 

Horizontal alignment measured  on fixture plate scribe - parallel
9.410 0.002
9.406 -0.002

Forward edge of array foundation fixture plate - measured
28.563

deviation from
Elevation checks near four corners of array foundation "fixture plate" average

16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations
Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY 
•  Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.

Deviation from level (average elevation) is less than 0.001 feet. 
•  Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.

Variation from parallel is from -0.002  feet to +0.002 feet from average. 
•  Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU. 

Design location is 3.292 feet 
starboard of ship centerline 
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Port Side
EASTING NORTHING ELEVATION

Forward Edge - Transverse array foundation - measured
28.343
28.338

Port edge - Transverse array - measured
-0.181

Centerline of array - calculated  
28.093
28.088

Port edge of foundation plus 1.806 feet 1.624
to calculated array centerline 

deviation from 
Elevation checks near four corners of array foundation level

14.679 0.002
14.675 -0.001
14.675 -0.001
14.677 0.001

SUMMARY 
•  Transverse array foundation average measured elevation is 14.677 feet 

below IMU (0.006 feet above design location).
Deviation from level (average elevation) is 0.003 to -0.001 feet

•  Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average). 

•  Transverse array centerline is calculated to be 1.624 feet starboard of IMU. 

Foundation forward edge minus        
0.25 feet to array centerline

0.861 feet below baseline with 0.965 
foot offset = 98.180 feet average 
elevation
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered bo
transmitter and receiver foundations. The data provided here is primarily "calculated".

EASTING NORTHING ELEVATION

Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563

as measured 
Transmitter  (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate 
as measured - forward portion of plate
(near receiver array)
Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations
Receiver/Transducer Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263
Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY
•  Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation 

of 16.085 feet.  Deviation in elevation measurements across the  array fixture plate is less than 0.001 fe
•  Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.
•  Transverse array centerline is measured to be 9.406 feet starboard of IMU. 

Variation from parallel of the fixture plate across entire starboard array is ± 0.002  feet (from average). 
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Westlake Consultants, Inc.
9/23/2003

Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283

Foundation Plate Stack Antenna Alignment 7.677
Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.411
Port GYRO Foundation Plate Alignment 2.411

Stbd GYRO Foundation Plate Alignment 3.866
Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY
•  Foundation plate stack antenna alignment is parallel to ship's centerline.
•  Port GYRO Foundation Plate is aligned parallel to ship's centerline.
•  Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.
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Email regarding Standard Deviation of Westlake Survey 
 
Subject: Precision of Measurements - NOAA Fairweather (1109-11 and 12) 
Date: Thu, 12 Aug 2004 12:06:45 -0700 
From: "Elaine McDonald" <emcdonald@westlakeconsultants.com> 
To: <mark.wetzler@noaa.gov> 
CC: "Derek Colclough" <dcolclough@westlakeconsultants.com>, 
     "Mike Hargrave" <mhargrave@westlakeconsultants.com>, 
     "Judi Haney" <jhaney@westlakeconsultants.com>, 
      
Greetings Mark - 
 
As promised I am writing to document our conversation of late yesterday afternoon 
regarding the reliability of measurements on the NOAA Fairweather. 
 
We discussed your question here at Westlake and possible interpretations. 
 
We believe the you can comfortably use plus/minus 3 mm as the standard error of any 
given distance between 2 measured/located points on the vessel. We are confident that 
given the same circumstances, were we to repeat the measurements, our inter-point 
distances would be within plus/minus 3 mm of data reported (standard error). 
 
If the measurements were taken from a single instrument set up within a 
fairly close range the distance would be reliable to nearly plus/minus 1 mm.  
However, we had to take many measurements from a number of setups around, on, and 
inside the vessel, and we then tied all of these measurements to a common coordinate 
system. Consequently, it is not realistic to expect a 1 mm error. 
 
As we discussed yesterday, there are many other factors that will impact the location 
of each point and, consequently, the distance between two or more points. 
Temperature, sun light, deformation of the vessel when it is in and out of the water, 
movement of the drydock, settlement, definition of the actual point to be measured 
relative to the identified structure etc. all impact the reliability or repeatability 
of measurements. 
 
Nonetheless we appear to be in agreement that the 3 mm value will work in your 
software without introducing significant, additional variability. 
 
If you have questions or require additional information, please give me a call - or 
email. 
 
Best wishes, 
 
Elaine for Derek Colclough, Director, Industrial Measurement Division 
 
Elaine McDonald 
Director of Marketing 
Westlake Consultants, Inc. 
15115 SW Sequoia Parkway (150) 
Tigard, Oregon  97224 
 
phone    503-684-0652 
fax        503-624-0157 
toll-free  800-523-8750 
email     emcdonald@westlakeconsultants.com 
 
We invite you to visit our website  www.westlakeconsultants.com 
 
 
 



Patch Test Acquisition Log __S-220_________ 
                                                                      (Vessel) 

Page _1__ of _1__ 
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Date: Sept. 16,2004 DN: 260 Local Area:  Cape Decision Wx: 
SV Cast #1 filename: 
04260225 

UTC time: 
2257 

Lat: 
56/02.595 

Lon: 
133/56.249 

Depth: 
130.8 

Ext Depth: 
170 

SV Cast #2 filename: UTC time: Lat: Lon: Depth: Ext Depth: 

 

Personnel: 
FA Personnel 

Other Comments: 

 

ROLL LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Roll_8_W  8  
Roll_8_E  8  
    
    
    

1 

    

 

PITCH LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Pitch_6_330 330 6  
Pitch_6_155 155 6  
    
    
    
    
    

1 

    

HEADING LINES 

SV Cast: XTF Line Filename: Hdg: Speed (knots): Remarks: 
Heading_6_330 330 6  
Heading_6_155 155 6  
    
    
    

1 

    



Processing Patch Test        __S220___ _             260/9-16-04                           
        (Vessel)    (Dn/Date) 

□ HVF Hydrographic Vessel File created or updated with current offsets 
Name: __________________________ Date/Time: ______________________ 

x Data Converted  HDCS_Data in CARIS 

x True Heave Applied 

x Tide Applied _______________ Zerotide.tid ________________________________ 
Type (Zero, Observed, Verified) 

        □ Zoned _____________________________________________________ 
ZDF File 

x SVP applied 04260225, Back timed cast to 1200_____________________________
 File 

x Lines merged 

        x Data cleaned to remove gross fliers 
Compute Correctors – Order 

 
1) Precise Timing         2) Pitch Bias         3) Roll Bias        3) Heading Bias 
 
Do not Enter/Apply Correctors until all evaluations are complete and analyzed. 

  
Patch Test Results/Correctors 
 
Evaluator Timing (sec) Pitch (deg) Roll (deg) Hdg (deg) 
Grant 0.09 0.17 0.03 -1.30 

Jess 0.13 -0.64 -0.03 -0.42 

Mark 0.11 0.3 0.03 -0.6 

Lynn 0.12 0.5 0.02 -1.10 

Kim 0.10 0.2 0.00 -0.65 

Final Values 0.11 0.2 0.00 -0.80 

 
Final Values based on: AVG  Consensus  Consensus  Consensus
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NOAA POS/MV Calibration Report

Ship: Fairweather Vessel: S220
Date: 9/16/2004 Dn: 260
Personnel: Wetzler, Sampadian

PCS Serial # 846

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 2.10d

POS Version (Use Menu View > Statistics) MV320 Ver3 SN846 HW1.3 SW02.10d
GPS Receivers

Primary Receiver SGN 98490013

Secondary Receiver CGN 96200099

Calibration area
Location: Affleck Canal, AK D M S
Approximate Position: Lat 56 4 30

Lon 134 3 27
DGPS Beacon Station: Biorka
Frequency: 305 kHZ

Satellite Constellation (Use View> GPS Data)
Primary GPS Secondary GPS

PDOP 2.480 (Use View> GAMS Solution)



POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector

4.065 Two Antenna Separation (m) 0 X Component (m)
0.70 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

Configuration Notes: GAMS needed re-calibration because the antenna cables were reversed; the Port antenna 
is now the primary antenna. The heading calibration threshold was set high because of possible time 
constraints but we were able to achieve a heading accuracy of 0.468 before requesting CAL.

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 17:50
End time: 17:53
Heading accuracy achieved for calibration: 0.468

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
4.067 Two Antenna Separation (m) -0.032 X Component (m)
0.500 Heading Calibration Threshold 4.067 YComponent (m)

0 Heading Correction 0.017 Z Component (m)

GAMS Status Online X
Save Settings X

Calibration Notes: After shutdown and restart the calibration appears to be good and no drift in heading.
However, the GAMS solution was slow to FIX.  Once fixed, the Heading accuracy is around 0.013 deg on average.

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: S220_091604_SN846.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

NOTE: COM3 and Analog are not used.
Heave Filter (Use Settings > Heave) Events (Use Settings > Events)

SETTINGS Continued
Time Sync (Use Settings > Time Sync)



INSTALLATION (Use Settings > Installation)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)



User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver
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Appendix IV 
 
 
Total Propagated Error (TPE) 

 
 

   TPE Values 
1      Loading 
2      Device Models 



FAIRWEATHER SURVEY Doc. No .         
REP-6XX

 DAPR         
Appendix IV

Process Owner   
Grant Froliech

 

Documents Title                      
FA_TPE_Values_2004

Last update       
Jan 12, 2004

 Version        
2.1

Approval Date      

Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101
Positioning System POS/MV          

Model 320 V3
POS/MV          

Model 320 V3
POS/MV       

Model 320 V3
 POS/MV         

Model 320 V3
StdDev Gyro (deg) 0.02 0.02 0.02 0.02
68% CI Heave% Amp 5 5 5 5

Heave (m) 0.05 0.05 0.05 0.05
Roll (deg) 0.02 0.02 0.02 0.02
Pitch (deg) 0.02 0.02 0.02 0.02
Pos. Navigation (m) 0.5 0.5 0.5 0.5
Timing Trans (s) 0.001 0.001 0.001 0.001
Nav Timing (s) 0.001 0.001 0.001 0.001
Gyro Timing (s) 0.001 0.001 0.001 0.001
Heave Timing (s) 0.001 0.001 0.001 0.001
Pitch Timing (s) 0.001 0.001 0.001 0.001
Roll Timing (s) 0.001 0.001 0.001 0.001
SV Meas (m/s) 0.5 0.5 0.5 0.5
Surface SV (m/s) 0.5 0.1 0.5 0.5
Tide Meas (m) 0.01 0.01 0.01 0.01
Tide Zoning (m) 0 0 0 0
Offset X (m) 0.003 0.003 0.007 0.007
Offset Y (m) 0.003 0.003 0.007 0.007
Offset Z (m) 0.003 0.003 0.007 0.007
Vessel Speed (m/s) 0.03 0.03 0.03 0.03
Loading 0.03 0.03 0 0
Draft (m) 0.05 0.05 0.05 0.05
DeltaDraft (m) 0.01 0.01 0.04 0.01
MRU alignStdev gyro unknown unknown unknown unknown
MRU align roll/pitch unknown unknown unknown unknown

Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101
Positioning System POS/MV          

Model 320
POS/MV          

Model 320
POS/MV       

Model 320
POS/MV         

Model 320
 

Offsets MRU to Trans X 2.868 0.493 0.262 0.272
MRU to Trans Y 8.252 7.665 -0.151 -0.164
MRU to Trans  Z 4.753 4.559 0.546 0.55
Nav to Trans X 2.993 0.618 1.159 1.2
Nav to Trans Y 19.145 18.558 1.048 0.937
Nav to Trans Z 16.253 16.060 3.687 3.719
Trans Roll 0.00 0.00 0.00 0.00



See 

Appendix VI-1
Wetzler, M., (2004) Measuring Launch Offsets Standard Operating Procedure, NOAA Ship FAIRWEATHER Launches.  

For 1010, see
Appendix III-1010-2
1010_Offsets & Measurements.xls

For 1018 see
Appendix III-1018-2
1018_Offsets & Measurements.xls

For S220, see
Appendix III-S220-2
S220_Offsets & Measurements.xls
Report of Sonar Array installation on NOAA FAIRWEATHER, Westlake Consultants, Inc September 23, 2003, 11 pages
S220_Stability_Test.jpg

Vessel Offsets                                                    



1010 1018



For full POS/MV Specifications, see posmv v320 specs.pdf located in Appendix I.

Attitude Data                                               



Latency Uncertainty Estimates                                 
Precise Timing and Transducer Timing

For information on upgrading NOAA Multibeam Acquisition Systems to “Precise Timing.”   
See Precise Timing Setup.doc authored by Evans, B., (2004) and located in Appendix VI-1

Below is an email concerning latency, Riley, J., (2004) CARIS 5.4 Email, 2 pages.  





Below is email regarding a discussion on latency, originally from Rainier 2004 Error Estimates

Below is 2nd Discussion of Latency, originally from Rainier 2004 Error Estimates



SeaBird 19plus 

The full specifications for the Fairweather SeaBird 19Plus CTDs are located in Appendix I.







SeaBird 45                                                  
Surface Sound Velocity (8160)

For full SeaBird 45 specifications, see SBE45 specs.pdf located in Appendix I.





Tide Zoning from CO-OPS                                     
(Subject to change survey to survey) 

From THOMAS JEFFERSON Survey
*TJ Zoning error used because no FAIRWEATHER projects zoning error has been supplied



Typical Observed Tide Measurement                                   
(Subject to change per project) 

From PS Shyla Allen
RSS (Root Sum Square) rounded up to 0.01, observed tide measurements are not fully available 
during acquisition, therefore the value at 0.01 is a conservative estimate.
Station Date Time WL Sigma I F R T

9451600 5/10/2002 0:00 0.791 0.004 0 0 0 0 rss
9451600 5/10/2002 0:06 0.745 0.008 0 0 0 0 0.003332
9451600 5/10/2002 0:12 0.702 0.008 0 0 0 0
9451600 5/10/2002 0:18 0.642 0.009 0 0 0 0
9451600 5/10/2002 0:24 0.608 0.006 0 0 0 0
9451600 5/10/2002 0:30 0.57 0.006 0 0 0 0
9451600 5/10/2002 0:36 0.533 0.008 0 0 0 0
9451600 5/10/2002 0:42 0.505 0.007 0 0 0 0
9451600 5/10/2002 0:48 0.478 0.008 0 0 0 0
9451600 5/10/2002 0:54 0.448 0.007 0 0 0 0
9451600 5/10/2002 1:00 0.42 0.008 0 0 0 0
9451600 5/10/2002 1:06 0.397 0.005 0 0 0 0
9451600 5/10/2002 1:12 0.367 0.004 0 0 0 0
9451600 5/10/2002 1:18 0.347 0.006 0 0 0 0
9451600 5/10/2002 1:24 0.331 0.003 0 0 0 0
9451600 5/10/2002 1:30 0.315 0.006 0 0 0 0
9451600 5/10/2002 1:36 0.297 0.003 0 0 0 0
9451600 5/10/2002 1:42 0.288 0.004 0 0 0 0
9451600 5/10/2002 1:48 0.28 0.002 0 0 0 0
9451600 5/10/2002 1:54 0.27 0.004 0 0 0 0
9451600 5/10/2002 2:00 0.26 0 0 0 0
9451600 5/10/2002 2:06 0.26 0 0 0 0
9451600 5/10/2002 2:12 0.267 0 0 0 0
9451600 5/10/2002 2:18 0.283 0 0 0 0
9451600 5/10/2002 2:24 0.281 0 0 0 0
9451600 5/10/2002 2:30 0.297 0 0 0 0
9451600 5/10/2002 2:36 0.32 0 0 0 0
9451600 5/10/2002 2:42 0.337 0 0 0 0
9451600 5/10/2002 2:48 0.35 0 0 0 0
9451600 5/10/2002 2:54 0.375 0 0 0 0
9451600 5/10/2002 3:00 0.401 0.003 0 0 0 0
9451600 5/10/2002 3:06 0.433 0.005 0 0 0 0
9451600 5/10/2002 3:12 0.466 0.004 0 0 0 0
9451600 5/10/2002 3:18 0.503 0.005 0 0 0 0
9451600 5/10/2002 3:24 0.541 0.005 0 0 0 0
9451600 5/10/2002 3:30 0.585 0.006 0 0 0 0
9451600 5/10/2002 3:36 0.63 0.007 0 0 0 0
9451600 5/10/2002 3:42 0.672 0.008 0 0 0 0
9451600 5/10/2002 3:48 0.714 0.007 0 0 0 0
9451600 5/10/2002 3:54 0.768 0.006 0 0 0 0
9451600 5/10/2002 4:00 0.806 0.006 0 0 0 0
9451600 5/10/2002 4:06 0.859 0.006 0 0 0 0
9451600 5/10/2002 4:12 0.906 0.007 0 0 0 0
9451600 5/10/2002 4:18 0.958 0.008 0 0 0 0
9451600 5/10/2002 4:24 1.007 0.008 0 0 0 0
9451600 5/10/2002 4:30 1.05 0.008 0 0 0 0
9451600 5/10/2002 4:36 1.111 0.01 0 0 0 0
9451600 5/10/2002 4:42 1.16 0.008 0 0 0 0
9451600 5/10/2002 4:48 1.228 0.008 0 0 0 0
9451600 5/10/2002 4:54 1.288 0.008 0 0 0 0
9451600 5/10/2002 5:00 1.348 0.009 0 0 0 0



NOAA Ship FAIRWEATHER

Vessel Loading                                                                
Standard Deviation Based on Various Loading Conditions

See Loading_worksheet.xls located in Appendix IV - 3

R:\System\2004\Appendices\Appendix IV TPE\FA_TPE_Values_2004.xls



Dynamic Draft

Hull 1010
See 1010/DDSSM section of Appendix III-1010-4.

Std Dev
0.04

Hull 1018
See 1018/DDSSM section of Appendix III-1018-4.
Std Dev not utilized due to problems with the DDSSM data.







See 8101_CARIS_Device_Model_xml.doc located in Appendix IV - 2
See 8111_CARIS_Device_Model_xml.doc located in Appendix IV - 2
DeviceModels.xml, the Device Model used by the Fairweather while processing in CARIS  during the 2004 season, is located in Appendix IV - 2.

DeviceModel.XML Explanantion from Bill Lamey HIPS/SIPS 
Program Manager 08/05/2004

    <SonarModel label="Simrad EM300" key="em300">
<Max_Num_Beams value="135"/>             /* Maximum number of beams on device */
    <Operating_Frequency_1 value="30.0"/>   /* Operating frequency 1 (or prime freq.), kHz */
    <Operating_Frequency_2 value="0.0"/>     /* Operating frequency 2 (or zero), kHz */
    <Max_Angle value="75.0"/>                     /* Maximum angle away from nadir, deg. */
    <Beam_Width_Across value="1.0"/>           /* Beam widths, degrees */
    <Beam_Width_Along value="1.0"/>            /* Beam widths, degrees */
    <Steering_Angle value="0.0"/>                   /* Angle beyond which beams are steered, deg. */
    <Range_Sampling_Frequency value="5000.0"/>  /* Range sampling frequency, Hz */
    <Range_Sampling_Distance value="0.15"/>        /* Range sampling distance, m */
<Min_Pulse_Length value="5.0"/>                    /* Minimum pulse length, ms. */
    <Rates> 
      <Repitition value="10"/>                     /* Maximum rep. rate, pings/second */
      <Bathy value="10"/>                         /* Rate of bathymetry packets per second */
      <Attitude value="200"/>                     /* Packets of attitude information per datagram */
      <Imagery value="1"/>           /* Packets of imagery per datagram */
    </Density>
    <DeviceProperties>
      <Multibeam value="Yes"/>      /* Device is a multi-beam (else single-beam). Note that MB not= MBES since e.g. K5K has multiple beams. */
      <SideScan value="No"/>        /* Device is a true side-scan sonar */
      <Towed value="No"/>           /* Device is towed/tethered or is being towed */
      <Calibrated value="Yes"/>     /* Device backscatter is calibrated in dB */
      <DualFrequency value="No"/>  /* Device uses two operating frequencies */
      <HasAccuracy value="No"/>     /* Accuracy information for device is available through device module calls */
      <Steered value="Yes"/>          /* Device has steered beams */
      <Splithead value="No"/>          /* Device is physically in two halves (typically one on either side of the ship) */
      <Bathymetric value="Yes"/>     /* Device can generate bathymetry information */
      <Imagery value="Yes"/>          /* Device can generate imagery (backscatter) */
      <Attitude value="Yes"/>          /* Device can generate attitude datastream */
    </DeviceProperties>
  </SonarModel>



Email: CARIS Device Model
Date: 07/22/2004
From:K.Wing Wong (CARIS)

The range sampling distance is specified in terms of metres.
It is used to compute the Range measurement error (equation 3.20 in
the 1995 Rob Hare/CHS report). The code that we received from UNH has
this value hardcoded for a number of devices. In our implementation
we have moved those defaults into the devicemodel XML file, so that
the user can change them.

The range sampling frequency is specified in Hz, and was originally
intended for use in computing errors due to beam angle measurements.
This value is not actually being used in the computation, I think due
to the fact that its validity was not certain.



Email correspondence, originally from Rainier 2004 Error Estimates, 2 pages.





NOAA Ship FAIRWEATHER

Vessel Loading                                                                                             
Standard Deviation Based on Various Loading Conditions

1010 1018 S220
Vessel Loading Std Dev Worksheet Vessel Loading Std Dev Worksheet Vessel Loading Std Dev Worksheet

DN Reading 
From

Draft Reading 
Beginning

Draft Reading 
End Draft Change DN Reading 

From
Draft Reading 

Beginning
Draft Reading 

End Draft Change DN Draft Reading 
Beginning

Draft Reading 
End Draft Change

254 BM A 0.875 0.825 -0.050 253 BM A 0.795 0.770 -0.025
254 BM B 0.875 0.825 -0.050 253 BM B 0.825 0.815 -0.010

Std. Dev 0.000 Std. Dev 0.011 Std. Dev #DIV/0!

Draft readings should be taken by same person for morning and afternoon readings
Only enter values into the non-colored cells.  Colored cells are locked.

R:\System\2004\Appendices\Appendix IV TPE\1_Loading\Loading_worksheet.xls



- <SonarModel label="Reson SeaBat 8101" key="sb8101">
  <Max_Num_Beams value="101" />  
  <Operating_Frequency_1 value="240.0" />  
  <Operating_Frequency_2 value="0.0" />  
  <Max_Angle value="75.0" />  
  <Beam_Width_Across value="1.5" />  
  <Beam_Width_Along value="1.5" />  
  <Steering_Angle value="60.0" />  
  <Range_Sampling_Frequency value="10000.0" />  
  <Range_Sampling_Distance value="0.05" />  
  <Min_Pulse_Length value="0.15" />  
- <Rates>
  <Repitition value="30" />  
  <Bathy value="30" />  
  <Attitude value="0" />  
  <Imagery value="30" />  
  </Rates>

- <Density>
  <Bathy value="1" />  
  <Attitude value="0" />  
  <Imagery value="1" />  
  </Density>

- <DeviceProperties>
  <Multibeam value="Yes" />  
  <SideScan value="No" />  
  <Towed value="No" />  
  <Calibrated value="No" />  
  <DualFrequency value="No" />  
  <HasAccuracy value="No" />  
  <Steered value="Yes" />  
  <Splithead value="No" />  
  <Bathymetric value="Yes" />  
  <Imagery value="Yes" />  
  <Attitude value="Yes" />  
  </DeviceProperties>
  </SonarModel>

 



<SonarModel label="Reson SeaBat 8111" key="sb8111"> 
    <Max_Num_Beams value="101"/> 
    <Operating_Frequency_1 value="100.0"/> 
    <Operating_Frequency_2 value="0.0"/> 
    <Max_Angle value="75.0"/> 
    <Beam_Width_Across value="1.5"/> 
    <Beam_Width_Along value="1.5"/> 
    <Steering_Angle value="361.0"/> 
    <Range_Sampling_Frequency value="80000.0"/> 
    <Range_Sampling_Distance value="0.037"/> 
    <Min_Pulse_Length value="0.15"/> 
    <Rates> 
      <Repitition value="35"/> 
      <Bathy value="35"/> 
      <Attitude value="0"/> 
      <Imagery value="35"/> 
    </Rates> 
    <Density> 
      <Bathy value="1"/> 
      <Attitude value="0"/> 
      <Imagery value="1"/> 
    </Density> 
    <DeviceProperties> 
      <Multibeam value="Yes"/> 
      <SideScan value="No"/> 
      <Towed value="No"/> 
      <Calibrated value="No"/> 
      <DualFrequency value="No"/> 
      <HasAccuracy value="No"/> 
      <Steered value="No"/> 
      <Splithead value="No"/> 
      <Bathymetric value="Yes"/> 
      <Imagery value="Yes"/> 
      <Attitude value="Yes"/> 
    </DeviceProperties> 
  </SonarModel> 
 



Appendix V 
 
 
Additional Calibration Reports 

 
 

    Control 
    CTD 
    Leadlines 
    Total Stations 

 
 



   Header File for Station:  Kukkamaki 2004 Level 100056 
 
-------------------------------------------------------------------------------- 
 
Station Name:        kukkamaki 
Station State:       ak 
Chief of Party:      Mark Wetzler 
Instr Person:        abrams 
Rod Person:          wetzler 
Level SN:            100056 
Level Make/Mod:      NI 2 
Level Stadia:        333 
Rod SN:              559587 
Rod Make:            Leica 
Rod Increment:       Full 
Survey Order:        3rd Order 
Weather:             Cloudy 
 
 
 
 
   Benchmark for Station:  111-1111 
 
-------------------------------------------------------------------------------- 
 
1 - (a) Staff Stop       2 - T.P.                  
3 - (a) ETG              4 - AQUA-old              
5 - AQUA-new             6 - TBM #1                
7 - TBM #2                
Page 1 
 
 
 
   Raw Data File for Station:  111-1111 
 
-------------------------------------------------------------------------------- 
 
  BACKSIGHT     FORESIGHT 
 
 S  C R      BM      TOP  MID  BOT C R      BM      TOP  MID  BOT   DATE    TIME 
001 0 1 Kukkamaki   1444 1429 1415 0 1 Kukkamaki   1449 1433 1418 08/20/04 05:15 
002 0 1 Kukkamaki   1452 1423 1392 0 1 Kukkamaki   1480 1419 1359 08/20/04 05:16 
001 0 1 Kukkamaki   1449 1433 1418 0 1 Kukkamaki   1444 1429 1415 08/20/04 05:17 
002 0 1 Kukkamaki   1452 1423 1392 0 1 Kukkamaki   1480 1419 1359 08/20/04 05:17 
 
 
 S  C R      BM      TOP  MID  BOT C R      BM      TOP  MID  BOT   DATE    TIME 
001 0 1 (a) Staff S 0150 0100 0050 0 1 TBM #1      0150 0100 0050 08/27/04 00:06 
002 0 1 TBM #1      0150 0100 0050 0 1 (a) Staff S 0150 0100 0050 08/27/04 00:07 
 
 
Page 2 
 
 
Benchmark:  Kukkamaki     Station Name:  kukkamaki, ak 
       To:  Kukkamaki           Number:  111-1111 
     Date:  08/20/04    Time:  05:15 UTC      Order:  3rd Order 



________________________________________________________________________________ 
Set up   B.S.   Mean  Thread  Sum          F.S.    Mean   Thread   Sum 
number  reading        int.  of int.     reading           int.   of int. 
-------------------------------------------------------------------------------- 
 
    FOREWARD RUN 
 
  1444   15    1449   16 
001  1429    1.42933    29   1433    1.43333    31 
  1415   14    1418   15 
 -----   --------  ----  -----   --------  ---- 
  4288    1.42933    29   4300    1.43333    31 
    -1.43333 
    -------- 
    -0.00400 
 
 
    BACKWARD RUN 
 
  1452   29    1480   61 
002  1423    1.42233    60   1419    1.41933   121 
  1392   31    1359   60 
 -----   --------  ----  -----   --------  ---- 
  4267    1.42233    60   4258    1.41933   121 
    -1.41933 
    -------- 
     0.00300 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
________________________________________________________________________________ 
 Forward Run  -0.0040 m  Backward Run   0.0030 m 
 Mean Elevation -0.0035 m  Distance    0.0200 Km 
 Error   -0.3600 mm/m Allowable Error   0.0500 mm/m 
-------------------------------------------------------------------------------- 
Stadia:  333   Rod:  Full   Level:  NI 2         SN:  100056    Weather:  Cloudy     
Chief:  Mark Wetzl     Instrument Person:  abrams         Rod Person:  wetzler    
   Pacific Regional Section, Seattle, WA. 
________________________________________________________________________________ 
 
Page 3 
 
 
Benchmark:  Kukkamaki     Station Name:  kukkamaki, ak 
       To:  Kukkamaki           Number:  111-1111 
     Date:  08/20/04    Time:  05:17 UTC      Order:  3rd Order 



________________________________________________________________________________ 
Set up   B.S.   Mean  Thread  Sum          F.S.    Mean   Thread   Sum 
number  reading        int.  of int.     reading           int.   of int. 
-------------------------------------------------------------------------------- 
 
    FOREWARD RUN 
 
  1449   16    1444   15 
001  1433    1.43333    31   1429    1.42933    29 
  1418   15    1415   14 
 -----   --------  ----  -----   --------  ---- 
  4300    1.43333    31   4288    1.42933    29 
    -1.42933 
    -------- 
     0.00400 
 
 
    BACKWARD RUN 
 
  1452   29    1480   61 
002  1423    1.42233    60   1419    1.41933   121 
  1392   31    1359   60 
 -----   --------  ----  -----   --------  ---- 
  4267    1.42233    60   4258    1.41933   121 
    -1.41933 
    -------- 
     0.00300 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
________________________________________________________________________________ 
 Forward Run   0.0040 m  Backward Run   0.0030 m 
 Mean Elevation  0.0035 m  Distance    0.0200 Km 
 Error    0.0400 mm/m Allowable Error   0.0500 mm/m 
-------------------------------------------------------------------------------- 
Stadia:  333   Rod:  Full   Level:  NI 2         SN:  100056    Weather:  Cloudy     
Chief:  Mark Wetzl     Instrument Person:  abrams         Rod Person:  wetzler    
   Pacific Regional Section, Seattle, WA. 
________________________________________________________________________________ 
 
 



 

 
 

 
Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4585



CALIBRATION SHEETS
Temperature Calibration - S/N 4585........................................................................................................................................................................................................................1

Conductivity Calibration - S/N 4585.......................................................................................................................................................................................................................2

Pressure Calibration - S/N 4585...........................................................................................................................................................................................................................3

SBE 5M Configuration - S/N 050647.........................................................................................................................................................................................................................4

Calibration Manual Generation Date:  10 June 2004
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 04-May-04 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS
a0 =  1.144238e-003
a1 =  2.800401e-004
a2 = -1.599101e-006
a3 =  2.064399e-007
 
 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL
       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)
   1.0000            686550.960             1.0000              0.0000
   4.5000            613874.183             4.4999             -0.0001
  14.9999            430359.044            15.0001              0.0002
  18.5000            380275.871            18.4998             -0.0002
  24.0000            311679.154            23.9998             -0.0002
  29.0000            258970.010            29.0004              0.0004
  32.5000            226924.233            32.4998             -0.0002
 
MV = (n -  524288) / 1.6e+007
R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln2(R)] + a3[ln3(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 04-May-04 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:
g = -1.029557e+000
h =  1.489816e-001
i = -1.752308e-004
j =  3.475449e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006

 
 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL
       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)
  22.0000     0.0000    0.00000    2630.76    -0.0000     -0.00000
   1.0000    34.9275    2.98456    5190.28     2.9846      0.00001
   4.5000    34.9074    3.29247    5385.00     3.2925     -0.00001
  14.9999    34.8640    4.27683    5964.35     4.2768      0.00000
  18.5000    34.8548    4.62292    6154.85     4.6229      0.00000
  24.0000    34.8449    5.18241    6450.64     5.1824     -0.00000
  29.0000    34.8401    5.70578    6715.25     5.7058     -0.00000
 
f = INST FREQ / 1000.0
Conductivity = (g + hf 2 + if 3 + jf 4) / (1 + δt + εp) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction

-0.002

-0.001

0.000

0.001

0.002

0 1 2 3 4 5 6 7

R
es

id
ua

l, 
(S

/m
)

Conductivity (Siemens/m)

04-May-04  1.0000000

103



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 01-Apr-04 

SBE19plus PRESSURE CALIBRATION DATA
 5076 psia S/N 5433

 
COEFFICIENTS:
PA0 =    4.122797e-001
PA1 =    1.543137e-002
PA2 =   -6.621421e-010
PTEMPA0 = -6.648085e+001
PTEMPA1 =  5.248301e+001
PTEMPA2 = -5.831752e-001

PTCA0 =  5.087085e+005
PTCA1 = -1.554920e+000
PTCA2 =  1.198843e-001
PTCB0 =  2.398063e+001
PTCB1 = -2.075000e-003
PTCB2 =  0.000000e+000

 
  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION
  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST
         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT
   14.80 509647.0   1.7       14.63  -0.00         32.50     1.93   509715.97
 1115.04 581024.0   1.7     1114.57  -0.01         29.00     1.86   509691.60
 2115.20 646306.0   1.7     2114.67  -0.01         24.00     1.76   509665.49
 3115.31 711973.0   1.7     3114.97  -0.01         18.50     1.65   509649.81
 4115.38 778014.0   1.7     4115.20  -0.00         15.00     1.58   509644.82
 5115.49 844434.0   1.7     5115.34  -0.00          4.50     1.37   509632.18
 4115.36 778050.0   1.7     4115.76   0.01          1.00     1.30   509635.66
 3115.28 712023.0   1.7     3115.75   0.01
 2115.13 646357.0   1.7     2115.47   0.01         TEMP(ITS90)   SPAN(mV)
 1114.96 581071.0   1.7     1115.30   0.01            -5.00       23.99
   14.79 509677.0   1.7       15.07   0.01            35.00       23.91
 
y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t2

pressure (psia) = PA0 + PA1 * n + PA2 * n2

Date, Avg Delta P %FS
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0647

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA8.015 7.73

Vin 9V voltage across C2: VDC      Current mA8.014 7.4

Vin 6V voltage across C2: VDC      Current mA5.888 7.61

Pump submerged test, no load, Vin 12VDC Average current draw in water: 121 mA
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PRESSURE TEST
CERTIFICATES

SBE 19plus Pressure Test Certificate - S/N 4585...........................................................................................................................................................................................................1

SBE 5M Pressure Test Certificate - S/N 0647...............................................................................................................................................................................................................2
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1808 136th Place NE, Bellevue, Washington  98005 USA 
Website: http://www.seabird.com

Sea-Bird Electronics, Inc.

SBE Pressure Test Certificate

Serial Number:

Job Number:

Test Date:

4585

36026

3/8/2004 Description SBE-19 SeaCat Profiler

SBE Sensor Information: Pressure Sensor Information:

Model Number: 19 Sensor Type: Druck

Sensor Serial Number: 5433

Sensor Rating: 5000

Pressure Test Protocol:

Low Pressure Test: PSI   Held For Minutes

High Pressure Test: PSI   Held For Minutes

50 15

5000 15

Passed Test:

Tested By: ML

Customer Name NOAA/PMC

Phone:   (425) 643-9866
FAX:      (425) 643-9954
Email: seabird@seabird.com
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1808 136th Place NE, Bellevue, Washington  98005 USA 
Website: http://www.seabird.com

Sea-Bird Electronics, Inc.

SBE Pressure Test Certificate

Serial Number:

Job Number:

Test Date:

0647

36026

4/15/2004 Description SBE-5M Mini-Submersible Pump

SBE Sensor Information: Pressure Sensor Information:

Model Number: 5M Sensor Type: None

Sensor Serial Number: None

Sensor Rating: 0

Pressure Test Protocol:

Low Pressure Test: PSI   Held For Minutes

High Pressure Test: PSI   Held For Minutes

50 15

10000 15

Passed Test:

Tested By: DF

Customer Name NOAA/PMC

Phone:   (425) 643-9866
FAX:      (425) 643-9954
Email: seabird@seabird.com
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4616



CALIBRATION SHEETS
Temperature Calibration - S/N 4616........................................................................................................................................................................................................................1

Conductivity Calibration - S/N 4616.......................................................................................................................................................................................................................2

Pressure Calibration - S/N 4616...........................................................................................................................................................................................................................3

SBE 5M Configuration - S/N 050651.........................................................................................................................................................................................................................4

Calibration Manual Generation Date:  10 June 2004
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 13-May-04 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS
a0 =  1.266766e-003
a1 =  2.586384e-004
a2 =  4.388350e-007
a3 =  1.305821e-007
 
 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL
       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)
   1.0000            622316.325             1.0000             -0.0000
   4.5000            552525.400             4.5000              0.0000
  14.9999            379349.198            14.9999             -0.0000
  18.5000            332862.233            18.5000             -0.0000
  24.0000            269768.692            24.0000              0.0000
  29.0000            221758.685            29.0000             -0.0000
  32.5000            192768.010            32.5000             -0.0000
 
MV = (n -  524288) / 1.6e+007
R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln2(R)] + a3[ln3(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 13-May-04 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:
g = -1.045285e+000
h =  1.453177e-001
i = -2.826921e-004
j =  4.105207e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006

 
 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL
       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)
  22.0000     0.0000    0.00000    2686.28    -0.0000     -0.00000
   1.0000    34.6538    2.96340    5258.57     2.9634      0.00001
   4.5000    34.6339    3.26921    5454.90     3.2692     -0.00000
  14.9999    34.5909    4.24687    6039.19     4.2469     -0.00001
  18.5000    34.5816    4.59058    6231.35     4.5906     -0.00000
  24.0000    34.5717    5.14625    6529.76     5.1463      0.00001
  29.0000    34.5668    5.66603    6796.72     5.6660      0.00000
  32.5000    34.5648    6.03707    6980.85     6.0371     -0.00000
 
f = INST FREQ / 1000.0
Conductivity = (g + hf 2 + if 3 + jf 4) / (1 + δt + εp) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 07-Jun-04 

SBE19plus PRESSURE CALIBRATION DATA
 1450 psia S/N 4616

 
COEFFICIENTS:
PA0 =    7.363594e-001
PA1 =    4.421346e-003
PA2 =   -9.233915e-012
PTEMPA0 = -7.610142e+001
PTEMPA1 =  4.912463e+001
PTEMPA2 = -2.225885e-001

PTCA0 =  5.204318e+005
PTCA1 =  1.310369e+001
PTCA2 = -2.500431e-001
PTCB0 =  2.473825e+001
PTCB1 =  5.000000e-005
PTCB2 =  0.000000e+000

 
  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION
  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST
         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT
   14.59 523741.0   2.0       14.63   0.00         32.50     2.23   523837.35
  314.74 591615.0   2.0      314.66  -0.00         29.00     2.16   523836.54
  614.74 659504.0   2.0      614.68  -0.00         24.00     2.06   523829.25
  914.74 727427.0   2.0      914.76   0.00         18.50     1.94   523822.29
 1214.92 795374.0   2.0     1214.86  -0.00         15.00     1.87   523816.16
 1514.98 863345.0   2.0     1514.98   0.00          4.50     1.65   523736.70
 1214.91 795385.0   2.0     1214.91  -0.00          1.00     1.58   523670.18
  914.73 727440.0   2.0      914.82   0.01
  614.72 659521.0   2.0      614.75   0.00         TEMP(ITS90)   SPAN(mV)
  314.71 591629.0   2.0      314.72   0.00            -5.00       24.74
   14.59 523730.0   2.0       14.58  -0.00            35.00       24.74
 
y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t2

pressure (psia) = PA0 + PA1 * n + PA2 * n2

Date, Avg Delta P %FS
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0651

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.929 9.29

Vin 9V voltage across C2: VDC      Current mA7.928 8.8

Vin 6V voltage across C2: VDC      Current mA5.885 7.99

Pump submerged test, no load, Vin 12VDC Average current draw in water: 120 mA
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PRESSURE TEST
CERTIFICATES

SBE 19plus Pressure Test Certificate - S/N 4616...........................................................................................................................................................................................................1

SBE 5M Pressure Test Certificate - S/N 0651...............................................................................................................................................................................................................2
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1808 136th Place NE, Bellevue, Washington  98005 USA 
Website: http://www.seabird.com

Sea-Bird Electronics, Inc.

SBE Pressure Test Certificate

Serial Number:

Job Number:

Test Date:

4616

36026

5/17/2004 Description SBE-19 SeaCat Profiler

SBE Sensor Information: Pressure Sensor Information:

Model Number: 19 Sensor Type: Druck

Sensor Serial Number: 5512

Sensor Rating: 1450

Pressure Test Protocol:

Low Pressure Test: PSI   Held For Minutes

High Pressure Test: PSI   Held For Minutes

50 15

900 15

Passed Test:

Tested By: PC

Customer Name NOAA/PMC

Phone:   (425) 643-9866
FAX:      (425) 643-9954
Email: seabird@seabird.com

107



1808 136th Place NE, Bellevue, Washington  98005 USA 
Website: http://www.seabird.com

Sea-Bird Electronics, Inc.

SBE Pressure Test Certificate

Serial Number:

Job Number:

Test Date:

0651

36026

4/15/2004 Description SBE-5M Mini-Submersible Pump

SBE Sensor Information: Pressure Sensor Information:

Model Number: 5M Sensor Type: None

Sensor Serial Number: None

Sensor Rating: 0

Pressure Test Protocol:

Low Pressure Test: PSI   Held For Minutes

High Pressure Test: PSI   Held For Minutes

50 15

10000 15

Passed Test:

Tested By: DF

Customer Name NOAA/PMC

Phone:   (425) 643-9866
FAX:      (425) 643-9954
Email: seabird@seabird.com
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4617



CALIBRATION SHEETS
Temperature Calibration - S/N 4617........................................................................................................................................................................................................................1

Conductivity Calibration - S/N 4617.......................................................................................................................................................................................................................2

Pressure Calibration - S/N 4617...........................................................................................................................................................................................................................3

SBE 5M Configuration - S/N 050649.........................................................................................................................................................................................................................4

Calibration Manual Generation Date:  10 June 2004
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 11-May-04 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS
a0 =  1.291823e-003
a1 =  2.526379e-004
a2 =  1.450684e-006
a3 =  9.186631e-008
 
 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL
       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)
   1.0000            585601.879             1.0000             -0.0000
   4.5000            518753.727             4.5000              0.0000
  15.0000            354111.031            14.9999             -0.0001
  18.5000            310185.358            18.5001              0.0001
  24.0000            250731.238            24.0000             -0.0000
  29.0000            205598.150            29.0000             -0.0000
  32.5000            178383.838            32.5000              0.0000
 
MV = (n -  524288) / 1.6e+007
R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln2(R)] + a3[ln3(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)

-0.02

-0.01

0.00

0.01

0.02

-5 0 5 10 15 20 25 30 35

R
es

id
ua

l, 
(D

eg
re

es
 C

)

Temperature, Degrees C

11-May-04    0.00

102



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 11-May-04 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:
g = -9.988625e-001
h =  1.277874e-001
i = -2.759004e-004
j =  3.510651e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006

 
 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL
       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)
  22.0000     0.0000    0.00000    2801.28     0.0000      0.00000
   1.0000    34.7750    2.97277    5584.71     2.9728      0.00001
   4.5000    34.7554    3.27954    5795.80     3.2795     -0.00001
  15.0000    34.7123    4.26020    6423.47     4.2602      0.00001
  18.5000    34.7032    4.60498    6629.74     4.6050      0.00000
  24.0000    34.6934    5.16236    6949.94     5.1624     -0.00000
  29.0000    34.6883    5.68371    7236.26     5.6837     -0.00001
  32.5000    34.6861    6.05585    7433.69     6.0559      0.00001
 
f = INST FREQ / 1000.0
Conductivity = (g + hf 2 + if 3 + jf 4) / (1 + δt + εp) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 07-Jun-04 

SBE19plus PRESSURE CALIBRATION DATA
 1450 psia S/N 5513

 
COEFFICIENTS:
PA0 =   -4.963912e-001
PA1 =    4.431500e-003
PA2 =   -1.012479e-011
PTEMPA0 = -7.905883e+001
PTEMPA1 =  4.950230e+001
PTEMPA2 = -4.960344e-001

PTCA0 =  5.191864e+005
PTCA1 = -1.113324e+001
PTCA2 =  2.771534e-001
PTCB0 =  2.460838e+001
PTCB1 =  6.750000e-004
PTCB2 =  0.000000e+000

 
  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION
  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST
         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT
   14.59 522490.0   2.1       14.63   0.00         32.50     2.31   522573.13
  314.74 590250.0   2.1      314.67  -0.00         29.00     2.23   522565.54
  614.74 658027.0   2.1      614.70  -0.00         24.00     2.13   522556.16
  914.74 725829.0   2.1      914.75   0.00         18.50     2.01   522538.38
 1214.92 793664.0   2.1     1214.84  -0.01         15.00     1.94   522540.34
 1514.98 861531.0   2.1     1514.99   0.00          4.50     1.72   522594.40
 1214.91 793681.0   2.1     1214.92   0.00          1.00     1.64   522650.56
  914.73 725845.0   2.1      914.82   0.01
  614.72 658042.0   2.1      614.77   0.00         TEMP(ITS90)   SPAN(mV)
  314.71 590257.0   2.1      314.70  -0.00            -5.00       24.61
   14.59 522481.0   2.1       14.59  -0.00            35.00       24.63
 
y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t2

pressure (psia) = PA0 + PA1 * n + PA2 * n2

Date, Avg Delta P %FS
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0649

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.947 11.8

Vin 9V voltage across C2: VDC      Current mA7.948 11.0

Vin 6V voltage across C2: VDC      Current mA5.868 10.2

Pump submerged test, no load, Vin 12VDC Average current draw in water: 124 mA
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PRESSURE TEST
CERTIFICATES

SBE 19plus Pressure Test Certificate - S/N 4617...........................................................................................................................................................................................................1

SBE 5M Pressure Test Certificate - S/N 0649...............................................................................................................................................................................................................2
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1808 136th Place NE, Bellevue, Washington  98005 USA 
Website: http://www.seabird.com

Sea-Bird Electronics, Inc.

SBE Pressure Test Certificate

Serial Number:

Job Number:

Test Date:

4617

36026

5/17/2004 Description SBE-19 SeaCat Profiler

SBE Sensor Information: Pressure Sensor Information:

Model Number: 19 Sensor Type: Druck

Sensor Serial Number: 5513

Sensor Rating: 1450

Pressure Test Protocol:

Low Pressure Test: PSI   Held For Minutes

High Pressure Test: PSI   Held For Minutes

50 15

900 15

Passed Test:

Tested By: PC

Customer Name NOAA/PMC

Phone:   (425) 643-9866
FAX:      (425) 643-9954
Email: seabird@seabird.com
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1808 136th Place NE, Bellevue, Washington  98005 USA 
Website: http://www.seabird.com

Sea-Bird Electronics, Inc.

SBE Pressure Test Certificate

Serial Number:

Job Number:

Test Date:

0649

36026

4/15/2004 Description SBE-5M Mini-Submersible Pump

SBE Sensor Information: Pressure Sensor Information:

Model Number: 5M Sensor Type: None

Sensor Serial Number: None

Sensor Rating: 0

Pressure Test Protocol:

Low Pressure Test: PSI   Held For Minutes

High Pressure Test: PSI   Held For Minutes

50 15

10000 15

Passed Test:

Tested By: DF

Customer Name NOAA/PMC

Phone:   (425) 643-9866
FAX:      (425) 643-9954
Email: seabird@seabird.com
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[SVP_VERSION_2] 
04212141.svp 
Section  2004-212  14:19   48:20:00  -123:30:00 
       0.7          1505.9 
       3.0          1502.1 
       4.0          1501.2 
       5.3          1500.6 
       6.1          1500.2 
       7.2          1499.3 
       7.9          1498.6 
       8.1          1498.2 
      10.6          1498.2 
 
 
[SVP_VERSION_2] 
04212141.svp 
Section  2004-212  14:18   48:20:00  -123:30:00 
       0.6          1505.8 
       3.0          1502.0 
       4.0          1501.2 
       5.3          1500.5 
       6.1          1499.9 
       7.2          1499.0 
       7.9          1498.4 
       8.1          1498.2 
      10.5          1498.2 
 
 
[SVP_VERSION_2] 
04212143.svp 
Section  2004-212  14:32   48:20:00  -123:30:00 
       0.5          1505.8 
       0.7          1505.6 
       2.9          1501.6 
       3.9          1501.1 
       5.4          1500.5 
       6.4          1500.0 
       7.2          1499.2 
       7.9          1498.5 
       8.1          1498.1 
      10.6          1498.1 
 
[SVP_VERSION_2] 
04212143.svp 
Section  2004-212  14:32   48:20:00  -123:30:00 
       0.6          1505.7 
       2.9          1501.9 
       3.9          1501.2 
       5.4          1500.3 
       6.4          1499.4 
       7.2          1498.9 
       7.9          1498.4 
       8.2          1498.1 
      10.8          1497.9 
 
 
 



7/30/2004  COMPARE 2 FILES:  141_4616.FAQ, 141_4617.FAQ    SYSTEM: RESON 8111 
RESULT: PERCENT DEPTH DIFF OK  0.06 
Last line of travel time table: 
0.02  10.32  0.01  0.06  23.14  0.00  -0.02 
 
 
7/30/2004  COMPARE 2 FILES:  143_4585.FAQ, 143_4616.FAQ    SYSTEM: RESON 8111 
RESULT: PERCENT DEPTH DIFF OK  0.15 
Last line of travel time table: 
0.02  10.32  0.02  0.15  23.14  -0.01  -0.03 
 
 
7/30/2004  COMPARE 2 FILES:  141_4616.FAQ, 141_4617.FAQ    SYSTEM: RESON 8160 
RESULT: PERCENT DEPTH DIFF OK  0.01 
Last line of travel time table: 
0.01  10.02  0.00  0.01  10.37  0.00  -0.02 
 
 
7/30/2004  COMPARE 2 FILES:  143_4585.FAQ, 143_4616.FAQ    SYSTEM: RESON 8160 
RESULT: PERCENT DEPTH DIFF OK  0.02 
Last line of travel time table: 
0.01  10.02  0.00  0.02  10.37  0.00  -0.03 
 
 
7/30/2004  COMPARE 2 FILES:  141_4616.FAQ, 141_4617.FAQ    SYSTEM: RESON 8101 
RESULT: PERCENT DEPTH DIFF OK  0.01 
Last line of travel time table: 
0.02  10.25  0.00  -0.01  34.67  0.00  -0.01 
 
 
7/30/2004  COMPARE 2 FILES:  143_4585.FAQ, 143_4616.FAQ    SYSTEM: RESON 8101 
RESULT: PERCENT DEPTH DIFF OK  0.02 
Last line of travel time table: 
0.02  10.25  0.00  -0.02  34.67  0.00  0.00 
 
 
7/30/2004  COMPARE 2 FILES:  141_4617.FAQ, 143_4585.FAQ    SYSTEM: RESON 8111 
RESULT: PERCENT DEPTH DIFF OK  0.09 
Last line of travel time table: 
0.02  10.31  -0.01  -0.09  23.14  0.00  0.01 
 



FAIRWEATHER Leadline 10_01_04
calibrated 9/22/2004

Meter Mark Actual Measurement Corrector
1.0 0.996 0.004
2.0 1.990 0.010
3.0 3.000 0.000
4.0 3.997 0.003
5.0 4.992 0.008
6.0 5.990 0.010
7.0 6.980 0.020
8.0 8.020 -0.020
9.0 9.030 -0.030
10.0 10.020 -0.020

Average correction 0.004
Standard deviation 0.012

Measured by AST Mike Castle
Recorded by AST Verena Kellner

Leadline Depth vs. Corrector
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FAIRWEATHER Leadline 10_02_04
calibrated 9/22/2004

Meter Mark Actual Measurement Corrector
1.0 1.010 -0.010
2.0 2.000 0.000
3.0 2.930 0.070
4.0 3.960 0.040
5.0 5.030 -0.030
6.0 5.930 0.070
7.0 6.960 0.040
8.0 7.990 0.010
9.0 8.950 0.050
10.0 9.980 0.020

Average correction 0.024
Standard deviation 0.037

Measured by AST Mike Castle
Recorded by AST Verena Kellner

Leadline Depth vs. Corrector
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FAIRWEATHER Leadline 20_01_04
calibrated 9/26/2004

Meter Mark Actual Measurement Corrector
1.0 0.99 0.010
2.0 1.99 0.010
3.0 2.99 0.010
4.0 3.98 0.020
5.0 4.97 0.030
6.0 5.99 0.010
7.0 6.99 0.010
8.0 7.98 0.020
9.0 9.00 0.000

10.0 10.10 -0.100
11.0 10.95 0.050
12.0 11.90 0.100
13.0 13.05 -0.050
14.0 13.96 0.040
15.0 15.00 0.000
16.0 15.93 0.070
17.0 16.91 0.090
18.0 17.90 0.100
19.0 18.89 0.110
20.0 19.91 0.090

Average Correction 0.040
Standard deviation 0.053

Measured by AST Mike Castle
Recorded by AST Verena Kellner

Leadline Depth vs. Corrector
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FAIRWEATHER Leadline 20_02_04
calibrated 9/26/2004

Meter Mark Actual Measurement Corrector
1.0 0.997 0.003
2.0 1.980 0.020
3.0 2.990 0.010
4.0 3.990 0.010
5.0 4.980 0.020
6.0 5.980 0.020
7.0 6.980 0.020
8.0 7.980 0.020
9.0 8.980 0.020

10.0 9.980 0.020
11.0 10.980 0.020
12.0 11.990 0.010
13.0 12.990 0.010
14.0 13.980 0.020
15.0 14.980 0.020
16.0 15.990 0.010
17.0 17.000 0.000
18.0 18.030 -0.030
19.0 19.010 -0.010
20.0 20.010 -0.010

Average Correction 0.008
Standard deviation 0.014

Measured by AST Mike Castle
Recorded by AST Verena Kellner

Leadline Depth vs. Corrector
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FAIRWEATHER Leadline 20_03
calibrated ?/?/2004

Meter Mark Actual Measurement Corrector
1.0 1.0 0.000
2.0 2.0 0.000
3.0 3.0 0.000
4.0 4.0 0.000
5.0 5.0 0.000
6.0 6.0 0.000
7.0 7.0 0.000
8.0 8.0 0.000
9.0 9.0 0.000
10.0 10.0 0.000
11.0 11.0 0.000
12.0 12.0 0.000
13.0 13.0 0.000
14.0 14.0 0.000
15.0 15.0 0.000
16.0 16.0 0.000 Leadline not to be finished until 2005
17.0 17.0 0.000
18.0 18.0 0.000
19.0 19.0 0.000
20.0 20.0 0.000

Average Correction 0.000
Standard deviation 0.000

Leadline Depth vs. Corrector
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FAIRWEATHER Leadline 30_01
calibrated ?/?/2004

Meter Mark Actual Measurement Corrector
1.0 1.0 0.000
2.0 2.0 0.000
3.0 3.0 0.000
4.0 4.0 0.000
5.0 5.0 0.000
6.0 6.0 0.000
7.0 7.0 0.000
8.0 8.0 0.000
9.0 9.0 0.000

10.0 10.0 0.000
11.0 11.0 0.000
12.0 12.0 0.000
13.0 13.0 0.000
14.0 14.0 0.000
15.0 15.0 0.000
16.0 16.0 0.000 Leadline not to be finished until 2005
17.0 17.0 0.000
18.0 18.0 0.000
19.0 19.0 0.000
20.0 20.0 0.000
21.0 21.000 0.000
22.0 22.000 0.000
23.0 23.000 0.000
24.0 24.000 0.000
25.0 25.000 0.000
26.0 26.000 0.000
27.0 27.000 0.000
28.0 28.000 0.000
29.0 29.000 0.000
30.0 30.000 0.000

Average Correction 0.000
Standard deviation 0.000

Leadline Depth vs. Corrector
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Appendix VI 
 
 
Procedures 

 
1      Offsets and Configurations 
2      Calibration and Testing 
3      Acquisition 
4      Processing 
5      Quality Control 
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0.0 Document Scope 
 
The scope of this document covers the procedure on how to place launch 
benchmarks and to measure launch offsets using a theodolite and an auto level. 
  
1.0 Background 
 
In order to collect hydrographic quality multibeam data it is critical to have offset 
measurements between attitude sensors, heading sensors, antennas, and 
multibeam sonar heads.  These offset measurements are used in configuring the 
Pos/MV (Attitude, Heading and Heave) for proper functioning and in CARIS to 
allow correctors to be applied.   
 
Within the Pos/MV V3 Installation and Operation Guide dated 17 October 2003 
there are specifications to how accurately a measurement must be accomplished 
in order to obtain the system accuracies defined in the manufacture’s 
specifications.  Offset measurements must be known to their standards.  
Furthermore, poor understanding of vertical offsets will create vertical errors in 
the data.  If the separation between the phase center of the multibeam 
transducer and the waterline is only known to within 10 cm, that 10 cm becomes 
a limiting factor in your vertical error. 
 
Traditionally within Office of Coast Survey these measurements were made with 
a steel tape, straight edge, plumb bob, carpenters square, carpenters level and a 
ruler.  The accuracy of such measurements was not resolved. 
 
With the implementation of Bathymetry Associated with Statistical Error (BASE) 
surface in CARIS 5.4, and Office of Coast Survey’s adoption, the need for error 
modeling became necessary.  The validity of bathymetric measurements is 
directly dependant on our knowledge and confidence of individual error sources 
that compose the error model.  It is vital that the statistical error of the offset 
measurements be known for inclusion into the error model. 
 
To enhance the precision and accuracy of launch offset measurements, and to 
aid in determining the statistical error of such measurements, permanent 
benchmarks must be welded to the launch and a ship’s frame of reference (SFR) 
should be established.   
 
2.0 Overview of Procedure 
 

2.1 Initial Launch Leveling, Placing Benchmarks and 
Measurements (Building a SRF) 
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For the first time a launch is leveled and measured a significant amount of 
work is involved.  The general steps are as follows: 

• Level the Launch 
• Position Bench Mark’s (BM)  
• Weld BMs in place 
• Measure BM, antenna, IMU, and multibeam phase center positions  

vertically 
• Measure BM, antenna, IMU, and multibeam phase center positions 

horizontally 
 

2.2 Following Levels and Measurements 
Any measurements required after a launch has been given a SRF are 
greatly simplified.  With BM’s near multibeam equipment the vessel is not 
required to be leveled again.  Measurement errors for not being level are 
minimized by short horizontal and vertical distances and a ready reference 
frame of athwartships axis or longitudinal axis information is available.  In 
general due to proximity, errors from measuring a known BM to a needed 
position should be less than 3 cm.  This is well within the requirements for 
positioning equipment for the Pos/MV. 
 
If there is need for precision measurements, less than a centimeter, the 
procedure would be to: 

• Level the launch using known differences in elevation (DE’s) 
between BMs. 

• Measure BMs, antenna, IMU, and multibeam phase center 
positions  vertically 

• Measure BMs, antenna, IMU, and multibeam phase center 
positions horizontally 

 
3.0 Required Equipment 
 

3.1 Auto Level 
A calibrated auto level is required prior to leveling and benchmarking a 
launch.  The level must have an associated rod which reads in ½ cm or 1 
cm increments. 
 
3.2 Theodolite 
The theodolite used to set in the benchmarks must be calibrated prior to 
setting and positioning bench marks and other offsets.  The theodolite 
should utilize Electronic Distance Measuring Equipment (EDME) and have 
associated prisms for positioning. 
 
3.3 Boat leveling gear 
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Screw type boat jacks simplify the leveling procedure.  They allow the 
boats position to remain static over the process.  A hydraulic jack can be 
used for some of the large vertical movements in the initial part of the 
leveling procedure.  Blocking is handy for distributing the weight of the 
keel. 
 
Leveling with a trailer, blocking and hydraulic jacks is also viable if there is 
sufficient blocking to get the rubber wheels off of the ground.  The rubber 
wheels would prove to be a source of error as personnel moved around 
onboard the vessel. 
 
3.4 Benchmarks 
Small, low profile benchmarks made out of the same material as the 
vessel are needed to mark the vessel.  These benchmarks are to be set in 
critical locations, near multibeam equipment, antennas and attitude 
sensors for ease of relocating the equipment at a later date. 
 
3.5 Welder and Welding Gear 
A welder and gear are required to place benchmarks. 
 
3.6 Miscellaneous equipment 

1. Plumb bob 
2. Steel Tape (metric) 
3. Carpenter’s squares 
4. Tripods 
5. High precision digital level 

 
  
4.0 Required Measurements for Hardware and Software 
 

4.1 Pos/MV 
Measurements required by the IMU are lever arm distances from the IMU, 
the multibeam transducer, the heave measurement location (roll point), 
and the primary GPS antenna to the chosen reference point.  In the case 
of launch 1010 the reference point and the IMU are coincident.  This 
simplifies installation.  There is also a need for an antenna separation 
distance. 
 
4.2 CARIS 
Measurements required by CARIS are transducer to the reference point, 
IMU to the reference point and waterline to the reference point. 
 

5.0 Leveling the XY Plane Orthogonal to Gravity (Z-Axis) 
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5.1 Justification for Leveling 
The first step in measuring launch offsets and setting benchmarks is 
having the ability to make repeatable measurements.  This is done by 
creating a reference plane for the launch.  This is a critical step which has 
historically been omitted during offset measurements by OCS personnel.  
By not creating a reference plane there is no capability to utilize gravity to 
create a Z-axis that is orthogonal to a SRF.  The magnitude of this 
oversight is depicted in Figure 1 and Figure 2. 

 

Antenna

IMUD1

Figure 1 shows the separation between the IMU and the primary GPS antenna for the POS/MV.  In 
the chosen level frame of reference this distance is D1.  The blue marks are static from Figure 1 to 

Figure 2. 
 

Antenna

IMUD2

Figure 2 shows the separation between the primary GPS antenna and the mark which was above the 
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IMU in the chosen level frame of reference.  Note that D2 is smaller than D1.  The launch is down 4˚ 
by the bow. 

 
Figure 1 and Figure 2 visually depict the importance of defining a frame.  What is 
shown is that the horizontal separation between the IMU and the antenna is 
decrease with a pitch angle of bow down.  Taken to absurdity if the launch was to 
continue to pitch down the antenna would be directly over the IMU creating a 
zero separation. 
 
Another critical fact is that horizontal differences are created.  Figure 3 shows a 
14.5 cm horizontal change based upon a 4˚ pitch down by the bow and a 2.1 m 
vertical drop from the mark at the top of the cabin to the IMU.   
 
In order to avoid such “variations” to the offsets it is critical to define a SRF for 
each vessel.  The definition of the SRF would allow the vessel to have a XY 
plane defined such that it could always be perpendicular to gravity and that 
“leveling” the vessel would be repeatable from year to year.  Benchmarks, A, B, 
C and D in Figure 3 are used for repeatable “leveling”. 
 

A

B

C
D

E

F

G I

J

Bottom of Hull Top of Hull

Cabin Interior

K

H

TBM on ground

Figure 3 depicts a launch benchmarking scheme. 
 
 

5.2 Leveling Procedure Method A: Leveling to an Installed IMU 
 
On the FAIRWEATHER Jensen’s leveling was accomplished to the 
surface of the POS/MV’s IMU.  This can only be done if and only if the 
vessel level and the IMU level are close to equivalent.  This is the case on 
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the FA launches since the IMU’s are located on, and parallel to, the keels 
of the vessels.   
 
The leveling procedure is an iterative process.  A high precision digital 
level is zeroed with respect to local gravity and then placed upon the IMU 
in the athwartships direction.  Level the launch athwartships using the jack 
screws and/or hydraulic jacks and blocking.  Rotate the level to the IMU’s 
longitudinal axis.  Level the launch longitudinally.  Repeat this process 
until no changes are made in either direction.   
 
Ensure that the results are reasonable (i.e. that the launch and the IMU’s 
level are nearly equivalent). For the leveling of a vessel by leveling the 
IMU the athwartships error must be less than ½ degree and the 
longitudinal error must be less than 2 degrees.  There is difficulty in 
making such measurements due to the camber and sheer on the vessel.   
 
If the above specification is met then the launch considered to be leveled.  
There is no such state as absolute leveling of the launch.  Theoretically 
the launch is symmetric so the port side aft stern location should be 
identical to the starboard side aft stern, but boats are built by people and 
they warp.  Level fore and aft is even a much more difficult concept 
because of sheer on a launch and the fact that pitch changes with loading.   

 
Repeatability of measurements from year to year is accomplished by 
using differences in elevations (DE’s) of known benchmarks after they are 
placed and positioned.  These  DE’s are used to create the SRF. 
 
Required DE’s are between BM A and BM B for athwartships level and 
between BM C and BM D for longitudinal level.  See Figure 3 for BM 
positions. 

 
 
5.3 Leveling Procedure Method B: Leveling the Vessel to 

Symmetric Points 
 
This leveling procedure is also an iterative process.  This procedure is 
accomplished before a launch is benchmarked.  The first step is to 
approximate the positions of BM A, B, C and D.  These do not have to be 
completely accurate, but will be refined later before actual BM installation. 
 
Step 2 is to level athwartships use BM’s A and B with an auto level atop of 
the cabin.  Jack the trailer on the low side until the difference in elevation 
between the benchmarks read zero. 
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Figure 4 shows athwartships leveling. 

A

AB B

 
Leveling fore and aft is a bit more complicated as there is no true “level”.  
One could choose to define level by using the design waterline of the 
vessel, or base level off of flat surfaces.  Another method would be to use 
an actual waterline, but that may change with loading.  What is needed is 
an approximation of a longitudinal level.  Once it is defined, that is going to 
be the longitudinal level for the vessel; the reference frame is defined 
which is orthogonal to gravity.   

 
In Figure 5 the setup for leveling the launch longitudinally is depicted.  
Since the longitudinal level is “arbitrary” it is critical that the difference in 
elevation between benchmark C and D be recorded in the Offset 
Measurement spreadsheet located in a Data Acquisition and Processing 
Report appendix.  It is only by using that difference in elevation that the 
launch can be leveled again. 

 

C
D C

D

Figure 5 shows leveling the launch longitudinally.  The critical measurement to record for future 
leveling operations is the difference in elevation between benchmark C and D. 
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Once the launch is leveled fore and aft check the athwartships level as it 
may have changed with the jacking of the bow.  Repeat the athwartships 
leveling and then fore and aft leveling as necessary. 
 

6.0 Installation of Benchmarks 
 

6.1 Benchmark Requirements 
It is recommended that the BMs be installed permanently on the launch to 
increase accuracy and repeatability of offset measurements and to 
establish reference points in which future equipment can be surveyed into.   
The benchmarks should be located in close proximity to survey equipment 
(Inertial Motion Unit, Antenna, Transducer) so that future measurements 
from a benchmark to such equipment would be small.  This would 
decrease measurement error if the launch were not level.  For example if 
a mark was .5 m away from a relocated instrument and there was an error 
of 3˚ on all axes the total error vector would be less than 2 cm.  This is 
within NOS accuracy tolerances for differential GPS positioning as defined 
in the Specification and Deliverables and within the positioning error for 
installing equipment for the POS/MV.   
 

 
6.2 Setting Benchmarks 
Prior to setting the benchmarks the vessel MUST be level.  This is 
necessary for determining the axes using a sight plumb bob.   
 
Establish the vessels longitudinal axis of the vessel by setting a 
benchmark on the bow and the stern, referred to as BM C and BM D, 
respectively in Figure 3.  The location for BM C can be determined by 
measuring the distance athwartships on the stern and dividing by 2.  Set 
the mark in a location which the tripod can be set up over.  On the bow set 
BM D on a reasonable approximation of the centerline in a manner that 
the tripod can be set up over the location.  BM C and BM D are also used 
to define the athwartships axis of the vessel. 
 
Once the marks are in place set the theodolite on BM C and sight the 
plumb bob line over BM D.  Zero the angle on the theodolite.  Turn 90˚ to 
Port and align BM A.  Flip the telescope and align BM B.  BM A and BM B 
should be inboard enough to allow a tripod with a prism over the marks. 
 
Next align all other center line BM’s visible from the setup on BM C.  That 
would be BM F, BM J and BM K.  Again the marks should be set in such a 
manner that a tripod can be placed over them. 
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To place the remaining marks on the cabin top set the theodolite over the 
BM F and align the instrument to the center by sighting the fore or aft 
centerline benchmark.  Set the card to zero.  Turn the instrument 90˚ to 
port from the centerline and use it to align BM E.  Flip the telescope and 
align BM G.  Again they should be inboard enough to set up the tripod 
and, if possible, in line with the POS/MV antennas. 
 
Setting in BM H and BM I is accomplished by measuring horizontally from 
the keel to the desired off-axis location of the marks.  Then measure from 
BM C to a temporary location the same distance off-axis.  Punch the 
location and record the distance (it will be the same as the X-Axis offset 
distance for both BM H and BM I.  Set up the theodolite over the location 
and sight BM A.  Zero the card and turn aft 90˚.  Place a TBM near the 
stern on the ground.  Flip the telescope and sight a plumb bob line at the 
forward end of the vessel.  Place another TBM.  Set up the theodolite on 
the aft TBM and sight the forward TBM.  This line should be parallel to the 
longitudinal axis of the launch.  Place BM H and BM I in line with a one 
meter separation.  Their alignment can be used to determine parallel and 
perpendicular axis for the purpose of measuring short distances during the 
field season when re-leveling and realigning the launch is impractical.  
This allows for more precision in measuring distances. 

 
7.0 Positioning BMs and Equipment on the Z Axis 
 
In order to position BMs with respect to Z the methodology used is shooting three 
wire levels according to the procedures defined in the Users Guide for the 
Installation of Bench marks and Leveling Requirements for Water Level Stations 
dated October 1987.    
 
Each point is to be measured twice in accordance with the leveling procedure, 
and the runs between benchmarks are to be checked for closure.  According to 
Users Guide, the maximum closure tolerance for a single third-order section, one 
setup, less than 0.1 km in length, is 2 mm.  For launches the implication is that 
DE’s between benchmarks must be less than 2 mm. 
 
In order to measure elevations to BMs or equipment on the bottom of the launch 
a rod must be inverted.  This is accomplished by shooting a metric tape which is 
held vertical with the 0 end on the BM.  The values read are then made negative.  
This has the effect of adding the reading to the height of the instrument. 
 
Reading tape can also be done on the interior of the launch where a level rod 
would not fit. 
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8.0 Positioning BMs and Equipment on the XY Plane 
 
This is the most complicated portion of positioning the benchmarks in 
instruments on the launch.  The key is to work is having a defined centerline of 
the vessel.  The concepts for measuring and calculating the offsets are relatively 
simple: 
 

1. Always reference angle measurements with respect to the centerline. 
o This is accomplished by setting up over known marks, or making 

TBMs as needed for alignment, and backsighting known marks.   
2. Measuring horizontally, using an accurate instrument with proper 

technique, from point to point or BM to BM.  Ideally this is done with a total 
station with EDME. 

3. Use simple trigonometry and geometry for positioning BM’s and 
equipment with both horizontal distances and angles. 

 
An example of the aforementioned concepts is shown in Figure 6.  The distances 
and angles required to calculate the horizontal position of BM H is shown.  The 
procedure would be to setup the theodolite on BM C, sight a plumb bob line on 
BM D and zero out the card.  Turn 90˚ to starboard and tack in a temporary 
benchmark.  Measure the distance from BM C to the TBM and record (d1 in the 
diagram).  Setup on the TBM and backsight BM C.  Turn the angle from BM C to 
BM H (a1 in the diagram).  Measure the horizontal distance from the TBM to BM 
H (d2 in the diagram).  Now d3 and d4 can be calculated and referenced back to 
BM C, thereby tying in BM H with the rest of the BM’s.  
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Temporary BM placed on ground perpendicular to CL.
Setup over TBM and backsight the Aft CL BM to set
card.

d3=d2*cos(90-a1)

d4=d2*sin(90-a1)
sin(90-a1)=d4/d2

cos(90-a1)=d3/d2

A

B

C
D

E

F

G I

J

Bottom of Hull Top of Hull

Cabin Interior

K

H

TBM on ground

d1 d2

a1

90-a1

Measured distance
Calculated distance

Measured angle

 Figure 6 shows positioning BMs on the launch horizontally.  It is important to always zero the 
theodolite to a known axis of the vessel. 
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0.0 Document Scope 
 
The scope of this document covers installing software and configuring COM ports 
necessary for the utilization of Reson 81XX series sonars and TEI Real Time 
Bathy. It does not cover hardware installation such as Digi Boards or wiring.  This 
should be performed by the ET. 
 
1.0 WARNING! 
 
Seek the FOO’s permission before performing any of these tasks!  If you haven’t 
performed any of these tasks before, ask for help from an SST/CST/FOO.  If 
improperly performed these tasks can seriously hinder survey operations! 
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2.0 Removal of old software 
 
Completely remove all previous versions of TEI Isis Sonar and TEI Suite if they 
are installed on the computer.  This includes manually deleting the TEIdll folder 
from the WINDOWS directory.   
 
3.0 Install new versions of TEI software 
 

3.1 Install Isis Sonar v6.6 (or newer) 
Follow the prompts and install the complete setup using the 
defaults supplied by the installer program on both Hull#_Acq and 
Hull#_Nav 

3.2 Install TEI Suite v2.10 (or newer) 
Follow the prompts and install the complete setup using the 
defaults supplied by the installer program on Hull#_Nav 
 

4.0 Install Applanix POS/MV Controller Software v2.1 
 
For the FA setup the POS/MV PCS must have TrueHeave installed.  This feature 
makes it possible to fully utilize the “Paint the Bottom” paradigm that the FA has 
adopted.  TrueHeave removes any induced heave caused by turns during 
acquisition.  See the ET for help on installing this feature if it is not already. 
 

4.1 Install Wizard 
Follow the prompts and install the complete setup using the 
defaults supplied by the installer program on Hull#_Nav 

 
5.0 Install Sentinel System Drivers 
 
These are the dongle drivers that license the TEI programs. If not installed, the 
TEI software will not work. 
 

5.1 Install Wizard 
Follow the prompts and install the complete setup using the 
defaults supplied by the installer program on Hull#_Nav & 
Hull#_Acq 
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6.0 Install Digi Board Drivers 
 
This is the software that controls the Digi Board, which allows for the expansion 
of COM ports beyond the standard two COM ports. 
 

6.1 Install Wizard 
Follow the prompts and install the complete setup using the 
defaults supplied by the installer program on Hull#-Acq 

 
7.0 Configure Hull#_Acq Isis Sonar 
 

7.1 Setup Sonar  
1. File→Record Setup→Sonar Setup→Multibeam 

Bathymetry→Reson Seabat 81XX 
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2. File→Record Setup→Serial Ports (n.b. This may differ 
depending on wiring diagram) 
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3. Tools→ASCII Report→Form 2 

 

e 
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8.0 Configure Hull#_Nav DelphMap 
 

8.1 Setup DelphMap Navigation Template 
1. Serial port data acquisition settings→COM 

→Navigation→Isis_Nav 
 
 
 
 
 

Procedures\1_Offsets and 
Configurations\Configuring_RT_Bathy_SOP.doc  
 



 FAIRWEATHER SURVEY 
 

Doc No. 
SOP-6XX PROCEDURE 

Process Owner: Grant Froelich 
Date: Sept 22, 2004 
R:\System\2004\Appendices\Appendix VI Approval: CST FAIRWEATHER 

Approval Date: 12/23/04 Page 6 of 12 

 

Document Title 
Configuring RT Bathy  

Version 
1 

Effect Date: 
Dec 23, 2004 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9.0 Configure TEI 81XX Server 

 
9.1 Configure 8111 Server 

1. Open the 81XX server by either clicking Record on the Isis 
screen or by opening the 81XX server through the executable 
(Sbat8100.exe).  

2. Configure the 8111 as follows from the highlighted column in the 
following screen grab.   
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3. Click on Setup Comms... to setup the communication protocols 
for the 8111. 
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9.2 Configure 8160 Server 
 

At this time you can only have one Reson system controlled through Isis at a 
time.  If you are switching to the 8160 use the following setup. 
 

1. Open the 81XX server by either clicking Record on the Isis 
screen or by opening the 81XX server through the executable 
(Sbat8100.exe).  

2. Configure the 8160 as follows from the highlighted column in the 
following screen grab 
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3. Click on Setup Comms... to setup the communication protocols 
for the 8160. 
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9.3 Configure 8101 Server 
 

The 8101 is only utilized on 1010 and 1018. Do not use the 8111 or 8160 
settings for either of those platforms.   
 

1. Open the 81XX server by either clicking Record on the Isis 
screen or by opening the 81XX server through the executable 
(Sbat8100.exe).  

2. Configure the 8101 as follows from the highlighted column in the 
following screen grab. 
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3. Click on Setup Comms... to setup the communication protocols 
for the 8101. 
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Upgrading NOAA Multibeam Acquisition Systems to “Precise Timing” 
 
Document Custodian:  LTJG Ben Evans, HSTP-West 
Last Update:  10 May 2004 
 
 
I.  Background 
 
“Precise Timing” is a multibeam sonar data acquisition configuration which improves the 
timing of sonar, attitude, and positioning data by applying a time stamp at the point of 
acquisition and retaining that time in the xtf data logged in ISIS, rather than applying a 
time tag as the data arrives in ISIS.  This reduces the effect of latency in the serial and 
Ethernet interfaces NOAA has traditionally employed to transfer bathymetry, imagery, 
position, and attitude data to ISIS for logging.   
 
This configuration was developed and tested by Doug Lockhart of Fugro TGPI (formerly 
Thales Geosolutions), in cooperation with Applanix and Triton Elics International.  It was 
further tested by HSTP and NOAA Ship RAINIER on Launch 1021 (RA-3) with 
excellent results.  At this point, precise timing has only been implemented on data 
acquisition systems consisting of Reson 81xx series multibeam sonars with the 81-P 
processors, POS MV position and attitude sensors, and Triton Elics ISIS data 
acquisition software. 
 
The intent of this document is to explain Precise Timing to NOAA’s hydrographic 
platforms, and provide a “how to” for performing the upgrade for the aforementioned 
Reson + POS MV + ISIS system configuration. 
 
 
II.  Theory 
 
Accurate bathymetry from multibeam sonar systems requires merging data from several 
different sources create a final product fully corrected for vessel characteristics, position, 
and dynamics, water levels, and water column properties.  The quality of this product is 
dependent not only on the accuracy of these independent measurements, but their 
synchronization in time.  Obviously, applying corrections measured at one time to 
soundings acquired at another could result in erroneous results.   
 
Because of their highly dynamic nature, position, attitude, and bathymetry are the three 
datasets which must be most accurately synchronized.  Traditionally, NOAA 
hydrographers have accomplished this by logging all data in a single data acquisition 
system (ISIS) whose clock (Windows NT+ PC timer) is set to GPS time.  Each data 
packet which arrives in ISIS is stamped with this time, and logged.  Any time stamp 
available from the originating instrument is ignored.  While this requires that only the 
data logging system’s time must be correct, it assumes that data logged remotely will still 
be valid at the time they actually arrive and are logged in ISIS.  Any latency between 
measurement and logging must be assumed to be constant, and is estimated from the 



navigation timing section of the patch test.  However, NOAA hydrographers have 
consistently found that this latency can be variable, particularly when transferring data 
between instruments and ISIS via RS-232 serial interfaces.  This commonly manifests 
itself as “jitter” in the delta time between successive navigation fixes and attitude 
measurements as data is examined in CARIS HIPS.  Severe cases can produce noticeable 
“attitude artifacts” in digital terrain models. 
 
Precise Timing is an alternate approach to the problem of synchronizing data from 
multiple sources.  Rather than marking bathymetry, navigation, and attitude datagrams 
with “real-world” time as data arrive in ISIS, a timing message generated by the POS MV 
is used to synchronize the ISIS computer and Reson multibeam with the POS MV’s UTC 
time.  Data are time stamped at the point of measurement, and transferred to ISIS via 
Ethernet rather than serial interface simply for file storage. CARIS HIPS honors the 
precise time stamps contained in the datagrams, rather than using the noisy PC-based 
timing present in the XTF data packet headers.  The latency in the serial reference-UTC 
time message is determined by patch testing, and corrected during processing in CARIS.  
Replacing several individual serial interfaces with this single serial message results in 
significantly lower correction values, and more precise synchronization of bathymetry, 
position, and attitude.  Simulations and field tests conducted by Fugro and additional 
field testing aboard NOAA Ship RAINIER have confirmed this improvement. 
 
The figure below compares data from two lines run during RAINIER’s spring 2004 patch 
tests in Lake Washington, Seattle.  The data in red were acquired by Launch 1021 (Reson 
8101 with Precise Timing) and the beige from Launch 1006 (Reson 8101 with standard 
timing).  The view is looking across the track of a roll calibration line for both vessels, 
with the best angle and time biases applied.  (Note that these data have not been corrected 
for water levels, hence the vertical offset.)  Conditions were very calm in both cases, so 
dynamic input to the vessels was limited. However, a qualitative difference in the spread 
of the data due to imprecision in roll timing is apparent.  Quantitatively, the standard 
deviation of the delta time between successive navigation fixes is 0.0898 seconds for the 
line acquired with standard timing, compared with 0.0005 seconds for the precise timing 
line. 
 



 
 
III.  What you will need 
 
The following materials are needed to replicate the Precise Timing configuration of 
RAINIER’s Jensen launches, assuming the system to be upgraded is already configured 
for traditional serial position and attitude data and ISIS timing.  The exact requirements 
will vary from system to system. 

A.  Basic System Prerequisites 
• Version 3 POS MV 
• Reson multibeam sonar with 81-P processor 
• ISIS data acquisition system 
• CARIS HIPS 5.3 with SP3 and all SP3 hotfixes applied (v5.3.3+).  Support 

for Precise Timing is included in the base HIPS v5.4 install.  Tests have only 
been exercised using v5.3.3, but there are no known problems with v5.4 in 
regards to Prcise Timing. 

B.  New Hardware 
• Three output serial data Y to split the POS MV Com 1 output to the Hypack 

computer, ISIS computer, and Reson 81-P processor.  It should also be 
possible to use an unbuffered Black Box data broadcaster, though this has not 
been tested. 

• Sufficient serial cables to make the above connections. 
• Additional Ethernet switch with at least three ports for the POS MV subnet to 

distribute the Group 102 message to ISIS and retain the controller software on 
the Hypack machine.  Note preference for “switch” vice “hub”, to minimize 
any latency.  While it may be possible to eliminate this additional switch by 
combining either the Reson or POS subnets with the ship network, this is not 
preferable.   

• One additional 10baseT network card to connect the ISIS computer on the 
POS MV subnet. 



• Sufficient network cable to make the required connections. 
C.  New Software 

• ISIS Version 6.5 (March 2004 release), available as a service pack to v6.41 
(November 2003 release).  Posted on Hydro3 FTP server and to be included 
on May 2004 Hydrosoft DVD. 

• POS MV firmware version 2.1, available from Applanix.  Contact Peter 
Stewart (pstewart@applanix.com) with the serial number of the POS MVs 
you wish to upgrade. 

• POS MV controller software version 2.1, available on Hydro3 FTP server and 
to be included on May 2004 Hydrosoft DVD. 

 
 
IV.  Acquisition System Configuration 
 

A.  Wiring Configuration 
The hardware changes required to implement Precise Timing are relatively simple.  
The wiring diagram below shows an example of Precise Timing implementation from 
NOAA Launch 1021 (RA-3).  The exact configuration will obviously differ slightly 
from vessel to vessel, but the essential elements are described here. 

 
 

Timing String:   

mailto:pstewart@applanix.com


The key to precise timing is the $UTC serial timing string which synchronizes the 
ISIS and 81-P clocks to the POS MV.  This message can only be generated from 
Com 1 of the POS MV.  Ideally, $UTC would be the only sentence on this serial 
line in order to further limit any latency in transfer of this data.  However, while 
ISIS can now receive position and attitude via Ethernet (see below), Hypack still 
requires the NMEA $GGA, $HDT, etc. via serial.  These messages also can only 
be generated on Com 1 of the POS MV, so currently the position and timing 
sentences are enabled together.  In the near future, Hypack may be capable of 
reading the POS Ethernet message (this is an active HSTP project with Hypack 
and Applanix), or NOAA may transition to line navigation in ISIS.  Either of 
these scenarios would eliminate the need for the NMEA messages on this string. 
 
Note that although all data arrive in ISIS with time tags applied, it is still 
necessary to synchronize ISIS time to the $UTC string.  This is because the POS 
MV Group 102 data transmitted to ISIS via ethernet (see below) is accurately 
timed, but does not include a date.  The date is applied in ISIS, so the ISIS clock 
must be synchronized to the POS MV time to ensure that the date and time match. 
 
On Launch 1021, the output of the POS MV Com1 is sent to a three way data Y, 
with one output going to Hypack Com 5 for line navigation, and the other two to 
ISIS Com 5 and Reson 81-P RS-232 Port 1 for time synchronization.  To take 
full advantage of the benefits of the limited timing latency afforded by this 
configuration, it is important not to use a buffered data broadcaster in place 
of the data Y.  Also, note that while any open com port can be used for this string 
on the ISIS machine, the Reson 81-P requires that the UTC time input be on Com 
1.  Systems still using Com 1 of the 81-P to transmit bathymetry data to ISIS will 
need to be reconfigured for Ethernet bathymetry to take advantage of Precise 
Timing. 
 
During testing, RUDE found that it was necessary to move the $UTC input to a 
high numbered com port on the ISIS machine for ISIS to read the data properly. 
 
Ethernet Group 102 Message: 
Precise Timing uses the Ethernet logging function of the POS MV to broadcast 
time stamped position and attitude data to ISIS.  Assuming the POS MV 
controller software is running on the Hypack computer, this requires installation 
of an additional 10baseT card in the ISIS machine and connection to the POS MV 
LAN.  This additional network connection must be configured with an IP address 
compatible with the POS MV subnet.  Again, to avoid delay in data transfer, 
ensure that an Ethernet switch rather than a hub is used on this subnet.  (While the 
data is time tagged and will be logged correctly, Ethernet delay may cause 
noticeable latency in the update of data displayed in ISIS during acquisition.)  If 
the POS MV controller software is installed on the ISIS computer, this network 
switch can be replaced with a crossover cable directly from the POS to ISIS. 
 
POS MV TSS String:



Since ISIS reads attitude data from the POS MV Ethernet message, there is no 
need for serial attitude input to the ISIS.  The connection from Com 2 of the POS 
MV to Com 6 of ISIS shown above is a legacy of the previous configuration on 
Launch 1021, but is disabled in the ISIS software.  The TSS string input to RS-
232 Port 3 on the Reson 81-P is not absolutely essential either, but is important 
for roll compensation of the depth filters. 
 
Side Scan / Bathymetry Data: 
Note that Launch 1021 is configured with the Reson 81-P on the ship subnet.  
This is not ideal, as it could result in delay in the bathymetry and side scan data 
reaching ISIS in the unlikely event of high ship network traffic during acquisition, 
and more importantly necessitates assigning the Reson 81-P an IP address which 
is unique on the ship’s network.  However, this configuration does eliminate the 
need to install a third NIC in the ISIS computer.   

 
B. Software Configuration 

POS MV: 
See the screen grabs below from the POS MV Controller for the correct 
configuration of the POS MV Com 1 and Ethernet outputs.   

 
 

The “$UTC” message must be enabled on the Com 1 output, along with any other 
NMEA messages necessary for Hypack.  An update rate of 1 Hz is sufficient for 
the timing sentence alone, but a higher update rate may be necessary for the 
position and heading data in Hypack.  As always, the baud rate should be selected 
appropriately for the length of the serial string and the update rate.   
 



 
 
Ethernet Logging control must be enabled to transmit position and attitude data to 
ISIS.  Select “Ethernet Logging” from the “Logging” drop down menu in the POS 
MV Controller to access the dialog box above.  Enable only the Group 102 Sensor 
1 Data message.  Although RAINIER’s testing was all conducted at a 50 Hz 
update rate, 25 Hz is probably sufficient.  When these settings are applied, the 
software may prompt the user to enable other data groups in addition to 102.  
These are unnecessary, and the error should be ignored. 
 
Also, in the “Tags, Multipath, and Autostart” dialog box under Settings → 
Installation, ensure that Time Tag 1 is set to UTC time.   
 
In addition to these two data outputs, if the TSS string is required for the Reson 
processor, the POS MV Com 2 output must be set up appropriately. 
 
Note that any permanent changes made to the POS MV output configuration must 
be saved to non-volatile memory by choosing the “Save Settings” option under 
the “Installation” drop down menu, or simply saving settings upon exiting the 
POS MV controller. 
 
Isis:
First, the serial position and attitude inputs to Isis from the POS MV must be 
disabled in Isis in the “Serial Port Setup” dialog box.  Multiple inputs with the 
same data to Isis will cause problems in the .xtf data.  Ensure that these obsolete 
inputs are disabled by unchecking the “Status On” box for the appropriate entries 
in the “Serial Port Setup” dialog box. 
 
The ISIS configuration must be updated to enable reading the $UTC timing string 
and the Group 102 message from the POS MV. 
 



 
 

The $UTC timing input is enabled by setting the input port’s status to “On” in 
ISIS Serial Port Setup, and checking the “UTC Time”, as shown above.  The Port 
Settings must match the output settings on Com 1 of the POS MV.  Hexidecimal 
data will be visible in the ISIS Serial Port Test window and should update at the 
rate selected in the POS MV Com 1 setup.    
 

 
 
The Ethernet position and attitude input from the POS MV is enabled by selecting 
an unused serial port, and clicking the “POS RAW” template (see above).  This 
brings up the following dialog box: 
 



 
 
Ensure that “Connect” is checked.  Port Number 5602 is correct, and cannot be 
changed.  Although the attitude packet will no longer used for bathymetry, the 
CARIS converter still uses this packet for Side Scan conversion (for both 
“Heading from Attitude” or “Heading from Ship” choices), so it should be left 
enabled.  The “Test” function does not produce a recognizable data stream, 
though it will print data in the test area if the connection has been made.  
 
Reson 81-P: 
To enable the $UTC input to the Reson processor, set the “TimeBd” variable in 
the Config menu (accessible only from the BITE screen) to the output baud rate of 
Com 1 of the POS MV. 

 
C.  Testing 

To confirm that the $UTC serial string and Group 102 Ethernet inputs are 
working correctly, check the following: 
 
Isis: 
With the POS MV and Reson up and running, start “Record” mode in Isis.  Check 
the Parameter Display window to confirm that Navigation and Sensor Data are 
updating and match the values displayed on the POS Controller software.  Time 
should also match the POS MV UTC time, and should update at the rate set in the 
POS MV Com 1 output setup.  (Some units have noted that this time updates with 
the Reson 81-P input rather than the POS MV.  TEI has not been able to explain 
this behavior, but since ISIS uses only the date from the $UTC string, it should 
not be a problem.) 
 

 
 

Reson: 
In the BITE Menu, check to see that the UTC Time and Date are displayed, 
updating, and match the values displayed on the POS MV controller.   



 

 
 
 
V.  Data Processing in CARIS HIPS 
 
Precise timing requires a slight change to data conversion procedure in CARIS HIPS.  
When using the Precise Timing configuration, ISIS stores navigation and attitude data in 
the “Raw Navigation Datagram” packet of the .xtf file, rather than the traditional 
“Sensor”, “Ship”, and “Attitude” fields.  See the screen grab of Step 6 of the .XTF 
converter below for details.  Note that all three parameters (Ship Navigation, Attitude, 
and Bathy Gyro Data Field) must be set to Raw Navigation for correct conversion. 

 
 
Check that the data were acquired and converted correctly by checking the navigation 
and attitude data update rate in the appropriate editors.  The delta time (“d-Time” in the 
HIPS Query) for these data should be constant and correspond to the update rate set in 
Ethernet Logging Setup on the POS MV, as in the screen grab below. 



 

 
 
 
V.  Patch Testing 
 
Calibration lines for pitch, roll, and yaw are all acquired as usual.  However, rather than 
running lines in the same direction but different speeds over a feature or steep slope to 
determine time latency from navigation, this value can be determined more precisely 
from any single line by examining the residual uncorrected roll at the edge of the swath.  
This is most easily accomplished by examining one or two of the roll bias calibration 
lines, but requires some non-trivial amount of dynamic roll (i.e., need a line of data 
wherein roll is not “dead flat”).  As usual, latency should be the first value determined in 
the patch test, and rechecked as the other parameters are determined.  The procedure is 
described in detail below: 
 

1. With all bias values set to zero, open a line or pair of lines in the HIPS Calibration 
Utility (the old HDCS Editor).  To accentuate the affect of timing latency, these 
lines should be acquired in fairly deep water over a smooth bottom.  In general, 
the lines acquired for roll bias determination will work well for timing too. 

 
2. Create a subset which runs along the line, and is wide enough to include the outer 

beams. 



 
 

3. Open the subset, and orient the viewing rectangle so that it is long in the along 
track direction, and several beams wide across track.  Set the View Orientation to 
look across track, and note any vertical spreading of the soundings or along track 
periodic ripple (see below).  These artifacts are caused by slight mismatch 
between the times used to tag the roll and bathymetry data.  This is caused by the 
latency in the $UTC serial timing string from the POS MV to ISIS and the Reson 
processor.   



 
 

4. Enter Calibration Mode, and adjust Roll Time Error to “flatten” the soundings. 

 
 

5. Since this latency results from delay in the timing synchronization string, all data 
are affected by it.  Thus, once a value has been determined by examining the roll, 



enter this as the Time Error value for Navigation, Heave, Gyro, and Pitch as well.  
(Alternately, these values can be left set to zero, and the time latency value 
entered with the opposite sign as the “Swath Time Error” 

 
 
6. Process the rest of the patch test normally, rechecking the time latency value at 

each step. 
 
Upgrading an existing system to Precise Timing requires a new time latency value for the 
VCF.  However, Precise Timing does not affect the physical parameters of the system, so 
the mounting angle biases (roll, pitch, and yaw) in VCF remain the same.  Thus, running 
a partial patch test consisting of one or two lines over a deep, flat area and following the 
procedure above to determine the new latency value is sufficient. 



EQUIPMENT AND INSTRUMENTS

SOUNDING EQUIPMENT

AF.1. Manual Depth-Measuring Devices

AF.

AF.1.1.  LEAD LINE. All  field units en-
gaged  in  hydrographic  surveys  where general
depths are less than 20 fm shall have one or more
lead lines marked and calibrated. Lead lines are re-
quired for the following purposes:

Standard lead-line material is mahogany-col-
ored tiller rope with a phosphor-bronze wire center.
The center consists of six strands of seven 33-B (S-
gage) wires each. The wire core is flexible and should
not break after continual use and coiling. The rope is
size 8 (about 0.24 in. in diameter), and is made of water-
proofed, solid braided, long-staple cotton. The braid
should be tight enough so that broken wire strands
will not protrude through the covering and injure a
leadsman's hands. Material for lead lines may either be
requisitioned from the Marine Centers or be pur-
chased from a well-equipped marine supply dealer.

AF.1.1.1. Marking lead lines. Depending on
the depths in which they will be used and on the
size of the vessel, lead lines should be 15 to 30 fm
long. Each lead line is identified by a consecutive
number stamped on a metal disk attached at the in-
board end of the line. Identification is made when a
line is initially graduated. This number is to be re-
tained throughout the life of the lead line or until
re-marking is necessary.

Two units of measurement, the fathom and
the foot, have traditionally been used to mark lead
lines for hydrographic surveys in the United States.
Only one unit is to be marked on a lead line. Hy-
drographic parties surveying in both depth units
should be equipped with at least one lead line grad-
uated in each unit.

The braided covering of an unseasoned lead
line tends to shrink when wet causing the wire core
to buckle and the strands to break. Broken strands
are  likely  to protrude through the covering and
cause hand injuries. To prevent rupturing the core

Intermediate marks are placed between the
fathom  marks  to permit readings to the nearest
tenth of a fathom. Each half of a fathom is marked

AF-1 (JUNE 1, 1981)

1.  To  search  for  or  to  confirm least
depths over shoals and sunken rocks.

2. To confirm echo soundings in kelp or
grass areas.

3. To  obtain  bottom  samples   (when
sampling device is attached).

4.  To obtain vertical cast comparisons
with echo soundings.

5. Occasionally to suspend instruments
for temperature and salinity observations from a
small vessel.

with repeated use, preseason each lead line as fol-
lows:

1.  Prepare the lead line by soaking it in
salt  water  for 24 hr. Then, while the line is still
wet, work the cotton covering along the wire by
hand until the wire protrudes from the covering.
The  wire should protrude about 1 ft for each 10
fm of line. This is a tedious procedure requiring
the  cooperative  efforts  of  several people. The
covering can be pushed back and slackened only
a  few inches at a time; this length of slack must
be pushed nearly the full length of the line before
the  next  few  inches can be started. The excess
protruding wire is cut off. The covering must not
be  worked  back  too  far, or it will form bulges
along the wire. Lead lines so prepared will main-
tain an almost constant length for future use.

2.  Next, the line is dried under tension
(about  50  lb)  and then soaked again for 24 hr.
Never boil a lead line as this destroys the water-
proofing of the cover.

3. After attaching a lead to the line, the
line should be wetted down again and placed under
a tension equal to the weight of the lead; this ten-
sion is maintained while the line is being graduated.
Temporary marks made at this time can be used
for later permanent marking. Graduation marks on
a new lead line may be laid off with a steel tape.
The best method, however, is to mark the distances
permanently on a suitable surface such as on the
deck of a ship or on a wharf if the survey party is
shore based. Permanent markings are convenient
when verifying the graduations in the future.

Traditional markings for lead lines graduat-
ed in fathoms are shown in Table AF-1.



HYDROGRAPHIC MANUAL

TABLE AF–2.— Markings for lead lines graduated in feet

MarksFeet

Each fathom mark should extend 2 in from
the lead line. Leather marks are made in one piece

TABLE AF–1. — Markings for lead lines graduated in fathoms

MarksFathoms

ipated, a metric lead line should be prepared. Each
meter and half meter is marked using an identifica-
tion system convenient to the observers. A marking
similar  to that of a lead line graduated in feet is
recommended (such as red, white, blue, yellow,
and leather).

On occasional surveys for which the depth
unit is the meter, soundings may be taken with lead
lines graduated in feet, provided that the measure-
ments are converted to meters prior to plotting. In
such cases, the hydrographic records must clearly
and unmistakably identify which soundings are in
feet. When extensive soundings in meters are antic-

AF.1.1.3. Sounding leads. These in standard
weights of 5, 7, 9, 14, and 25 lb are requisitioned
from the Marine Centers. Each survey unit should
have one or more leads with a snapper-type bot-
tom-sampling device attached. (See AK.2.7.) Vari-
ous methods may be used to attach the lead to the

AF-2(JUNE 1, 1981)

by a seizing of black thread; each even tenth of a
fathom (0.2, 0.4, 0.6, and 0.8) is marked by a seizing
of white thread. Odd tenth readings are estimated.

1, 11, 21
2, 12, 22
3, 13, 23
4, 14, 24

5, 15, 25
6, 16
7, 17
8, 18
9,19
10
20

One strip of leather
Two strips of leather
Blue bunting
Two strips of leather secured in the

middle so that two ends point
upward and two downward

White bunting
White cord with one knot
Red bunting
Three strips of leather
Yellow bunting
Leather with one hole
Leather with two holes

with strips (about ¼ in in width)  that  are slit in
the free end of the mark. Bunting marks are made
by folding a small piece of bunting to about 5/8 in
wide by 5 in long; this length of folded bunting is
then folded once again in the middle then secured
to the lead line so the folded end is free.

Waxed linen thread should be used to se-
cure marks to the lead line in such a manner that
there can be no possibility of slippage. Do not in-
sert the thread through the braided covering of the
line. All marks except 4-, 14-, and 24-fm marks
should  be  secured so that their free ends are up
when  sounding.  Marks  so secured will tend to
stand out more from the line when vertical.

Traditional markings for lead lines graduat-
ed in feet are shown in table AF-2.

Intermediate  odd  feet  (1, 3, 5, 7,...) are
marked by white seizings. Leather markings at the
10-ft multiples should be the same size as the fath-
om marks on lines graduated in fathoms. Bunting
marks that identify intermediate even feet should
be slightly smaller in size.

2, 12, 22, ...
4, 14, 24, ...
6, 16, 26, ...
8, 18, 28, ...
10, 60,110
20, 70, 120
30, 80, 130
40,90, 140
50
100

Red bunting
White bunting
Blue bunting
Yellow bunting
One strip of leather
Two strips of leather
Leather with two holes
Leather with one hole
Star-shaped leather
Star-shaped leather with one hole

AF.1.1.2.  Verification of lead lines. Lead
lines used for sounding are compared with a stan-
dard at the beginning of a season and at frequent
intervals thereafter, depending on usage. When the
checks are made, lead lines must be wet and under
a tension equal to the weight of the attached lead
in water. The testing standard should be a good re-
cently calibrated steel tape or premeasured gradua-
tion marks on deck or ashore.

Stamp 5 (figure 4-29, section 4.8.3.6), Lead-
Line Comparison, is used to record comparison re-
suits in sounding records. A comparison should be
made either at the beginning or at the end of each
day a lead line is used. (See 4.8.3.6.) If a lead line is
found to be correct, a statement to that effect is suf-
ficient. When incorrect, comparison results are en-
tered for each fathom or for each 5 ft to the extent
of the depths measured. True lengths of the gradua-
tion marks as determined by comparison against the
standard are entered on stamp 5 in the column head-
ed ''D''; corresponding graduation mark values are
entered under the column headed ''M." Corrections
to lead-line soundings are obtained by subtracting
column M from column D. Replace or re-mark lead
lines if the errors exceed 0.5 ft or 0.2 fm.



EQUIPMENT AND INSTRUMENTS

lead line. The preferred method is to have a galva-
nized thimble at the lower end of the lead line to
which the lead can be attached by a shackle. The
sounding lead and the snapper sampling lead can
then be interchanged on the same line.
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Antenna Installation Calibration 

Note: For a successful antenna installation calibration, the GPS Azimuth 
Measurement Subsystem (GAMS) must be able to use data from five or more 
satellites with a Positional Dilution of Precision (PDOP) equal to or less than 
three. Perform the antenna installation calibration at a time when there is 
‘good satellite geometry’. 

Note: It is recommended that the user make use of the GPS mission 
planning software to identify an optimal time of day during which the PDOP is 
at a minimum in order to achieve a good GAMS calibration. 

You should perform the following procedure with the vessel under way in an 
area where unrestricted manoeuvring is possible. You have the option of 
allowing POS MV to start the calibration automatically (this is called a 
Calibration auto-start), or to start the calibration manually. 

1. Select Tools, Configuration, then select Use GAMS Solution check 
box in the GAMS pane. This permits POS MV to use GAMS heading 
aiding in its antenna calibration solution, refer to Figure 16 on page 4-
26. 

2. Select View, GAMS Solution to open POS MV GAMS Solution 
window shown in Figure 25 on page 5-16. 

3. Select the following from the Controller’s menu bar in the order 
indicated to re-initialise the POS MV: 

a) Settings, Mode, Standby 

b) Settings, Mode, Navigate 

4. Select Settings, Installation, GAMS Installation to open the GAMS 
Parameter Setup window shown in Figure 17 on page 4-26. 
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Figure 16:  Navigator Configuration Window 

 
Figure 17:  GAMS Parameters Setup Window 
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5. In the GAMS Parameter Setup window, enter a value between 0.5 
and 5.0 degrees in the Heading Calibration Threshold field. Choose 
OK. 

When the indicated RMS heading error falls below the setting for 
Heading Calibration Threshold, POS MV will start the antenna 
installation calibration routine. Choose an easy value for POS MV to 
achieve as you perform a series of calibration manoeuvres with the 
vessel: 

• Set a lower value (approximately 0.5°) if you can manoeuvre the 
vessel aggressively. 

• Conversely, set a higher value (approximately 1°) if the most 
aggressive manoeuvres you can perform are 180° turns followed 
by a straight run. 

6. In the GAMS Parameter Setup window, (Figure 17), perform the 
following: 

a) In the Two Antenna Separation field enter a value in metres. 
Choose Apply. You should ensure the accuracy of this value to 
within ±5 mm (±3/16 in). 

Refer to Installation Checklist on page 2-51 for instructions to 
measure the antenna separation distance 

b) In each of the component fields in the Baseline Vector pane, 
enter ‘0’. Chose Apply and then OK. 

7. Manually transition POS MV to Navigate mode. This also commands 
GAMS to begin execution of its on-the-fly ambiguity resolution 
algorithm. You can monitor the progress of this algorithm through the 
GAMS Solution screen. 
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Note: Perform steps 8 and 9 only if you use ‘calibration auto-start’. 
Otherwise, go straight to step 10 if you wish to start the calibration 
manually. 

8. Select Settings, GAMS Calibration Control, Start from the main 
window of the POS MV Controller program. The displayed GAMS 
Status becomes CAL Requested. See Figure 18 on page 4-28 for a 
view of the controller settings menu and status pane. 

This command prepares the system for an automatic start to the 
calibration process, but does not actually start it. Instead, the 
calibration process will start automatically when the POS MV RMS 
heading error falls to below the value that you set for the Heading 
Calibration Threshold field in paragraph five above. 

 

Figure 18:  Controller Settings Menu and Status Pane 

9. If possible, when GAMS has resolved the carrier phase ambiguities 
(GAMS Status on the main screen of the controller will read Ready 
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Offline), perform a series of full turns, ‘S-turns’ or ‘Figure-8’ 
manoeuvres, each lasting approximately one minute. 

On the main window of the POS MV Controller program, monitor the 
POS MV heading accuracy. When the value displayed falls below the 
setting for Heading Calibration Threshold, finish the turns and 
manoeuvres and hold the vessel steady on a course and at a fixed 
speed. 

The displayed GAMS Status becomes CAL in Progress and this 
condition lasts for approximately 60 seconds. When POS MV has 
completed the calibration, the displayed GAMS Status becomes CAL 
Completed. This condition lasts for approximately five seconds and 
then changes to Online. 

Note: Perform steps 10, 11 and 12 only if you use the manual start to the 
calibration. Otherwise, go straight to step 13 if you used the ‘calibration 
auto-start’ feature described in paragraphs 8 and 9. 

Note: Before you proceed to step 10, make certain the GAMS 
Parameters Setup window displays the values that you entered in steps 5 
and 6. 

10. When GAMS has resolved the carrier phase ambiguities, the 
displayed GAMS Status becomes Ready Offline. You can start the 
calibration manually at any time. 

If possible, perform a series of full turns, ‘S-turns’ or ‘Figure-8’ 
manoeuvres, each lasting approximately one minute. During these 
manoeuvres, monitor the POS MV heading accuracy on the main 
window of the POS MV Controller program. Ideally, the heading 
accuracy displayed should be as small as possible. 
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Wait until the heading error becomes as small as possible before you 
start the calibration. If you can perform only limited manoeuvres in the 
vessel, even a simple change of course will cause the heading 
accuracy to improve. 

11. To start the calibration, select Settings, GAMS Calibration Control, 
Force from the main window of the POS MV Controller program. This 
will command an immediate start to the calibration process. 

The GAMS Status becomes CAL in Progress and this condition lasts 
for approximately 60 seconds. When POS MV has completed the 
calibration, the displayed GAMS Status becomes CAL Completed. 
This condition lasts for approximately five seconds and then changes 
to Online. 

12. If you wish to suspend the calibration while it is in progress for any 
reason, select Settings, GAMS Calibration Control, Suspend. The 
displayed GAMS Status then becomes CAL Suspended. 

The system suspends the partially completed calibration process until 
you resume it. To resume the calibration process select Settings, 
GAMS Calibration Control, Start. 

13. If you wish to stop the calibration while it is in progress for any 
reason, select Settings, GAMS Calibration Control, Stop. The 
displayed GAMS Status then becomes Ready Offline. The system 
cancels the partially completed calibration process. 

To start a new calibration process, select Settings and then select 
GAMS Calibration Control, Start or GAMS Calibration Control, 
Force. 
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14. Select Tools, Configuration and make certain you have selected the 
Use GAMS Solution button in the GAMS pane. Choose OK and then 
select Settings, Save Settings. Wait until the POS MV Controller 
program displays the ‘Settings Saved’ message panel. Choose OK to 
close the message panel. 

15. Monitor the system operation and look for the following indications of 
a successful calibration to appear on the main window of the POS MV 
Controller program: 

• The displayed GAMS Status remains Online. 

• The displayed heading accuracy drops slowly to less than 0.15° 
and eventually settles to a value of 0.02° in a low multipath 
environment. The actual value that it settles upon will depend on 
the current setting for multipath environment. 

If the calibration was successful and no GPS dropouts occur, 
POS MV should settle into steady-state operation using GAMS 
heading aiding as indicated by the ‘Online’ status. 

If the calibration was not successful, GAMS will reject the carrier 
phase ambiguities repeatedly and will eventually reject the installation 
parameters. If this occurs, repeat the calibration process. 

16. If the installation parameters appear to be correct, select Installation, 
GAMS Installation and write down the displayed parameters. Keep 
the written record in a safe place for future reference. 

Refer to Operation with GAMS on page 5-15 for a description of how GAMS 
uses the GAMS installation parameters to aid the On-the-Fly (OTF) ambiguity 
search. 
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Installation Parameter Correction 

The surveyed antenna baseline vector may include the following errors: 

• The length of the vector may not be correct if there were large 
multipath errors during the calibration process. This may affect the 
reliability of GAMS ambiguity resolution during future POS MV 
initialisation sequences. 

• There may be an azimuth error similar in size to the displayed 
heading accuracy that existed during the calibration process. This 
results in a constant offset in the displayed heading during normal 
operation of POS MV with GAMS heading aiding. 

To correct these errors: 

1. If the displayed antenna separation differs by more than 5 mm (3/16 in) 
from the value that you measured after you installed the antennas, 
clear the installation parameters and then re-enter the measured 
separation distance in the GAMS Parameter Setup window, see 
Figure 17 on page 4-26. Choose OK to install the new antenna 
separation distance. 

Begin a new calibration procedure as described in Antenna 
Installation Calibration on page 4-25. 

The 5 mm (3/16 in) allowance accounts for differences that may exist 
between the antenna phase centres and their geometric centres. 

2. If you can identify the heading offset then enter a Heading Correction 
in the GAMS Parameter Setup window. Choose OK to install the new 
correction value. 
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POS MV will then compute new components of the surveyed antenna 
baseline vector having a corrected azimuth. 

3. Select Settings, Save Settings to save the new values to the PCS. 

Note: The Heading Correction entry in the GAMS Parameter Setup window 
allows you to correct an inaccurately surveyed baseline vector. You can use 
this method to obtain a more accurate vector. 

Note: You should not use this facility to implement the installation angles of 
the IMU body frame with respect to the echo-sonar frame. Refer to Installation 
Parameters on page 2-37 and Initial Configuration on page 4-14 for 
instructions to measure and enter these installation parameters. 

System Power-Off 

Once the initial configuration of POS MV is completed select Settings, Save 
Settings from the POS MV Controller program to save all the settings to non-
volatile memory. 

 

The POS MV Controller program will display a message panel to 
confirm that it has saved the settings successfully to non-
volatile memory. Wait for this message to appear and then 
choose OK to close the message panel before you power-off the 
PCS. 

If you power-off the PCS before the program has displayed the 
confirmation message panel you may corrupt the settings in 
non-volatile memory. 

Check that the PCS has stored the parameters correctly: 

1. Select File, Exit or press Alt, F4 to close the POS MV Controller 
program. Press the green POWER switch on the PCS front panel to 
power-off POS MV. 
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2. Wait for thirty seconds and then press the green POWER switch to 
power-on the PCS. Re-start the POS MV Controller program. 

3. Select Settings, GAMS Calibration Control and check that the PCS 
has saved all the GAMS installation parameters correctly. Select 
Cancel. 

Leave POS MV powered-on to reduce the electrical and thermal stresses that 
occurs when the system is powered-off and powered-on. 

Note: Applanix recommends you use an uninterruptible power supply to 
power POS MV. If you follow this recommendation, you will not need to 
power-off the system while switching on board generators. 

To power-off POS MV for transportation, storage or repair: 

1. Close the POS MV Controller program (if it is running). 

2. Press the green POWER switch on the PCS front panel. 

Save Settings 

 
Cycling power while saving may result in lost settings. 

Save the POS MV parameters after any modification, otherwise changes will 
be lost when the POS MV power is cycled (powered down and up). Each time 
POS MV is powered up, the settings default to the stored values. To save the 
settings, select Settings, Save Settings from the POS MV Controller menu 
bar. The POS MV Controller indicates when the settings are successfully 
saved (may take up to 30 seconds to save the settings). 
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FAIRWEATHER (S220), 1010 and 1018 
PATCH TEST Procedures 

Created by SST Abrams 

Background:  
Survey launches 1010 and 1018 are equipped with Reson SeaBat 8101 multibeam echosounders.  Positioning 
data for each launch is provided by a POS/MV 320.  Residual biases due to misalignment of the sonar will be 
assessed in CARIS HIPS and entered in the hydrographic vessel files (HVFs) for 1010 and 1018. 
 
FAIRWEATHER (S220) is equipped with a Reson SeaBat 8111ER and a Reson SeaBat 8160 multibeam 
echosounder.  Positioning is provided by a POS/MV 320.  Residual biases due to misalignment of the sonar 
will be assessed in CARIS HIPS & SIPS v5.4 and entered in the hydrographic vessel files (HVF) for each 
system.   

Patch Test Location, Date, and Personnel:  
The launch patch tests will be performed in Ketchikan, AK at a time to be determined.  The launch patch 
tests will include pitch, precise timing, roll, and heading lines.  See Graphic 1 for an example of patch test 
line plans.  

 

 
Graphic 1: Example of Launch Patch Test Lines 

 
The ship patch tests will be performed in Port Angeles, WA at the end of July, 2004.  If ship schedule 
changes or equipment problems arise, the ship patch tests may be conducted in Ketchikan, AK at a time to be 
determined.  Deep water is necessary for patching the Reson 8111ER and Reson 8160 systems.  The ship 
patch tests will include precise timing, pitch, roll, and heading lines. 
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Equipment: 
• Reson 8101 multibeam echo-sounder 
• TSS POS/MV 320 with True Heave 
• DGPS receivers (type and model TBD) 
• Seacat SBE19plus sound velocity profiler 

Procedure: 
1.  Precise Timing:  Run one line in a moderate sea state (Beaufort 1-2), where there will be some dynamic roll 
(i.e. not flat calm). One of the roll lines can be used for this test. 
 
2.  Pitch:  Run two pair of coincident lines at same speed (4 Knots) and opposite directions over a known 
target.  The nadir beams must be run directly over the target.  Only one pair of lines is completely necessary, 
the other set is for comparison and redundancy. 
 

 
 

3.  Roll:  Run two pair of coincident lines at same speed and opposite directions over a flat or gently sloping 
bottom.  Speed is arbitrarily set at 4 Knots, though any speed will do as long as the lines are run at the same 
speed.  Only one pair of lines is completely necessary, the other set is for comparison and redundancy. 

   
4.  Heading:  Run one pair of lines offset by 2.8 x water depth to either side of a known target at the same 
speed in opposite directions.  Water depth is defined as the top of the known wreck. The actual line spacing 
will be determined in the field to acquire the target in the ideal outer beams.   

Processingi: 
 

A. Make New Hydrographic Vessel File 
• Put in lever arm numbers—Reference Point (RP), IMU, transducer(s), and settlement & squat 

measurements. 
• Time, pitch, roll, and heading numbers stay at zero. 

      
B. Convert Data 

• Tide, SVP correct, and merge.  DO NOT FILTER. 
• Roughly clean the data, getting out the major flyers only. 

 
C. Computing Correctors—Order of Operations 

1. Precise Timing  
2. Pitch Bias 
3. Roll Bias 
4. Heading Bias 

 

Known target

4 Knots 

run x2 

4 Knots 

run x2 

2.8 x water depth 

4 Knots 
 
Known target 
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1.  Precise Timing Biasii 
• With all bias values set to zero, open a line or pair of lines in the CARIS HIPS Calibration 

Utility.  It is fine to use the roll lines for the precise timing determination. 
• Create a subset which runs along the line and includes the outer beams. 
 

 
• Open the subset, and orient the viewing rectangle so that it is long in the along-track 

direction and several beams wide across-track.  Set the view orientation to look across 
track and note any vertical spreading of the soundings or along-track periodic ripple 
(see image below).  These artifacts are caused by slight mismatch between the times 
used to tag the roll and bathymetric data.  This is caused by the latency in the $UTC 
serial timing string from the POS/MV to ISIS and the Reson processor. 
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• Enter the Calibration Mode and adjust Roll Time Error to “flatten” soundings 

 
 
• Since the latency results from delay in the timing synchronization string, all data are 

affected by it.  Thus, once a value has been determined by examining the roll, enter it 
as the Time Error value for Navigation, Heave, Gyro, and Pitch as well. 

 
• Place the results of the precise timing determination in the HVF. 
• Process the rest of the patch test, rechecking the time latency value at each step. 

2.  Pitch Bias 
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• Two pitch lines on top of each other. 
• View subsets for pitch bias parallel to track. 
• Adjust the pitch. 
• Compute average, apply, and close out. 
• Merge all lines. 

 
3.  Roll Bias 

• Two roll lines on top of each other. 
• View subsets perpendicular to track. 
• Adjust the roll.   
• Compute average, apply, and close out. 
• Merge all lines.  

 
4.  Heading Bias 

• Two lines offset from one another. 
• View subsets parallel to track. 
• Adjust yaw. 
• Compute average, apply, and close out. 
• Merge all lines. 
 

D. Review--Look Over the Data 
• Create a grid—make a tight one and look for artifacts that could be related to heave, pitch, 

roll, or time errors. 
• Open the data in subset mode in multiple places—see if the data is lining up well everywhere. 
• Have as many eyes over as much of the process as possible.  Have more than one person 

compute all the errors and compare and average out the different answers. 
 
 
                                                 
i Adapted from the NOAA Ship RAINIER patch test write-up, done 03/21/03 by SSTs Stuart and Morgan. 
ii Taken from “Upgrading NOAA Multibeam Acquisiton Systems to ‘Precise Timing’, done 05/10/04 by LTjg Evans. 
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Dynamic Draft Settlement and Squat Method (DDSSM) Procedure  
Compiled by SST Abrams 

Last updated: 07/22/04 
 

PURPOSE 
The intent of this document is to define a test procedure for the Dynamic Draft Settlement and 
Squat Method (DDSSM).  The DDSSM replaces the optical level measurement method of 
determining settlement and squat.  The DDSSM will be used on NOAA Ship FAIRWEATHER 
(S220) and survey launches 1018 and 1010. 
 
EQUIPMENT 

FAIRWEATHER 
Configuration 1 

FAIRWEATHER 
Configuration 2 

1010 1018 

POS/MV 320 with 
True Heave 

POS/MV 320 with 
True Heave 

POS/MV 320 with 
True Heave 

POS/MV 320 with 
True Heave 

Reson 8111ER Reson 8160 Reson 8101 Reson 8101 
SeaCat 19plus SeaCat 19plus SeaCat 19plus SeaCat 19plus 
 SBE 45 Micro TSG   
 
 
REQUIREMENTS 
The DDSSM test has to be performed in an area with a well-known tidal signal.  Alternately, an 
area where the water level does not vary much, such as a lake, is acceptable. 
 
The bottom of the test area should be flat or gently sloping.  A shallow water depth, 
approximately 7-10 meters, is ideal for minimizing attitude errors. 
 
In previous implementations of the DDSSM test, the heave sensor was a limiting factor.  With 
the introduction of True Heave in POS/MV, induced heave error should no longer be an issue. 
 
LOCATION 
The DDSSM tests for 1010 and 1018 will be performed in Ketchikan, AK in a area with 
minimum tidal variation, a flat bottom, and a relatively shallow depth (~10 meters).  The exact 
location and time of the tests is to be determined.   
 
The DDSSM test for S220 will be performed in Ketchikan, AK at a time to be determined.  Tidal 
correctors will have to be acquired in cooperation with CO-OPS. 
 
METHOD 
The DDSSM test consists of running the same planned line repeatedly in one direction at idle 
and a series of pre-defined RPM’s.  The survey launch will also sit motionless in neutral at three 
locations on the planned line for comparison.  The lines must be run within 3 meters of the 
planned line so that nadir beam overlap is achieved.  To eliminate the possibility of induced 
heave error not neutralized by True Heave, the line should be run for 1 minute and 30 seconds 
before beginning data acquisition.  The planned line will be approximately 1000 meters long.  
See Graphic 2 of the planned line below. 
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Zero motion locations

 
Graphic 2: DDSSM test planned line 

 
 
 
The DDSSM test should be performed at least once for each vessel.  If time permits, run the 
DDSSM two to three times for each vessel in order to provide comparison data. 
 
PROCESSING 
After the DDSSM data has been acquired, determine all other vessel biases (roll, pitch, heave, 
heading) and apply them before processing the dynamic draft lines.  Convert the dynamic draft 
lines in CARIS v5.4 with batch converter.  The batch conversion should filter swaths to 45°/45°, 
filter depths, apply tides, sound velocity, and merge the data. 
 
After conversion, open the lines in CARIS v5.4.  Open subset editor and create a thin rectangle 
over one of the zero motion locations. 
 

 
Graphic 3: Subset Example 

500m 1000m

1 2 3
Run-up Data Acquisiton 

 
 
 
In the 2-D subset window, draw a rectangle over the nadir lines.   
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Graphic 4: Selecting Nadir Beam Soundings 

 
Query the selected soundings.  Right click in the Query window and save the information to a 
text file. 
 
Open Cygwin, or an equivalent Unix command program.   

• At the prompt, type grep 2 filename > tempfile and enter.  The filename is the saved 
query text file and the tempfile is a temporary file where the information is sent.   

• At the prompt, type awk ‘{print $2, $5}’ tempfile > basefile and enter.  This will cull 
out the unnecessary fields.  Field $2 contains the line name and field $5 contains the 
depth values.   

• At the prompt, type grep line_name basefile > line_name.txt and enter. This will copy 
each line into its own file.   

Repeat this entire process for each line*. 
 
*If this process doesn’t work, import the query text file directly into Excel and edit fields there. 
 
Import each text file into Excel and average the depth column.  Record the average depth for 
each location (3 locations) for all of the separate lines (RPM).   
 
Enter the average depth values for each location in the results table.  The results table has 
functions entered to difference the locations and average the differences.  The results are the 
dynamic draft values for use in the Hydrographic Vessel File (HVF).  Create an Excel Graph of 
the dynamic draft results with speed in knots on the X-axis and dynamic draft in meters on the 
Y-axis. 
 
REPORTING AND RESULTS 
The blank ship and launch acquisition and results forms are in the file DDSSM Data Collection 
and Results Forms.xls.  An acquisition and results form should be filled out for each DDSSM 
test performed.  The final results forms should be placed in the DAPR.   
 
The final dynamic draft values for each vessel should be entered into their respective 
Hydrographic Vessel File (HVF).   
   



DGPS System Check Procedures 
10/8/2004 

 
The purpose of a DGPS system check is to ensure your positioning system is functional and to 
check for any blunders in positioning of a beacon, USCG or our flyaway beacon, or in your 
geodetic survey parameters.  As a general rule this should be completed on the first day of 
acquisition, on a weekly basis for every system, and on the last day of every project. 
 
The check must be between two completely independent systems, which means receiving 
correctors from two different beacons.  During the system check process, each platform must 
manually force the use of a different beacon.   
 
System Check Procedure: 

1) Set up the Trimble Backpack so that its antenna is directly above the IMU on the 
launch. 

2) Ensure one platform (launch or backpack) is set to use the primary beacon as listed on 
the POD and the other platform has the secondary beacon selected. 

3) Coordinate between one person at the Acquisition computer on the launch and 
someone with the Trimble Backpack in order to simultaneously capture a screen grab 
of the POS and log a position with the Trimble unit. 

a. Save the screen grab files as dddSC_#, where ddd is the Julian day number, 
SC for Systems Check and # is the number of the screen capture (1, 2, 3). 

b. For Trimble logging, name the data file TRB#_ddd, where # is the Trimble 
unit (1 or 2) and ddd is the Julian day number.  Use the Generic dictionary and 
simply create generic points. 

4) Record the number of satellites and HDOP on the Launch Systems Check Form, 
which can be printed from the digital copy located in R:\Utilities\Survey_Forms. 

5) Repeat this process two more times. 
6) Visually check to make sure the positions are relatively close and begin running the 

day’s hydro.  The allowable HDOP is 2.5 meters, so one would hope the position 
difference is on the order of 5 meters or less.  However, given an estimated system 
error of 4 meters for a USCG beacon, the Pmax (max position error) must be less than 
15 meters + actual separation to meet specs.  

 



 
Data Transfer Procedure: 

1) When transferring data to the ship, create a new folder for that day in: 
I:\200X_Projects\OPR_XXXX_FA_0X\Project_Reports\HVCR\System_Checks\Boat# 

2) Copy and paste screen grab files directly into this new DN folder. 
3) Open the first screen grab. 
4) Open Pydro. 
5) Select Coordinate Conversion under the Misc menu. 
 

 
 

6) Enter the latitude and longitude from the screen grab into the appropriate fields in the 
conversion window and click Convert.  The Easting and Northing will be displayed in 
the bottom bar of the LatLon to UTM window. 

 

 
 

7) Navigate to R:\Utilities\Systems_Check, and open the Launch_System_Check 
worksheet. 

8) Enter the converted positions into the appropriate Easting and Northing fields for the 
launch. 

9) To get position data off the Trimble unit, use the following procedure: 
a. Connect the hand held Trimble unit to one of the computers that has 

Pathfinder Office on it.  (O-lab, Processor_3 or Tough Book) 
b. In the main Pathfinder window, select Data Transfer from the Utilities menu.   



 
 

c. Select GIS Datalogger on Windows CE from the Device pull-down menu.   
d. Under the Receive tab, press Add and select Data File from the menu.   

 

 
 

e. Navigate to the data file to be exported  (labeled TRB#_ddd). 
f. Click Browse and navigate to the export file location, which will be the DN 

folder created on the I: drive, as indicated above (if you’re connected to the 
network). 

 

 



 
g. Click Open. 
h. In the Data Transfer window, select Transfer All.   
i. Once the transfer is complete, click Close. 
j. In Pathfinder Office, select Export from the Utilities menu.   

 

 
 
k. Under the pull-down menu called Choose an Export Setup, select the Sample 

Configure ASCII Setup option.  The Input File should automatically select the 
file you transferred in the previous steps.  If not, click Browse to navigate to it.  
The Output Folder should be the DN folder created on the I: drive, as 
indicated above (if you’re connected to the network). 

 

 
 



 
 
l. Click the Properties button and select the Configurable ASCII tab. 

 

 
 
m. Click the New button and name the template System Check, then click OK. 
n. In the ASCII Export Template Editor window, make the Output File Extension 

“txt”. 
o. Select Easting, Northing and GPS Time from Macro Palette and click OK. 

 

 
 



p. Select the Coordinate System tab in the Export Setup Properties window. 
q. Choose Use Export Coordinate System and click the Change button. 

 

 
 
r. In the Export window that appears, change the coordinate system to the 

appropriate UTM Zone in NAD 1983. 
 

 
 
s. Click OK in the Export window and in the Export Setup Properties window.  

A text file will be created in the output location you selected. 
 



10) Use Notepad or WordPad to open the files transferred from the Trimble Backpack. 
 

 
 

11) Enter the position information into the appropriate Easting and Northing fields in the 
Launch_System_Check worksheet. 

12) Transfer Satellite and HDOP information from the acquisition form to fill the 
remaining fields in the worksheet. 

13) Save a copy of the worksheet to the DN folder on the I: drive.  Name it 
Boat#_SC_ddd 

14) If the System Check fails, notify the FOO or CST. 
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0.0 Document Scope 
 
The scope of this document covers setting up and acquiring multibeam data 
using TEI Isis and TEI DelphMap/DelphNav/RT Bathy Programs.  
 
1.0 RT Bathy Set Up 
 
Currently you need two machines to run Real Time Bathy properly.  Both must 
have Isis v6.6 (or newer) installed and one must have TEI Suite v2.10 (or newer) 
installed.  For this document I will call the acquisition Isis (connected to Reson) 
“Hull#_Acq” and the processing Isis (performing RT Bathy) “Hull#_Nav”. 
 
2.0 Setup in Hull#_Nav 
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2.1 Isis Sonar 
 

1. Open Isis 
2. Configure→Playback speed→Set Pings to read per update to 50 
3. Tools→Realtime BathyPro Map→Multibeam Bathymetry 

 
2.2 BathyPro Real Time 
 

1. Open Project (HXXXXX.dmp) in DelphMap from C:\Project\OPR-
XXXX-FA-XX\HXXXXX\RT_Bathy\. If you do not have DelphMap 
open, BathyPro will open it for you.   

2. Set the DTM File settings. Under Encoding Type choose 
“Average”.  Save the DTM to the correct folder (see Section 5.0). 

3. Set the Map Projection and Settings.  You must uncheck the Set 
Default Limit Box. 

4. Under Boundaries in the Map Projection and Settings menu, 
enter a bounding box for the area you wish to create the DTM for.  
Use a reasonable resolution for the DTM size (i.e. don’t use 1m 
resolution for a 10,000m x 10,000m box). 

5. Enter the North-West corner of the bounding box for the area you 
wish to create the DTM for. 

6. The input projection is Not Projected (Lat/Long) (using NAD83 as 
datum) 

7. The output projection is UTM with the correct zone (using NAD83 
as datum)  

8. Click on START 
9. The box next to START should switch to “Waiting…” 
 

2.3 DelphMap 
 

1. Right click on Background 
2. Import an Background Image 
3. Browse to the folder where the coverage map is located and select 

it (see Section 5.0). 
4. Click on “Change...” to change the projection of the chart.  It should 

be in UTM with the correct zone number (using NAD83 as the 
datum). 
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Figure 1. RT Bathy Window 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
Figure 2. Setting grid type and location 

 
 

 
Figure 3. Setting Bounding box and grid 

projection 

Will switch to Waiting.... 
when you click START 

3.0 Recording data on Hull#_Acq 
 

1. Click on Switch button 
2. Click on Record data to File Name radio button and browse to 

correct storage location (see section 5.0) 
3. When ready to start recording, click on the Switch Now! button. 

This will start logging data. 
4. When getting close to end of line click on the Display Only radio 

button 
5. When ready to stop logging, click on the Switch Now! button. This 

will end data logging. 
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Figure 4. Click on Switch to open recording 

dialog 

 
Figure 5. Switch File Dialog 

4.0 Playback on Hull#_Nav 
 

4.1 Isis Sonar 
 

1. Hit the Play button on Hull#_Nav.   
2. Navigate to the folder that contains the .XTF files. 
3. Open the .XTF that you just created in Hull#_Acq 
 

4.2 BathyPro Real Time 
 
1. The box next to START should be counting up.  The number should 

correlate to the ping number on the Isis computers.  If the box says 
“Outside”, then Isis thinks your bounding box coordinates are off.  
Double check to make sure that they are correct. 

2. If the box next to START still says “Waiting…” after a few moments, 
then click STOP in the BathyPro window and Stop in Hull#_Nav.  
Close the BathyPro window and repeat Section 2.2.   

 
4.3 DelphMap 

 
1. Click on Plug to display boat navigation  
2. Click on arrows to bring up Left/Right indicator  
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5.0 File Structure/Data Management 
 
The following are the file structures that shall be used from now on.  It is no 
longer acceptable to place files wherever you choose. These structures are 
specific to each platform and must be followed as such. 
 

5.1 Ship S220 File Structure 
 

5.1.1 220_Acq 
XTF Data:  
D(Data):\Projects\OPR-XXXX-FA-XX\HXXXXX\DNXXX\ 

 
5.1.2 220_Nav 
TrueHeave:  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\TrueHeave\DNXXX\ 
RT Bathy Projects (HXXXXX.dmp):  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\ 
RT Bathy Grids, Tracks, Coverage, etc:  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\DNXXX\ 
RT Bathy Shoreline: 
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\Shoreline\ 
RT Bathy Polygons: 
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT-Bathy\Polygons\ 
 
5.1.3 Velocity 
Velocity files will be directly transferred to the preprocess folder on 
the I: drive from the O-Lab 
 

5.2 Launch 1010 File Structure 
 

5.2.1 1010_Acq 
XTF Data:  
\\1010_Nav\Projects\OPR-XXXX-FA-XX\HXXXXX\XTF_Data\DNXXX\ 
 
5.2.2 1010_Nav 
TrueHeave:  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\TrueHeave\DNXXX\ 
RT Bathy Projects (HXXXXX.dmp):  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\ 
RT Bathy Grids, Tracks, Coverage, etc:  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\DNXXX\ 
RT Bathy Shoreline: 

R:\Utilities\FA_SOP\2_Acquisition\ISIS Approval Date: 12/23/04 
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C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\Shoreline\ 
RT Bathy Polygons: 
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT-Bathy\Polygons\ 
Velocity files:  
C:\Sound_Velocity\ 
 

5.3 Launch 1018 File Structure 
 

5.3.1 1018 _Acq 
XTF Data:  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\ 
 
5.3.2 1018 _Nav 
TrueHeave:  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\TrueHeave\DNXXX\ 
RT Bathy Projects (HXXXXX.dmp):  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\ 
RT Bathy Grids, Tracks, Coverage, etc:  
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\DNXXX\ 
RT Bathy Shoreline: 
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\Shoreline\ 
RT Bathy Polygons: 
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT-Bathy\Polygons\ 
Velocity files:  
C:\Sound_Velocity\ 

 
6.0 Issues/Things to watch for  

1. If you minimize Hull#_Nav then RT Bathy won’t work. Isis must be 
visible.   

2. Making the Hull#_Nav Isis window very small (not minimized) will 
help the speed of playback.  

3. Hull#_Acq must display Lat/Long in Decimal Degrees (i.e. 
34.9827271 -120.12891717) for navigation in Hull#_Nav to display 
correctly. 

4. The POS/MV must be booted up first before any other equipment.  
If it is not, then it will not work correctly. 

5. Telemetry output must be on Form 2.  Nicole Stagner (TEI Rep) 
thinks that Form 1 may not know how to correctly output at 1 Hz.  
Problems seem to arise. 

6. Logging TrueHeave at >2Hz causes Real Time Bathy lag. 
7. Real Time Bathy lag increases with depth. 
8. Use the “Slider Bar” to increase the playback speed to catch up the 

real time bathy display. 
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0. Document Scope 
 
This document outlines the new standard operating procedures for creating a data 
dictionary, preparing georeferenced background files, and creating and configuring a 
project with the necessary settings for efficient and S-57 compliant shoreline data 
acquisition. 
 
1. Data dictionary 
 
The data dictionary is a customized list of features that allows the user to assign S-57 
attribution directly in the field rather than during processing back on the ship or in the 
office.  The data dictionary itself does not contain positions or feature-specific 
information, but rather structures data collection in the field and prompts the user to enter 
relevant information.  NOTE: Check your data logger under C:\MyDocuments\TerraSync 
for an existing data dictionary and verify it is the approved version 
(Fairweather_DD.ddf).  If the data dictionary is created you can skip ahead to section 2: 
TerraSync Configuration. 
   

1.1. Pathfinder Office 
You will use GPS Pathfinder Office throughout the suitcase shoreline process, for 
everything from creating a data dictionary to processing GPS data and exporting 
shapefiles to Pydro.  Upon opening GPS Pathfinder Office, a dialog box will prompt 
you to select a project.  Later in the process you will create a new project; for now 
select Default. 
  
1.2. Data dictionary creation to S57 standards 
To create a new data dictionary, choose Data Dictionary Editor from the Utilities 
menu in Pathfinder Office.  When the Data Dictionary Editor opens, select File → 
New.  Fill out the Name and Comment fields.  Give data dictionary a descriptive 
name and save (File →Save) to the ship’s designated network folder (2004 
Fairweather data dictionary: R:\Utilities\Shoreline_S57\Trimble\Data 
Dictionary\Fairweather_DD.ddf).  Eventually, the final data dictionary will be 
transferred to the TerraSync folder of the acquisition laptop or data collector. 

 
1.2.1. Add new features 

Date: Oct 15, 2004 Approval: CST FAIRWEATHER Page 2 of 21 

Now that the dictionary has been created, it must be populated with the potential 
feature objects and attributes you will want to record in the field.  Consult the 
CARIS S57 catalog (C:\Program 
Files\Python23\Pydro\S57\S57cat\frames\S57catalog.htm) for a list of S-57 
feature objects, attributes, and coding information.  The NOAA point features file 
(C:\Program Files\Python23\Pydro\forms\NOAAHydroS57PointObjects.xls) is a 
good resource to help determine which features and attributes are necessary to 
include. 
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To add a new feature, click the New Feature button at the bottom of the left-hand 
(Feature) column. 
 

 
 
Click on the Properties tab and fill in the Name and Comments fields for your 
new feature: name the feature after the S57 feature object acronym, and use the 
comment field to describe what the code represents.  Under Feature 
Classification, select Point. 
 
               

Date: Oct 15, 2004 Approval: CST FAIRWEATHER Page 3 of 21 

 

Change symbol style preferences for this feature by clicking on the Symbol tab; 
these can be edited later as well.  In the Default settings tab, set GPS logging 
preferences: 

S57 Object Acronym 
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NOTE: Carrier phase logging can be collected, but requires a minimum lock of 10 
minutes which is generally impractical and unnecessary for shoreline acquisition. 
 
1.2.2. Add new attributes 
Each feature must have certain pieces of descriptive information, or attributes, 
attached to it in order to be useful.  Highlight the feature you wish to add an 
attribute to, then click New Attribute in the right-hand (Attribute) column.  Select 
attribute type.  Most of your attributes will be Menu, Numeric, and Text types, but 
for each detached position (DP) you will also need Date and Time attributes.  
Refer to the Pathfinder Office help menu for more information on the different 
specific attribute types. 

 
1.2.2.1. Add “menu” type attributes 
Fill in Attribute Name and Comment fields.  You must decide whether you 
want this feature to be required for entry in the field.  If you do not want this 
attribute to be required, leave the On Creation: Normal option selected in the 
Field Entry section at the bottom, otherwise choose Required.  Note the 
distinction between a mandatory S-57 attribute and a required data dictionary 
attribute; for instance the OBJNAM (Object name) and INFORM 
(Information) attributes are not mandatory for S-57, but you will want these 
fields to be required in order to record unique identifiers and feature object 
names for each position, so that they can later be correlated with DP forms 
and other notes. 
  
Click New.  Fill in Attribute Value and check the Default box if you want to 
set this value as the default for the attribute, otherwise leave it unchecked. 
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In order for Pydro to recognize 
the S-57 assignment, each menu-
type attribute value must also 
have a code attached.  Consult the 
attribute’s entry in the S-57 
catalog and fill this into the Code 
Value 1 field: 
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After you click Add, the New Attribute Value window will stay open for you 
to insert remaining attribute values.  Close the window after all values have 
been added. 
 
 
1.2.2.2. Add numeric, text, time, and date attributes 
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1.2.3. Organize features and attributes 
Arrange features and attributes in a convenient order for field acquisition.  The 
more efficient you are when collecting positions, the more data you will be able to 
gather.  Using the up and down arrows on the toolbar at the top of the Data 
Dictionary Editor, arrange features so that the most commonly used ones are at 
the top of the list.  In the attributes column, move required attributes to the top of 
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the list for each feature.  You may want to consider consistently putting a 
common attribute (i.e. INFORM) as the last required field so that, at a glance, you 
can tell which attributes are required and which are discretional. 
 

 
  
 

2. TerraSync Configuration 
 
TerraSync, the GPS logging interface you will be using during feature collection, has five 
modes: Map, Data, Navigation, Status, and Setup. The mode you’re in is determined by 
which of these options is selected in the uppermost left-hand menu.  When you switch 
modes, the display windows and menu options will automatically change.   

 
There are two ways to change TerraSync GPS Settings.  The first method will work in a 
pinch; the second is recommended.   

   
2.1. Change GPS settings in TerraSync 
In Setup mode, click on each of the different buttons (Logging, GPS, Real-time, 
Coordinates, Units, and External) and set your preferences. 
 
2.2. Change GPS settings by creating a Configuration File 
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You can save your desired settings by creating a configuration file in Pathfinder 
Office Configuration Manager (located in Pathfinder Office folder from Windows 
Start menu, or Utilities→ Other→ Configuration Manager, if Pathfinder Office is 
already open).  Through File→ New, choose TerraSync Configuration in the next 
window, and say OK.  If multiple data collectors may be used, it is a good idea to 
save the configuration file in an accessible location 
(R:\Utilities\Shoreline_S57\Trimble\Configuration Files) rather than just the C:\\ 
drive of one computer or datalogger.  This file can be referenced or updated easily for 
future projects. 
 
NOTE: Creating a new configuration file for each project is recommended since the 
DGPS beacon frequency will change for each area.  Each file should be well labeled 
with the project name and/or date.  The project configuration file may have already 
been created so it is a good idea to check for an existing configuration file on the data 
logger under C:\MyDocuments\TerraSync\Configuration and verify if it is correct. 
 
To create a new configuration file, click on each tab and set according to your 
preferences, or follow the examples: 
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NOTE: In the Real-time tab, Frequency must be determined prior to configuration 
and entered manually.  The frequency you will enter depends on which U.S. Coast 
Guard DGPS base station in the area is being utilized, which will vary by project and 
location. 
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NOTE: While it is possible to configure a laser range-finder or other external sensor 
to feed directly into the GPS log, this capability is not part of the Fairweather’s 
procedure as of 2004.  Thus far, the laser has not been accurate or consistent enough 
to warrant automatic association with GPS positions without first passing through a 
human filter.  A digital camera with the proper functionality can also be connected to 
a laptop or data collector and set up as a sensor. 
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When all properties are set as desired, choose a descriptive name and File→ Save the 
configuration file to the data logger in the folder C:\My 
documents\TerraSync\Configuration. 
 

3. Project and data file setup 
 
3.1. Create background files 
In order to navigate through and collect good data from the areas you are interested 
in, you will need to make one or more geo-referenced background file from existing 
images, both raster (charts) and vector (shoreline, features, etc.). 
 
In MapInfo, go to File→ Open and navigate through the project’s folder to a BSB 
chart or shoreline file that you want to work with.  If multiple charts of the same area 
are available, choose the one with the largest scale.  You can now work with this 
image in the form of a MapInfo table. Start by setting the projection; all background 
files must be georeferenced in a coordinate system that matches the coordinate system 
of your TerraSync configuration. 
  

3.1.1. Set Map Window projection for vector images 
For vector files, set map window projection using the Map→ Options command, 
click on the Projection button, and choose Longitude / Latitude (NAD 83).  This 
does not change the projection of the table but only the way it is displayed in the 
map window. 
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3.1.2. Set projection for raster images  
To set the projection for a raster image, navigate to Table→ Raster→ Modify 
Image Registration, select Raster Table, and say OK. Choose Projection and again 
specify Longitude / Latitude (NAD 83).  The projection of all background files 
must match the settings your TerraSync file in order for them to be compatible. 
 
When using a raster image, the window projection will change automatically to 
match that of the raster file, and does not need to be set manually. 

 
3.1.3. Additional tables 
Open any other images you want to include in your background file by using the 
File→ Open command.  To rearrange or edit the layers’ properties, right click on 
the window and select Layer Control.  To change the projection of a vector table, 
all raster layers must first be removed from the workspace. 
 
To remove a layer from your workspace, do so through File→ Close, then 
highlight the layer you wish to close.  Simply clicking the X in the upper right-
hand corner will close the table from view but won’t actually remove it. 
 
If you wish to continue working with the group of tables that are currently open, 
save your session as a workspace (.WOR file) to the survey shoreline folder. 

 
3.1.4. Save background image as a georeferenced TIF file 
To set the scale (1cm=10,000 cm seems to work well), zoom, or re-center the 
image, right-click and select Change view and then Map Scale.  If you are happy 
with the scale of the image but want to resize the window, change the When 
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Resizing Window field from Fit Map to New Window to Preserve Current Scale, 
under Map→ Options: 
 

 
 
When you are satisfied with the display, you are ready to capture it as a 
georeferenced TIF file. 
 
If your copy of MapInfo has no menu called WorldReg, you can add the 
WorldReg program so that it automatically loads every time you open MapInfo.  
Choose Tools→ Tool Manager→ Add Tool, and on the local drive, navigate to 
the WorldReg tool: 
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Under the WorldReg menu choose Save window as TAB.  Make sure to check the 
Create World File box, Select Image file type as TIF, and say Create Table.  
 

 
 
The naming convention for background files is to use the number of any charts 
that are included in the image, and the H number of any shoreline data or features.  
Two different chart images may be called 17402_1 and 17402_2, a TIF file with 
shoreline/features might be H11362_1, and an image including both types of 
raster and vector tables would be 17402_ H11362_1.  Make sure that whoever 
will be acquiring shoreline data knows what each different image represents. It 
might be useful to include some cardinal direction in the naming convention to 
benefit different users.  Save the TIF images to a temporary location like 
R:\\Transfer\Hxxxxx\Trimble\Trimble_background_files (when you’re done 
working with them you will transfer them to the datalogger). 
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After you’ve saved the image, check to make sure the size is appropriate by 
opening the TIF file you just created and zooming in to the scale you’ll be 
working at in the field.  Raster images should be clear and not too pixellated to be 
useful; otherwise return to your table and experiment with different scales 
(Change View→ Map Scale) until you are satisfied with the resultant image.  It 
may be necessary to break the image into more than one background file if you 
have a large area to cover. 
 

                    

The coordinates in 
the TFW file should 
make sense based 
on the selected 
coordinate system: 

 
As long as the Create World File box was checked when saving the image, each 
TIF should have an associated TFW (World File) that lists the image’s 
coordinates and can be opened in any text editor.  Open the TFW in WordPad or 
TextPad to ensure that Longitude and Latitude coordinates appear reasonable. 

 
3.2 Transfer data dictionary to datalogger 
In order to use the data dictionary to collect and attribute positions in the field, you 
will need to transfer the data dictionary into TerraSync on a GPS data collector or 
field PC.  If you choose to use a laptop as your field device, this machine could 
double as your office computer.  Whether you log positions on a laptop or a handheld 
data collector is a choice that will have to be made based on available equipment, 
quantity of data to be collected, familiarity and efficiency of the field team with each 
type of device, durability of the equipment, and weather considerations. 
 
NOTE: If your datalogger is a separate device from your processing computer, you 
will need to utilize some type of data transfer software.  If no such program is 
included with your datalogger, download Microsoft ActiveSync to your processing 
computer: www.microsoft.com/windowsmobile/resources/downloads/default.mspx. 
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Connect handheld unit and processing computer via serial port, USB, or infrared port 
(refer to device’s User’s Guide for details). 
 
Under the Utilities menu in Pathfinder Office on your processing computer, select 
Data Transfer.  If using a separate datalogger, connect the device to your computer 
using appropriate serial and/or USB cables.  Choose a device from the pull-down 
menu, or add a new one by clicking the Devices button; then press New. 
 
If you plan to use a Trimble data collector as your field device, choose GIS 
Datalogger on Windows CE.  If using a Windows laptop as the field device, choose 
GIS Datalogger on Windows PC. 
 

 
 
The follow-up screens will vary depending on the type of device you select.  Fill in 
the location of your datalogger, enter the correct port when prompted if using an 
outside device, type in a name and click Finish.  Minimize Pathfinder Office. 
 
Turn datalogger on, and open Microsoft ActiveSync.  In the Partnership window that 
pops up, just say No and set up a guest partnership. 
 
In ActiveSync, check to make sure the correct port for your device is allowed, 
through File→ Connection Settings, and say OK. 
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If ActiveSync does not automatically detect your device after this window closes, 
navigate to File→ Get Connected.  After your device is found, ActiveSync should 
indicate that the status is connected: 
 

 
 

Minimize ActiveSync and reopen Pathfinder Office.  The icon in the upper right 
corner of the Data Transfer window (Utilities menu) indicates the status of your 
computer’s connection with the field device.  If “Not connected” is displayed, click 
the button with the green checkmark to connect to the device (the button with the red 
arrow disconnects). 
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Click the Send tab and then press Add; select Data dictionary from the pull-down 
menu.  Navigate to your data dictionary and Open. 
 
In the Data transfer window select Transfer All.  Once the transfer is complete, press 
Close. 
 
3.3. Create a new project 
If creating a new project, it is best to first use an explorer window to manually create 
new folders with the desired Pathfinder project name 
(OPR_OXXX_FA_04\HXXXXX) in the Pathfinder local drive (C:\Pfdata\). 
 
In Pathfinder Office, select File→ Projects.  Choose a project from the drop-down 
menu or click New. 

 
Type in desired project name and click Browse to find the folder you just created. 
Accept default settings for Backup, Base and Export folders. 
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Click OK in the Project Folders window, and again in the Select Project window. Exit 
Pathfinder Office. 
 
NOTE: You are now ready to acquire shoreline data!  Before actually venturing out in 
the field, you may want to set up a TerraSync data file and load it with the correct 
configuration settings so that you don’t have to waste any time during your shoreline 
window.  To create TerraSync data and configuration files, proceed on to Shoreline 
Acquisition SOP. 
 
Back to top 
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0. Document Scope 
 
This document outlines the new standard operating procedures for acquiring shoreline 
data and logging detached positions to meet S57 standards.  Effectively, this SOP 
outlines everything that needs to be done in the field or immediately before collecting 
data.  To set up for this process, see Shoreline Presurvey SOP. 
 
1. Set up TerraSync for GPS logging  
Everything in this section should be done in preparation for a specific survey, but should 
be set up before actually going out in the field. 
 

1.1. Create a new TerraSync data file 
In TerraSync, enter Data mode (select “Data” in the upper left-hand menu).  In the 
menu directly below it, choose New File (If you are resuming work from an old file, 
choose Existing File).  All the data you acquire in a given session will be stored in the 
file you are now creating, so make sure to give it a descriptive name, i.e. TR1258 
(Trimble Unit 1 data from day 258).  Leave antenna Height and Measure To fields as 
default; these are not necessary as they apply only to vertical GPS positions.  Select 
your data dictionary from the pull-down menu (in order to be accessible it must be 
located directly in C:\My Documents\TerraSync). 
 

 
 
  
1.2. Load background files into TerraSync 
All final background files must be saved into the datalogger’s TerraSync folder to be 
accessible.  If the datalogger is the same machine that background files are currently 
saved on, simply copy all TIF’s and associated files to C:\My documents\TerraSync. 
 
If background files are located on a separate machine, these will need to be 
transferred in ActiveSync.  Open ActiveSync and connect to datalogger and transfer 
the files with the procedure outlined above in Section 3.2 of the Shoreline Presurvey 
SOP, substituting file type “Background” for “Data Dictionary.” 
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Open TerraSync on your datalogger and select Map mode.  From Layers→ 
Background File, navigate to your file.  Select File Type→ Background, find the 
desired image, and click OK. 
 

 
 
 
The first time you load a background image you will get this message (select yes): 
 

 
 
If the image does not immediately appear in the map window, try pressing the Zoom 
Extents button (equal sign with a circle around it in the lower left-hand corner of the 
map window). 
NOTE: Upon transfer of the georeferenced TIF file to TerraSync, a CS (coordinate 
system) file will be created, among others.  If the coordinate system of the image is 
changed and then reloaded into TerraSync, the original CS file must be deleted before 
TerraSync will acknowledge the new coordinate system. 
 
1.3. Load configuration file into TerraSync 
Even if the correct configuration file is already listed, you may need to reload it if the 
GPS is not connecting: from Setup mode, press the Change button, and then Load.  
As long as it was saved directly into your datalogger’s local TerraSync folder (C:\My 
documents\TerraSync\Configuration), the configuration file you created for the 
current project should be listed as an option.  Select the file and then press Load. 
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1.4. Customize TerraSync Display 
Immediately before going out to survey, open TerraSync and the project you created 
if it is not already open, choose Existing File from the second menu in the Data 
window and select the file you created.  If prompted for antenna height, leave as 
default; antenna height does not matter unless you are using GPS for vertical heights. 
 
There are three different windows that can simultaneously display different sections, 
or modes (i.e. Map, Data, and Status); set them up the way you want them to be when 
you start collecting points. 
 

 
 
 

2. Collect GPS positions 
 

2.1. Connect to GPS in TerraSync 
Make sure your GPS receiver is connected to the data logger through the appropriate 
COM port (specified under GPS Settings in Setup mode).  From Setup mode, Click 
on the Options button and choose Connect to GPS, or simply click the “GPS” button 
in the upper right-hand corner of the window.  Icons on left-hand side of the upper 
toolbar display current status; clicking on each icon provides additional details. 
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Connecting to GPS: 
 

 
 
 
 
Connected: 

 

Battery 
power 

remaining 
 

Number of 
satellites 
received 

 
In Data mode, choose Collect Features from the second pull-down menu, then Log 
Later from the Options menu.  This setting is recommended for logging precise 
positions from a launch because the time required for S57 attribution is most likely 
longer than the boat can stay still.  Choosing Log Later allows you to enter feature 
attributions at a leisurely pace, and to acquire a GPS signal only when you are ready.  
Select Collect Features from the Data menu to prepare for acquisition. 
 
2.2. Collect GPS data with S57 attribution 
When you are ready to begin taking a position, highlight the desired feature type from 
the list in TerraSync’s Collect Features mode, and click Create (this will not begin 
logging). 
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Fill in all required fields (all those above and including the INFORM field) as well as 
any desired optional fields; click OK.  To abandon the feature or switch feature types, 
click Cancel and start again. 
 
NOTE: It is important to enter the correct feature type before beginning to log; as 
attribute fields are specific to feature type you won’t easily be able to change feature 
type in Pydro.  Attributes can easily be altered in Pathfinder or Pydro, so it is fine to 
take more detailed notes by hand and electronically update attribute fields later. 
 
To begin logging, click the Log button in the upper right hand corner of the Data 
window in Collect mode.  The pencil icon on the left-hand side of the upper toolbar 
indicates that positions are being logged and displays the number of positions 
recorded for this feature. 
 
 Positions recorded 

for current feature  

 
 
After several positions have been logged (if the boat is drifting it is better to get just a 
few localized points than many spread-out ones), press Pause to end logging for this 
feature.  It is possible to add more positions to the feature by hitting Resume and then 
Pause, but this option should be used with discretion and not while drifting. 
 

2.2.1. Account for offsets 
Often, a feature will be at some distance and bearing from the actual GPS antenna 
when a position is logged.  Offsets can be accounted for during creation of a new 
feature: from Data mode, choose Collect, then click the Create button. From the 
Options menu select Offset.  The simplest way to measure offset from a shoreline 
vessel is through the Distance - Bearing technique; select this option, then Next. 
 

 

R:\Utilities\FA_SOP/2_Acquisition\Shoreline Approval Date: 12/23/04 

 



 FAIRWEATHER SURVEY 
 

Doc No. 
SOP-6XX PROCEDURE 

Procedure Owner: Annaliese Eipert 
Date: Oct 15, 2004 Approval: CST FAIRWEATHER Page 7 of 8 

Document Title 
S57 SHORELINE ACQUISITION 

Version 
1 

Effect Date: 
Dec 23, 2004  

 
While logging the position, another person should determine range (visually or 
with a laser rangefinder) and bearing (with a compass adjusted for true North) 
from the Trimble antenna to the point of interest of the feature.  After logging but 
before closing the position, follow instructions on the Offset screen to enter 
Bearing (T) and Horizontal distance in the blank fields.  Vertical distance does not 
need to be entered.   
 

 
 
Press OK to return to the feature attributes; press OK when values have been 
filled in and you are ready to record the position. 
 
2.2.2. Input external sensor data to GPS 
It is possible to connect external sensors (i.e. a laser rangefinder or camera) to the 
GPS unit so that data transmitted by the sensor will automatically be recorded and 
associated with a DP.  However, the laser rangefinder was not consistently 
accurate enough in moving seas to make this option desirable in 2004. 
 

3. Complete Detached Positions (DP’s) form 
To log a detached position (DP), fill out all information on the DP form: DP 
form_FA_04. 
 
A system should be set in place in order to keep track of all the positions that are logged 
and to ensure that no positions with duplicate names are recorded.  For example, use a 
Unit #, Day #, DP# format, where 12581 represents Trimble Unit 1, Day 258, DP 1, and 
225913 represents Trimble Unit 2, Day 259, DP 13.  This is the same unique number that 
is entered as OBJNAM attribute when entering information in the data logger.  
 
For each DP, make sure to record the position number (i.e. 12581) and feature type 
($CSYMB, UWTROC, BCNLAT) as well as the position of the actual feature in relation 
to the GPS antenna.  It is also important to record how the depth or height was 
determined.  Range may be determined visually or with a laser rangefinder; use the 
INFORM field to note any other relevant pieces of information. 

  
3.1. Associate photographs with DP’s 
If possible and desirable to take photos, keep track of how many photos were taken of 
each feature or make some sort of notes to indicate which pictures correspond to each 
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DP so they can be correlated back on the ship.  It is helpful to mention any other 
relevant information as well, such as the direction the picture was taken toward or the 
water level at the time. 
 

Continue on to Shoreline Processing SOP! 
Back to top 
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11  IINNTTRROODDUUCCTTIIOONN  
 
The purpose of this Technical Note is to describe the procedure involved in converting 
SHP files to a Notebook Edit Layer.  The advantage of this method is the transfer to an 
Edit layer of the spatial components of the SHP file and mapping of relevant attributes to 
their S-57 counterpart. Once in the Edit layer, the data can be edited. Relevant S-57 
attributes can also be specified.   
 
In order to provide SHP file conversion support, Notebook now includes options for the 
following tools: 

• The CARIS conversion utility was added to Notebook. It allows conversion of 
SHP files into a CARIS file and Access .mdb database file.  

• A new Visual Basic tool was developed for Notebook to allow merging the 
CARIS file’s spatial components with the original SHP file attributes contained 
in the Access .mdb file. This uses the output from the conversion utility to 
produce a merged Access .mdb file. This file can be parsed into Notebook 
using the Object Import Utility. 

 
These utilities support the following workflow for SHP file conversion to Notebook’s Edit 
layer (stand-alone HOB). This support provides Notebook with a self-contained import 
solution for SHP files. 

• SHP file -> Conversion utility -> CARIS File + MDB file 
• CARIS File + MDB file -> CARIS To MDB -> Merged MDB file 
• Merged MDB file -> OIU -> OIU layer 
• OIU layer -> Import Selection -> Edit Layer 
 

The details of this procedure are provided below. 
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22  RREEQQUUIIRREEMMEENNTTSS  
 
Note that the visual Basic tool  CARIS2MDB requires the Windows .NET framework 1.1 
OS extension in order to operate normally. The option to install this free OS extension is 
provided in the CARIS Notebook 2.2 beta install. This upgrade can also be made by a 
system administrator by accessing the Microsoft Windows site, downloading the 
Microsoft Windows .NET framework 1.1 install and installing it on the computer.   
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33  TTHHEE  CCOONNVVEERRSSIIOONN  UUTTIILLIITTYY  
 
The conversion utility allows mapping of the SHP file to a CARIS file and an Access 
database (.mdb) file.  
 
After conversion, the CARIS file will contain the spatial elements of the shape file. One 
attribute field must also be mapped as a unique identifier allowing the link between the 
CARIS map and its corresponding attributes in the Access .mdb file. In the following 
example, the OBJECTID attribute field in the SHP file will be mapped to two CARIS 
identifiers: CARIS Key and Source ID. These will be used later to merge the spatial 
contents of the CARIS map together with the attribute content of the Access .mdb file.  
 
 The Access .mdb file will contain the attributes that must be preserved for the S-57 
objects but that do not map to CARIS identifiers. 
 
The user must first open a data set in CARIS Notebook 2.2 beta. This data set can be 
one of the SHP files to convert or a S-57 ENC for the same area. The following 
command is used to launch the conversion utility. 
 
Tools > SHP to CARIS import > Conversion Utility 
 

  
 
 
This will open the Conversion Utility’s interface at step 1 (see on next page). 
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For this conversion we are going from SHAPE (Source) to CARIS (Destination). Specify 
these two entries and click on Next. 
 
At step 2 of the conversion, the user must specify the source directory where his SHP 
files are stored and the CARIS file that will be created as part of the conversion. 
 

 
 
The user must select the path to the directory acting as the Shape file’s repository. This 
source directory can be selected with the Browse button in the top section of the 
window.   
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Note that a special care must be given to avoid very long path names for either the 
source or the destination directory.  
 
The path and name of a new or existing CARIS file that will be used as destination must 
be specified. This is done through the use of the Browse button in the lower entry 
section of the window. The path must first be specified with the browser. In the case of 
the creation of a new CARIS file as part of the conversion, the new file name must be 
typed and Opened. Since the default file format is a CARIS map, there is no need to add 
the extension.des in the file name. See below in the screen capture. 
 

 
 
 
Specify the file name and click on Open. 
 
Click on Next at the bottom of step 2’s window.  
 
The step 3 window appears. This is where the source setup is done: 
 

SSHHPP__ttoo__EEddiittLLaayyeerr__NNBB2222bbeettaa  99 



 
 

 
 
 
At step 3, the user must know what the projection of the SHP file is. Because a new 
CARIS file is being created, the appropriate coordinate system of the SHP file must be 
known and used.  
Select the option: User defined 
 
In this case the SHP file’s coordinate system is a UTM grid, Zone 9 N, on the datum 
NAD83. The preferred scale is 1:10000 and the resolution and units can stay as they 
are: 0.02 m on the ground. 
 
Select Group: UTM-NAD83 
Select Zone:  Zone 09N (132W to 126W) 
Set Scale: 1:10000 
Set Resolution: 0.02 
Set Units: Metres 
 
Click on Next. 
 
At step 4, the layer mapping is done. 
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Click on Add. 
 
The layer mapping is divided into # steps: 
 
Step 1 of layer mapping allows to setup the Source SHP file data to convert. See below: 
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Select the layer or SHP file to convert. Automatically, the data type is selected. In this 
converter, the SHP file must always be of only one data type: points or lines. 
 
Click on Next 
 
At step 2 of layer mapping, the destination CARIS file is setup. An layer name is chosen. 
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There is no need here to assign system generated keys. 
 
Click on Next. 
 
At step 3 of the layer mapping, the attributes of the SHP file are mapped to the CARIS 
identifiers: 
 

 
 
The attribute field OBJECTID from the SHP file is being mapped to both the CARIS Key 
and to the Source ID destination attributes. Both the Feature Code and the CARIS 
Theme are set as default values. The Feature code is set as CLSL (CoastLine Surveyed 
Line). The CARIS Theme or layer number is assigned as 1000 (any number can also be 
selected between 0 and 2000000). 
 
Note that it is very important at this step to assign the same SHP attribute field to both 
the CARIS Key and the Source ID. This will be required when the CARIS and MDB files 
are merged together.  
 
Click on Finish. 
  
The program returns to step 4 of the Conversion Utility (see on the next page).  
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Highlight the conversion to be done. 
 
Click on Next 
 
The final step of the conversion (step 5) appears on the screen. 
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The conversion can be saved as a template.  
 
Put a check mark in the Run Conversion Process  
 
Click on Finish. 
 
The conversion runs and provides a status window.  At the end of this conversion a 
CARIS map and an Access .mdb file are created.  
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44  CCAARRIISSTTOOMMDDBB::  MMEERRGGEE  CCAARRIISS  AANNDD  ..MMDDBB  FFIILLEESS  
 
At the end of the Conversion Utilities, the two files produced contain the spatial 
information (CARIS file) and the attributes of the SHP file (Access .mdb file). 
CARISToMDB is a new utility added to Notebook to merge the information from the two 
files, the CARIS map and the Access .mdb file into a single Access .mdb file. 
 
To use this utility, make sure that data is opened in Notebook and use: 
 
Tools > Shape to CARIS Import > CarisToMDB 
 

 
 
This will call the following interface: 
 

 
 
Using the Open and Save As browse buttons, select the 2 input files and the merged 
output file. 
 
Example: 
Input Caris File: D:\test\CARIS2MDB_testJan05\Shape_shoreline 
Input MDB File: D:\test\CARIS2MDB_testJan05\Shape_shoreline.mdb 
Output MDB file:  D:\test\CARIS2MDB_testJan05\Shape_shoreline_merg.mdb 
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Click on Run to launch the merge procedure.  
 
This resulting single Access .MDB output file is needed to allow the mapping of the S-57 
attributes through the Object Import Utility. 
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55  OOIIUU::  MMAAPPPPIINNGG  TTHHEE  MMDDBB  FFIILLEE  TTOO  SS--5577  OOBBJJEECCTTSS  
 
Now that the SHP file’s information has been regrouped into a single Access Database 
file that includes both the spatial components and the original SHP attributes, it can be 
parsed into S-57 objects using the Object Import Utility (OIU).  
 
This utility can convert points or lines data into S-57 objects. For each input file, a single 
type of S-57 object will be created.  
 
Several scripts will be created to allow the parsing of different types of S-57 objects. 
Make sure that a scripts directory has been setup to receive these.  
 
The OIU is launched from the menu bar or by using its icon: 
 
Select: Tools > Object Import Utility 
 

   
 
The OIU interface is launched. 
 

 
 
Click on Tools > Options  
 
This allows setting the directory where the OIU scripts will be stored 
(see next page). 
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Use the browse button to set and select the Object Import Utility Scripts Directory. 
 
Example: D:\CARIS\Notebook\21\scripts 
 
Click on Apply. 
 
Click on OK. 
 
If there are already scripts generated in the scripts directory, they will be listed when the 
Object Import Utility Window is refreshed. 
 

 
 
To add a new OIU script, click on Create. 
 
The Step 1 window for Creating an Object Import Utility Script  appears (as seen on the 
next page): 
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Choose a good name for the script. 
 
Script name: Shoreline 
 
Select the Access .MDB data source. This Access database is an ODBC compliant 
source.  
 
Choose ODBC as the data source. 
 
Click on the Browse button to select setup the ODBC source. 
 
The ODBC Data Source Administrator Window appears. 
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Click on Add. 
 
The Create New Data Source Window appears. This is where the type of ODBC source 
is selected. Look for Microsoft Access .mdb  and select it. 
 

 
 
Click on Finish. 
 
The conversion script’s ODBC type of connection must be named and the output file 
must be specified. 
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In the example, the Data Source name is: SHP_shoreline 
The Description is given as: Convert SHP shoreline to S-57 
 
The input database must be specified in the Database section: 
 
Click on Select. 
 
Select the merged Access .mdb generated at the previous step with CarisToMDB. 
 

 
 
Select the directory where the merged Access .mdb was created and select the proper 
merged .mdb file. 
 
In the example,  
Directory: D;\test\CARIS2MDB_testjan05 
Database name: Shape_shoreline_merg.mdb 
 
Click on OK 
 
The ODBC Microsoft Access Setup window reappears. 
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Click on OK. 
 
The ODBC Data Source Administrator window comes back. This is where the source 
setup must be selected. 
 
Select the Source setup just configured: 
 

  
 
The User Data Source SHP_Shoreline is selected. 
 
Note that selecting the User Data Source and clicking on Configure allows changing the 
input database (.mdb) used by the script. 
 
Click on OK. 
 
This brings you back to Step 1 of the Create Object Import Script procedure (see next 
page). 
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Click on the tab on theright of the ODBC entry box to get the drop down menu shown on 
the figure above. Select the ODBC setup called SHP_Shoreline (User)  
 

 
 
Select a Table. There should be a single table in the .mdb file.  
 
The file contents must then be specified. Here, the data is of Line Type. It is being 
mapped to the S-57 Object Acronym: COALNE (which stands for coastline). Select the 
proper Object Type from the drop down list and the proper Object Class. 
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In this case: 
Table: H11334_CFF_Shoreline_polyline 
Object Type: Line 
Object Class: COALNE 
 
Note here that the SQL query is a powerful tool that could be used to isolate objects with 
certain attributes (example: Attribute field content: Natural: Mean High Water).  This 
could be used to restrict the conversion to these entries only.  
 
Click on Next 
 
The final step of the OIU script setup is the mapping of the S-57 Object’s attribute to the 
attributes given in the input .mdb file. See below. The following is only an example. 
 

 
 
 
Note that the Merge operation added the 3 top fields to the .mdb file. The mapping is as 
shown above.  The ground coordinates in eastings and northings are mapped to the 
appropriate CARIS Keywords. The KeyXY field must be mapped to the CARIS Key.   
 
Note that additional attribute definitions were added to the S-57 dictionary to allow 
storing 3 new user specified fields: userid, remrks and recomd. 
 
As shown their mapping is as follows: 
userid: OBECTID 
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remrks: ATTRIBUTE 
recomd: CLASS 
 
Click on Next. 
Specify the Input Coordinate system. This coordinate system is still the same: UTM 
Zone 9N on Datum NAD83.  
 

 
   
Select the appropriate selection for the Group and the Zone. 
 
Click on Finish. 
 
In the OIU’s main screen, select the appropriate script for converting the merged Access 
.mdb file into S-57 objects. 
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Click on Execute. 
 
The data contained in the merged Access .mdb file is now residing on a temporary OIU 
layer (see below). It needs to be imported and saved into a permanent Edit Layer 
(Stand-alone HOB file). 
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66  CCOOPPYY  TTHHEE  OOIIUU  LLAAYYEERR  TTOO  AANN  EEDDIITT  LLAAYYEERR  
 
To finalize the transfer, the new S-57 data must be transferred from the OIU virtual layer 
to an Edit Layer (permanent stand-alone HOB file). This will be achieved with the Import 
Selection utility. 
 
The following steps must be done: 
 
Create the Edit Layer intended for receiving the new information. Make sure that the 
name will reflect both the source and content of the new S-57 data. 
 
Example : create an empty Edit Layer called: test_NOAA_H11334 
 
Select the new OIU layer in the layer tree. 
 
Select all on the OIU layer. 
 

 
 
To perform the transfer, use the Import Selection from the Tools menu. 
 
Tools > Import Selection 
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Use the tab in the “Import Object(s) into” section to select the new Edit layer from the list. 
 
In the case where there are no previous foid (S-57 unique Feature Object ID) attributes 
recorded for the new objects, keep all the defaults and click on OK. 
 
For the case where original S-57 foids need to be preserved, choose the “Use existing 
identifiers (…” in the “Object identifiers” section and click on OK. 
 
The result will be as given on the next page: 
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At this point, the original SHP data has been mapped and converted into S-57 objects on 
an Edit layer. Standard S-57 attributes can now be populated and specified as required. 
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0.0 Document Scope 

 
This is a step by step guide to acquiring RESON data. 

                                                  
1.0 Start-up Procedure      
 

1.1 Turn on ISIS computer.                                
                                                                  
1.2 Make Day Number Folder on the Isis machine under appropriate project 

and sheet in Windows Explorer. It is also helpful to have this folder open 
and visible in Windows Explorer somewhere on screen to make sure that 
the lines are being recorded and saved correctly. 

 
1.3 Launch Isis Sonar from the desktop.  An empty shell will come up. 
 
1.4  Turn on RESON machine. 
 
1.5 On the upper left hand corner of the ISIS screen, hit “REC” (RECORD).  

 
 

1.6 Three important image screens will come up in the Isis Main Window: 
 

   3-D Screen     2-D Screen 

 
            Vertical Waterfall/Sidescan 
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The Isis Seabat 81xx Server menu will come up that will allow you to change the 
settings that affect these three ISIS image screens as well as the RESON  screen—i.e. 
general data quality of the sonar itself.   
               
           Isis Screen                                       Reson Screen 
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2.0 Isis Seabat 81xx Server
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without getting too many flyers.  When the power is set too high, 
often there will be a glow or a halo around each ping (this can be a 
result of other settings being too high also), as well as flyers.  Do 
what you can to prevent this from happening.  

 
2.3      Gain Type  

 
Gain type should always be TVG (Time Varied Gain). 

 
Auto Gain – Auto Gain is an automatic gain function that can be 
used instead of Rx Gain, which is where the gain can be set 
manually.  The setting for this ranges from Auto 1 to Auto 10.  This 
will analyze the bottom return to increase or decrease the receiver 
gain.  Auto 2 through 4 are the typical settings for acquisition.  
Again, try and set this as low as possible to prevent possible flyers 
and the “power glow” that will be seen if any setting is too high.  To 
run the gain manually, hit “Off” on the drop down menu. 

 
Rx Gain – Gain is the “ears” of the sonar.  The Gain function 
controls the amount of receiver gain to be applied to the returned 
sonar signal.  If you are using manual Gain mode, keep the number 
as low as possible, ranging from about 4 to 12 for best results. 

 
2.4      Range  

 
The Range setting determines ping rate and how far down the  
sonar will “see”.  The 8101 minimum range is 0 (though the setting 
will never be seen so low) and maximum is 400. This will be the 
setting that will most likely be changed the most because it is so 
closely linked with water depth.  The 8111 minimum range is 5 and 
maximum is 1400. The 8160 minimum range is 5 and the maximum 
is 5000. The Range should be kept above or even with the widest 
part of the wedge on the RESON computer screen, as in the first 
illustration below.  
 
 

 
1                                      2                                        3 
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Good                            Too Low                                Bad 
Outer Beams are Lost 

 
 

2.5      Max Ping Rate   
 

This will be already be set 20.0 Hz for the 8101.  For the 8111 it is 
set at 20.0 Hz. For the 8160 it is set to 15.0 Hz. The only reason to 
change these values is if the vessel is in shallow water and moving 
very slowly and you wish to reduce superfluous data.   These 
values should never be changed without approval of the FOO. 

 
2.6      Tx Pulse Width  
 

Pulse Widths on the 8101 ranges from 21µs to 225 µs, but keep 
these numbers within 70µs to 120µs for best results during 
acquisition.  On the 8111 this value ranges from 50 µs to 670 µs, 
the recommended/minimum value for the 8111 is 225 µs.  Donot go 
below 225 µs, nothing is gained by going lower.  On the 8160 this 
value ranges from 0.2 ms to 10 ms.  For the 8160 the pulse width is 
range dependent. At 750m, the minimum is 150 micro sec, at 
1000m  the minimum 300 micro sec, and at 1750 the minimum is 1 
milli sec (the minimum is listed here, pulse width can be set higher 
but resolution decreases).  The smaller the number, the narrower 
the pulse width.  A narrow pulse width means higher resolution 
while cutting back on range capabilities; likewise a larger pulse 
width lowers the resolution while increasing the range (better outer 
beam response.  Therefore, in sloping areas, increasing the pulse 
width will increase how much slope the Reson can acquire.   

 
2.7       Filter  

 
There are two types of filters that can be used during acquisition: 
The “Auto Depth Filter from Isis Attitude” and the Filter based on 
“Depth”, “Range”, or “Both” for depth and range together.   

 
2.7.1 Auto Depth Filter  
 
Percentage ranging from 1% to 100%.  This filter is most helpful in 
sloping areas, i.e. the steeper the slope, the better the sonar will 
pick it up when the percentage is set high.  However, a high 
percentage on a flat area will create flyers, so keep the percentage 
low in these cases.   
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2.7.2 Filter based on Depth or Range  
 
Auto Depth Filter must be unchecked.  To select between Depth, 
Range, or Both, simply click on the drop down menu to highlight 
your choice.  For multibeam, utilize only the Depth option.  Under 
Min (m); and Max (m); set depth values appropriate to the depth of 
water that you are working in, keeping in mind that any depths 
outside of this minimum and maximum will not be acquired.   
 
2.7.3 No Filter 
 
It is also possible to run with no filter by selecting “None” in the drop 
down menu. 

 
2.8      Apply All  
 

This button is inessential because every change made in the 
Seabat Server is immediately applied.  Another reason it is not 
recommended to use this is it can cause the system to crash. 

 
2.9    More Options 

 
These are mainly configuration options. It is important to know 
where they are found, however these options should not be 
changed without FOO or CST approval. 
 

 
 
 

 
3.0 Reson Display Screens 

 
The Main Sonar Display Screen, which is used for acquisition, is shown below. 
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Date and Time                   Cursor X, Z, R, Position              Operation Menu 
 

 3.1 Cursor Position  
 

 When the cursor is within the wedge, its position is  
 displayed.  X = Across Track, Z = Depth, R = Range. 
 
3.2 Operation Menu  
 

There are four different menus, Main, Ocean, Filters, and Display. 
There is also the Menu Off option. To change between menus, 
simply click on Menu to scroll to the menu you need. 

 
3.2.1 Main Menu  
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The Main Menu shares the same information that is found in 
the top half of the Isis Seabat Server: Range, Max (Ping) 
Rate, Tx Power, Tx Pulse (Width), Rx Gain, Gain Mode, and 
Auto Gain.  These numbers should mirror the numbers in the 
Isis Seabat Server.  If for some reason this is not the case, 
and changing settings in Isis has no effect on the sonar, the 
settings in the Main Menu can be changed by using the 
three-button trackball.  The three buttons function as so: Left 
button—down, Right button—up, Middle button—speeds up 
the direction when held with the right or left button. 

 
 

3.2.2 Ocean Menu  
 
There are three options: Spread, Absorb, and Velocity.  
Spread and Absorption are linked together, where the 
numbers represent the amount of spreading and absorption 
loss that can be expected. These values will factor into the 
TVG, which in turn affect the return signal.  For the 8101, 
keep these numbers at 30 and 70 in salt water and 30 and 
20 for fresh water for the spread and absorption respectively.   
For the 8111, keep these numbers at 30 and 30 for salt 
water and 30 and 5 for fresh water.for the 8160 keep these 
numbers at 30 and 13 for salt water and 30 and 2 for fresh 
water.  Velocity is the speed of sound for the area.  This only 
applies for the 8160 which receives surface sound velocity 
via the SBE 45 TSG.  This value should roughly correspond 
to the sound velocity seen during the last CTD cast. If it 
differs greatly then you should consider taking a new cast. 
  

 
System Spread Absorb 

(sea) 
Absorb 
(fresh) 

8101 30 70 20 
8111 30 30 5 
8160 30 13 2 

  
 

3.2.3 Filters Menu 
 
Found in the bottom half of the Seabat Server, namely Filter, 
Min Range, Max Range, Min Depth, Max Depth, and Head 
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Tilt.  Head Tilt has to do with if the transducer had been 
mounted with a roll offset, which does not apply to our 
Reson transducers. 

  
3.2.4 Display Menu  

 
Color, Contrast, Dots, Grid, and Freeze. This menu has to 
do with how objects on the Reson screen are being 
displayed.  These options do not need to be changed. 

 
3.3 BITE Menu  

By clicking on “BITE” in the upper left-hand corner, the Built-In Test 
Environment (BITE) Screen opens up.  This  menu is available for 
viewing diagnostic and configuration  information—like some of the 
information found in More  Options of the Isis Seabat Server.  The color of 
the BITE  button shows if the Reson system is operational or not: 
 GREEN = System is operational;  

YYEELLLLOOWW = System is operational but some areas are not working 
properly or are out of sync;  
RED = System is not operational—there is a malfunction 
somewhere. Inside the BITE menu, the text will also be in one of 
three different colors depending on the status of each particular 
setting.  The color code is same as above except that text will also 
be WHITE to show that the system is operating OK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The BITE Menu Screen looks something like this below: 
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Updated: 2/15/2005 
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                                       BUILT- IN TEST  B T 
BITE
Process Owner: Lynn Morgan 
Updated: 2/15/2005 
R:\Utilities\FA_SOP\2_Acquisition\Reson 

Approval: CST
Approval Date:

 
Wet-End Status            Commuication 
          Leak: +5.0V           Uplink: Good 
HeadTemp: +18.4°C   Downlink: Good 
            -5V: -4.8V          Internal: Good 
         +12V: +12.0V     Ethernet: 00E0CB030498 
          -12V: -12.0V           Local: 192.168.195.101 
 DipSwitch:  50               Remote: 192.168.195.102 
                                        Gateway: 192.168.1.1 
Firmware Version            Subnet: 255.255.255.0 
    Dry: 8101-2.09-E34D 
    Wet: 8101-1.08-C215   Sensor Inputs 
                                              Pitch: 
                                                Roll: 
                                             Heave: 
                                          Velocity:   
                                       UTC Date:   
                                      UTC Time:   
                                                           
             Receiver Gain Offsets:          
+3db                                                   
+0db                                                   
 
- 3db                                                    
                                                            
            Receiver Phase Offsets:       
 +45°                                                                             
  +0°                                                     
  
- 45°                            
                                                                                     
                                                                                     
Config 
 
 
In the upper right hand corner, the BITE menu display
can still be viewed while in this menu. 
 
 

3.4 Sensor Inputs   
Here are where the numbers are fo
the Reson system. Next go to Wind
CALI
 FAIRWEATHE
 12/23/04 

  
  
  
  
  
  
  

  
  
  
                    
  

       H
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und for Heav
ow\Graph\P
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 Uplink: 
 Format: 
         Sidescan: 
         TestPtrn: 
            Output: 
         ProfilBd:  
         TimeBd: 

        ContrlBd: 
      MotionBd: 
     VeloctyBd: 

       UDP Base: 
        Oriented: 

eadSync: 
            Projectr: 
             MENU: 

ata wedge, so that it 

e, Pitch, and Roll for 
itch, Roll, Heave  
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The window that pops up will only show Pitch values.  In order to view Roll and Heave 
as well, right click inside the graph box and under “Which Motion to Display?” check 
each of the boxes for the other sensors. 
 

3.4.1 Good motion sensor data will look like this 
 

 
 
 

 
3.4.2 Parameter Display  

 Sensor data is also visible through the Parameter Display.     
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 Look to see that these values are changing and they are not  zero.   

 
 

  3.4.3 ISIS Shutdown 
 
 If any or all of these sensors values are not changing or flat-lining in  
 the Pitch, Roll, and Heave Motion Window, the ISIS computer   
 must be shut down—DO NOT RESTART, SHUT DOWN.  After,   
 beginning again with the start-up procedure; make sure that the   
 RESON has been turned off before the Isis is brought up again.  
  

A possible reason for this communication error is if the Isis computer was never 
shut down.  Check to see if the Isis computer is on upon first getting in the 
launch.  If it is, log in and shut down.   

 
  3.4.4 Altitude 
 

Another value to monitor is the Altitude.  It is found in the Parameter Display 
under Sensor Data. To see it displayed larger, simply click left of the Alt button:  

 
This is what will pop up: 
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Creating/Updating Projects in DelphMap          
 

Table of Contents 
 
0.0 Document Scope         1  
1.0 Importing Chart Files        1  
    1.1 Reprojecting Charts         1 
    1.2 Inserting Charts (Reprojected .TIFF’s) into DelphMap   2 
    1.3 Inserting Charts (.BSB/.KAP’s) into DelphMap    2 
2.0 Importing Polygon Files        3  
3.0 Importing RSD Shoreline Files       3 
4.0 Coloring RSD Shoreline Labels and Lines     4 
5.0 Saving the Project         4 
 
0.0 Document Scope 
 
The scope of this document is to familiarize the reader with the process of 
creating a new project and updating the current project in TEI DelphMap. 
 
1.0 Importing Chart Files 
 
Currently there is a rounding issue with DelphMap 
importing .BSB/.KAP files.  With small scale charts it 
is very obvious.  The work around is to reproject the 
charts into GeoTiffs using NOAA Chart Reprojector. 
 

1.1 Reprojecting Charts  
 

1. Open NOAA Chart Reprojector  
2. Select .KAP to be reprojected 
3. Give to new .TIFF the same name as 

chart 
4. Give the new .TIFF the format TIFF 
5. Give the new .TIFF the projection 

UTM and the correct zone (using 
NAD83 as datum) 

6. Rename the .TIFW extension to .TFW 
 

 
 
 

 
 
 

Figure 1. NOAA Chart Reprojector Window 

R:\Utilities\FA_SOP\1_Presurvey\ Approval Date: 12/23/04 
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1.2 Inserting Charts (Reprojected .Tiffs) into DelphMap 
 

1. Right click on Background 
2. Import an Background Image 
3. Browse to the folder where the charts are located and select the 

chart for the project 
4. Click on “Change...” to change the projection of the chart.  It 

should be in UTM with the correct zone number (using NAD83 
as the datum) 

5. DelphMap will then ask for a projection for the project.  This 
should be in UTM and have the correct zone number (using 
NAD83 as datum). (This step only occurs when first importing 
objects into a new project) 

 
1.3 Inserting Charts (.BSB/.KAP’s) into DelphMap  
 

1. Open the “project” menu, scroll down to “import,” and click on 
“Import an Image Background” 

2. When the “Insert a Background Layer” window opens, click on 
the top button with three dots on it.  An “Open” window will 
appear.  Change the “Files of type” to “BSB Chart (*.kap),” and 
browse to the correct folder.  Double click on the correct file so it 
will appear in the “File name” box.  Click on open. 

3. On the “Insert a Background Layer” window, click the “Change” 
button.  A “Projection settings” window will appear.  Select “Not 
Projected (Longitude, Latitude)” and click next. 

4. A “Projections settings” window will open.  Select “North 
American Datum (1983)” as the datum (unless you know the 
datum of the chart to be otherwise).  Click “Finish”. 

5. Check the North and West most coordinates in the “Insert a 
Background Layer” window.  If the latitude or longitude are 
obviously incorrect, there has been an error importing the file (it 
may be a corrupt file). 

6. Click on the “OK” button in the “Insert a Background Layer” 
window. 

7. The chart should appear in the DelphMap project.  As of right 
now, there is a registration issue, so the chart will appear 
skewed.  The best thing to do is reproject the chart as a 
GeoTIFF, and import that into DelphMap. 
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2.0 Importing Polygon Files 
Polygon files are setup by the Sheet Manager before and during the project.  
These files outline the area to be covered by the acquisition unit.  They should be 
imported before a project and re-imported as they are updated to reflect current 
coverage needs. 
 

1. Right-Click on Vector layers in DelphMap 
2. Insert layers→change the file type to Shape *.SHP 
3. Select the Polygon file from the Project folder 
4. Click on Change… to change projection of the shape file. 

 

 
Figure 2. Setting .shp projection 

 
 

5. The Input Projection is usually UTM/NAD 83 with correct zone 
number 

6. The Output Projection is UTM/NAD 83 with correct zone number 
7. Place in project folder (see TEI_RT_Bathy_SOP.doc Section 

5.0). 
8. Specify layer name (i.e. HXXXXX_Poly_region_A) 
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3.0 Importing RSD Shoreline Files 
 

1. Right-Click on Vector layers in DelphMap 
2. Insert layers→change the file type to Shape *.SHP 
3. Select the Shoreline file from the Shoreline folder (see 

TEI_RT_Bathy_SOP.doc Section 5.0). 
4. Click on Change… to change projection of the shape file. 

 

 
Figure 2. Setting .shp projection 

 
 

5. The Input Projection is usually Not Projected (Lat/Long) but can be 
UTM/NAD 83 with correct zone number 

6. The Output Projection is UTM/NAD 83 with correct zone number 
7. Place in shoreline folder (see TEI_RT_Bathy_SOP.doc Section 5.0) 
8. Use ATTRIBUTE as label 
9. Specify layer name (i.e. HXXXXX_CFF_Shoreline) 
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4.0 Coloring RSD Shoreline Labels and Lines 
 

1. Right click on the layer you wish to change the 
colors  

2. Click on Properties 
3. Click on Settings 
4. Color RSD Shoreline and Points as Green 
 

 
5.0 Saving the Project 

 
1. Save the project as the H number (i.e. HXXXXX.dmp) 
2. Save the project to: 
C:\Projects\OPR-XXXX-FA-XX\HXXXXX\RT_Bathy\ 

R:\Utilities\FA_SOP\1_Presurvey\ Approval Date: 12/23/04 

 



C i d P i I f ti

Acquisition Information 
Date: Dn# Vessel: Pg of

Personnel: # of XTF Files Transferred:

Weather & Sea State: Local Area: Survey:

LOADING from B.M. B (Starboard side): AM: PM: Why not taken?

Sound Velocity Information
Cast #:

Cast Name:
UTC Time:

Latitude:
Longitude:
Ext. Depth:

Back timed to:
For Lines:

Sound Velocity Comments:

True Heave Filename(s): Depth Range (m):

Acquisition Comments:

Delete lines: # of Lines Deleted:

XTF Line Remarks (Need only list lines with issues)
Filename: Remark:

Please contact AST Kellner for changes to this form.
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Conversion and Processing Information 
Software Version & Update: CARIS 5.4 SP1 HF 12 Number of HDCS Files:

Processor(s): Batch File: Insert batch as an object here 
only if used.

End of day processing
(Note Processing Steps only if Manually Applied) Nightly Review & QC

Converted:
Open (HXXXXX_Daily) Session & add lines: Open (HXXXXX_Daily) Session:

SV profile selection method: Create Subset Tiles for daily FS:
Tide file: Review Daily BASE Child Layers:

True Heave Applied: Additional Filters Applied:
Merge Clean Data:

Compute TPE: Contour:
Filtered  (0-100) IHO 1 and 0 Qlty-Rejected: Generate Soundings:

Filtered (100-500) IHO User def - 1/0.023/5/5: Review for DTONS:
Query Lines: Chart Comparison:

Create daily Field Sheet: Mark Examined Soundings:
Create daily BASE Surface & save session:

Open (HXXXXX_QC) Session & add lines: Recompute Coverage BASE Surfaces:
Update/Recompute Coverage BASE(s): Export to I & Copy to R:

Export to I & Copy to R:

Processing Comments:

Processing Query 
Total Mileage

0

Length Line Project Vessel Day TideLoaded TideFile SVPCorr SVPFile Merged Outdated TPE Co Speed Heading TotalTime
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     Bathymetric Quality Control
"RAW" Data Sources       Processing

Deliverables

Sound Velocity 
Profiles 

Multibeam 

Single Beam
 (Ceeducer) processed for 

reference only, not 
combined with MB data. 

Used only for ES disproval 
DPs

VelocWin

stored in
PreProcess   
P/V/D/L

Sensor offsets, biases, 
draft, and uncertainty 

estimates

Tide data - 
height & time 

correction

.HVF files

Cleaning 
procedures are 

dependant on the 
examination of the 
BASE surfaces. All 
data is reviewed in 

subset mode

Review/Clean 
HPR/NAV 
as needed

Swath Edit
Line Cleaning

as needed

Subset 
Editor 

Area based cleaning

.SVP
 file

Addl Filters 
applied as needed

Select "Designated" 
& "Outstanding" 

Soundings
Point Features

Collected with Trimble 
TerraSync & processed with
GPS PathFinder into S-57 

attributed .shp files
Display 
Critical 

Soundings

                   Pydro
   (1) Open/create PSS
    (2) Insert Trimble DPs & GPs (.shp)
    (3) insert AWOIS.mdb
    (4) insert images

Field Sheet Editor 
(QC Tools)

Query Tiles 

Contours 

Depths 

Finalized BASE 
Surfaces

w/Depth Thresholds & 
Resolutions

for QC & Crit Sdgs only

                CARIS Notebook
   (1) Import Pydro XML to HXXXXX_Features.hob
   (2) Convert source shoreline .shp files to .hob files
   (3) Create .hob files with S-57 attribution 
        and marker layers as necessary
         (a)  HXXXXX_Shoreline_Updates
         (b)  HXXXXX_Shoreline_Notes
         (c)  HXXXXX_Charted_Shoreline

   CARIS HIPS (DPs)
(1) SVP correct (DPES)
(2) Load Tide (DPES, DPNE)
(3) Merge (DPES, DPNE)      Pydro (DPs, GPs, DTONs & AWOIS)

         (Only DPs are processed in CARIS HIPS)
   (1) Insert HIPS/SIPS Line Features 
   (2) Designated & Outstanding sdgs reviewed for DTONs
   (3) DTONs selected
   (4) S-57 attribution finalized
   (5) edit & flag features (DPs, GPs, DTONs & AWOIS)
   (6) save PSS
   (7) XML stored unzipped 

                    Mapinfo
    (CARIS Notebook functionality is            
limited at this time, Mapinfo utilized to)
  (1) review during shoreline preparation & 
create boat sheets
  (2) edit source shoreline files
  (3) use Universal Translater to               
translate Mapinfo .tab files to .shp files
  (4) use WorldReg to create geotiffs 
forTerraSync shoreline background files

.SHP files

.SHP files

                    CARIS HIPS 
                Initial Processing
  (1)  Convert RAW
  (2)   Apply Predicted, Zoned Tides
  (3)   SVP Correct
  (4)   Load True Heave  
  (5)   Merge
  (6)   Compute TPE
  (7)   Filter IHO 1 for depths <100m 
  (8)   Filter "User defined" for depths >100m
          (a=1.0, b=0.023, Hort. 5m+5%) 
  (9)   Daily BASE Surface processed
(10)   Add daily lines to BASE for quality 
          control & coverage review

.XML file

        PSS
HXXXXX.pss
XML files (for Notebook)
Images

     FIELD PRODUCTS
HXXXXX_Notebook.hsf 
       session w/ hob files:
HXXXXX_CFF_Shoreline
HXXXXX_(Add/Mod/Del)Features
HXXXXX_Bottom_Samples
HXXXXX_Shoreline_Updates
HXXXXX_Shoreline_Notes
HXXXXX_Charted_Shoreline

  DESCRIPTIVE REPORT
HXXXXX_DR.doc
Appendices
Separates

Designated & Outstanding Sdgs from HDCS_DATA

.Tid & .ZDF files
(PREDICTED)

.Tid & .ZDF files
(OBSERVED or 

SMOOTH)

                CARIS
DATA
     Raw & Processed
HXXXXX_FINAL Fieldsheet
     Non-Finalized Base surfaces
     Critical Soundings

  Acquisition & 
Processing Logs  
including line queries
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MEMORANDUM FOR: Distribution 
 
 
FROM:   W. Michael Gibson 
    Chief, HSD, OCS 
 
SUBJECT:   Hydrographic Surveys Technical Directive 2004-3 
    (HSTD 2004-3) 
 
 
TITLE:   CARIS HIPS 5.4 BASE Surface Processing 
 
EFFECTIVE DATE: September 10, 2004 
 
SECTION 1. PURPOSE 
 
This Hydrographic Surveys Technical Directive (HSTD) grants permission for NOAA 
field units to process hydrographic survey data using CARIS HIPS 5.4 BASE surfaces.   
BASE surface processing may replace the line by line swath editing and shoal bias 
binning process that is currently authorized.  Each command may choose the time to 
switch depending on project requirements, capabilities of personnel and familiarization 
with the new techniques.  It is anticipated that all NOAA field units will be formally 
trained and ready to process all data using BASE surfaces beginning in early 2005. 
 
SECTION 2. POLICY 
 
Effective immediately, NOAA field units may deviate from current documented 
procedures (project instructions, NOS Hydrographic Surveys Specifications and 
Deliverables, Field Procedures Manuel, etc.) in order to process hydrographic survey data 
using BASE surfaces.  Deliverables to the Processing Branches will be affected as 
described in Section 5 of this memorandum.  Draft versions of Chapter 4 of the Field 
Procedures Manual, THOMAS JEFFERSON Base Surface Standard Operating 
Procedures, and RAINIER BASE Surface Creation and Data Processing documents are 
available to provide guidance. 
 
All NOAA field units should continue to work closely with their Processing Branch to 
ensure that new deliverables meet requirements for charting and that all new processes 
are properly documented in the Descriptive Report and Data Acquisition and Processing 
Report. 
 
Management must stress that the new processing techniques do not remove the 
requirement for hydrographers in the field (or personnel at the Processing Branch) to 



review full resolution data.  All critical soundings and dangers to navigation must be 
thoroughly reviewed to ensure that the appropriate depth will be forwarded for chart 
compilation.  This may require selecting a ‘designated’ sounding, essentially overriding 
the BASE surface, or simply a check by an experienced hydrographer to ensure that the 
BASE surface node accurately reflects the desired depth to be charted. 
 
SECTION 3. RESPONSIBILITIES 
 
The approval, promulgation, revision and amendment of this policy shall be the 
responsibility of the Chief, Hydrographic Surveys Division or his designee.  All 
employees associated with the NOAA hydrographic survey program are encouraged to 
suggest policy changes, via their supervisor, that will promote increased efficiency and 
quality of the services provided by the division. 
 
NOAA field units shall continue to work closely with the Processing Branches to ensure 
data submitted can be readily verified and efficiently compiled for nautical charting.   
 
The Atlantic Hydrographic Branch (AHB) will continue to develop procedures to verify 
and compile the THOMAS JEFFERSON (TJ) BASE surface surveys already submitted.  
Special steps will be taken to verify and document that proper and accurate depths are 
being compiled for charting. 
 
The TJ has the most experience using the new techniques, they will continue to update 
their Standard Operating Procedures (SOP) documentation and provide guidance on best 
practices. 
 
SECTION 4. GENERAL 
 
Background 
 
Suggested background reading includes, “NOAA’s Office of Coast Survey Adopts a 
Surface-Based Approach to High Density Hydrographic Data Analysis and Archiving, A 
Brief Overview”, by LT Rick Brennan, NOAA, and “Implications of the Navigation 
Surface Approach for Archiving and Charting Shallow Survey Data”, by Andrew 
Armstrong, Rick Brennan and Shepard Smith.  Copies of the papers can be made 
available upon request. 
 
Due to the volume of data collected by modern multibeam sonars, NOAA no longer has 
the luxury of manually reviewing and verifying every individual sounding.  In addition, 
we need to change our processing and archiving of survey data to end the practice of 
forcing the data into a pipeline created for lead lines. 
 
New techniques for handling multibeam data have been developed at the NOAA funded 
Center for Coastal and Ocean Mapping and Joint Hydrographic Center (CCOM/JHC).  
The techniques use the power of the multitude of measurements obtained from modern 



multibeam echosounders to compute a statistically valid depth for a given spot on the sea 
floor.   
 
To do this effectively, an error model is needed for all systems supplying measurements 
to compute a sounding (sound velocity probe, motion sensor, GPS, tide gages, etc.).  
Once this comprehensive error model is assembled, then all the inherent errors in each 
measurement can be propagated to each individual sounding.  Once each sounding has an 
associated error, or Total Propagated Error (TPE), we can then compare each sounding in 
an objective manner with its neighbors.  
 
In the past, when only a couple of soundings were obtained on each spot of the sea floor, 
it made sense to choose the shoalest.  However, if we have dozens of soundings, we 
should use our knowledge of the inherent accuracy of each sounding (TPE) to determine 
the highest probability of the depth at a location.  To fully benefit from the statistical 
power provided by having millions of soundings, we can form a surface model of the sea 
floor, in this case a regular grid.  The node spacing is driven by the highest resolution the 
data will support, primarily the type of sonar and water depth.  For example, in depths 
less than 15 meters, we should achieve a grid resolution of 0.5 meter.  Each node of the 
grid will have a computed depth composed of many soundings, each sounding weighted 
by its TPE and distance from the node.  Each node will also include other attributes, such 
as, an associated uncertainty, standard deviation, density (number of soundings used in 
the computation), minimum depth, maximum, etc. 
 
It is important to note, that the Hydrographer must always have the capability of over 
riding the depth computed by the algorithm and have tools available to check the 
relevance of depths.  For instance, an echosounder return from the top of a submerged 
piling may be combined with soundings from the surrounding sea floor to compute a 
depth at the grid node that is deeper than the piling top.  In this case, the Hydrographer 
will notice a problem due to the high standard deviation of the grid at that point.  After 
review of the full resolution data, she can select the sounding at the top of the piling as a 
special ‘designated’ sounding.  This forces the grid node (and surface) to that sounding. 
 
BASE Surfaces 
 
The process of using high resolution grids to process multibeam data is part of the newest 
CARIS HIPS release (version 5.4).  CARIS implementation of the grid concept is called 
Bathymetry with Associated Statistical Error (BASE) surface.   
 
The first step in processing with BASE surfaces, is to create a HIPS Vessel File (HVF).  
This is an essential component in calculating the Total Propagated Error (TPE) for each 
sounding.  This file includes error estimates for each sensor, as well as offset 
measurements (and the potential error of those offset measurements).  Examples of HVF 
files used by the THOMAS JEFFERSON and RAINIER, with references are available 
upon request.  The examples may be used as a guide, but each vessel’s HVF will be 
unique.  The entries of the HVF are dependent on specific models of equipment installed 
on the vessel. 



 
The THOMAS JEFFERSON (TJ) has been processing data using the new CARIS tools 
for over a year.  They have worked closely with CARIS, troubleshooting the software, 
suggesting improvements and ensuring that the software can function in a ‘real world’ 
environment. 
 
Primary Objective 
 
The primary objective of developing a new pipeline for Hydrographic survey data, is to 
streamline the ping-to-chart process to shorten the time required in getting sounding data 
to MCD for charting. 
 
The new tools when fully implemented should reduce the processing time required by 
field units, allowing surveys to get off the ships faster with a higher confidence that an 
area was properly and completely surveyed.   
 
Once in the Processing Branches, the data should be verified quickly and chart 
compilation from a final surface should be faster and more accurate than current methods. 
 
Secondary/Parallel Objectives 
 
The final BASE surface for a survey can be archived to provide products for users 
outside OCS.  Currently, the final product of a hydrographic survey is a smooth sheet, a 
sounding plot at the scale of the survey.  At survey scale, we can plot soundings at a 
spacing not much tighter than 5 mm, therefore, for a typical 1:10,000-scale survey, we 
have a single sounding every 50 meters.  NMFS, USGS, marine geologists, state 
agencies, etc., will have interest in the higher resolution BASE surface data.   
 
Current products delivered to MCD include a smooth sheet and H-drawing (compilation 
of the survey data at chart scale) as MicroStation drawing files.  We could update our 
processing pipeline as described above and still provide these products.  However, PHB 
has been working on an ENC S-57 initiative to update these products. 
 
The primary deliverables from HSD to MCD will become a S-57 exchange set (H-cell) 
representing the chart revisions from a new hydrographic survey.  An interim deliverable 
will be an S-cell, which is an S-57 version of a smooth sheet created in CARIS.  Once 
fully implemented, these products will replace the current production system which 
requires the drafting of a smooth sheet in MicroStation, and subsequent manual chart 
compilation in SCARS. 
 
The H-cell initiative will eventually eliminate the MicroStation drafted smooth sheet as 
the final archive of a hydrographic survey (and thus reliance on MicroStation).  It will 
also reduce the use of in-house customized software for the compilation of smooth sheets 
and chart revisions.    
 



Official guidance on changing the deliverables to MCD will be provided under separate 
cover when appropriate.  HSTD 2004-3 is intended to just change the processing 
procedures and data submission of NOAA hydrographic field units.  If required, the new 
field unit deliverables could be used to create a traditional MicroStation smooth sheet and 
H-drawing.   
 
Testing of New Technologies 
 
The Joint Hydrographic Center (JHC) developed the algorithms and ideas behind 
processing hydrographic data via TPE and gridded surfaces.  JHC has conducted several 
tests of the concept using actual survey data in Snow Passage, Valdez, Woods Hole and 
Portsmouth.  Several academic papers have been written. They have conducted many 
tests showing that the techniques are a valid, efficient and accurate tool for processing 
hydrographic data in support of nautical charting.     
 
The TJ has spent the last year or more processing data using early beta versions of HIPS’ 
BASE surface processing routines and more recently with the final version of CARIS 
HIPS 5.4.   They have found no major problems that would require them to ‘reprocess’ 
the data.  In all instances, the BASE surface process provided meaningful results. 
 
HSD has reprocessed a WHITING survey using the latest version of HIPS.  The analysis 
continues, but overall the final soundings agree very well.  No major issues were found to 
discredit the BASE surface process. 
  
The RAINIER has started to implement full HIPS 5.4 capabilities by dual processing 
several surveys.  The new techniques allowed them to troubleshoot and fix problems in 
the data that were not noticeable with earlier processing procedures.   
 
As the organization moves forward with the new technology, all hydrographers, 
cartographers and physical scientists both in the field and in the Processing Branches 
must take steps to ensure that accurate depths are compiled for charting.  The accurate 
depths will not in all cases be the shoalest sounding available, but must be the most 
accurate depiction of the seafloor.  All critical soundings and dangers to navigation must 
be analyzed, comparing the BASE surface nodes to the full resolution data to ensure that 
appropriate least depths are available for chart compilation. 
 
SECTION 5. EFFECT ON OTHER ISSUANCES 
 
This Directive supersedes the processing procedures and deliverables detailed in current 
versions of Project Instructions, Standing Instructions, Field Procedure Manual (FPM) 
and the NOS Hydrographic Surveys Specifications and Deliverables. 
 
NOAA field units that implement BASE surface processing will submit to the Processing 
Branches the following deliverables: 
 

1. CARIS Field Sheet (FS) to include: 



- original source BASE surface 
- finalized BASE surfaces with a naming convention indicative of the 

resolution 
2. Descriptive Report (DR) 

- The DR should explicitly describe the finalized BASE threshold 
resolutions used (i.e. a table of depth ranges vs. BASE resolution) 

- explain variances from the pre-existing threshold guidelines listed in the 
draft FPM 

- describe the number of BASE surfaces used (i.e. the 5M BASE may be 
split into several 5M surfaces), 

3. Data Acquisition and Processing Report (DAPR) 
- the DAPR and DR must reflect and describe the new processing 

procedures, including the source and value of HVF entries, 
4. Full resolution CARIS HDCS files, PYDRO S-57 features and associated 
supporting files are still required. 

 
Additional HSTDs will be issued as the process continues to evolve.  If during the 
processing and verification of data there are immediate concerns that must be addressed, 
please contact HSD as soon as possible.   Jeffrey Ferguson (jeffrey.ferguson@noaa.gov) 
will be the primary point of contact for all comments and questions on this Directive. 
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JAM . 8 ZMK 

Distribution 

W. Michael Gibson 
Chief, HSD, OCS 

SUBJECT: Hydrographic Surveys Technical Directive 2004-3 
(HSTD 2004-3) 

TITLE: CARE HIPS 5.4 BASE Surface Processing 

EFFECTIVE DATE: January 3,2005 

SECTION 1. PURPOSE 

This Hydrographic Surveys Technical Directive (HSTD) grants permission for NOAA 
field units to process hydrographic survey data using CARIS HIPS 5.4 BASE surfaces. 
BASE surface processing may replace the line by line swath editing and shoal bias 
binning process that is currently authorized. Each command may choose the time to 
switch depending on project requirements, capabilities of personnel and familiarization 
with the new techniques, as well as coordination from the appropriate Quality Assurance 
Branch (AHBPHB). All NOAA field units will be formally trained and ready to process 
all data using BASE surfaces beginning in early 2005. 

SECTION 2. POLICY 

Effective immediately, NOAA field units may deviate from current documented 
procedures (project instructions, NOS Hydrographic Surveys Specifications and 
Deliverables, Field Procedures Manual, etc.) in order to process hydrographic survey data 
using BASE surfaces with all additional attributes (shoal, depth, density, standard 
deviation, etc.). Current documented procedures are in the process of being updated to 
reflect the new procedures. In addition, data collected in 2004, prior to the effective date 
of this HSTD, may be processed and delivered using the new BASE surface processing 
techniques. Deliverables to the Quality Assurance Branches will be affected as described 
in Section 5 of this memorandum. Draft versions of Chapter 4 of the "Field Procedures 
Manual", the THOMAS JEFFERSON'S "Base Surface Standard Operating Procedures", 
the FAIRWEATHER'S "Survey Bathyrnetric Processingyy, and the RAINIER'S "BASE 
Surface Creation and Data Processing" documents are available to provide guidance. 

All NOAA field units should continue to work closely with their Quality Assurance 
Branch to ensure that new deliverables meet requirements for charting and that all new 
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processes are properly documented in the Descriptive Report, Data Acquisition and 
Processing Report, and System Certification documentation. 

The new processing techniques do not remove the requirement for hydrographers in the 
field (or personnel at the QA Branch) to review full resolution data. All critical 
soundings and dangers to navigation must be thoroughly reviewed to ensure that the 
appropriate depth will be forwarded for chart compilation. This may require selecting a 
'designated' sounding, essentially overriding the BASE surface, or simply a check by an 
experienced hydrographer to ensure that the BASE surface node accurately reflects the 
desired depth to be charted. The Descriptive Report (DR) shall explain the steps taken to 
ensure that all significant soundings have been properly represented and that the BASE 
surface soundings are accurate. 

SECTION 3. RESPONSIBILITIES 

The approval, promulgation, revision and amendment of this policy shall be the 
responsibility of the Chief, Hydrographic Surveys Division or hislher designee. All 
employees associated with the NOAA hydrographic survey program are encouraged to 
suggest poIicy changes, via their supervisor, that will promote increased efficiency and 
quality of the services provided by the division. 

NOAA field units shall continue to work closely with the Quality Assurance Branches to 
ensure data submitted can be readily verified and efficiently compiled for nautical 
charting. 

The Atlantic Hydrographic Branch (AHB) will continue to develop procedures to verify 
and compile the THOMAS JEFFERSON (TJ) BASE surface surveys already submitted 
and the Pacific Hydrographic Branch (PHB) will work to develop procedures to evaluate 
and compile BASE surfaces to be submitted by RAINIER, FAIRWEATHER and 
NOAA's current time charter vessel RIV DAVIDSON. Special steps will be taken to 
verify and document that proper and accurate depths are being compiled for charting. It 
is essential that AHB and PHB work closely to coordinate the development of new ofice 
procedures to evaluate BASE surfaces. 

All hydrographic vessels and HSD personnel shall work towards ensuring that the Field 
Procedures Manual (FPM) and other supporting documentation are properly updated to 
reflect current and appropriate best practices. Suggested changes to documentation 
related to BASE surface processing should be made to Jeffiey Ferguson 
(i effrev. fer~uson@noaa.~ov) through the appropriate chain of command. Mr. Ferguson 
will, as needed, promulgate the changes as an updated HSTD, or change to the FPM or 
other appropriate documentation. In addition, a copy of any internal Standard Operating 
Procedures (SOPS) related to BASE surface processing should be forwarded to Mr. 
Ferguson. 



SECTION 4. GENERAL 

Suggested background reading includes, "NOAA's Office of Coast Survey Adopts a 
Surface-Based Approach to High Density Hydrographic Data Analysis and Archiving, A 
Brief Overview", by LT Rick Brennan, NOAA, and "Implications of the Navigation 
Surface Approach for Archiving and Charting Shallow Survey Data", by Andrew 
Armstrong, Rick Brennan and Shepard Smith. Copies of the papers can be made 
available upon request. See Attachment One for additional background information. 

SECTION 5. EFFECT ON OTHER ISSUANCES 

This Directive supersedes the processing procedures and deliverables detailed in current 
versions of Project Instructions, Standing Instructions, Field Procedure Manual (FPM) 
and the NOS Hydrographic Surveys Specifications and Deliverables. 

NOAA field units that implement BASE surface processing will submit to the Quality 
Assurance Branches the following deliverables: 

1. CARTS Field Sheet (FS) to include: 
- original source BASE surface 
- finalized BASE surfaces with a naming convention indicative of the 

resolution 
- Critical Soundings layer 
- The HVFs that were used to convert and process the data 

2. Descriptive Report (DR) 
- The DR should explicitly describe the finalized BASE threshold 

resolutions used (i.e. a table of depth ranges vs. BASE resolution) 
- explain variances fiom the pre-existing threshold guidelines listed in the 

draft FPM and SOP 
3. Data Acquisition and Processing Report (DAPR) 

- the DAPR and DR must reflect and describe the new processing 
procedures, including the source and value of HVF entries 

4. Full resolution CARIS HDCS files, PYDRO S-57 features and associated 
supporting files are still required. 

Additional HSTDs will be issued as the process continues to evolve. If during the 
processing and verification of data there are immediate concerns that must be addressed, 
please contact HSD as soon as possible. J e f i y  Ferguson ~effre~.fer~~son@~oaa.aov) 
will be the primary point of contact for all comments and questions on this Directive. 

Distribution: 
(1) All HSD Employees 
(2) NOAA Ship RAINIER 
(3) NOAA Ship THOMAS JEFFERSON 
(4) NOAA Ship RUDE 
( 5 )  NOAA Ship FAIRWEATHER 



Attachment One 

New techniques for handling multibeam data have been developed at the NOAA funded 
Center for Coastal and Ocean Mapping and Joint Hydrographic Center (CCOM/JHC). 
The techniques use the power of the multitude of measurements and advanced error 
modeling obtained from modem multibeam echosounders to compute a statistically valid 
depth for a given spot on the sea floor. 

To do this effectively, an error model is needed for all systems supplying measurements 
to compute a sounding (sound velocity probe, motion sensor, GPS, tide gages, etc.). 
Once this comprehensive error model is assembled, then all the inherent errors in each 
measurement can be propagated to each individual sounding. Once each sounding has an 
associated error, or Total Propagated Error (TPE), we can then compare each sounding in 
an objective manner with its neighbors. 

In the past, when only a couple of soundings were obtained on each spot of the sea floor, 
it made sense to choose the shoalest. However, if we have dozens of soundings, we 
should use our knowledge of the inherent accuracy of each sounding (TPE) to determine 
the highest probability of the depth at a location. To fully benefit from the statistical 
power provided by oversampling, we can form a surface model of the sea floor, in this 
case a regular grid. The node spacing is driven by the highest resolution the data will 
support, primarily the type of sonar and water depth. For example, in depths less than IS 
meters, we should achieve a grid resolution of 0.5 meter. Each node of the grid will have 
a computed depth composed of many soundings, each sounding weighted by its TPE and 
distance from the node. Each node will also include other attributes, such as, an 
associated uncertainty, standard deviation, density (number of soundings used in the 
computation), minimum depth and maximum depth. 

It is important to note that the Hydrographer must always have the capability of over 
riding the depth computed by the algorithm and have tools available to check the 
relevance of depths. For instance, an echosounder return. from the top of a submerged 
piling may be combined with soundings from the surrounding sea floor to compute a 
depth at the grid node that is deeper than the piling top. In this case, the Hydrographer 
will notice a problem due to the high standard deviation of the grid at that point. After 
review of the full resolution data, if appropriate, the sounding at the top of the piling will 
be selected as a special 'designated' sounding. This forces the grid node (and surface) to 
that sounding. 

BASE Surfaces 

The process of using high resolution attributed grids to process multibeam data is part of 
the newest CAlUS HIPS release (version 5.4). CARIS implementation of the attributed 
grid concept is called Bathyrnetry with Associated Statistical Error (BASE) surface. 

The first step in processing with BASE surfaces is to create a HIPS Vessel File (HVF). 
This is an essential component in calculating the Total Propagated Error (TPE) for each 



sounding. This file inchdes emr  estimates for each sensor, as well as offset 
measurements (and the potential error of those offset measurements). Examples of HVF 
files used by the THOMAS JEFFERSON and M I N E R ,  with references are available 
upon request. The examples may be used as a guide, but each vessel's HVF will be 
unique. The entries of the HVF are dependent on specific models of equipment installed 
on the vessel. 

The THOMAS JEFFERSON (TJ) has been processing data using the new CARE tools 
for over a year. They have worked closely with CARIS, troubleshooting the software, 
suggesting improvements and ensuring that the software can function in a 'real world' 
environment. 

Primary Objective 

The primary objective of developing a new pipeline for Hydrographic survey data which 
incorporates CARIS BASE surfaces is to streamline the ping-to-chart process to shorten 
the time required in getting sounding data to the chart. Without a change to the current 
processing paradigm, our ability to get the data to the end user faster, would be more 
difficult, especially with the impact of additional data h m  FAIRWEATHER, the time 
charter, increased contracting and outside source data. 

The new tools when fully implemented should reduce the processing time required by 
fieId units, allowing surveys to get off the ships faster with a higher confidence that an 
area was properly and completely surveyed and that data meet accuracy and quality 
requirements. 

Once in the Quality Assurance Branches, the new products will also allow the 
bathymetric data to be verified quickly and chart compilation from a final surface should 
be faster and more accurate than current methods. 

SecondaryTParallel Objectives 

Secondary objectives include creating a single, multipleuse product to support both 
nautical charting and other applications of the bathymetric data such as geology, essential 
fish habitat and ecosystem mapping, and coastal engineering and management. 
Additionally, the final BASE surface for a swvey can be archived and distributed to 
provide products for uses other than nautical charting without significant reprocessing of 
the data. 

Concurrent efforts underway to redefine the deliverables from a hydrographic survey 
used to update nautical charts will utilize BASE surface products. Currently, the final 
product of a hydrographic survey is a smooth sheet, which is a sounding plot decimated 
so that at the scale of the survey no soundings overlap. A typical 1 : 10,000-scale survey 
will have a single sounding every 50 meters. 



Current products delivered to the Marine Chart Division (MCD) include a smooth sheet 
aad H-drawing (compilation of the survey data at chart scale) as MicroStation drawing 
files. However, PHB has been working on an initiative to update these products in a 
more efficient manner utilizing gridded surfaces and the S-57 exchange format. 

The primary deliverables from HSD to MCD will become a S-57 exchange set (H-cell) 
representing the chart revisions from a new hydrographic survey. An interim deliverable 
will be an S-cell, which is an S-57 version of a smooth sheet created in CARIS. Once 
fully implemented, the H-cell will replace the current production system which requires 
the drafting of a smooth sheet in MicroStation, and subsequent manual chart compilation 
in SCARS. The H-cell deliverable will be generated from BASE surfaces. 

The H-cell initiative will eventually eliminate the MicroStation drafted smooth sheet as 
the deliverable used to revise NOAA charts (and thus reliance on MicroStation). It will 
also reduce the use of in-house customized software for the compilation of smooth sheets 
and chart revisions. 

Official guidance on changing the deliverables to MCD will be provided under separate 
cover when appropriate. HSTD 2004-3 is intended to just change the processing 
procedures and data submission of NOAA hydrographic field units to the Quality 
Assurance Branches. 

Testing of New Technologies 

The Joint Hydrographic Center (JHC) developed the algorithms and ideas behind 
processing hydrographic data via TPE and gridded surfaces. JHC has conducted several 
tests of the concept using actual survey data in Snow Passage, Valdez, Woods Hole and 
Portsmouth. Several academic papers have been written. They have conducted many 
tests showing that the techniques are a valid, efficient and accurate tool for processing 
hydrographic data in support of nautical charting. 

The THOMAS JEFFERSON has spent the last year or more processing data using early 
beta versions of HIPS' BASE surface processing routines and more recently with the 
final version of CARIS HIPS 5.4. They have found no major problems that would 
require them to 'reprocess' the data. In a11 instances, the BASE surface process provided 
meaningful results. 

HSD has reprocessed a WHITING survey using the latest version of HIPS, for 
comparison to traditional processing methods. The final soundings agree very well. No 
major issues were found to discredit the BASE surface process. 

The M I N E R  has started to implement full HIPS 5.4 capabilities by dual processing 
several surveys. The new techniques allowed them to troubleshoot and fix problems in 
the data that were not noticeable with earlier processing procedures. 



As the organization moves forward with the new technology, all hydrographers, 
cartographers and physical scientists both in the field and in the Processing Branches 
must take steps to ensure that accurate depths are compiled for charting. The accurate 
depths will not in all cases be the shoalest sounding available, but must be the most 
accurate depiction of the seafloor. All critical soundings and dangers to navigation must 
be analyzed, comparing the BASE surface nodes to the full resolution data to ensure that 
appropriate least depths are available for chart compilation. 
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Document Scope  
 
This document, in six sections, serves two main purposes: 1) to document the standard 
operating procedures used to generate, process, and review BASE surfaces and 2) to 
provide a fundamental level of understanding about the theories and ideas underlying 
those procedures.  
 

1. HIPS Vessel File (HVF) 
The HVF is a list of sensors with their physical and calibration measured offsets, 
plus associated uncertainty estimates.  The purpose of estimating the extent of the 
uncertainties is to quantify error and when necessary, reduce it.  

 
2. TPE Calculation  

While it is beyond the scope of this document to explore the details of assigning 
an uncertainty to each piece of information that goes into making a sounding 
solution, this section does discuss how to calculate TPE in CARIS HIPS and some 
useful general concepts concerning TPE. 
  

3. BASE Surface Generation  
After introducing the idea of representing bathymetry as a weighted-mean 
gridded model, rather than as a collection of shoal-bias excessed soundings, this 
section examines the uncertainty-weighed gridding method used by CARIS HIPS 
when generating BASE surfaces  
 

4. Data Cleaning  
After contrasting the traditional “line-by-line” approach to data cleaning with 
the newer “surface-centric” approach and exploring the difficulties encountered 
in bridging the two, this section presents a few general ideas to keep in mind 
when cleaning data utilizing the various layers of a CARIS HIPS 5.4 BASE 
surface.  
 

5. Finalize Surfaces  
Before discussing how to finalize BASE surfaces in CARIS HIPS 5.4, this section 
introduces assigning a final uncertainty to grid nodes, flagging “designated” 
soundings, and preserving the optimal resolution of data by “cookie cutting” out 
appropriate depth ranges.  
 

6. Combine Surfaces  
Although generating combined surfaces is currently an official responsibility of 
the processing branch, it is useful for the ship to do so also in order to be able to 
produce sounding plots efficiently. This section discusses how CARIS HIPS 
combines two or more BASE surfaces into a separate BASE surface with a 
resolution no finer than that of the coarsest-resolution contributing surface. 
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1. HIPS Vessel File (HVF)  
Prior to data acquisition the physical and calibrated offsets between the multibeam sonar 
and the inertial motion unit and the a priori uncertainty estimates of the survey equipment 
are entered into HIPS Vessel Files (HVF).  The following section pertains only to the 
uncertainty entries in the HVF.   In general the HVF will be updated, as needed, by either 
the Chief Survey Technician or the Field Operation Officer.  All changes to the HVF 
must be thoroughly documented.  
 

1.1 Total Propagated Error Entries 
 

From CARIS HIPS and SIPS Vessel Editor Window: 
Edit>Active Sensors, select “TPE Values.” 
 
Highlight TPE values from the sensor options listed and enter the following 
information: 

Date, Time and Comments (Initials) 
Enter Offset (physical measurements): 
MRU to transducer 
Navigation to transducer  
Transducer roll. 
Enter the StdDev* (standard deviation): 
Sensor errors, latencies 
Offset measurement errors 
Loading and Draft error  
MRU mis-alignment errors. 

 
Select the sonar Model from the drop down menu for Swath 1 (and Swath 2-if 
dual transducers).  This is a required entry for the BASE surface creation.  If the 
sonar model is not listed in the drop down menu add the required information to 
the DeviceModel.XML, usually located in the C:\CARIS\HIPS\System folder.  

 
Save the HVF, if you have an older version of the HVF (VCF) the new file will 
not overwrite the VCF however, the extension is not apparent later when you 
define vessels for a project.  If you will be using both HVFs and VCF name the 
HVF, [Vessel_Sonar]_HVF. 
 

* While it is beyond the scope of this document to explore the details of assigning an 
uncertainty to each piece of information that goes into making a sounding solution, it is 
useful to mention that the uncertainty values are reported at one sigma (68 % CI).  The 
uncertainty estimates and supporting documentation for the FAIRWEATHER HVFs can 
be found in FA_TPE_Values_2004.xml.  
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2. TPE Calculation  
 

A prerequisite for generating BASE surfaces is that all soundings must have an 
associated total propagated error (TPE). TPE calculation consists of assigning a 
horizontal and vertical error to each sounding based on the uncertainty of each piece 
of information that goes into making that sounding solution. Examples of 
uncertainties include the following:  

- roll from the motion sensor  
- positioning from the navigation system  
- sound velocity information from a CTD (conductivity, temperature, and density) 

cast  
- the sonar’s bottom detection method  

 
The sources of the uncertainty values vary from manufacturers’ specifications, to 
theoretical values, to field tested empirical observations.  It is beyond the scope of this 
document to explore the details of assigning an uncertainty to each piece of information 
that goes into making a sounding solution.  
 

2.1. Compute Total Propagate Error (TPE)  
There are two ways to initiate the “Compute TPE” function:  

i) via the Process menu option  
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ii) via the “Compute TPE” button on the “Process” toolbar  
 

 
 
Although there is no interactive dialogue box during the Compute TPE process, 
there is a window allowing a user to cancel the operation and a status bar window 
in the lower left. 
 

3. BASE Surface Generation  
 

A BASE surface is a representation of bathymetry with additional attributes, 
important among which is uncertainty. The notion of a BASE surface is a significant 
change in the way bathymetry is represented. Whereas bathymetry traditionally has 
been reported as a collection of shoal-biased excessed soundings (tailored for 
nautical chart production), a BASE surface represents bathymetry as a weighted-
mean gridded model. Representing bathymetry as a model, versus a collection of 
down-sampled soundings, allows the full resolution of the source data to be 
preserved, i.e. data is not lost, and, in turn, allows the ship’s product to be more 
valuable for a wider range of uses.  
 

3.1. Create a Field Sheet        
The Field Sheet defines the geographical extents for the BASE surface, tiling, 
contours, etc.  A field sheet must be created before a BASE can be made. 

Create a Field Sheet 
Process>New Fieldsheet 
Name the Field Sheet; H###### 
Leave the default horizontal and depth resolution. 
Define the datum and zone 
Define the extent: 

 
 



 
 

Process Owner: Lynn Morgan 
Date: Sept 16, 2004 
R:\Utilities\FA_SOP\ 3_Processing\CARIS HIPS 

Approval: CST FAIRWEATHER 
Approval Date: 12/23/04 Page 6 of 38 

 

FAIRWEATHER SURVEY 
 

Doc No. 
SOP-6XX PROCEDURE 

 

Document Title 
Bathymetric Processing
  

Version 
2 

Effect Date: 
Dec 23, 2004 

 

 
 
Type in the extents or Use the extents of the data on the screen or Click and drag extents 
 

3.2. Start the BASE Surface Wizard  
 

There are three ways to initiate the BASE Surface Wizard:  

i) via the “Process” menu option  
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ii) via the “New BASE Surface” button on the “Process” toolbar  

 
 

iii) via right-clicking on an existing fieldsheet in the session tab of the 
control window and selecting “New BASE Surface…”.  

 

 
 

 
3.3. Specify BASE Surface Name and Color Map  
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Although the resolution of a BASE surface is recorded in the xml metadata file generated 
with every BASE surface, it’s helpful to include the resolution in the name of a BASE 
Surface for easy reference. 

 
Typical boat day BASE surface nomenclature:  
Vessel_DayNumber_Resolution→ Example 1010_253_2m 
  
3.4. Specify Resolution, Weighting Method, and Additional Attributes  

 

 
 

 
3.4.1. Resolution  
To preserve optimal data resolution, different depth ranges are gridded using 
different resolutions. Typically, deeper areas are gridded at a courser resolution 
than shoaler areas, where data density is typically greater. In practice, a BASE 
surface for each desired resolution is created for the entire survey area, and then 
during the finalize step, the appropriate depth range is “cookie cut” out (see 
Section 6).  

 
Although the resolutions and depth ranges will vary from survey to survey, based 
on, among other factors, the sonars used and survey speed, a 2 meter resolution 
grid created during the batch process (See Appendix I) has been found to be a 
good starting point for determining what the cleaning resolution for the boat day 
should be set at.    
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3.4.2. Weighting Method  
CARIS HIPS allows BASE surfaces to be generated using one of two weighting 
methods: swath angle weighting and uncertainty weighting.  
 
NOTE: Although CARIS calls a swath angle-weighted grid a BASE surface, it 
does not contain an estimate of statistical error, as does an uncertainty-weighted 
BASE surface. In the rest of this document, “BASE surfaces” will refer to BASE 
surfaces generated using the uncertainty weighting method.  
 
Swath Angle Weighting  

Swath angle weighting is the weighting scheme used in CARIS HIPS 5.3 
and earlier releases. Swath angle weighting involves 1) modeling each 
beam’s footprint to determine its radius of influence and 2) weighting each 
footprint by 2 factors:  

i- Range → The weight of a footprint is inversely proportional to its 
distance from a node.  

ii- Swath Angle → A footprint is weighted by its grazing angle as 
defined in the file HIPS\System\GrazingAngleWeights.txt.  

 
Uncertainty Weighting  

Unlike swath angle weighting, uncertainty weighting does not model a 
beam’s footprint. Rather, the weight and radius of influence for each 
sounding is based on that sounding’s uncertainty (TPE).  
 
Determining the grid nodes to which a particular sounding will contribute 
weight (a sounding’s radius of influence) is based on the idea of 
propagated depth-uncertainty (the vertical component of TPE). In general, 
soundings (observation points) do not coincide with grid nodes (estimation 
points). Soundings are propagated to grid nodes according to a power law 
that increases the vertical component of the sounding’s TPE to account for 
this difference. The propagated uncertainty is a strong function of distance 
between observation and estimation points, d, but it also depends on the 
horizontal component of TPE and grid node spacing. A threshold of 
acceptable uncertainty is based on a user specified IHO order (see figure 
on top of next page). 
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Generalized Uncertainty Growth 
Curve  

A sounding, i, will contribute 
weight to all of the grid nodes 
falling within domain Di, which is 
determined by the propagated 
uncertainty mapping of 
observation point to estimation 
points, as described above (see 
figure to right).  
 
The weight a sounding will 
contribute to a node is the inverse 
of the propagated uncertainty of 
that sounding, i.e. the lesser the 
uncertainty, the greater the weight.  
 

          A sounding's radius of influence 
 
The depth at a given grid node, n, is the mean depth (weighted by 
propagated depth uncertainty) of the set N of soundings whose domain, Di, 
contains n (see figure below). Likewise, the uncertainty at a given node is 
the mean uncertainty (weighted by propagated depth uncertainty) of all the 
soundings contained in set N. 
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3.4.3. Layer Selection  
CARIS HIPS, by default, generates two layers, depth and uncertainty. The depth 
and uncertainty layers are weighted means, weighted by uncertainty. A user can 
also choose to generate five other layers, which report various statistics of the 
sample of soundings that contributed to a node: density, mean, standard deviation, 
shoal, and deep.  See graphic next page. 
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The depth layer is the uncertainty-

weighted bathymetry model.  
 
 
The uncertainty layer is the uncertainty-
weighted uncertainty model.  
 
 
 
The density layer reports the 
number of soundings that 
contributed to each node.  
 
 
The standard deviation layer 
reports the standard deviation of all 
the soundings that contributed to 
each node.  
 
The mean layer reports the average 
of all the soundings that contributed 
to each node.  
 
 
 
The shoal layer reports the shoalest 
of the soundings that contributed to 
each node.  
 
 
 
The deep layer reports the deepest 
of the soundings that contributed to 
each node.  
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3.5. Specify an Acceptable Uncertainty Threshold (Select IHO Order)  

 

 
IHO Order  
As was mentioned in the previous section, the specified International Hydrographic 
Organization (IHO) S-44 order serves as a maximum level of allowable uncertainty. 
Any sounding whose propagated uncertainty is greater than the allowable uncertainty 
will not be used in generating the grid.  
 
The IHO Order that is selected here is dependant on water depth and survey purpose; 
generally NOS surveys are required to met IHO Order 1 accuracy tolerances.  See 
Appendix II of this document for additional information IHO accuracy tolerances.  
 
Along with every BASE surface, CARIS HIPS generates, in the same folder as the 
BASE surface, a corresponding xml-formatted metadata file that contains four 
sections:  
 
SourceData →  This section lists all the source HDCS line data.  
 
DisplayParameters →  This section lists the display parameters, such as the selected 

color map and shading parameters, of each of the layers in the 
BASE surface.  

 
Information →  This section records what computer user created the BASE surface, 

the date and time he/she created it, and what version of software was 
used.  
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SurfaceInformation → This section records information about the BASE surface as a 

whole, such as its coordinate system, resolution, dimensions, 
and the minimum and maximum of each of its layers. 

4. Bathymetric Processing  
 

Instead of the very time intensive, traditional method of cleaning data line by line, 
BASE surfaces, which incorporate soundings’ TPE (total propagated error), allow 
processors to take a more efficient “surface-centric” approach to data cleaning. By 
viewing the depth layer in conjunction with other layers, particularly the uncertainty 
and standard deviation layers, processors can save time by targeting only the areas 
that need cleaning. After the appropriate edits have been made to the data and the 
BASE surface is regenerated, the BASE surface is then ready for the finalization 
process, which is discussed in the next section.  
 
However, the transition from the traditional way of cleaning data to the more recent 
way has not been a single large leap. Although the foundation has been laid for a 
surface-orientated multibeam data processing pipeline, which gets away from looking 
at multibeam depth, attitude, and navigation data line by line as a matter of course, 
sheet managers are still “sub-setting” all the data as one would have traditionally 
done (albeit with perhaps a less stringent eye), because although the BASE surface 
implementation in CARIS HIPS 5.4 does minimize the influence of small, isolated 
bursts of noise, it does not have implemented CUBE “proper.” Whereas CUBE 
“proper” formulates multiple hypotheses and then calculates a best guess of which 
hypothesis is the true bottom, the CARIS HIPS 5.4 implementation of TPE/BASE 
surface concepts will incorporate in its gridded bathymetry model all soundings that 
have an associated TPE within the acceptable limits of uncertainty. For example, 
whereas CUBE “proper” functionality might recognize a burst of noise from a school 
of fish near the surface as a separate bottom track, or hypothesis, and not incorporate 
those soundings into its final depth model, CARIS HIPS 5.4 would incorporate the 
noise into its final depth model (given that those soundings have not been rejected 
and have an associated TPE within the acceptable limits of uncertainty). The current 
processing procedures are a blend between new and old rather than a complete shift 
to the new.  
 
The basic idea behind a surface-centric approach to data cleaning is to 
systematically view the various BASE layers and investigate any anomalous features. 
Following are examples illustrating how a surface-centric approach to data cleaning 
can help target systematic and non-systematic errors that need to be cleaned or 
further examined. 
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4.1. BASE Surface Evaluation: Non-Systematic Errors  
  

 4.1.1. Attitude Data Gap  
Rather than view attitude data line by line as a matter of course, BASE surfaces allow a 
processor to target only the areas that need cleaning or examination, which is illustrated 
in Figure 3. Further investigation of the along-track anomaly in the standard deviation 
layer of a BASE surface revealed a 42-second gap in the attitude data.  

 
      Standard Deviation Anomaly        Attitude Time Series Data   

4.1.2. Depth Data “Blow Out”  
Although sheet managers, in reality, are still systematically reviewing entire surveys in 
subset mode (albeit with a less stringent eye), edits can be targeted by searching for 
anomalies in any of a BASE surface’s layers. The following screen grabs illustrates how 
the shoal layer and an appropriately colored standard deviation layer can rather 
conspicuously reveal a blowout.  

 

 
Depth data "blow out" 
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"Blow out” revealed in shoal layer      
 

  
"Blow out”revealed in standard deviation layer 
 

4.2. BASE Surface Evaluation: Systematic Errors  
In addition to revealing isolated blunders, such as attitude data gaps and depth 
“blow outs”, BASE surfaces are essential to identifying, visualizing, and 
quantifying systematic errors in data, such as svp-induced “smiles”, tide busts, 
and inaccurate vessel configuration offsets, as illustrated below. 
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4.2.2. Inaccurate Lever Arm 

 
 
4.2.1. SVP-Induced “Smiles”  

 
     

 

 

The outer beams of svp-induced   “smiles” show 
up as along-track areas of relatively high standard 
deviation (the brighter red areas).  
 

A possible inaccurate heave leaver arm 
manifests itself as a series of 
alternating across-track highs and lows 
in a depth layer 
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4.2.3. Tide Error 

 
A tide error appears as two distinct stripes of relatively high standard 
deviation in the area of overlap.  
 

4.3 Filters   
Processing of the bathymetric data will be dependant of the results of the grid.  There 
are several filtering options, discussed below.  By filtering after conversion the 
rejected data points can be viewed and reaccepted if deemed necessary.   
 

4.3.1. TPE  
The TPE filtering option rejects (or accepts) soundings with uncertainty values that fall 
outside limits set by International  Hydrographic Organization (IHO) standards.  See 
Specification and Deliverables (page 62) for more detail on NOS accuracy tolerances. 
Filter lines after computing TPE. 
 

Tools>Set Filters   
Use Order 1 in 100m of water or less. Set the Depth Limit Minimum to 0 and 

Maximum to 100.  
In depths greater than 100 m use "User defined" with the 'a' and 'b' error 

tolerance from Order 2 (1.00 and 0.023) and horizontal uncertainty of 5 
meter + 5% of the water depth.  Set the Depth Limit Minimum to 101 and 
Maximum to a value greater than expected maximum depth. 
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To calculate the error limits for depth accuracy, the constant depth error (a) and the factor 
of the depth dependent error (b) are combined with depth (d) and the depth dependent 
error (b * d) in the following formula: 
 

Error limit for depth accuracy =  
  
4.3.2. Swath (Multibeam) and Single Beam Filtering 
It may to be advantageous to filter based on sonar Quality Flags, Angle from nadir or, for 
both multibeam and single, a Depth threshold.  

 
 
4.4 Object detection aided with side scan mosaic 
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In navigationally significant areas collected without acoustic backscatter, a review of 
the data must be done in line mode in addition to subset mode to aid in object 
detection.     
 

If the multibeam data is collected with acoustic backscatter a mosaic should be reviewed 
in conjunction with the BASE surface to aid in object detection.      
 
a) Slant range correct the data 

• Create a Field Sheet 
• Process>Slant Range Correction 

 

 
Create a mosaic  

• Process> New Mosaic 
• Select the following options: 
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4.5 Subset Mode  
   Data quality, based on the evaluation of the BASE surface, will greatly influence 
how the data will be processed.  Currently, all data will be reviewed in subset mode.  
Noisy data will require further hydrographer evaluation and may necessitate line 
cleaning. 

 

4.5.1 Designated Soundings            
It may be necessary to flag a shoal sounding as “Designated” to ensure that it is 
preserved in the final combined BASE surface.  The Designated Sounding depth 
value will be applied to the nearest node.  To find the least depth highlight a cluster of 
soundings and use the Find Designated Sounding icon.  

 
 
Determining whether a sounding should be flagged as “Designated” it is helpful to 
view the BASE surface with the HDCS data.  The can be done by checking on 
Reference Surface on the Surface tab while in subset mode.   
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HDCS Data                   BASE Surface 
 
5. Quality Control 
The processes described below are reiterative by nature and it is not intended to be an 
exhaustive description of quality control procedures for bathymetric surveys but, it is 
limited in scope to reviewing the multibeam data in CARIS.    
 
5.1 Display Critical Soundings 
Depths that are flagged with Designated, Examined and Outstanding status flags can be 
displayed as a sounding layer in HIPS.   

• View>Display Critical Sounding 
 
Since depths that are flagged as Designated generally represent least depths in 
navigationally significant areas, these soundings will be reviewed by the survey manager, 
assistant and Field Operation Officer as possible Dangers to Navigation (DtoN) 
submittals.  
 

5.2 Field Sheet Editor  
Contours and depths can be displayed in the HIPS session to aid in cleaning and 
evaluation.  Contours and depths are reviewed on daily basis for anomalous depths.  
Please note that depths flagged as Designated will not be reflected in the depths and 
contours unless the BASE surface has been finalized (See Section 6).     

 
In HIPS: File>Save Session 
Name the session  
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Tools>Field Sheet Editor 
In FSE if the Contour and Sounding function is not available, re-open the Field Sheet 
 
 

5.2.1. Contours  
• Tools>Contours>New Contour Layer 
• Set the contour interval (see Appendix 8 of NOS Specifications and 

Deliverables) 
 

5.2.2. Depths  
• Tools>Soundings>New Soundings Layer 
• Selected the Depth Base layer 

Select the following options: 
  
 

5.2.3. Selection Criteria 
Selects the depth from a designated area.  Select Radius Value and mm at map scale, 

enter the survey scale. 
 

5.2.4. Use Single Defined Radius 
Sets a standard minimum distance between soundings 
 

5.2.5. Selection Type 
Select the Shoal bias depth option 
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 5.3 Tiles 

• Tools>Tiles>Tiling 
• Selected the Tiling method 
• Tile by Depth Tolerance of 5 meters (variable-dependant of depth range 

and density) 
• Options: additional attribute StandardDeviation 

User defined attribute (e.g. display all sounding that are less than 
11 fathoms).  

• The surface can be queried for information that will aid in cleaning and in 
QC/ QA such as querying for high standard deviations which may be 
associated with noise in the dataset.  Query results can be reviewed in HIPS 

subset mode from Field Sheet Editor using the  icon. 
 

o Tools>Tiles>Display Query 
or 

Right click on the Tile layer in the information window 
 

5.5 Danger to Navigation (DtoNs)  
It is useful when examining the survey for significant least depths to generate a finalized 
BASE Surface that can be used to create contours and depths of a specific depth range.  
For example a depth threshold of zero to twelve fathoms can be used to aid in 
determining DtoNs.  See Section 6.5 for defining depth thresholds.     

 
6. Finalize BASE Surface  
 

Finalizing BASE Surfaces serves three purposes:  
 

1) To assign grid nodes a final uncertainty  
A grid node’s final uncertainty can be one of three options: 1) that node’s 
a priori uncertainty-weighted uncertainty, i.e. predicted error, 2) the grid 
node’s standard deviation, i.e. observed error, or 3) the greater of the two. 
Which option is selected will depend on what the user intends to report. 
NOAA Ship THOMAS JEFFERSON uses the “Greater of the two” option 
to maintain a conservative uncertainty estimate.  
 

2) To apply designated soundings  
In instances when a BASE surface does not accurately represent, due to 
the nature of the weighting algorithm, the least depth of a fine 
navigationally significant feature (such as a tall, narrow coral head or a 
shipwreck’s mast), a sounding can be flagged as “designated” to force the 
nearest BASE surface grid node to honor the depth of that sounding.  
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3) Define depth thresholds  

A single-resolution grid covering an area may not necessarily be the 
optimal resolution for the entire area. To maintain the optimal resolution 
for a given depth range, the finalize process, in effect, “cookie cuts” out 
the desired depth range.  
 
 

6.1. Open Finalize BASE Surface Dialogue  
There are two ways to initiate the Finalize BASE Surface dialogue:  

i) via right-clicking on an existing BASE surface  
 
 

 
 
  ii) via the “Process” menu option 
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6.2. Select Final Uncertainty Source  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the Greater of the two values option 1) to maintain a conservative 
uncertainty estimate (in cases when the observed standard deviation is less than 
the a priori uncertainty-weighted uncertainty) and 2) to ensure that the observed 
error is used when it is greater than the predicted error (when the standard 
deviation is greater than the a priori uncertainty-weighted uncertainty).  
 

 
6.3. Specify “Minimum uncertainty” (if applicable)  

The option to specify a “minimum uncertainty” is, for all intents and purposes, an 
obsolete concept, originally meant to provide a user a way to avoid 
uncharacteristically small uncertainty values in areas of very high data density; 
however, the uncertainty algorithm for which the minimum uncertainty option 
was intended is not the uncertainty algorithm currently implemented in CARIS 
HIPS and is no longer relevant to all but the most unusual and unlikely cases in 
which a user has reason to believe that the calculated TPE is inadequately low.  
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6.4. Apply Designated Soundings  

 
 
Check the Apply designated soundings option to force the BASE surface to incorporate 
any soundings flagged as designated. During the finalize process, the nearest grid node to 
any “designated” sounding will be forced to have a depth of the “designated” sounding.  
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During the ongoing development of BASE surfaces and a BASE surface-
orientated processing pipeline, there have been various schools of thought and 
questions concerning what soundings should be flagged “designated”. 
Implemented procedures have included 1) flagging, as a matter of course, all 
items’ least depths addressed in a descriptive report, 2) flagging only those 
“report” items’ least depths whose model depth differs from their P/V/D/L/P/B, or 
HDCS, depth by more than a foot, and 3) flagging both chart and non-chart 
features’ least depths whose model depth differs from their HDCS depth. Another 
idea that has arisen is to designate those features’ soundings whose depths differ 
from the model by more than the acceptable IHO accuracy for  soundings’ depths; 
however, how such a comparison could be easily performed would also be open 
for discussion. Whatever specific guidelines are developed, comparing the model 
with the source soundings will now be significantly less thorny with the ability to 
view HDCS data and BASE surfaces together in a 2-d and 3-d environment with 
CARIS HIPS 5.4, Service Pack 1.  
 
There has also arisen the question of which stage in processing should soundings 
be “designated” – for example, 1) in CARIS HIPS by the day/night processors or 
2) in PYDRO by the sheet manager. Although the ability to flag soundings 
“designated” in both programs is beneficial, it’s been suggested that the ideal 
stage at which to flag soundings “designated” is in CARIS HIPS, where a user is 
able to view all the source HDCS data and BASE surface in the same 
environment.  
 
Another point that has arisen is that of having too many “designated” soundings. 
Although no model will always represent accurately the least depth of every fine 
navigationally significant feature, it should be representative a good portion of the 
time (or else one might question its usefulness). Having “too many” (admittedly a 
relative and ambiguous notion) designated soundings, i.e. too many cases where a 
model does not accurately represent what the hydrographer believes to be a least 
depth, is an indication that the resolution of the model is too course. By 
generating a new BASE surface with a finer resolution, the user is not 
“smoothing” the bottom as much and, in turn, is representing more accurately the 
least depth of features; however, the goal is to find a balance between resolution 
and data density.  
 

 
 
 
 
 
 
 



 

Process Owner: Lynn Morgan 
Date: Sept 16, 2004 
R:\Utilities\FA_SOP\ 3_Processing\CARIS HIPS 

Approval: CST FAIRWEATHER 
Approval Date: 12/23/04 Page 29 of 38 

 

FAIRWEATHER SURVEY 
 

Doc No. 
SOP-6XX PROCEDURE 

 

Document Title 
Bathymetric Processing   

Version 
2 

Effect Date: 
Dec 23, 2004 

 
6.5. Defining the Depth Threshold 

 

  
 

 
If the survey area covers more than one desired depth range, specify the depth range 
to be “cookie cut” out. As is shown in the 2-meter resolution BASE surface below, 
relatively deep areas may not support a grid’s resolution, whereas relatively shoal 
areas could be gridded with a finer resolution. To maintain the optimal resolution for 
a given depth range, the finalize process, in effect, “cookie cuts” out the desired depth 
range.  
 

 

 
 
 



 

Process Owner: Lynn Morgan 
Date: Sept 16, 2004 
R:\Utilities\FA_SOP\ 3_Processing\CARIS HIPS 

Approval: CST FAIRWEATHER 
Approval Date: 12/23/04 Page 30 of 38 

 

FAIRWEATHER SURVEY 
 

Doc No. 
SOP-6XX PROCEDURE 

 

Document Title 
Bathymetric Processing   

Version 
2 

Effect Date: 
Dec 23, 2004 

 
 

The following resolutions and depth ranges have shown to be a good starting 
point when using a SIMRAD EM1002 in about 40-120 meters, a RESON 8101 in 
about 4-80 meters, and a RESON 8125 in about 4-50 meters:   
Depth Threshold for Finalization of the BASE Surface 
0.5-meter resolution → 0-15 meters depth  
1.0-meter resolution → 14-30 meters depth  
2.0-meter resolution → 29-60 meters depth  
5.0-meter resolution → 59-150 meters depth 
10.0-meters resolution → 149 & deeper 
 
The depth ranges overlap by a meter to ensure that there are no gaps between 
adjacent BASE surfaces. 
 
The BASE Surface deliverable will be five (as applicable) non-finalized BASE 
Surfaces.  The Processing Branch will finalize the BASE Surface upon the 
application of smooth tides.  To aid in processing at the Branch the nomenclature 
should include the depth range that the surface is able to support. 
 
Example: 
HXXXXX_DepthRange_Resolution    →H12345_0-15_0p5m     

 
7. Combine BASE Surfaces  
 

Generating combined surfaces, from which selected sounding layers can be 
generated, is currently an official responsibility of the processing branch; however, it 
is useful for the ship to do so also in order 1) to be able to produce sounding plots in 
CARIS without the problems associated with deconflicting soundings in areas of 
overlapping fieldsheets and 2) to be able to insert a survey’s bathymetry model into 
PYDRO more efficiently than if multiple finalized surfaces were used.  The usefulness 
of the combined surfaces functionality is of question since creating one surface at a 
particular resolution will generate the same results.   
 
As illustrated on the next page, the combine function combines more than one BASE 
surface, with same or differing resolutions, into a new BASE surface that has a user 
specified resolution and maintains shoal depths.  
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7.1. Initiate the Combine BASE Surface function  
There are two ways to initiate the Combine Surfaces dialogue:  

i) via right-clicking on a “target” fieldsheet  

 
As the “target” fieldsheet is the geographical limits of the combined BASE surface, the 
fieldsheet should encompass all of the BASE surfaces intended to be combined. The 
BASE surfaces intended to be combined can be in the “target” fieldsheet, another 
fieldsheet, or various fieldsheets.  

 
ii) via the Process menu option  
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7.2. Select the surfaces to be combined  

 
 
Select the desired BASE surfaces by expanding the Fieldsheet listing(s) and then 
highlighting the desired surfaces. The new combined surface will be output to the 
active Fieldsheet if the user initiated the Combine Surface dialogue via the 
“Process” menu option or to the clicked-on Fieldsheet if the user initiated the 
Combine Surface dialogue via right clicking on a Fieldsheet.  
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7.3. Specify a surface name and resolution  

  
The resolution specified should be no finer than that of the coarsest-resolution 
contributing surface. CARIS HIPS deconflicts nodes using a simple shoal-biased 
algorithm in which each input node is snapped to the nearest output node, keeping 
the shoalest node.  
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8.0  Exporting BASE Surface(s) 
The following processing procedures may vary from platform to platforms based on the 
software tools available.  
 
8.1 Pydro  

 
Inserting bathymetry 
Pydro cannot directly access a BASE surface.  CARIS intends to release an 
Application Programming Interface (API) that will allow direct access BASE data.  
The work around is to create a weighted grid in Pydro from the BASE surface. 

Open Pydro 
• Data>Inset>HIPS Weighted Grid 
 

Define the file path to the HDCS data 
 
Define the “Selection criteria for drawing on the chart”   

• BUG v4.5.1-Double click on the CARIS Weighted Grid Data from the list 
• Under the Selection window-File>Close 

 
Pydro adds a ‘_HNS’ to the file name of the imported BASE surface 

 
Inserting Designated Soundings 

Define the file path to the designated soundings 
• Data>Insert>CARIS Line Features 
• Select the folder that contains the survey HDCS data  

 
 

8.2 MapInfo 
Run HydroMi 

Define the path to HydroMi 
• Tools>Tool Manager 
• Add Tool 
• Add title: Hydro Mi 
• Location (normally): C:\Program 

Files\Python23\Pydro\Hydro_MI.MBX 
• Check Loaded and Autoload from the main Tool Manager window 

 
Insert the Pydro PSS  

•  Post-Survey>Draw Preliminary Smooth Sheet 
Select the PSS with the '.wgfsl' extension 
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Appendix I 

Batch Processing  

Batch Processing combines and automates numerous processing steps.  The order in 
which the tasks are completed is important since the results of one step may be required 
for further processing to be accomplished.  The following are the processing steps, in the 
order that they are performed, used to convert and apply correctors to the bathymetric 
data:    

 

(01) Convert RAW 

(02) SVP Correct 

(03) Apply Predicted, Zoned Tides 

(04) Load True Heave 

(05) Merge 

(06) Compute TPE 

(07) Filter IHO 1 for <100m water depth 

(08) Filter "User defined" (a=1.0, b=0.023, Hort. 10m+5%) for >100m water depth 

(09) Add to BASE-(Generally at 2m resolution for coverage) 

(11) Slant range correct (if sonar has backscatter) 

(12) Mosaic side scan 
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IHO Orders 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Acronyms used in this guide 
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BASE     The Bathymetry Associated with Statistical Error (BASE)  

Surface. A georeferenced representation of the seabed  
derived from processed bathymetry and computed 
uncertainty (error) values. The algorithm applies soundings 
to the grid based on beam footprint size. A customizable 
weighting system allows more emphasis in the mean 
calculation to be placed on the inner nadir beams or on 
soundings with lower uncertainty values.  

 
HVF HIPS Vessel File. A vessel configuration file in XML 

format that consists of a list of sensors with their physical 
and calibration measured offsets, plus any error values. 
These are applied to the observed data during processing. 
The HVF supersedes the Vessel Configuration File (VCF). 

 
TPE  Total Propagated Error. TPE is derived from a combination                

of  all individual error sources and is used to calculate 
horizontal and vertical uncertainties for soundings. 

 
 
 
 
 
 
 
 
 
 

The following people were instrumental in providing the information necessary to 
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0. Document Scope 
 
This document outlines the new standard operating procedures for processing of 
shoreline data to S57 standards, from data transfer to export of S57 feature objects into 
Pydro and SVP and tide corrections in CARIS.  For background information, see Suitcase 
Shoreline Presurvey SOP and Suitcase Shoreline Acquisition SOP. 
 
1. Transfer data from field datalogger back to ship 

 
1.1. Boat sheets and DP forms 
Boat sheets and DP forms are valuable pieces of data and must be kept track of and 
submitted as part of the DR.  Completed DP forms should be filed in the appropriate 
sheet binder, and boat sheets should be stowed in a plastic sleeve in the back of the 
binder. 
 
1.2. Data transfer 
In Pathfinder Office, select Data Transfer from the Utilities menu.  Then select a 
device from the pull-down menu.  The icon in the upper right corner of the window 
indicates the status of Pathfinder’s connection with TerraSync.  If “Not connected” is 
displayed, click the button with the green checkmark to connect to TerraSync; the 
button with the red arrow disconnects. 
 
Click the Receive tab and then press Add and select Data File from the pull-down 
menu.  Navigate to your data file.  Click Browse in order to find your project folder; 
set this as your destination location.  Click Open. 
 

 
 
In the Data transfer window select Transfer All.  Once the transfer is complete, press 
Close. 
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1.3. Open Data 
Go to File→ Open.  Navigate to your project folder, find your file, and click Open.  
You can now view and manipulate your data in three different windows: Map, 
Feature Properties, and Position Properties. 
 

 
 

 
2. Edit attribution information in Pathfinder 
 
Before exporting the shapefiles for use in Pydro, check to make sure that all information 
is correct, and that it matches any notes on the DP form.  Scroll through all attribute 
fields for each point and make sure all information is correct. 
 
Clicking on a point in the Map window will automatically select it and bring up its 
attribution information in the Feature Properties and Position Properties windows.  In 
NOAA Ship FAIRWEATHER  TMP-600  
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each of these windows, the forward and back arrows can also be used to scroll between 
points.  Double-clicking on a point in the Feature Properties window will automatically 
bring up its Attributes tab and allow you to edit the field.  Make sure to save any changes 
you make. 
 
NOTE: Currently, if converting the data into shapefiles, Pathfinder is unable to correctly 
export any DP’s with a VALSOU or HEIGHT of a zero value; exporting points with 
VALSOU or HEIGHT = 0 will result in a null value and will import incorrectly in Pydro.  
Before exporting, any zero values should be changed to a slightly more conservative 
value, like observed depth = -0.01 m. 

 
3. Process in Pydro 

 
3.1. Export shapefiles to Pydro 
When you’re ready to export shapefiles to Pydro, choose Export from the Utilities 
menu.  Select the Sample ESRI Shapefile Setup option under the pull-down menu 
called Choose an Export Setup, and click Browse in order to select your Output folder 
(the Export subfolder of your Pathfinder Office project folder).  Press Browse in order 
to find the raw SSF Trimble data files you wish to export from the Pathfinder project 
Backup folder. 
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Click Properties and make sure all tabs are set according to the following examples: 
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In the Attributes tab, Code Value 1 must be checked in the “Export Menu Attributes 
as” field so that Pydro can correctly interpret their S57 attribution. 
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NOTE: One set of files (DBF, SHP, SHX) will be created per feature type ($CSYMB, 
UWTROC, WRECKS, etc.) so each file may contain one or many points, depending 
on how many DP’s were given this feature name in the field. 
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After exporting points, open an explorer window of the Pathfinder Export folder, and 
find the files you just created.  Rename each file, giving it the Trimble GPS unit and 
Julian Day Number (TR1XXX_ or TR2XXX_) as a prefix.  Files must be uniquely 
identified in this manner before transfer into Pydro, otherwise the next DP of the 
same feature type will repeat the file name. 
  
3.2. Prepare photos for DP’s 
Upload or scan any photos from the field and then erase them from the camera to 
avoid any future confusion.  Name photos by their DP numbers and any other notes 
that will help the sheet manager and cartographers understand what the picture 
represents (i.e. the cartographer could interpret “12583_hp_toE” to mean that the 
photo is of the high point of DP 12583, and was taken towards the East). 
 
If the subject of a photo is unclear or if multiple features are represented in the same 
picture, it may be useful to crop or label the picture with text and arrows in a photo 
editor.  Save final copies of DP photos in a subfolder of the survey’s PSS folder.  It is 
fine to have multiple pictures for one feature, but any “fun” pictures from the day 
should be saved elsewhere. 
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3.3. Open or create a PSS 
Open Pydro.  If you are updating an existing PSS, open it through File→ Open→ 
Open PSS; if no PSS has yet been created, open the background chart you wish to use 
by choosing File→ Open→ Open BSB chart.  Save the PSS with the survey name 
(i.e. H11362) to the project’s PSS folder. 
 
NOTE: Saving the PSS performs two processes; it writes a new line in the HDCS 
data and it creates a new PSS or overwrites an existing one.  For this reason, be 
especially careful to use the existing PSS if there is one so you don’t end up 
overwriting a session that already has DP’s in it.  Also, make sure that only one 
person at a time is updating a PSS so that the other’s changes aren’t lost. 
  
3.4. Bring in DP’s and GP’s 
Also refer to the Survey_PIC_Shoreline_SOP.doc for a step by step guide. 
 
This process will change with pending Pydro updates (current version 4.9.3).  
Currently, to bring in your GPS positions, select Insert Generic GPs/DPs from the 
Data menu.   
 
Templates have been created for UWTROC, $CSYMB, BCNSPP, SBDARE and 
MORFAC.  To use these templates, select Open Template from the File menu and 
navigate to R:\Utilities\III_Pydro\Parser Templates and open the appropriate file.  
Data is then inserted into the smooth sheet by selecting Process File(s) from the File 
menu.  Navigate to the Export subfolder of your project, and select the shapefile 
(.shp) of the feature that you exported from Pathfinder, then click Open.  Repeat this 
process for each type of feature to be inserted. 
 
If there are feature types to be inserted which do not have templates created, it is 
possible to create one.  For each separate feature type: choose File→ Open data file, 
navigate to the Export subfolder of your project, and select the shapefile (.shp) of the 
feature that you exported from Pathfinder. 
 
On the left-hand side of the screen, check the boxes of all rows you wish to populate 
with field data.  In the pull-down menus on the right-hand side of the screen, find the 
attribute to be associated with each Data Type.  After the attribute is set, the Field 
Delimiter and Field Num columns will automatically fill in with the appropriate 
values. 
 
The Field Num column can also be filled in manually, which is desirable when two 
separate data dictionary attributes (i.e. RECDAT and Time) must be used in order to 
fill one of Pydro’s Data Types (i.e. Time).  Refer to the window at the very bottom of 
the screen that lists all attributes.  Find the desired (i.e. time and date) entries and, 

NOAA Ship FAIRWEATHER  TMP-600  
Document Location & Name:    Page 0 of 15 
 R:\Utilities\FA_SOP/0_FA_New\Shoreline_Processing.doc   



 FAIRWEATHER SURVEY 
 

Doc 
No. SOP  

TMP-
600 

 

Document Title 
S57 SHORELINE PROCESSING 

Version
1 

Effect Date: 
Oct 15, 
2004 

counting the blank before the first semicolon as 1, determine the field numbers of the 
attributes and enter them in the Field Num column. 
 
Most features are classified as DP’s but SBDARE (bottom samples), FLODOC 
(floating docks), and fixed or floating ATON’s (buoys, beacons, mooring facilities, 
etc.) are considered GP’s.  DP’s and GP’s are treated almost identically at this point, 
distinguished only by which checkbox in the lower right corner of the screen is 
checked. 
 

 

 

Check this 
box for DP’s 

Do not check 
any boxes for 
GP’s 

 
 
3.4.1 Create a Generic DP or GP Import template 
It may be useful to create an import template once all this information has been 
filled in.  A separate template will have to be created for each feature object class, 
and the templates will only be usable as long the data dictionary has not been 
altered.  To create a template, select File→ Save Template and specify 
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R:\Utilities\III_Pydro\Parser Templates as the destination folder.  In the future, 
after a template already exists, the Open Data Files step may be skipped and Open 
Template used instead. 

 
3.5. Process files 
In the Generic GPs/DPs Import window, go to File/ Process file(s) and select one or 
more appropriate shape files.  Click Open.  If you are processing DP’s, when 
prompted to ‘Associate the incoming DPs with a HIPS/SIPS “Project”’, select the 
CARIS\HDCS_DATA\HXXXXX folder of the current survey. 
 
GP’s do not need to be associated with a HVF (formerly VCF).  However, when 
importing DP’s, a window will pop up, asking you to select the vessel these points 
were taken from.  All Trimble DP’s will start with 
TRB1 or TRB2, depending on the unit, followed 
by _DPES for echosounder or _DPNE for 
nonechosounder.  If unsure about the vessel or if 
DP’s in the same file are of mixed vessel type, 
leave HVF as unassigned and edit vessels later.  
   
In Pydro, choose Config → DP Vessels and when 
asked to Browse to HIPS/SIPS VesselConfig 
folder, find the project’s 
CARIS\HDCS_DATA\VesselConfig folder.  In 
the following window select the correct vessel, 
paying close attention to ES (echosounder) or 
Non-ES (non echosounder) type: 
 
To view your points, a background image must be 
loaded.  Zoom in on a location, or randomly zoom 
in several times and then right-click → “Select closest feature.”  Echosounder and 
non-echosounder features alike will normally appear black; the currently selected 
feature will be red. 
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3.6. Remarks, recommendations, and flags 
Any final updates or edits to S57 attribution should be made at this point.  For GP’s, 
click on the S57 button in the upper left-hand corner of the screen, make sure the 
correct Object Class is indicated, and use the Mandatory Attributes and Additional 
Attributes tabs to update any fields. 
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For DP’s, press the DP button next to the S57 button to open the DP Editor.  In the 
window that pops up you can make limited attribution edits as well as change the 
Vessel Configuration for each individual DP: 
 

 
 
After each feature has been checked any additional comments, such as disproval 
methods or disproval notes, should be added to the Remarks tab.  For disprovals, 
check the Significant flag.  If a DP needs additional work or investigation, flag 
Investigate.  For charted items, include the chart # in the DP remarks (i.e. "Chd 
(17382) rk disproval" or "Chd (16701) rk hp new ldg”).  Save the final PSS. 
 

4. Apply correctors to DP’s in CARIS 
 
Only DP’s will be brought into CARIS; GP’s do not need tide or SVP corrections.  Both 
echosounder and non-echosounder DP’s will get tide-corrected but only echosounder 
DP’s undergo SV correction.  Open CARIS HIPS/SIPS and set directory to the correct 
project through Tools → Options → Directories.  Tide and SVP files should be recorded 
on the Detached Positions Log that will be submitted as part of the Descriptive Report for 
the project, in HXXXXX\Descriptive_Report\Separates\1_Logs\Detached_Positions.   
 

4.1. Apply sound velocity (SVP) correctors 
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In CARIS HIPS, File → Open Project and open Project/Vessel/Day/Line.  Select all 
echosounder DP’s; from the Process menu, choose Sound Velocity Correction.  
Check “Load New SVP file” and then Select to find the SVP file that best fits the 
time and area the DP was taken in (for singlebeam, the cast and DP may have been 
taken a couple days apart).  Choose the Set Profile selection method and choose 
Process. 
 
4.2. Apply tide correctors 
In the open project, select all DP’s.  Choose Process → Load Tide and click Multiple 
tide stations using tide zones; Select and navigate to the Zone Definition Files (ZDF) 
in the Predicted (or Observed if available) subfolder of the CARIS project’s Tide 
folder.  In the Load Tide window, choose Load. 
 
4.3. Merge 
Select all DP’s; Process → Merge.  Exit CARIS. 
 

5. Update Pydro Feature Log 
 
In the Pydro Feature Log (HXXXXX\Descriptive_Report\Separates\1_Logs\ 
Detached_Positions), note the HVF, Tide and SVP file applied to each DP or GP, as well 
as any comments of issues that arose during processing. 
 

Back to top 
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Inserted 
Pydro 
Features 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NO Primary? 
Is Feature the “Primary” contact on a physical object? 
1.  Best DP on a shoreline feature? 
2.  Best SSS Image? 
3.  SWMB or VBES Least Depth? 
4.  Dive Investigation DP? 

YES 1.  Select best feature on object 
and designate as “Primary”. 
2.  Designate Correlating 
Contacts “Secondary”. 1.  Designate as “Primary”. 

2.  Designate Correlating   
Features “Secondary”. 

NO 

Mark “Resolved” 

Significant? 

 Does the feature meet the standard of “Significance”? 
1.  DP corresponds to significant feature? 
2.  SSS Contact Height >1m or 20% of water depth in >20m of water? 
3.  SSS Contact poses particular hazard to navigation? 
4.  SSS Contact of possible cultural or historical significance? 
5.  Bathy or Dive DP on significant feature? 
6.  Shoal sounding on “skin of the earth” type feature?

 
 
 
 YES  

1.  Mark “Significant”. 
2.  Assess Bathy Coverage. 

 
 
 
 
 
 
 

 
 

 
  
 

Investigate? 
Is additional investigation required? 
1.  Nadir, or near-nadir bathymetry coverage? 
2.  Suspicious sounding or DP? 
3.  Diver Investigation required to identify object? 

1.  Mark “Investigate”, clear 
    “Tgt Exported” flag if set. 
2.  Export Investigation Items 
      (sets “Tgt Exported”). 
3.  Plan and execute additional  
     coverage (SWMB, VBES,  
     DI, DP) 

YES 

1.  Clear “Investigate” 
2.  Select new “Primary” 
3.  Describe Investigation 
     in “Remarks” 

NO 

NO 

Mark “Resolved” 

Chart? Does the Hydrographer recommend plotting this feature on the Smooth 
Sheet?  (includes features representing disproval DPs)

YES 

1.  Mark “Chart” and select Feature Type. 
2.  Make Charting Recommendation if required. 

Report? 

YES 

NO 

Mark “Report” 

Does feature require further discussion or contain a recommendation? 
Will feature be specifically addressed in Shoreline Report, in appendix to the 
Descriptive Report? 

1.  Mark “DTON”. 
2.  Generate DTON Report. 
3.  Mark “Resolved”. 

YES NO 
Mark “Resolved” DTON? 

  



The Editor Notebook: 
Controls, Text Fields, Status Levels, and Flags  

 
Controls 

• S57 – Opens S57 Editor. 
o Set HSD Carto Code and S57 Attribution (if desired). 
o Edit “Carto Text”, which is exported to Microstation.  This will be linked to first line of 

“Remarks” field in a future version. 
• Awois Editor – Opens AWOIS Editor 

o Awois Item investigation to be updated by hydrographer, and submitted with completed 
survey, as part of the item investigation process. 

o This interface replaces need for separate MS Access process. 
• Pri – Brings Primary correlating feature to “Current Feature” position. Affected Charts – Drop 

Down list of charts covering the position of the current feature.  Requires CHAPP File from 
Marine Chart Division (which is distributed with Pydro).  Ensures that hydrographer and evaluator 
are aware of all charts that must be compared with this surveyed item. 

 
Text Fields 

• Remarks – Hydrographer’s description of the feature and investigation technique.  Detached 
Position remarks and HIPS Side Scan Sonar Contact annotations are copied here when these data 
are inserted.   

• Recommendations – The hydrographer’s charting recommendation if selected as a Chart item.  A 
recommendation is made for each chart affected.  Recommendations for changes to MHW and 
complete disprovals only. 

• Office Notes – Processing Branch comments on description and depiction recommendation of 
feature (concur / do not concur, etc). 

• Line / DB – The data path to the CARIS line data source (“Line”) or name of the Access database 
(“DB”) source of the feature 

• Time – System time at acquisition for bathymetric point features, or selection time for side scan 
contacts.  Clicking “Time” button toggles display units.  For Detached Positions, double clicking 
in data field opens DP editor. 

• Position – Position of Feature, with range and azimuth applied to DPs.  Clicking “Position” button 
toggles display units. 

• Depth – Processed least depth on feature.  For DPs and Bathy Features, this depth is that acquired 
at acquisition, corrected for requisite parameters through HIPS processing.  For SSS Features, 
Depth is the least depth found within the Least Depth Grid Size specified in PSS Parameters.  
Clicking “Depth” button forces bathy search for “Least Depth” and“Surrounding Depth”. 

• Surrounding Depth – For SSS Features, the average depth in the Surrounding Depth “donut” set 
by Surrounding Depth and Least Depth search radii.  This is used to define significance of the 
contact relative to local bathymetry. 

• Range – Range to DP target, entered by hydrographer in Hypack or DP Editor. 
• Azimuth – Direction to DP target in degrees relative to True North. 
• Observed Depth – Depth associated with DP or Bathy Feature as acquired before correction in 

HIPS. 
• Display Name – User editable feature name, originally set by hydrographer in feature source 

software (Hypack, CARIS).  Future Upgrade:  Clicking “Display Name” button will toggle display 
field between “Display Name”, first line of “Remarks”, and “Carto Text”.  

 



 
Status Levels 

• Pending – Status not set.  All features are “Pending” on import. 
• Primary – The best Pydro feature available for any physical object.  Typically, this is a bathy 

feature with least depth and position after an investigation is completed.  Each physical object has 
only one “Primary” Pydro feature representation.  Which feature is selected as “Primary” may 
evolve over the course of investigation. 

• Secondary – Pydro features corresponding to the same physical object as the Primary, but of 
lesser quality (imagery, depth, position).  Secondary features automatically assume attributes of 
their Primary. 

 
Flags 

• Reject - Should be used ONLY for mistakes; if data are re-acquired, a remark in the new feature 
shall reference the rejected feature. 

• Significant – Features which meet standards for significance, generally related to feature 
representation indicating a physical object that is significant for IHO S-44 survey accuracy.   

• Investigate – Feature requiring further investigation, typically additional SWMB coverage or a 
dive.  “Investigate” shall be cleared once the hydrographer is satisfied with coverage.  Features 
marked “Primary”, and “Investigate”, but not “Tgt Exported” will be exported on “Export 
Investigation Items”. 

• Tgt Exported – Feature for which a Hypack tgt has been exported, set automatically when 
“Export Investigation Items” is performed.  Presence of this flag prevents repeat exports, and 
signifies to reviewers that the hydrographer planned an investigation. 

• Chart – Feature recommended for application to the smooth sheet by the hydrographer.  Only 
available for those features already selected as “Significant”.  This includes DPs which disprove 
the existence of currently charted features 

• DTON – Feature selected by the hydrographer as a Danger to Navigation.  Only available for 
those features already marked “Chart”.  Features marked “Primary” and “DTON”, but not 
“Submitted” will be exported to the DTON .xml file. 

• Submitted – Feature which has been exported as a DTON.  Presence of this flag prevents 
duplicate DTONS. 

• Report – Feature specifically addressed in the Descriptive Report. 
• In Bathy – Forces depth from DP or Bathy contact into displayed soundings so that the final 

sounding set will include this depth.   
• Resolved – A feature which the hydrographer has finished investigating, assessing, and 

describing.  This is the final step in the field’s analysis of the feature, and setting “Resolved” locks 
the previous flag settings (can be unlocked by un-checking “Resolved”).  This indicates to the 
reviewer that the physical object has been described to the fullest extent by the hydrographer. 

• Office QC – Feature which office personnel have verified. 
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0.0 Document Scope 
 
This document is intended to guide sheet managers through shoreline processing.  The SOP 
Shoreline_Processing.doc is also a useful reference. 
 
1.0 Setting Up the Project 
 
Before sending boats out in the field, it is important to know where to send them and what needs to 
be verified.  The source shoreline files for the project will be translated to the appropriate format by 
the CST and made available to the sheet managers.  Be sure to thank the CST for doing this. 
 

1.1 CARIS Notebook 
 

Source shoreline files will be provided to the sheet manager in Notebook’s .hob format with 
S57 attribution.  Any additional items from the chart that should be addressed during 
verification will need to be digitized in Notebook. 
 
SETTING THE DIRECTORIES 
In order for CARIS Notebook to communicate properly with CARIS HIPS, the directories have 
to be properly set. 
1. From the Tools menu, select Options. 
2. Click on the Directories tab in the pop-up window. 
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3. Set the Root Path to the upper level CARIS folder associated with the survey. 
I:\200#_Projects\OPR_O###_FA_0#\Surveys\H#####\CARIS\ 

4. The Projects directory should point to the CARIS HDCS folder for the survey. 
5. The Session directory should point to the CARIS Session folder.  This will allow HIPS 

sessions to be opened into Notebook for reviewing shoreline data with a BASE surface in 
the background. 

6. The Fieldsheets directory should point to the CARIS Fieldsheets folder.  Individual 
fieldsheets can be opened in Notebook for review. 

7. Click on the Environment tab of the Options window. 
8. In order to view the HIPS BASE surfaces properly, the color maps in Notebook have to 

match those of HIPS.  Change the Image Colour Map Directory directory to match those 
of the HIPS system.  (Not currently working in Notebook 2.2 Beta) 

9. If pictures are going to be inserted in Notebook, the Multimedia Folder directory must be 
set to map the folder where the pictures are stored.  This directory is also under the 
Environment tab of the Options window.  (Not currently working in Notebook 2.2 Beta) 

10. Once all directories have been properly set, click Apply and then OK. 
 

OPENING SOURCE SHORELINE FILES 
1. From an explore window, browse to the raw data folder for the project on the H: drive and 

locate the X###_CFF_Shoreline.hob file. 
2. Save a copy of this project wide .hob file as H#####_CFF_Shoreline.hob in the Notebook 

Files folder for the sheet. 
3. Open CARIS Notebook.   
4. From the File menu, select Open, or click on the icon in the toolbar. 
5. Browse to the Notebook_Files folder and select the H#####_CFF_Shoreline.hob file. 
6. Click OK.  The file should appear in the Layers tab.   
7. Open the survey sheet limits and use it to edit the source shoreline, deleting any features 

outside the limits.  Make sure not to trim out too much, especially with line features. 
8. Save the changes to the layer. 
 
CREATING EDIT LAYERS 
Editable layers are used for digitizing charted items or adding new shoreline features. 
1. From the File menu, select New Edit Layer, or click on the button in the toolbar. 
2. Browse to the Notebook_Files folder and create a new .hob file, named 

H#####_CHD_Shoreline.hob 
3. Digitize any items from the chart to the CHD_Shoreline.hob layer, such as rocks or AtoNs 

that need to be addressed in the field and are not represented in the source shoreline 
files. 

4. After acquiring some shoreline data, another layer named H#####_Shoreline_Updates 
will need to be added. 

 
DIGITIZING FEATURES 
1. In the Layers tab, select the layer to be edited and Set As Active Digitize Layer from the 

Edit menu. 
2. Select the appropriate digitizing tool from the toolbar (point, line or area). 
 

  
 
3. When a digitizing tool is selected, a Select Object Acronym window will appear.  Choose 

the appropriate acronym from the list (UWTROC, $CSYMB, WEDKLP, etc) then click OK. 
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4. An Attributes window will appear.  Fill in any required fields, which will appear red, and 

any desired optional fields, then click OK. 
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5. The cursor symbol will change.  Click on the desired position for the digitized object, line 
or area. 

6. To end a digitized line or area, right click on the last point dropped and select End Line, 
or Close Line. 

7. Digitized features can be moved or edited using the Edit Feature tool in the toolbar.  
 

TURNING ON TEXT DISPLAY 
Some text from Object ID, Inform and Remarks fields can be displayed with the digital data.  
It is not currently possible to select which text is displayed.  It is either on or off. 
1. Go to the Tools menu and select Options. 
2. Select the S52 tab. 
3. There are several check boxes at the bottom of the window.  Turn on the Text option, 

then click OK. 
 

 
 
4. Text can be added to a feature by selecting it, then adding the desired comment to the 

remrks field.  This ability to add text will be used in place of a marker layer for point 
features. 
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MARKER LAYERS 
Marker layers are not stand alone layers. They must be attached as a child layer to an Edit 
layer.  Marker layers will be used to transfer notes made in the field from the boat sheet to 
line features in CARIS Notebook. 
1. Highlight the parent layer to which a marker layer will be added (e.g. CFF or Lidar). 
2. From the File menu, select New Marker Layer, or simply click the M icon in the tool bar. 
3. A new Marker layer will appear  in the Layers tab, with the same name as the parent 

layer.  Select the Marker layer and Set As Active Layer. 
4. Right click on the associated parent layer and Set as Snap Target. 
5. Choose the appropriate digitizing tool (usually point). 
6. An Attributes window will open and comments can be entered in the Marker text field. 
 

 
 

Attributes of the marker:  
mk_tim: Marker timestamp  Displays the date and time captured automatically from the 
computer 
mk_txt: Marker text  User text, description, recommendation, comment, etc., populated during 
entry 
mk_sta: Marker Status  Value is a number: 1. Active, 2. Dismissed, 3. Closed, 4. Unknown 
mk_unm: Marker User Name  Capture of the user account id.  Can be changed later 
mk_rel: Related feature ids  Capture of the FOIDs when objects on the parent layer are 
selected 
mk_pic: Marker picture file  A multi-media file can be attached to the marker 
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7. Once the text has been entered and other fields set as desired, click OK and the 
digitizing tool will appear. 

8. Hold down the left mouse button and the shift key.  Position the mouse over the desired 
location and release.  This will snap the marker to the object being marked. 

9. To display the text of the markers in the Display window, follow the steps for Turning on 
Text Display above, but check the Notes box in the S52 window. 

 
CAPTURING A FOID 
If a marker layer is attached to a parent layer that contains S-57 objects, it is possible to 
capture the Feature Object Identification (FOID), which is the S-57 worldwide unique ID, and 
snap to the source object. A reference FOID can only be captured on the parent layer of a 
marker.  This is not a necessary procedure, but if you need to do it, here’s how. 
1. From the Edit menu, select New Feature. 
2. Choose Create Marker Reference from Superselection when using just a single object 

highlighted in the worksheet window, or Create Marker Reference from Selection for 
several objects, or the entire parent layer. 

3. Follow Steps 1-4 above, to create a new Marker layer for the desired S-57 layer. 
4. Highlight the parent layer in the Layers window, then select the desired object 

(superselection) or objects (selection) from which to capture the FOID. 
5. Follow Steps 5-8 above to complete the marker.  

 
PRINTING A BOAT SHEET 
Once all preliminary shoreline data is in the Notebook session, a boat sheet will need to be 
printed.  The crew on the shoreline boat will write useful information on the boat sheet that 
will be transferred into Notebook by the sheet manager.  The process for printing a boat 
sheet is yet to be determined.  Hopefully, the Publication Designer from Notebook can be 
used to create a template for this.  For now, refer to R:\Utilities\I-
FA_SOP\1_Presurvey\Shoreline\Printing Boat Sheets.doc 
 

2.0 Post Acquisition Duties 
 
After acquiring shoreline data in the field, it will need to be transferred to Pydro and CARIS Notebook 
for processing.  These steps need to be done immediately, while the ship is still in the survey area. 
 

2.1 Pydro 
 

Open the PSS for the survey, or create a new one if one does not exist.  Be sure all metadata 
is entered and correct. 
 
INSERTING GPs AND DPs  
Positions recorded in the field must be imported into Pydro for processing.  The boat crew will 
be responsible for transferring the Trimble files to the appropriate folder. 
1. From the Pydro Data menu, select Insert > Generic GPs/DPs. 
2. In the pop up window, go to the File menu and select Open template. 
3. Browse to R:\Utilities\III_Pydro\ Parser Templates and open the appropriate template file 

(e.g. $CSYMB or UWTROC).  Some fields in the Import window will be filled in 
automatically. 
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4. Go to the File menu and select Open data file. 
5. Browse to the folder where the Trimble files were saved. 

I:\200X_Projects\OPR_XXXX_FA_0X 
\Surveys\H#####\CARIS\Preprocess\Trimble_GPs\Export\TRX_DDD 

6. Open the desired .shp file. 
7. From the File menu, select Process file(s) and open the shape file used in Step 6.  This 

seems redundant, but insures proper processing. 
8. When importing DPs, Pydro will ask for an associated CARIS project.  Point to the 

H##### folder within the HDCS Data folder for the project. 
9. Repeat Steps 6 & 7 for all new .shp files. 
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10. Fill in the Pydro Feature Log for each file inserted.  The template is located at 
R:\Utilities\II_Forms_Lists_and_Templates\2_Acquisition and Processing\Shoreline.  
Save a copy in Descriptive_Report  > Separates > 1_Logs > Detached_Positions. 

11. When all features have been imported, close the Import window and save the PSS.  The 
field unit used to acquire the DP’s should appear as a vessel in the associated HIPS 
project.  Tide and SV correctors will be applied as described in section 3.1 below. 

 
ADDING IMAGES 
1. Photos taken in the field should be saved in one Photos folder, within the survey PSS 

folder. 
2. To associate a photo with a DP, select a feature and click on the Cur Feature tab below 

the chart. 
3. Right-click in the blank space and choose Add Image(s).   
4. Navigate to the Photos folder, highlight the appropriate image(s), and select Open.  Once 

an image is displayed under the Cur Feature tab, the paths of all images can be 
displayed under the Cur Path tab.   

5. Alternatively, images can be added by having the Photos folder open and dragging and 
dropping the images into the Cur Feature window.   

 

 
 

6. To toggle between images, right-click in the image window with either the Cur Path or 
Cur Feature tab activated, and choose Next Image.   

7. To remove an image, right-click and select Remove Image. 
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CHECK FOR COMPLETENESS 
1. Check to make sure all items on the boat sheet and DP forms have been addressed.  

Insure that all remarks in Pydro are correct. 
NOTE:  The Range and Bearing values recorded on the DP forms are also entered into 
TerraSync, which automatically updates the position.  These fields in Pydro should be 
zeroes. 

2. Check to make sure all AWOIS items have been addressed. 
3. Make sure anything marked investigate has been investigated and that all HW VBES and 

SWMB disprovals have been obtained. 
4. Use the Pydro decision tree to check flags and update Recommendations, especially with 

disproval methods and notes.  Refer to R:\FA_SOP\3_Processing\Pydro\Pydro 
Logic_SOP.doc. 

5. Update Pydro session flags to Chart, Significant and Primary prior to leaving the 
acquisition area. 

6. Start marking things that will be addressed in the DR as Report and update the 
Recommendation tabs. 

7. Refer to R:\FA_SOP\3_Processing\Pydro\Pydro Logic_SOP.doc & The Editor 
Notebook_SOP.doc for more information.  It might also be helpful to look at the example 
shoreline report: 
 \\Fa_process_3\Primary 
Drive\Survey\OPR_O112_RA_02\H11121\Descriptive_Report\Appendices\Shoreline\H11
121_Shoreline_Report.pdf 

 
EXPORTING XML DATA 
1. From the Data menu, select Export > XML Feature Data. 
2. Set the filter to export only Primary features and click OK. 
3. Save the file as H#####_Features.xml in the PSS folder for the survey.  This file will be 

imported to CARIS Notebook for processing. 
 
2.2 CARIS Notebook 

 
IMPORTING PYDRO FEATURES 
CARIS Notebook can read features directly from the Pydro .xml file, exported as described in 
the Pydro section above.  If some features do not import, it is possible that they are not 
attributed correctly.  Refer to the S57 Attribution section below. 
1. From the Tools menu, select PYDRO Data Import. 
2. In the PYDRO data file name field, browse to the location of the Features.xml file. 
3. In the HOB data file name field, browse to the Notebook_Files folder and create a new 

.hob file called H#####_Features. 
 

 
 

Location: 
R:\Utilities\I_FA_SOP\3_Processing\Shoreline_Notebook Approval Date: 
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4. Click OK.  The features should appear in the Display window of CARIS Notebook. 
NOTE:  Bottom samples will not appear unless the text is set to display, as described in 
the Turning on Text Display section above. 

5. Separate features into Add, Modify and Delete layers. 
 

ADDING PICTURES TO EDIT LAYERS 
This process will hopefully be eliminated in future versions of Pydro, which will automatically 
export the pictures associated with each feature in the .xml file.  Currently the Multimedia 
directory cannot be set in Notebook 2.2 Beta, so this process does not work at all. 
1. Make sure the Mulitmedia Folder directory is mapped to the folder containing the pictures 

to be inserted.  See the Setting the Directories section above.  Doesn’t work in 2.2 Beta. 
2. Set the appropriate layer as editable. 
3. Select the item with which the picture will be associated.  The feature information will 

appear in the Selection tab at the bottom of the window. 
4. Under the Acronym label, look for a PICREP option (cartosymbols have it, underwater 

rocks do not) and click on the … browse box.  
 

 
 
5. The Multimedia Browser window will pop up.  Browse to the appropriate picture, then 

click Add and OK. 
 
ADDING SHORELINE NOTES 
Any notes made on the boat sheet in the field will need to be added to the Notebook session. 
1. For point features, add text such as “CFF RK NTD” directly to the remrks field of the 

digitized object.  Refer to the Turning on Text Display section above. 
2. Adding comments to carto-symbols or line features, such as “CFF FOUL VRD”, or “LDR 

LW NTD”, will require a Marker layer.  Refer to the Marker Layer section above. 
 

ADDING SHORELINE UPDATES 
1. Create a new edit layer named H#####_Shoreline_Updates.  Refer to the Creating Edit 

Layers and Digitizing Features sections above. 
2. Add any new features to this layer, such as fouls, ledges, shoaling or new high water 

lines which are not on the current chart, or in the source files.  Add comments to a Marker 
layer for the line features, as described above.  Do not add new point features to this 
layer.  These should have DP’s associated with them and brought into the Features layer 
using the Pydro Data Import described above. 

 
3.0 Processing Duties 
 
These are things that can be done as time allows and do not necessarily have to be completed while 
the ship is still in the survey area. 
 

Location: 
R:\Utilities\I_FA_SOP\3_Processing\Shoreline_Notebook Approval Date: 
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3.1 CARIS HIPS 
 

APPLY CORRECTORS 
1. Open a project in HIPS and open the DPs and GPs. 
2. Apply observed tides to all items. 

NOTE:  Zoned tides can only be applied to files containing more than one position.  A 
single tide station must be applied to any single DP or GP. 

3. Apply SVP correctors to any echosounder DPs.  If necessary, use a nearby cast taken 
during hydrography. 

4. Merge all data. 
 
3.2 Pydro 
 
S57 ATTRIBUTION 
1. Under the Details tab, click the S57 button to open the S57 Editor. 
2. A window will open with the information for the selected item. 

 

 
 
3. Check that the Object Instances displays the correct object type (e.g.  UWTROC, 

$CSYMB, etc). 
4. Left click on the appropriate object type in the Object Classes box.  It should already 

have a check mark in the box next to it. 
5. Information will appear in the Mandatory Attributes box.  Fill in the appropriate 

information. 

Location: 
R:\Utilities\I_FA_SOP\3_Processing\Shoreline_Notebook Approval Date: 
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6. Click Apply. 
7. Repeat this process for all features in the PSS. 

 
REVIEW FEATURES 
1. Compare the items inserted in Pydro with the DP/GP log.  Make sure the log is 

completely filled out and up to date. 
2. Check S57 attribution of all items and correct if necessary. 
3. Add chart numbers to chart items (e.g.  CHD (17424) RK DSP). 
4. Add Light List numbers to ATONs 
5. Address and update AWOIS items using the Pydro Editor function. 
6. Use the Pydro Features Tree to edit flags and update Recommendations, especially with 

disproval methods and notes.  Pydro flags should be updated to Chart, Significant and 
Primary.  Check the Report flag if an item needs to be addressed in the DR.  (This should 
already be done, but do it now if not complete.) 

7. Any item flagged as Report should have the surveying information in the Remarks tab 
and any necessary recommendations entered under the Recommendations tab. 

8. Check the DP Forms in the project binder.  Make sure they are completely filled out and 
match the information entered in Pydro. 
NOTE:  The distance and bearing entered in TerraSync as noted on the DP form will not 
appear in Pydro.  The position is automatically updated. 

9. Scan the finalized DP forms and save as a single PDF in:   
I:\OPR_XXXX_FA_0X\Surveys\H#####\Descriptive_Report\Separates\1_Logs\Detached
_Positions. 

10. Mark items as Resolved once they have been completely finalized.   
11. The features will need to be re-exported after all correctors have been applied and S57 

attributions made.  Refer to the Exporting XML Data section above. 
 

CREATE A SHORELINE REPORT 
1. From the Reports menu, select For List of Items. 
2. In the pop-up window, set the filter to Report. 
3. Fill in the fields as shown below, with a short text description for the report. 
 

Location: 
R:\Utilities\I_FA_SOP\3_Processing\Shoreline_Notebook Approval Date: 
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4. Click OK and save the file to the Shoreline appendix of the DR. 
 
3.3 CARIS Notebook 

 
REVIEW WITH BASE SURFACE 
1. From the File menu, select Open Session. 
2. Select the appropriate CARIS HIPS session for review.  The session should contain 

BASE surfaces, contours and soundings. 
3. Open all Notebook files necessary for review. 

NOTE:  Files must be opened individually.  Choosing to open a Notebook session will 
close the HIPS session.   

4. Individual fieldsheets can also be opened into Notebook as further reviewing tools. 
5. Review shoreline remarks and features with SWMB surfaces with contours and depths to 

make sure there are no conflicts (i.e. SWMB over CHD (17324) RK NTD). 
  
 

FINALIZING 
1. Import the final .xml features from Pydro to the H#####_Features.hob file.  Make sure all 

old files are deleted or over written.  Add, Modify, Delete layers? 
2. Check that the H#####_Shoreline_Updates.hob file is correctly attributed and complete. 
3. Make sure all notes, shoreline additions and edits have been entered from the boat sheet 

to the appropriate layer.  Refer to the Post Acquisition section above. 
4. Delete any outdated or extra layers from the final Notebook session. 
 

Location: 
R:\Utilities\I_FA_SOP\3_Processing\Shoreline_Notebook Approval Date: 
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0.0 Document Scope 
 
This document is meant to be used as a guideline for survey managers to insure that surveys are 
completed properly.  There is a general order to this list.  Some things have to be done in order, 
while others, like the Coast Pilot, DR and Final Fieldsheet prep can be started in advance.  This 
document can be used in conjunction with the QC Checklist.  The two should match fairly closely 
beginning with the Post Acquisition section. 
 
1.0 Survey Planning 
 
Survey planning begins before arriving at the survey area and continues throughout the project. 
 

1.1 Project Instructions 
 

Read and understand the project letter instructions, located here: 
I:\200X_Projects\OPR_XXXX_FA_XX\Project Files\Instructions\Letter Instructions\OPR-
XXXX-XX.doc 

 
1.2 Manager Responsibilities 

 
The survey manager is responsible for creating polygon files, a shoreline workspace, 
boat sheets, setting up projects on the launches (including suitcase shoreline and ship if 
necessary for your survey).  In addition, the Survey Manager is responsible for directing 
the daily work schedule (polygon plans and chartlets) of launches assigned to acquire 
data on the survey.  See: 
R:\Utilities\FA_SOP\0_Management\File Management\Survey File Management  
R:\Utilities\FA_SOP\1_Presurvey\Shoreline\Shoreline_Presurvey.doc & Printing Boat 
Sheets.doc 
R:\Utilities\FA_SOP\1_Presurvey\AWOIS_Presurvey\ AWOIS_Setup.doc 
R:\Utilities\FA_SOP\1_Presurvey\Creating_DelphMap_Projects_SOP.doc 
R:\Utilities\FA_SOP\2_Acquisition\Shoreline\Shoreline_Guidelines 
 
Remember to update your near shore polygons using the shoreline buffer, shoreline 
updates and new features to determine the inshore limit of hydro.  Review polygons with 
shoreline data so you don’t accidentally send a SWMB boat over a new rock, or into an 
area that is too shoal.  Also, use the Ceeducer depths that were collected to edit your 
polygons. 
 
DO NOT send multibeam boats inshore of the eight meter curve until shoreline 
verification has been run in that area.  Once shoreline has been run, export your new 
features from Pydro into Isis for use by the multibeam boats during near shore 
acquisition. 

 
1.3 Survey Log 

 
Keep a survey log in addition to the daily acquisition and processing logs to note any 
problems during the survey, or deviations from the DAPR.  This will be useful when 
writing the DR. 

 
 
 

Location: R:\Utilities\FA_SOP\0_Management Approval Date: 12/23/04 
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2.0 Post Acquisition 
 
These steps are intended to be followed both during acquisition and immediately after data 
acquisition has been completed for the survey. 
 

2.1 Quality Control and Assessment of Soundings 
 

During acquisition of data, the Sheet Manager is responsible for analyzing the quality of 
the soundings and insuring coverage and sounding density.  Before leaving the survey 
area, the Sheet Manager must review the BASE child layers in subset mode, checking for 
sound velocity and tide problems, as well as checking for ample coverage, especially 
over navigationally significant areas.  Unverified observed tides are usually available 
within a day or two and can then be applied to the data.   
 
It may be beneficial to create a subset tile layer in CARIS to keep track of areas that have 
been reviewed.  This review is not cleaning in subset.  It’s just a quick look in subset 
mode for lines that may not have been cleaned properly, holidays, SV, tide and other 
problems with the data.  Have the BASE surfaces open in CARIS and use different sun 
illumination angles.  Problem areas will look suspect. 

 
2.2 Check for Immediate DTON’s 
 
Look for any items in the bathymetry which are extremely navigationally significant.  
These items should be brought to the attention of the FOO and the CO immediately, so 
they can be added to the relevant charts as soon as possible.  Otherwise, the regular 
DTON review occurs at the end of post processing. 
 
2.3 Document Deviations from DAPR 
 
Any deviations from the DAPR should be recorded in the survey log, or the acquisition 
and processing logs.  Changes to the HVF, or other unusual steps taken during data 
acquisition or processing should be noted and explained in the DR.  Be familiar with the 
DAPR for the project. 
 
2.4 Shoreline 
 
Insure that shoreline verification is conducted in accordance with the Letter Instructions 
and that adequate annotations are made to allow for complete description of the 
shoreline environment.  Review Pydro and Notebook sessions, photos and DP forms for 
completeness prior to leaving the survey area.  Pydro PSS features should be completely 
addressed and with the Chart, Significant, Primary and Report flags checked where 
applicable.  See: 
R:\Utilities\FA_SOP\3_Processing\Shoreline\Survey _PIC_ Shoreline _SOP.doc 
R:\Utilities\FA_SOP\3_Processing\Pydro\Pydro Logic.doc & The Editor Notebook.doc 
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2.5 AWOIS Items 
 
Insure that all AWOIS items listed for the survey are either verified or disproved through 
methods listed on the AWOIS database technique section.  Update the AWOIS database 
using Pydro.  If there are questions about which method is best for a particular item, 
consult the FOO, CST or an SST. 
 
2.6 Coast Pilot Updates 
 
The Coast Pilot should be updated while still in the survey area.  Don’t put it off!  
Reference depths, bottom samples and shoreline information as needed to update 
relevant paragraphs.  See: 
R:\Utilities\FA_SOP\4_Deliverables\Coast_Pilot\Coast Pilot Survey PIC Instructions.doc 
 
2.7 Smooth Tide Request 
 
Request for Smooth Tides letters should be drafted and submitted as soon as a survey is 
completed.  These requests do not need to wait until all data processing is complete or 
the DR has been written.  See: 
R:\Utilities\FA_SOP\4_Deliverables\SmoothTides\Smooth Tides Request.doc 

 
2.8 Create Survey Outlines 

 
It may be necessary to make two or three outlines for the survey, depending on whether 
VBES and / or SSS are submitted as well as SWMB.  The table named 
H#####_Survey_Outline.tab should outline all data.  If only SWMB is being submitted, 
only one table is needed.  For step by step instructions on creating tables, see: 
R:\Utilities\FA_SOP\4_Deliverables\Survey_Outline\Survey_Outlines_2004.ppt 
 
If the survey has VBES or SSS, there will need to be an outline around the VBES 
coverage named H#####_VBES_Outline.tab and  an outline around the SSS coverage 
named H#####_SSS_Outline.tab, as well as the SWMB outline, named 
H#####_SWMB_Outline.tab. 
 
All of the outline files should be saved in:I:\Projects\ OPR-XXX-FA-0X\Surveys\HXXXXX\ 
Descriptive_Report\Appendices\Survey_Outlines 
 
2.9 Apply Observed Tides to CARIS Data 
 
Check the observed tide file to be applied to the data.  Make sure that all acquisition days 
are included in the tide file.  Be sure that there is a buffer of one extra day at the end of 
the file, or before any gaps in acquisition days.  This will cover any data collected after 
midnight GMT. 
 
Using CARIS, open the file in Tide Editor to insure that it looks OK.  Look for fliers and for 
problems with the data, such as a shift up or down in one section of the data, or any 
discontinuities.  Alert the tides people if you see a problem, so it can be corrected.  If you 
can’t find, or don’t know which tide file to use, check with the tides people. 
 
At the end of acquisition, reload the observed tides with the zone file to all lines and DPs. 
 

Location: R:\Utilities\FA_SOP\0_Management Approval Date: 12/23/04 
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2.10 Review Sound Velocity Files 
 
1) Check all SVPs, using CARIS Sound Velocity Editor to look for any fliers or other 

problems with the cast.   
2) Display SVP Positions in CARIS with the SWMB data open.   
3) From HDCS_Data folder, select the folder for one line from each boat day.  Use a 

text editor to compare the SVP file listed to the cast that the acquisition log query lists 
as being applied.   

4) Male sure that all casts listed in the acquisition logs have been copied to the 
appropriate folders to be applied to the data. 

5) Produce a list of all CTD casts performed during the survey to be included with the 
DR.  Use the template located at: 
R:\Utilities\Templates\SV_Cast_Example.doc 

 
2.11 Re-Merge CARIS Lines 
 
Check the CARIS H#####_QC session to make sure that it contains all SWMB lines.  
There should not be any DP files in the subset cleaning session.  Re-merge all lines once 
observed tides have been applied. 
 
2.12 Query All Lines 
 
Query all HDCS lines and save the results in the H#####_Data_Query.xls, in the 
Acquisition and Processing folder of the DR Separates .  Check that the appropriate tide 
file has been applied and that the SV profile makes sense as far as time and position.  
Compare this query with the original queries recorded in the acquisition and processing 
logs and investigate any discrepancies. 

 
3.0 Post Survey 
 
These steps outline the process for final review of data before submission. 
 

3.1 Quality Control and Data Review 
 
The Survey Manager must review the entire survey area in subset mode, using the 
H#####_QC session.  Refer to: 
R:\Utilities\\FA_SOP\Processing\CARIS\Bathy_Processing 
 
It may be helpful to create a subset tile layer for the entire survey to keep track of which 
areas have been checked.  This requires a surface that is up to date and contains all 
SWMB lines.  The CARIS session should not include any DPs or BSs.  The 
recommended tile size for a 1:10,000 scale survey is 20m.  Bigger than that causes 
overlap between subsets to be too large and smaller is not necessary. 
 
3.2 Designate Soundings 
 
Use CARIS Subset Editor to review the data with a BASE surface in the background.  
Designate soundings in areas where the surface doesn’t match the highest point of the 
data.  Refer to: R:\Utilities\\FA_SOP\Processing\CARIS\Bathy_Processing 
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Depth Threshold BASE Surfaces must be finalized in H#####_QC session for designated 
soundings to take effect and become critical soundings that will be submitted with data.  

 
3.3 Depth Checking for Flyers 
 
Using CARIS Fieldsheet Editor, create contours and soundings in the H#####_QC 
session.  Review the entire survey area and check areas with bulls eye contours or 
questionable depths using subset or line mode. 
 
3.4 Chart Comparisons 
 
Review depths in CARIS with the appropriate chart in the background.  Write up results in 
the DR.  Also, check the latest Local Notice to Mariners for the most recent updates to 
the chart.  
 
3.5 DTONs 
 
For information on selecting DTONs, refer to: 
R:\Utilities\FA_SOP\4_Deliverables\DTONs\Selecting DTONs.doc 
 
Select any possible DTONs in CARIS and mark soundings as outstanding or designated.  
Insert the item as a HIPS/SIPS Line Feature in Pydro and check the DTON flag.  Also, 
new DPs/GPs can be possible DTONs, so review the new features and check the DTON 
flag if applicable.  E-mail the FOO to review the possible DTONs in the PSS. 
 
Once the DTONs have been approved by the FOO, continue with the instructions given 
in: R:Utilities\FA_SOP\4_Deliverables\DTONs\DTONS_Procedure_XML.ppt 
 
Make sure all Remarks and Recommendations tabs have been filled in and then create 
an .xml of the DTONs.  Have the FOO review the .xml and e-mail it to MCD, CC-ing the 
Sheet Manager.  A digital copy of the e-mail should be kept in the DTON appendix for the 
DR.  This folder should also include the H#####_DTON.xml and the 
H#####_DTON_Report. 
 
3.6 Field Products 
 
A CARIS Notebook session should be created for the survey, which includes all shoreline 
and bottom sample data.  For the proper procedures, refer to: 
R:\Utilities\FA_SOP\3_Processing\Shoreline\Survey_PIC_Shoreline_SOP.doc 
 
3.7 Create Depth Threshold BASE Surfaces 
 
The H#####_QC session should contain all SWMB lines, but none of the DP or BS files.  
The fieldsheet can contain any BASE surfaces which were used during processing, but 
should also contain finalized BASE surfaces, with the appropriate depth thresholds.  
Refer to the Digital Submission Checksheet for suggested depth ranges and resolutions. 
 
The H#####_Final CARIS session should contain a field sheet with non-finalized BASE 
surfaces.  These surfaces should be named to reflect the resolution and depth ranges 
used for the finalized surfaces in the QC session. 
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3.8 Preliminary Smooth Sheet (PSS session in Pydro) 
 
Open the PSS in Pydro.  Use the Data Stats function to make sure that the data is not 
stale or outdated.  Check the shoreline and bottom sample DPs to insure that the 
appropriate flags are checked, the Remarks and Recommendations tabs are filled in as 
necessary and that correctors have been properly applied.  The DP forms should be 
scanned and the electronic copies saved in: I:\200X_Projects\OPR_XXXX_FA_0X 
\Surveys\HXXXXX\Descriptive_Report\Separates\1_Logs\Detached_Positions\HXXXXX_
DP_Forms.pdf 
 
3.9 AWOIS 
 
After all AWOIS items have been reviewed and resolved in Pydro, create an AWOIS 
report, using the Report function of Pydro.  Save the digital copy in the DR Appendix 3 
AWOIS folder. 
 
3.10 Descriptive Report 
 
In the DR, the Survey Manager describes what, where, why, when, how and with whom 
the survey was conducted.  The DR is a legal document and can be brought up in court 
to prove (or disprove) the accuracy of the survey.  Go to the template: 
I:\200X_Projects\OPR-XXXX-FA-0X\Surveys 
 
Save a copy to the survey folder: 
I:\200X_Projects\OPR-XXXX-FA-0X\Surveys\H#####\Descriptive_Report 
and name it H#####_Descriptive_Report.  Use the survey log and acquisition and 
processing logs to write about any issues encountered, or deviations from standard 
processes. 
 

3.10.1 Shoreline 
 
Disprovals and anything ambiguous, about which further information would be 
helpful to the cartographer, should be flagged for Report in Pydro.  Most 
shoreline discussion items will be in Pydro, if something was not positioned or 
could not be brought in as a GP, it will need a paragraph in the DR to address 
the item.  A general write-up on how shoreline was conducted, what programs 
and processes were used, and any deviations from shoreline procedures outlined 
in the DAPR should be included in the shoreline section of the DR. 
 
3.10.2 Junction and Prior Survey Comparisons 
 
Examine Junctions and Prior surveys in CARIS subset mode or Fledermaus (if 
possible).  Measure the distance for a general difference range and note if 
agreement was good or not.  Major discrepancies should be investigated and 
addressed in DR. 
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3.10.3 Digital Images 
 
Limits of Hydrography.jpg and Junctions.jpg are created in MapInfo with the 
survey limit displayed.  These images should be saved to the survey Misc folder, 
NOT in the Descriptive Report folder.  Insert the images directly into the DR.  The 
digital images do not get submitted separately. 
 
3.10.4 Cross Line Analysis 
 
Review a portion of your crossline areas in subset mode to get a general idea of 
how your data is matching up.  Discrepancies need to be investigated and written 
about in the DR if necessary.  
 
With all SWMB lines inserted into Pydro by type (Mainscheme or Checkline), use 
the built in function in Pydro to determine the mileage.  Then calculate the 
percentage of cross lines to mainscheme and report it in the DR.  If requirements 
were not met, be sure to include an explanation.  
 
3.10.5 Discussion of Issues and Deviations from Standards 
 
It is important to discuss any problems with the data, or processes that were 
done differently than those described in the DAPR. 
 
3.10.6 Cover and Title Pages 
 
Copy the templates from: 
R:\Utilities\Templates 
into the DR folder for the survey.  Fill in all fields with information from the project 
letter instructions and acquisition and processing logs. 

 
3.11 DR Appendices 
 

3.11.1 DTONs 
 
Refer to the DTON section (3.5) above. 
 
3.11.2 Geographic Names 
 
The Geographic Names form 76-155 will only need to be filled out if there are 
new geographic names in the survey area.  Save a copy of the form to the 
Geographic Names appendix folder and name it 
H#####_Geographic_Names.xls. 
 
The names will also need to be added as marker text in a new edit layer in 
CARIS Notebook, named H#####_GeoNames.hob.  This will go into the Final 
Fieldsheets\Notebook Files folder. 
 
Make a note in the DR referring to the Geopgraphic Names form in the 
Appendices andthat the names were included in the CARIS Notebook session. 
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3.11.3 Survey Outline 
 
Refer to the Survey Outline section (2.8) above. 
 
3.11.4 Smooth Tide Request 
 
Refer to the Smoot Tide Request section (2.7) above. 
 
3.11.5 Shoreline Report 
 
Use the report generating function in Pydro to produce a 
H#####_Shoreline_Report.pdf from the features flagged Report in the PSS. 
 
3.11.6 AWOIS 
 
Refer to the AWOIS section (2.5) above. 

 
3.12 DR Separates 
 

3.12.1 Acquisition and Processing Logs 
 
Clean up the binder.  It should contain only official paperwork, boat sheets, 
acquisition logs and DP forms.  Remove any personal items and unnecessary 
paperwork, such as polygon plans, PODs, etc.  Check that all DP forms are in 
the notebook. 
 
The digital folder should contain all acquisition and processing logs as well as the 
survey log.   
 
3.12.2 Side Scan Contacts 
 
Not applicable at this time. 

 
3.12.3 Sound Velocity Data 
 
Make a list of all CTD casts, using the template located at: 
R:\Utilities\Templates\SV Cast Example.doc.  Save the file into the appropriate 
Separates folder and name it H#####_SV.doc 

 
4.0 Submission 
 

4.1 Check Coverage and Accuracy Requirements 
 
The coverage requirements for the survey are specified in the project letter instructions.  
Check the data to make sure the requirements were met.  If they were not, be sure to 
make a note in the DR about what kind of coverage was achieved and why letter 
instructions could not be followed. 
 
The accuracy standards are as stated in the Specifications and Deliverable, unless 
otherwise noted in the project letter instructions.  Be sure the data meets standards and 
discuss any problems in the DR. 
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4.2 File Management 
 
Please remove/delete all extraneous files from the I drive.  This includes temp files, 
delete_me files, etc., which were used during processing but are no longer needed once 
the survey is approved.  Once the necessary files are copied into the Field Products 
folder, the survey files folder and its contents can be deleted.  Delete any non-official field 
sheets, surfaces and sessions from the I drive.  It should contain two sessions:  
H#####_QC and H#####_Final for each survey.  The H#####_Final session should 
contain a H#####_Final fieldsheet, named with the official non-finalized depth threshold 
and resolution BASE surfaces.  The H#####_QC session and fieldsheet can contain any 
surfaces, fieldsheets, contours, depths, etc. that were used during the review and QC of 
the survey.  Just tidy it up for submission.  Anything else is extraneous and can be 
deleted.  Please note that the I drive can and will be cleaned up after the data has been 
submitted. 
 
4.3 Quality Control Review 
 
When the field products, DR, Appendices/Separates and QC Checklist are complete, 
have a reviewer (FOO,  CST, SST) go through the QC Review Checklist prior to 
submitting the survey to the FOO for approval. 
 
4.4 Submit to FOO 
 
Submit the survey to the FOO for review and approval. 
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Hydrographic Survey Quality Control Checklist
Survey: Project: Survey PIC:

Bold underlines require a date and initials of when item was completed.
Refer to Survey Management SOP for detailed instructions to complete these steps.

Post Acquisition - review of data

Quality Control of survey area in subset prior to departure from field (SV, Tide, Holidays, Noise) 
BASE surfaces reviewed
Survey area reviewed in subset mode
Review Acquisition and Processing logs for issues/problem data

Check for immediate DTONs
Immediate DTONs submitted

Document special circumstances/problems and HVF changes/deviations from DAPR as occurred for DR
Issues listed in HXXXXX_Survey_Log.doc
Issues explained in DR

Shoreline acquisition & boat sheet/Notebook review
All items addressed (all data including CFF, Chart, Lidar, and new items)
AWOIS investigations complete

Pydro
DPs/GPs/Bottom Samples reviewed/flagged/S57 attributed
Pictures labeled correctly, in one folder, & inserted
AWOIS.mdb inserted

Coast Pilot review & write up with edits completed 

Smooth Tides Request (*.mif/mid and times of Hydro)
Produced, Submitted, Archived [Digital-copy (letter, times, & mif/mid) in Appendix VI Smooth Tide Req fldr]

Survey Outline
Produced, Submitted, & Archived (digital-copy in Appendix I Survey Outline folder)

Observed Tides
Observed tide file verified & checked for gaps/flyers (txt in Notepad, .tid in Caris Tide Editor)
Applied to lines
Applied to DPs

Verify Sound Velocity files
SVP files compared in digital acquisition logs vs. I drive – all should match
Each cast profile reviewed individually in CARIS 
SV cast positions displayed in CARIS (check for gross error)
SV cast list produced (digital copy in Separates III SV Profile List folder)
SV acquisition/processing deviations from the DAPR are noted in the DR.

Data re-merged in CARIS after observed tides have been re-applied. 

All lines re-inserted into HXXXXX_QC session, for BASE/subset review (not DP lines)

Data queried in CARIS (compare to digital acquisition logs)
Query all lines in CARIS 

Save query to H#####_Data_Query log
Compare query to SVP file in HDCS line directory (random sample)
Tide and SVP files applied are correct and most current (observed or verified)                

Problems/discrepancies investigated
Vessel speeds queried in CARIS and reviewed

Vessel speeds meet object detection requirements for relevant depths

HXXXXX OPR-XXX-FA-XX



Post Survey - post spatial (subset) review of data

Quality Control of cleaning performed by others and general QC of survey area
Complete Subset Review (include looking at rejected and BASE child layers)

Subset tiles created for review process
Review all examined soundings (to designate, mark outstanding, or reaccept)
Data checked for systematic errors (Std deviation child layer especially useful) 
Data issues discussed in DR if present

Designate soundings in areas where surface does not accurately represent the bottom 
# of Designated Soundings

Depth checking for flyers (CARIS Field Sheet Editor)
Contours & Soundings generated (CARIS Field Sheet Editor) 

Chart comparisons completed and documented in DR
Local Notice to Mariners checked for recent updates
Chart edition & date corrected through included in DR

DTONs (Dangers to Navigation) 
Selected (marked outstanding in CARIS and inserted as CARIS Line Feature)
Reviewed by FOO 
Pydro session updated/.xml produced 
FOO emailed 
Submittal email/DTON Report archived (digital copies in Appendix II DTON folder)

Field Products—Notebook and file management
All .shp files are in appropriate projection and name to include attribute description
All .hob files are in the Notebook session, named properly, & are in the Field Products/Notebook folder
Extraneous files are removed from the Field Products folder

CARIS Fieldsheets & Sessions cleaned up and submission ready
HXXXXX_QC Fieldsheet & Session tidied up 

Depth Threshold BASE surfaces finalized to produce critical soundings
Use Finalized (clipped by depth range) surfaces to assess coverage requirements were met

Non-Finalized BASE Surfaces produced (in HXXXXX_FINAL Fieldsheet & Session)
BASE surfaces include Depth Threshold ranges and resolutions

Pydro
PSS data IS NOT Stale or Outdated
All features resolved, flagged correctly and S57 attributed
DP forms match PSS & scanned into DP Log folder
Correct Vessels were selected for all data
Correctors were applied properly
Remarks/Recommendations completed in Pydro
AWOIS items finalized

AWOIS Report produced and archived (digital copy in Appendix III AWOIS folder)

Descriptive Report completed
Shoreline Processes described in DR
Shoreline Report produced in Pydro and archived (digital copy in folder)
Junction comparisons completed and documented in DR
Prior surveys were reviewed because of special issues 

Did the issues require an explanation in the DR
Cross-line (SWMB) comparisons completed and documented in DR

Required quantity of XLs met.  If not, addressed in DR.
SWMB Cross-line comparisons completed in subset mode in CARIS

Special circumstances/problems/issues/HVF changes/deviations from DAPR documented in DR
Does the data meet specifications?  Include an answer to this with any write-up.

Cover & Title sheets produced (digital copy in folder)
Appropriate Appendices completed and included with digital data
Separates completed and included with digital data



Submission
Coverage requirements were met.

If not, addressed in DR.

Accuracy requirements were met.
If not, addressed in DR

Digital folders cleaned up
HXXXXX_FINAL Fieldsheet folder contains only official Non-Finalized BASE Surfaces
Sessions & Fieldsheets open in CARIS and are not outdated

Content of all submission folders (CARIS, DR, Field Products, & PSS folders)
checked for completeness and suitability

Data checks
HVFs match current DAPR (check HVF database for which applies)

If not, addressed in DR.

Hydrographic Survey Quality Control Review Checklist completed
List name of reviewer

Date completed 

All data and DR submitted to FOO for approval

The quality and completion of all tasks are the responsibility of the Sheet Manager (OIC) (meaning if someone 
else completed a task, the OIC has verified the accuracy).  

Standard field surveying and processing procedures were followed in conducting the above mentioned survey.

The digital data and supporting records have been fully reviewed and are considered complete and adequate for 
review and approval.

Sheet PIC Name Printed Sheet PIC Signature Date

Field Operations Officer (FOO) Review

Data and DR are approved
Descriptive Report & Appendices reviewed

Shoreline Report reviewed
Pydro/Notebook Sessions reviewed
Processed HDCS Data reviewed in Fledermaus

FOO Name Printed FOO Signature Date



Hydrographic Survey Quality Control Review Checklist

Survey: Project: Survey Reviewer:

Bold underlines require and date and initials when item is completed.

Descriptive Report reviewed
Special circumstances/problems/issues/HVF changes/deviations from SysCert/DAPR documented in DR

Were data requirements met?

Quality Control Checklist reviewed

Logs reviewed
Digital Acquisition & Processing Logs
Pydro Feature Log
Survey Log

Quality and flyer check of depths/surfaces (review in CARIS w/ HXXXXX_QC Session & Fieldsheets)
Subset (include looking at rejected) – just need to look at around 10% of area

Shoals and Navigationally Significant areas reviewed 
Contours & Depths checked
Designated soundings reviewed
Errors discussed in DR if present

CARIS DP/BS line query
DPES lines are SVP/Tide/Merged
DPNE lines are just Tide/Merged

Outside Review of Shoreline & Pydro session
All features resolved
Remarks/Recommendations make sense
AWOIS Items resolved sufficiently
Files in Notebook folder open in CARIS Notebook
Review Notebook shoreline files with Caris Map .des from BASE surface for survey 

DTONs (Dangers to Navigation)
Reviewed/Verified

Chart comparisons reviewed
Ensure chart edition and date corrected through included in DR

Coverage and accuracy requirements were met
If not, addressed in DR.

Check that all lines are in HXXXXX_FINAL CARIS session
Session & Fieldsheet open correctly
HXXXXX_FINAL Fieldsheet folder contains official Depth Threshold BASE surfaces
Depth Threshold BASE surfaces open correctly and are not outdated



OPR-A###-FA-##

HXXXXX Survey X

CARIS
Fieldsheets

HXXXXX_FINAL  (Non-Finalized BASE Surfaces)
HXXXXX__0to20_1m Naming convention: HXXXXX_DepthRange_Resolution(m)

HXXXXX__19to60_2m
HXXXXX__59to150_5m
HXXXXX__149to250_10m
HXXXXX__249toXXX_15m

HXXXXX_QC (Working fieldsheet used throughout the survey for coverage and qc)
(The following are examples of possible files)
Preliminary Finalized BASE Surfaces
Subset Tiles
Depths and Contours

HDCS_Data 
HXXXXX  (processed CARIS HDCS data)
VesselConfig  (only vessels that apply to this survey)

Preprocess
ISIS (raw XTF data and True Heave from ISIS)
SVP_raw (raw SV data from Velocwin)
Trimble (raw data from TerraSync & exported SHP files from GPS PathFinder)

Session
HXXXXX_FINAL.hsf  (CARIS session)
HXXXXX_QC.hsf  (CARIS session)

SVP (processed CARIS SVP data files separated by vessel)
1010
1018
S220

Tide
Observed .tid and .zdf (Tide files applied to the data at the time of submission) 

DESCRIPTIVE REPORT
HXXXXX_DR.doc, HXXXXX_DR.pdf  (the final Descriptive Report)

Appendices
Survey Outline

HXXXXX_Survey_Outline.tab  (survey outline of hydrography)
HXXXXX_SWMB.tab (multibeam coverage)

DTON
HXXXXX_DTON.xml  (XML of DTONs exported from Pydro)
HXXXXX_DTON_Report.pdf  (report produced in Pydro)
HXXXXX_DTON_email.txt (copy of submission email)

AWOIS
HXXXXX_AWOIS.mdb  (Include only items that apply to this survey)
HXXXXX_AWOIS_Report.pdf  (report produced in Pydro)

Shoreline
HXXXXX_Shoreline_Report.pdf  (report produced in Pydro)

Quality Control
HXXXXX_QC_Checklist.doc
HXXXXX_Review_Checklist.doc
HXXXXX_Submission_Checklist.xls

Smooth Tide Request
HXXXXX.pdf (Smooth Tides Request & Abstract Times of Hydro)
HXXXXX.mif/mid files

Supplemental Correspondence
HXXXXX_Correspondence.xxx (digital copies of emails, request & correspondence)

Separates
Logs

Acquisition & Processing
HXXXXX_1010_8101_Log.xls
HXXXXX_1010_8101_Log.xls
HXXXXX_S220_8111_Log.xls
HXXXXX_S220_8160_Log.xls
HXXXXX_Survey_Log.doc

Detached Positions 
HXXXXX_Pydro_Feature_Log.xls
HXXXXX_DPForms.pdf (Scanned  DP forms)

Sound Velocity
HXXXXX_SV_Cast_List.doc  (contains filename, lat, lon, & depth)

Digital Data Submission Checklist

List all Non-Finalized BASE Surfaces - the number of surfaces 
submitted is dependent on the depth range of the data and the 
finest resolution the data can support.



FIELD PRODUCTS
Final Fieldsheet

Notebook Files
Source shoreline shapefiles
HXXXXX_Shoreline_Updates.hob
HXXXXX_Shoreline_Notes.hob
HXXXXX_Charted_Shoreline.hob
HXXXXX_Features.hob (hob file created from xml import)
HXXXXX.hsf (Notebook session)

PR and Constituent Products
Include all products that were provided to constituents

PSS  (Pydro Preliminary Smooth Sheet)
HXXXXX.PSS
Images (Non-SSS contact images associated with Pydro features, named w/unique identifier )
HXXXXX_S57Features.xml

HXXXXX Contents
size
number of files
number of folders

Survey data included in transmittal list text file



Analog Data Submission checklist
HXXXXX Sheet X

Digital Data on Hard Drive (listed on Digital Data tab)

Shoreline boatsheets

DP Forms

Daily acquisition forms
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